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Redwood Shores, CA 94065, USA

If you would like a reply, give your name, address, telephone number, and 
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Preface

Intended Audience
Welcome to Release 11i of the Oracle Common Application Components 
Implemenatation Guide.

This guide assumes you have a working knowledge of the following:

� The principles and customary practices of your business area

� Oracle Common Application Components

If you have never used Oracle Common Application Components, Oracle suggests 
you attend one or more of the Oracle Common Application Components training 
classes available through Oracle University.

� The Oracle Applications graphical user interface

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

Typographic Conventions 
The following table describes this documents typographic conventions.
:

Monospace text Monospace text represents code or SQL statements. 

lowercase italics Lowercase italics in the text represent variables. Substitute an 
appropriate value for the variable.
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Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle Corporation does not own or control. Oracle Corporation 
neither evaluates nor makes any representations regarding the accessibility of these 
Web sites. 

UPPERCASE Uppercase characters within the text represent command 
names, SQL reserved words and keywords, and terms 
associated with the Oracle database.

Indentation Indentation helps to show structure within code examples, 
but is not required. 

<text> Text inside angle brackets can mean either of the following:

� It denotes a variable that is replaced with an actual value at 
runtime. 

� In indicates XML elements in discussions about XML code.

Bold Text in bold either represents a button name or is used for 
emphasis.
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Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Common Application Components.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.

Related Documentation
Oracle Common Application Components shares business and setup information with 
other Oracle Applications products. Therefore, you may want to refer to other 
product documentation when you set up and use Oracle Common Application 
Components.

Oracle CRM Technology Foundation Implementation Guide contains information 
relating to User Management including user registration and management 
performed through the System Administrator’s Console.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Common 
Application Components (and any other Oracle Applications products). This guide 
also includes information on setting user profiles, as well as running and reviewing 
reports and concurrent processes.

You can access this User’s Guide online by choosing ”Getting Started with Oracle 
Applications” from any Oracle Applications help file.
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Documents Related to This Product

Oracle Common Application Components User’s Guide
The User’s Guide contains important reference and background information on 
each of the Oracle Common Application Components modules. In addition, it 
contains procedures and using information that describe the common user and 
tasks that are necessary to perform in each of the modules.

Oracle Common Application Components API Reference Guide
This manual describes the public, supported Common Application Components 
APIs. It includes API information for the following Application modules:

� Resource Manager

� Task Manager

� Notes

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product user 
guides and implementation guides.

Oracle Applications Supplemental e-Business Suite Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
e-Business Suite products. The steps should be done immediately following the 
tasks given in the Installing Oracle Applications guide.
xxx



Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.
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Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle Common Application 
Components. This manual details additional steps and setup considerations for 
implementing Oracle Common Application Components with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle Common Application Components 
with Oracle Applications' Multiple Organization support feature, so you can define 
and support different organization structures when running a single installation of 
Oracle Common Application Components.

Oracle Workflow Administrator's Guide 
Refer to this book for WF setup steps, the administrator Status Monitor, and 
administrative scripts.

Oracle Workflow Developer's Guide
Refer to this book for the WorkflowBuilder, defining workflow processes, and 
defining BES events, subscriptions, agents, and systems.

Oracle Workflow User's Guide
Refer to this book for responding to notifications and the self-service Status 
Monitor.

Oracle Workflow API Reference
Refer to this book for PL/SQL and Java Workflow APIs.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Common Application Components implementation team, as well as for users 
responsible for the ongoing maintenance of Oracle Applications product data. This 
manual also provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
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Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle Common Application Components Implementation Guide
Many e-Business products use Oracle Common Application Components. Use this 
guide to correctly implement Oracle Common Application Components.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Common 
Application Components and reach full productivity quickly. You have a choice of 
educational environments. You can attend courses offered by Oracle University at 
any one of our many Education Centers, you can arrange for our trainers to teach at 
your facility, or you can use Oracle Learning Network (OLN), Oracle University's 
online education utility. In addition, Oracle training professionals can tailor 
standard courses or develop custom courses to meet your needs. For example, you 
may want to use your organization’s structure, terminology, and data as examples 
in a customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Common Application 
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Components working for you. This team includes your Technical Representative, 
Account Manager, and Oracle’s large staff of consultants and support specialists 
with expertise in your business area, managing an Oracle8i server, and your 
hardware and software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with Web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications 
Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
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track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Part I

Getting Started

This part of the Common Application Components Implementation Guide contains 
the following chapters:

� Introduction

� Before You Begin





Introduct
1

Introduction

This chapter provides information on the following topics:

� Oracle E-Business Suite Overview

� Oracle Common Application Components Overview

� New in this Release

1.1 Oracle E-Business Suite Overview
The Oracle E-Business Suite is a comprehensive Web-based answer for 
business-to-business (B2B) and business-to-consumer (B2C) selling, marketing, and 
servicing through the Internet. The Oracle E-Business Suite consists of front-office 
Customer Relationship Management (CRM) applications and back-office Enterprise 
Resource Planning (ERP) applications. These applications automate marketing, 
sales, contracts, service, manufacturing, and supply chain processes as well as 
financial operations, project management, human resources operations, and 
business intelligence systems. 

The Oracle E-Business Suite sits on a multi-layer platform which includes: 

� Oracle 9i Database

� Oracle 9i Application Server

� Common Services and Components

� Oracle Internet Business Intelligence

Oracle 9i Database
All applications reside on the Oracle9i Database. The Oracle database drives 
enterprise E-Business applications, online transaction processing applications 
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(OLTP), query-intensive data warehouses, and high capacity Web sites. Because the 
Oracle database is available on many different platforms, applications can scale 
from handheld to laptop to desktop to enterprise providing consistent information 
over multiple channels.

Oracle 9i Application Server
The Oracle 9i Application Server (Oracle 9iAS) is a middle-tier server which 
independently delivers the technology needed to build Web sites and applications, 
create personalized portals, extract business intelligence, and manage a secure Web 
site infrastructure.

Common Services and Components
All the applications can leverage the common infrastructure and services 
components. Functionality includes Oracle Forms, Oracle Reports, Oracle 
Application Object Library (AOL), the Oracle JDeveloper and Oracle Discoverer 
development tools, the coding and UI standards, and other functionality used by 
the applications. 

For example, you can extend the applications according to your business needs 
using flexfields. You can create and assign responsibilities using the system 
administrator responsibility. Also, you can use Oracle Workflow to configure 
background processes and set up notifications so that all the appropriate managers 
and groups are notified.

Oracle Internet Business Intelligence
Above the E-Business Suite sits the Internet Business Intelligence application. This 
application integrate data from all of the E-Business Suite applications to provide 
key performance measurements, operating alerts, and management reports to every 
decision maker across the enterprise.

1.1.1 The Applications in the E-Business Suite
Customers can seamlessly share data from front-end applications (CRM) to backend 
applications (ERP). The CRM applications include:

� the Marketing suite

� the Sales suite

� the Contracts suite

� the Service suite
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� the eCommerce suite

The ERP applications include:

� Oracle Order Management

� Oracle Supply Chain Planning

� Oracle Manufacturing

� Oracle Financials

� Oracle Human Resources Management System

Customer Relation Management (CRM)
Companies use Oracle's CRM suite of applications to acquire, maintain, and 
enhance customer relationships, by assisting companies with marketing 
automation, sales force automation, contracts management, customer service and 
support, and business intelligence, in a multi-channel environment.

� The Marketing suite provides campaign planning and execution, budget 
management, list creation, reporting and analysis tools. Marketing professionals 
use the Oracle Marketing applications to drive quality leads to sales, to expand 
reach and to maximize marketing effectiveness by using a comprehensive set of 
marketing automation, analysis and multi-channel execution capabilities. The 
Marketing suite offers seamless integration with sales, service and operations.

� The Sales suite provides integrated tools for all those who are involved in the 
sales process, including field salespeople, telesales agents, distributors and 
resellers, customers purchasing over the Internet and sales executives. 

Armed with up-to-the minute information regarding customers, leads and 
opportunities, as well as forecasts and compensation plans and projections, 
managers can proactively and effectively manage a sales force while providing 
the sales people with the information needed to close sales. Using this 
information, the field sales force, telesales teams, resellers, and Web storefronts 
can collaborate in closing more business together as one sales team. 

� The Contracts suite enables authoring, executing and managing contracts, 
warranties and extended warranties which provides visibility to contract 
entitlements and proactively acting upon contractual commitments. Whether a 
buyer or a seller, issuing contracts or receiving them, the Contracts suite 
automates the full contract life cycle. 

� The Service suite manages service activities with the goals of profitability, 
employee productivity and complete customer satisfaction by addressing all 
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service and support activities from initial contact with the customer through 
issue resolution. Automating service efforts can potentially transform an area 
that has historically proven to be a cost center into a revenue generator. 

This suite of applications provides customer support, field service and depot 
repair functionality. In addition, Oracle Services offers complete visibility into 
spare parts availability, logistics, service billing and customer contract 
entitlements. Oracle Customer Care provides full access to customer 
information from each touch point in the enterprise and to each customer care 
agent or other employees who interact with the customer. All of the Service 
products can be deployed across Web, call center and mobile field channels. 

� The eCommerce suite of products aids in establishing profitable long-term 
relationships with customers through one-to-one marketing and personalized 
shopping experiences as well as proactive support and self-service capabilities. 
Oracle eCommerce synchronizes all customer interactions and transactions by 
integrating Web-based channels with traditional channels. 

Enterprise Resource Planning (ERP)
Companies use the ERP applications to control their back-office operations. For 
example:

� Oracle Order Management applications feature advanced configurator 
functionality, global available to promise, flexible pricing support, efficient 
delivery, high volume transactions and flexibility to adapt to changing business 
conditions.

� Oracle Supply Chain Planning applications provide the tools required to 
optimize flow of material, cash, and information across the extended supply 
chain.

� Oracle Manufacturing applications support all styles of manufacturing - 
engineer-to-order, discrete, process, flow, lot based, and project based 
manufacturing.

� Oracle Financials provide solutions for strategic planning, accounting, treasury, 
project management, and travel management. 

� Oracle Human Resources Management System is a comprehensive solution for 
managing a company's human resources, allowing organizations to attract, 
retain and develop critical skills and knowledge on a global basis.
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Common Application Architecture
The Common Application Architecture includes functionality that supports both 
CRM and ERP applications. For example, TCA, Oracle's Trading Community 
Architecture, consists of a database schema and Application Programming 
Interfaces (APIs) where you can model the complex relationships that occur within 
a business community and enter that data consistently throughout the enterprise. 
Because the model is not hierarchical, Oracle applications can model complex 
B2B2C relationships and not to be limited to either a B2B or B2C implementation. 
TCA delivers a 360-degree view of the customer.

1.1.2 Oracle Common Application Components
Oracle Common Application Components is:

� A common infrastructure upon which the CRM applications are built 

� A set of application components that can be used by all of the CRM applications

Oracle CRM Foundation divides into the Oracle Common Application components 
and the Technical Foundation components.

The key to the CRM products is that they are architected, designed, and built as an 
integrated suite of applications using the Oracle Common Application components. 
This layered architecture approach ensures that all CRM applications can interact 
with key business objects in a consistent manner.

One of the most important components of the CRM Foundation is the customer 
data model known as the Trading Community Architecture or the TCA. This 
powerful model permits Oracle to capture complex customer relationships and to 
support flexible business models across industries.

Oracle Common Application Components provide standard APIs for accessing and 
manipulating business objects such as Customers, Resources, and Tasks.

The Oracle Common Application Components business APIs facilitate the 
integration of the CRM suite in heterogeneous Information Technology 
environments where integration with legacy or third party applications is essential.

1.2 Oracle Common Application Components Overview
Oracle Common Application Components’s purpose is to provide the CRM suite 
with a robust architecture, a stable and performing technology stack, and reusable 
application components. 
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The following Oracle Common Application Components include: 

� Resource Manager

� Notes

� Development Tools

� Assignment Manager

� Task Manager

� Calendar (HTML and Forms-based)

� Escalation Manager

� Business Rule Monitor

Resource Manager
Resource Manager is a single repository for defining teams and groups of people. 
Once an entity is defined as a resource, it becomes visible to the entire CRM suite, 
and tasks and calendars, for example, can be associated to this entity.

Notes 
The entire CRM suite uses the notes infrastructure to create, maintain, and share 
notes related to customers, opportunities, service requests, and other business 
objects.

Development Tools
Oracle Common Application Components include several user interface 
components that can be embedded in an Oracle form and used by the other CRM 
modules. These components are referred to as development or infrastructure tools. 
They are:

� Gantt chart, a graphical tool that typically uses a bar chart to show the start 
date, end date and duration of tasks within the project

� Spreadtable, an object that contains rows, columns, and column headers set in a 
grid

Assignment Manager
The Assignment engine determines the best resource to be assigned to tasks based 
on availability and skill set. This engine is used by the various CRM modules to 
automatically assign tasks to a resource or a group of people.
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Task Manager
This is the universal model, which is used by the entire CRM suite. Tasks are 
created and assigned to groups or individuals and are created and shared across 
CRM through Forms and HTML.

Calendar
There are two Calendars. 

� The Forms-based Calendar is a scheduling tool used to define and view 
available times for a resource or a group of resources. Other CRM modules use 
the Calendar functionality to schedule resources. 

� Employees use the HTML-based Calendar as a personal productivity tool to 
effectively manage daily activities, appointments, and tasks.

Escalation Manager
You can manage situations either by creating an escalation document, assigning an 
escalation owner, or defining the necessary actions needed to resolve the escalation 
through the Escalation Manager interface. This module is used extensively by the 
service applications to ensure that Service Level Agreements are met.

Business Rule Monitor
You can proactively manage escalations using the Business Rule Monitor which are 
based on your business logic and needs. It consists of:

� The Business Rule Workbench: this is used to define a business rule

� The Business Rule Monitor: this is the engine that monitors documents over 
time against the user-defined business rules. 

1.3 New in this Release
This release of Oracle Common Application Components has many new features 
subsequent to the 11.5.8 release. These features are listed by module in the following 
section.
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1.3.1 Resource Manager

Ability to Configure Group and Team Member Notifications
You can configure groups and teams to ensure that group and team members 
receive notifications. This is accomplished by integrating resources, groups and 
group members, as well as teams and team members with the relevant Workflow 
roles.

Publishing Business Events
Resource Manager now publishes events such as creating and importing resources, 
updating resources, and deleting resources using the Oracle Workflow Business 
Event System. Applications that contain data directly affected by these events can 
subscribe to them and sync or modify their data accordingly.

Cascading Product Skill Ratings
Resource Manage provides options for cascading a product skill rating. You can 
cascade a product rating for all of its components, for only those components that 
are not already rated, or for none of its components.

Synchronizing End Dates for Employee Resources
Resource Manager enables you to synchronize the end date of an imported 
employee resource with the original employee resource in the application from 
which it was imported. The synchronization process also enables you to augment 
the end date with a unit of time specified in the "Resource active days after 
termination of source" profile option. This provides additional time to process the 
termination of the employee resource instead of doing so on the end date.

New Seeded Roles, Roletypes, and Groups
Resource Manager contains the new seeded data to support resources for the 
following:

� Oracle Advanced Service Online (AHL). The roletype, Default ASO Approver 
and the role Default ASO Approver support AHL resources. 

� Oracle Lease Contracts (OKL). The roletype Contracts, and the roles, 
Remarketer Team and Contract Portfolio Team support OKL resources.

� Oracle Service Contracts. The group Service Contracts supports Oracle Service 
Contracts Resources.
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1.3.2 Notes

HTML Notes Data Security Rules
HTML Notes module leverages the Application Object Library (AOL) data security 
model by using the object-oriented concept to allow you to customize the security 
rules and then grant object level security to users with qualifying access privileges.

In general, HTML Notes module provides the following security access if users are 
granted with these access privileges:

� Ability to view a note

� Ability to create a note

� Ability to update a regular note

� Ability to update a large note

� Ability to update a note’s secondary information including note type, status, 
relation (relate to) and attachment

� Ability to restrict "note type" list of values

Query Notes by "Source" and "Related To" in Forms
Like the functionality in the contextual HTML Notes, the Forms-based Notes 
module now adds two new radio buttons that enable users to view notes by either 
"Source" or "Related To."

By default, the "Source" radio button is selected to show all notes associated with 
the source from where the note is created. If the "Related To" button is selected, then 
the Notes window will query all notes associated with the source to which the 
current source is related.

Dynamic Exclusion of Inactive JTF Objects List of Values
Task Manager and Notes now allow unwanted resources or parties to be 
dynamically excluded from the resource list of values, such as the Relate To field if 
based on resources. For example, when relating a note to a party, the Relate To 
drop-down list returns all active parties. All inactive parties will be dynamically 
excluded from the Relate To list of values.

This functionality is enhanced by adding an extra column "INACTIVE_CLAUSE" to 
the JTF_OBJECTS table which dynamically filters out inactive data for the objects.
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1.3.3 Assignment Manager

Ability to Configure Color Coded Tasks
When implementing or administering Assignment Manager, you can now configure 
color coded tasks. Assignment Manager stores seeded color data in a color 
configuration table. You can modify the seeded color data stored in this table or 
create your own custom colors. Two of Assignment Manager’s default colors, 
however, are hard coded and cannot be modified.

Customizable UI
Assignment Manager is used by different applications each of which generally 
requires a limited subset of its total available fields and options. For this reason, 
when implementing Assignment Manager, the implementor or system 
administrator can customize its UI based on their application requirements. The 
Assignment Manager UI can be customized to meet the individual requirements of 
the following applications:

� Tasks

� Service Requests

� Service Request Tasks 

� Escalations

Assignment Manager stores seeded UI configuration data for each document type 
in a configuration table. In addition to modifying this data as required, you can also 
create new document types that retain default Assignment Manager UI.

Task Labels Appear in GANTT Chart
In addition to displaying color coded tasks, the GANTT Chart now displays task 
labels. When you view a resource in Assignment Manager, information for that 
resource including its assigned tasks is displayed in the GANTT chart.

Setting Up Enhanced Planning Options
Assignment Manager enables you to configure time planning options that use the 
SYSDATE and TIME functions to indicate the start of a shift instead of defaulting to 
the task’s start date. This is useful in situations where the task’s start date precedes 
the date and time in which the shift is assigned and consequently predates the 
resource’s shift assignment. Enhanced planning options are configured using the 
JTFAM:Use systime for Assignments profile option which is set to Yes or No at the 
site level. When set to Yes, the profile option enables the SYSDATE and TIME 
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functions to determine the start of a shift. When set to No, the profile enables the 
task start date and time to represent the start of a shift.

Gantt Chart Displays Overlapping Task Bars
The Gantt chart has been enhanced to visually indicate when a resource has more 
than one task assigned at the same time. Overlapping tasks are now displayed in a 
staggered fashion that provides a clear indication of when resources are assigned 
multiple tasks at the same time.

Gantt Chart Contains New Views or "Time Modes" 
The Gantt chart contains a new "six-hour" and a "three hour" view. Right clicking in 
the date section of the Gantt view can change the "Time mode". This enhancement 
enhances the Gantt chart’s usability by enabling the timescale to be changed with 
greater precision. Major and minor time ticks are additionally displayed in a more 
consistent, readable fashion.

User Level Profile to determine the default view in the Gantt Chart
The Gantt chart now recognizes a user level profile option that determines the 
initial Time Mode used in the Gantt. This profile option sets the default view for 
Assignment Manager. The default setting is the "day" mode.

Gantt Chart Provides Limited Keyboard Support
Keyboard support has been added for navigation within the resource section of the 
Gantt chart. Standard forms keyboard accelerators (commit, help, popup menus etc) 
are now recognized.

1.3.4 Tasks

HTML Task Data Security Rules
HTML Task Manager leverages the Application Object Library (AOL) data security 
model by using the data object oriented concept to replace hard-coded security 
rules. This way, data entered in Tasks can be further protected from accessible to the 
finest data security level. Task security rules can be easily customized and then 
granted to appropriate users with right access privileges. This functionality only 
applies to the HTML Tasks, not the Forms-based Tasks.

In general, HTML Task Manager provides the following data security rules in 
addition to supporting existing task rules:
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� Security access to stand-alone tasks and contextual sensitive tasks

Task Manager supports existing rules used for stand-alone and contextual 
sensitive tasks. Additionally, with the new security rules, users can be further 
granted with access privileges (full access or read only) for tasks with certain 
attributes, such as non-private tasks. To support backward compatibility, your 
system administrator can turn the new security rules on or off by using the Task 
Manager: Set Context Data Security profile option. When new security rule is 
enabled, "who has what permissions to access which task objects" is determined 
by the granted privileges.

� Security rules in granting resource list of values (LOV) access

The resource LOV can be secured and granted to an individual resource, all 
members of a group, or all resources. For example, if all members of a 
marketing group are assigned to Nancy Smith, then she will only see those 
marketing group members displayed in the resource list of values.

� Security rules in granting group managers access privileges to their 
subordinate’s non-private tasks

Based on the group hierarchy defined in Resource Manager, each manager can 
have full access or read only privileges to his or her subordinate’s non-private 
tasks if necessary privileges are granted to managers. In addition, this 
manager-directs security access only covers one level below. It does not include 
any multiple levels beneath.

Dynamic Exclusion of Inactive JTF Objects List of Values
Task Manager and Notes now allow unwanted resources or parties to be 
dynamically excluded from the resource (or source values) list of values. For 
example, an inactive employee will be dynamically excluded from the resource list 
of values, so that a task will not be assigned to an inactive employee.

This functionality is enhanced by adding an extra column "INACTIVE_CLAUSE" to 
the JTF_OBJECTS table which dynamically filters out inactive data for the objects.

Prevention of Duplicate References for Tasks
When a task is created with a resource of category party either as the customer, 
owner, or assignee, additional party references are also created and visible in the 
Tasks. If the party type is Source, then one reference for that source will be created. 
If the customer type is Person or Organization, then one reference for that person or 
organization will be created. If the customer type or resource type is Relationship, 
then three associated party references will be created:
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� The relationship itself (such as Jeff Walsh at Oracle Corporation)

� The party who is the subject of the relationship (Jeff Walsh)

� The organization which is the object of the relationship (Oracle Corporation)

If a task is created for Oracle Corporation and has the same resource, Jeff Walsh, 
listed twice as the customer contact, then the references of both the relationship and 
the party are also generated twice. 

To prevent the duplication of party references created for tasks, Task Manager 
makes the following enhancements:

� If a user manually adds any duplicate references in the Forms-based or HTML 
Tasks, then an error message will appear stating that the reference already 
exists.

� If calling modules call the JTF_TASK_REFERENCES_PUB. Create_References ( ) 
or JTF_TASK_REFERENCES_PUB.Update_References ( ) API that leads to the 
creation of duplicate references, then the system will ignore the duplicated 
references.

Users can manually delete existing references that are shared by one or more 
attributes without problems. For example, if you delete a customer contact name 
"John" for Oracle Corporation, then system will automatically delete the contact 
"John" as well as the relationship information "John at Oracle Corporation", but it 
will leave the organization "Oracle Corporation" unchanged in the system.

A New Search Criterion for Escalated Tasks Appears in the Find Tasks 
Window
A new search criterion, the Show Only Escalated Tasks check box, is now added in 
the Find Tasks window in Task Forms. This allows users to search for escalated 
tasks of all escalation levels if the check box is selected.

A New Alert Appears While Trying to Update Customer Information
Whenever a user tries to update customer information for an existing task in both 
Forms-based and HTML Tasks, a new warning message appears stating "The 
customer for this task will change. Changing the customer will remove the existing 
contacts for this task."

After user confirms this change, the customer name and number will be updated, 
and the contacts and contact points for the former customer will be removed from 
that task. Therefore, the user must then select new contacts from the newly added 
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customer for that task. If user declines this change after seeing this message, then 
there should be no change to the original customer.

Enhancements in the Task Template Groups Setup Window
Task Manager has the following enhancements in the Task Template Group setup 
screen:

� Two Descriptive Flexfields Are Available

Task Manager adds two new Descriptive Flexfields (DFF) in the task template setup 
screen which enables users to enter predefined flexfield information while defining 
task templates or template groups.

These two new descriptive flexfields are:

– Task Templates additional information. This flexfield located in the 
Related Task Templates region is used for the task template. Its values can 
be passed to the tasks that are created based on the task template.

– Task template groups additional information. This flexfield located in the 
Template Groups region is used for the template group; therefore, its values 
are stored in the template group and will not be passed to tasks.

� Task Type and Priority List of Values Are Based on Selected Document Type

When you define individual task template for a task template group, the available 
task Type and Priority list of values selection should be restricted by the selected 
document type for your template group. For example, if a template group is created 
for Service Request, then you should see only the service request related task types 
and priority information listed in the drop-down while defining task template 
attributes. 

Only Display Mapped Task Types and Mapped Task Priorities
When selecting a task type and a task priority from the list of values, you can only 
see the task types and the task priorities that are mapped to your source object 
displayed in the list of values. Any unmapped task types and unmapped task 
priorities to your source object are now dynamically excluded from the lists. In 
addition, if none of the types or task priorities is mapped to your source object, then 
you will see all task types and priorities from the list of values.

It is important to note that this enhancement changes the available task types and 
priorities shown in the list of values. In the past, you can see all your mapped task 
types or mapped priorities, AND other unmapped types or unmapped priorities 
that do not have any source object attached to them. Now, only the mapped task 
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types and mapped priorities will be displayed in the list of values. All other 
unmapped types or priorities will not be in the list.

Therefore, any user-defined task types or priorities need to be mapped to your 
source object; otherwise, you will not see them from the list after defining them.

How to map task types and task priorities, see Defining Task Types and Defining 
Task Priorities sections in the Oracle Common Application Components Implementation 
Guide.

Change Task "Name" to "Subject" Both in Forms and HTML Tasks
To better describe the purpose of a task creation and to alleviate possible confusion, 
Task Manager uses "Subject" as the field name to replace the task "Name" field in 
both Forms-based and HTML Tasks. The field name change propagates throughout 
Task Manager, in every place where the field is exposed. This includes the Forms 
and HTML Task screens as well as those owned by Service, Telesales, Customer 
Care, UWQ, Dispatch, Sales Online, Contact Center, Field Service Laptop, and Field 
Service Palm. To get the revised task "Subject" field title in the UIs owned by other 
products, please consult product-specific documentation for details.

Please note that after this replacement, task behavior should be the same as it was 
before. No other change should be expected.

Deletion of Personal Saved Search Records
Task Manager adds the Delete button in the personalized Saved Searches window 
that allows you to delete saved search records. After deleting existing saved 
searches, users are directed to the Task Search screen with a confirmation message. 
Only the seeded "My Open Tasks" saved search is not deletable. If users attempt to 
delete the seeded query "My Open Tasks", then an error message will be displayed 
on the screen. 

Deletion of Existing HTML Tasks
Task Manager adds the Delete button in the Task Details window for the HTML 
Tasks. This allows users to view the task details first and then decide wether or not 
to delete the task. Once a task is deleted, users are taken to the Task Summary 
window with a confirmation message.

Support Spreadtable Query Changes in Task Forms’ Spreadtable
In order to show only tasks with a specific task type (task_type_id) displayed in the 
JTF_TASKS spreadtable for the Forms-based Tasks, Task Manager modifies the 
where_clause constructed for Forms to include the where_clause set for the Tasks 
Introduction 1-15



New in this Release
form (Data Source Name: JTF_ TASKS) in the Metadata definition for spreadtable. 
As a result, the where_clause set for spreadtable will not be overridden by the 
where_clause constructed for the Forms.

Provide Color Data in a Table for Assignment Manager
In order for Assignment Manager to configure color-coded tasks, Task Manager 
now provides seeded color data in a color configuration table that stores a color for 
a given combination of Task Type, Task Priority, and Task Assignment Status. The 
color configuration table may also store additional color coding information that are 
defined by customers. The additional color codes must be stored in all three color 
formats supported by the table: Hex, RGB, and Decimal.

How to configure color coded tasks, see Assignment Manager in the Oracle Common 
Application Components Implementation Guide.

Task Manager Has One New Profile Option
Task Manager uses profile option Task Manager: Set Context Data Security to control 
task data security for the context sensitive tasks. It allows your administrators to 
turn the task security rules on or off based on your business needs.

For more information on this profile option, see Appendix A: Profile Options.

1.3.5 Calendar

Display of Calendar Events in HTML Calendar
In addition to scheduled appointments and tasks, HTML Calendar provides the 
ability to allow users to view calendar events, such as campaigns, on their calendar 
views. 

In order to use this functionality, the integrated applications have to perform the 
following tasks: 

1. Identify resource groups to which they would like to publish events and add 
CALENDAR_ITEMS usage to the groups.

2. Make sure that business objects (known as events in calendar) that are 
published are valid JTF_OBJECTS with all the following metadata defined:

� SELECT_NAME 

� SELECT_ID 

� FROM_TABLE 
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� OBJECT_CODE 

� WHERE_CLAUSE 

� WEB_FUNCTION_NAME 

� WEB_FUNCTION_PARAMETERS 

� WEB_HTML_CALL

3. Populate the JTF_CAL_ITEMS_B table using the JTF_CAL_ITEMS_PUB API. 

In order to view the calendar events in the personal calendars, calendar users must 
meet the following conditions:

� Users must belong to resource groups to which the event is published. 

� Users must have the "Display Events" set to yes in the calendar personal 
preference page from the Profile navigation link. 

� Users must further personalize how these calendar items will be displayed in 
their personal calendars by selecting the desired color and prefix text. 

This feature will work only when integrated applications implement the 
functionality and follow the required steps.

Oracle Marketing Online (OMO) is one of the applications that is currently 
implementing this functionality. Please refer to Oracle Marketing Online 
Implementation Guide for more details.

Ability to Differentiate Appointments from Tasks
The Calendar Personal Preferences page now allows you to choose desired color 
from drop-down list and to enter prefix that you wish to display in your calendar 
for appointments, tasks, and calendar items (like Marketing objects). 

This functionality is similar to the Group Calendar Subscription page to have 
different color or prefix selected for your subscribed group calendar events. The 
prefix can have up to 20 characters.

Appointment Drill Down Security Access
HTML Calendar provides the following security access for notes attached to an 
appointment:

� Owner of the appointment can have full access (view, update, and delete) to the 
notes created by him.
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� Invitees can have full access to the notes created by the appointment owner in 
the appointment accept or reject page.

� When a searched note has a source of appointment and you are not the owner 
or the attendee of the appointment, you will see a message "You do not have 
permission to access this page." displayed when trying to access the note.

Since the HTML Notes module leverages the Application Object Library (AOL) data 
security model to provide new security rules, it may change the behavior of 
accessing Notes from appointment drill down screens depending on the security 
rules setup in Notes. 

See HTML Notes Security Rules section, Data Security for HTML Notes chapter in 
the Oracle Common Application Components User’s Guide about the notes security 
access.

Previous and Next Months Dates and Tasks Displayed in The Current 
Month’s Calendar Monthly View
Calendar users now can view the last days of the previous month and the first days 
of the upcoming month displayed in the current month’s calendar monthly view 
but in gray color. In addition, if any tasks and appointments are scheduled within 
these previous and next months, then users can also see them shown in the current 
month’s calendar monthly view.

For example, the monthly view of October 2002 displays not only the appointments 
and tasks for October 1 to October 31, but also the tasks and appointments of 
previous month September 29, 30 and next month November 1 and November 2 in 
gray.

Group Calendar Appointments Cannot Be Private
HTML Calendar makes some enhancements for group calendar by removing the 
"private" check box in the Create Appointment window if the appointment is 
created for a group calendar. Therefore, all group calendar appointments are public 
to the group calendar subscribers.

Show Only Appointment Types Mapped to Object "Appointments"
Similar to the method used to map task types in Task Manager, HTML Calendar 
uses the same method of mapping desired task types to the object "Appointments" 
to control the Appointment types that appear in the drop down list. Only those 
types mapped to the object "Appointments" will be shown in the appointment type 
drop-down list. If no types are mapped, then all of the types will be displayed in the 
drop-down list.
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How to map task types, see Defining Task Types section in the Oracle Common 
Application Components Implementation Guide.

Public Calendar Description Enhancement
The description information of a public calendar can now be displayed in a 
wrapped text format if the description is very long.

Confirmation Message Appears at the Same Page Upon Appointment 
Deletion
Previously, when deleting an appointment, the confirmation message would appear 
on a blank page and you would have to manually navigate back to the original page 
where the appointment was deleted. Now, HTML Calendar enhances this usability 
by showing the confirmation message on the top of the calendar daily view page.

Calendar Privilege Code Modification for Task Security
When a user gives calendar access privilege to another resource, the access for tasks 
is also given simultaneously. The same functionality applies while revoking the 
grants. Since Task Manager leverages the AOL data security model, task security 
can be further customized around granting access to tasks. Granting calendar access 
to another user will still result in granting task access to the user. However, the 
access to the tasks can be restricted if additional data security has been 
implemented for tasks.

In the backend, the data entered into FND_GRANTS table is not compatible with 
the FND_APIs work. For the purpose of backward compatibility, a new row for the 
task security is created while the same row for calendar is still kept. Therefore, on 
every grant, there would be two rows created (instead of one row). The same is true 
for every revoke. Two rows will be deleted.

See Customizing HTML Task Security chapter in Oracle Common Application 
Components Implementation Guide about customizing task security.

Task Status Transition Rules Applies to the Calendar Datebook
In the past, when creating private tasks in the Calendar Datebook, users can see all 
task statuses in the Status list of values. Now, the Forms-based Calendar uses the 
task status transition rules defined in Task Manager to list only the task statuses 
specified in the transition rule that is associated with a user’s logged-in 
responsibility. The default value set in the “Task Manager: Default Task Status” 
profile option should be based on the task status transition rules defined in Task 
Manager.
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For example, if a Service Request transition rule is associated with the Field Service 
Dispatcher responsibility, then only the user logging with the same responsibility 
can see all relevant transition statuses displayed in the list of values. Please note 
that this feature is also available in the previous release.

See Defining Task Statuses and Status Transition Rules section about how to define 
task status transition rules in Task Manager of the Common Application Components 
Implementation Guide.

1.3.6 GANTT

Optional Startup Mode
GANTT has a new profile option, JTF_GANTT_DEF_TIMELINE_MODE that enables 
users to choose a startup mode. Available Startup Modes include:

� 15 Minutes Mode

� 30MIN

� Hours Mode

� 3 Hours Mode

� 6 Hours Mode

� Days Mode 

1.3.7 User Management

Flexible Address Fields
User Management contains flexible address fields that display the required address 
fields for different countries on the User Detail page, instead of displaying the same 
address fields for each country. On startup, address fields are displayed for the 
default country specified by the new JTA_UM_DEFAULT_ADDRESS_STYLE profile 
option.

Universal Approver Notifications
Universal approvers now receive notifications when a new approval is required. 
Previously, universal approvers had to log into the system and query approval 
requests for their organization to determine whether new approvals were required. 
This feature requires no additional configuration.
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Email Address Functions as User ID
The new profile option, JTF_UM_EMAIL_AS_USERNAME optionally enables user 
management to also use the email address information as a User ID. When set to 
Yes, the profile option disables the User ID field on the User Management 
registration screen. When set to No, the User ID is configured in the same manner 
as all prior releases of User Management.

New Profile Option: JTA_UM_HIDE_QUICKFIND
The new profile option JTA_UM_HIDE_QUICKFIND optionally hides the 
Quickfind menu on from users. The quickfind menu is not available to the guest 
user. When the guest user signs on, the value for this profile option is irrelevant.

New Information is Included in Confirmation Email Messages for 
Registration, Enrollments, and Password Reset 
During the registration process, User Management sends confirmation e-mail 
messages for User Types, Enrollments, Passwords, and Account Status. These 
messages now include the following:

� Registration Confirmation: User Type Approval Required

� Registration Confirmation: User Type Approval not required

� Registration Confirmation: User Type Approval required, no enrollments

� Registration Confirmation: User Type Approval not required, no enrollments

� Registration Confirmation for additional enrollments

� Reset Password Notifications

� FND User Account Inactivated Notification

TCA Uptake
TCA enhancements are now included in this release. Both the TCA Relationship 
Model and the v2 API's will be leveraged by User Management.

Improved Approval Email Messages
New approval workflows have been created to address User Type Approval 
Required, User Type Approval Notifications, Enrollment Approval Required, and 
Enrollment Notifications:

� User Type Approval Required
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These approvals generate workflow e-mails during the User Type requisition 
process:

– User Type Approval Request

– Reminder: User Type Approval Request

– Fail to Escalate User Type Approval Request

� User Type Approval Notifications

These notifications are sent during the User Type registration process:

– Primary User Request Approved

– Primary User Request Rejected

– Business User Request Approved

– Business User Request Rejected

– Individual User Request Approved

– Individual User Request Rejected

– Other User Request Approved

– Other User Request Rejected

� Enrollment Approval Required

These approval notifications are sent during the enrollment requisition process:

– Enrollment Approval required

– Reminder: Enrollment Approval Required

– Enrollment Approval Required (to Primary User Group)-Delegation 
Privileges available

– Enrollment with delegation Approval required

– Reminder: Enrollment with Delegation Approval Required

– Fail to Escalate Enrollment Request

– Fail to Escalate Enrollment Request with Delegation Request

� Enrollment Approval Notification

These notifications occur upon approval/rejection for enrollments:

– Enrollment Request Approved
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– Enrollment Request Rejected
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Before You
2

Before You Begin

This chapter provides an overview of what you need to have installed, 
implemented, and verified before implementing the Oracle Common Application 
Components. Topics include:

� Related Documentation

� Installation Verification

� Application Procedures

� Oracle Common Application Components Dependencies

2.1 Related Documentation
You may also want to consult the following documentation:

� Installing Oracle Applications, Release 11i

� Implementing e-Business Suite Applications

� Oracle Common Application Components User’s Guide

� Oracle Common Application Components Technical Reference Manual

2.2 Installation Verification
Before attempting to run e-Business Suite applications, first verify that you can 
perform the tasks outlined in the following table. The listed tasks are generic tasks 
that are typical of all users of the Oracle E-Business Suite. Depending on your 
business processes, and the modules that you are installing, not every listed task is 
applicable to your installation.
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The following table describes the non Common Application Components tasks that 
need to be performed, and which Common Application Components require the 
completion of the task before implementation.

Table 2-1 Application Dependency Checklist

Application Task Common Application Components

Application Object 
Library

1. Create an FND user

2. Assign AOL responsibility to the 
user

3. Set profile option

� Resource Manager

� Notes

� Spreadtable

� Gantt 

� Assignment Manager

� Task Manager

� HTML-based Calendar

� Forms-based Calendar

� Escalation Manager

� Business Rule Monitor

Oracle Human Resources Create an employee Resource Manager

Oracle Human Resources Create a new business unit Resource Manager

Oracle Receivables 1. Create a customer

2. Create a new organization

Resource Manager

Oracle Workflow Create a workflow with notifications � Resource Manager

� Task Manager

� HTML Calendar

� Notes

� Business Rule Monitor

� Escalation Manager

Oracle Inventory 1. Define categories

2. Define products and platforms

3. Define unit of measure

4. Define unit of measure classes

� Resource Manager

� Task Manager

� Assignment Manager
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2.3 Application Procedures
You must be able to complete each of the following non-e-Business Suite tasks 
successfully for your e-Business Suite applications to work properly. If you are 
unable to complete a task successfully, then correct the problem before continuing.

2.3.1 Creating an FND User
Perform the following steps to create a FND user in the Application Object Library.

Reference
Oracle Applications System Administrator’s Guide, See Chapter 2, Managing Oracle 
Applications Security

Prerequisites
None

Responsibility
System Administrator

Navigation
Navigate to Security > User > Define.

Steps
1. In the User window, enter a new user name in the User Name field.

2. Enter a password in the Password field.

3. Re-enter the password for verification.

4. Select the employee’s name from the list of Values (LOV) in the Person Field.

Oracle Purchasing Create a supplier contact Resource Manager

Oracle Order 
Management

Define sales credit types Resource Manager

Oracle General Ledger Set up descriptive accounting flexfields Resource Manager

Table 2-1 Application Dependency Checklist

Application Task Common Application Components
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5. In the Responsibilities sub-tab, select the CRM HTML Administration 
responsibility from the drop-down list of values.

6. Save the new user.

To verify that the user setup is successful, perform the following steps:

1. Login to your Personal Home Page as the newly created user.

2. Enter your new password when prompted.

You should now be able to access the Personal Home Page for this user.

2.3.2 Assigning AOL Responsibilities to the User
A responsibility defines an application user’s current privileges while working with 
Oracle Applications. When an application user signs on, they select a responsibility 
that grants certain privileges, specifically:

� The functions that the user may access. Functions are determined by the menu 
assigned to the responsibility.

� The concurrent programs, such as reports, that the user may run.

� The application database accounts to which forms, concurrent programs, and 
reports connect.

You cannot delete a responsibility because this information helps to provide an 
audit trail. You can deactivate a user’s responsibility at any time by setting the End 
Date to the current date. If you wish to reactivate the responsibility for the user, 
change the End Date to a date after the current date, or clear the End Date.

After creating the FND User, perform the following steps to assign the user AOL 
responsibilities.

Reference
Managing People Using Oracle HRMS (US), See Chapter 1, Employee Management

Prerequisites
None

Note: For this user to have access to HTML applications, you 
must set additional profile options as detailed in the Implementing 
Oracle Common Application Components manual.
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Responsibility
System Administrator

Navigation
Navigate to Security > User > Define.

Steps
1. With the user information populated in the window, select the Responsibility 

field in the Responsibilities tab.

2. Select the necessary responsibility from the List of Values (LOV).

3. Define the Effective dates.

4. Save your work.

2.3.3 Setting Profile Options
A user profile is a set of changeable options that affect the way your application 
looks and behaves. As System Administrator, you control how Oracle Applications 
operate by setting user profile options to the values you want. You can set user 
profile options at four different levels: site, application, responsibility, and user.

After creating the FND User, perform the following steps to set profile options.

Reference
Managing People Using Oracle HRMS (US), See Chapter 1, Employee Management

Prerequisites
None

Responsibility
System Administrator

Navigation
Navigate to Security >Profile > System.

Steps
1. In the Find System Profile Values window, select an appropriate check box for 

the profile option that you want to set before clicking Find.
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The System Profile Values window opens with the profile option you searched 
for.

2. Set an appropriate value for your profile option if the checkbox is selected:

a. Set the Site value.

This field displays the current value, if set, for all users at the installation 
site. 

b. Set the Application value.

This field displays the current value, if set, for all users working under 
responsibilities owned by the application identified in the Find Profile 
Values block.

c. Set the Responsibility value.

This field displays the current value, if set, for all users working under the 
responsibility identified in the Find Profile Values block.

d. Set the User value.

This field displays the current value, if set, for the application user 
identified in the Find Profile Values block. 

You should set site-level default values for any required options after 
installation of an application. If you do not assign a particular profile option 
at any of the four levels, that option does not have a default value and may 
cause errors when you use forms, run reports, or run concurrent requests. 

3. Save your work.

2.3.4 Creating an Employee
To successfully run most of the e-Business Suite products, you must first create 
employee resources within the ERP Human Resource Management System (HRMS) 
application. Perform the following steps to define an employee for minimal 
functionality.

Note: If Oracle HRMS is not installed, then you must enter a new 
employee using the Enter Person form by navigating to Resource 
Manager > Maintain Employee > Employee.
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Reference
Managing People Using Oracle HRMS (US), See Chapter 1, Employee Management

Prerequisites
None

Responsibility
US HRMS Manager or US Super HRMS Manager

Navigation
Navigate to People > Enter and Maintain.

Steps
1. Click New In the find window.

The People window opens.

2. Enter the following employee information in the appropriate form fields:

�  Last Name

�  First Name

�  Title

3. Select the person’s gender from the drop-down list.

4. Select Employee from the type drop-down list.

5. Enter the person’s social security number.

6. Save you work.

2.3.5 Creating a New Business Unit
A Business Group is a special class of organization. Every Business Group can have 
its own set of default values, with its own internal organizations, grades, jobs, 
positions, payrolls, employees, applicants, compensations and benefits.

Organizations are the basic work structure of any enterprise. They usually represent 
the functional, management, or reporting groups which exist within a Business 
Group. Perform the following steps to create a new business unit.
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Reference
Oracle Applications System Administrator’s Guide, See Chapter 2, Managing Oracle 
Applications Security

Prerequisites
None

Responsibility
US HRMS Manager or US Super HRMS Manager

Navigation
Navigate to Work Structures > Organization > Description.

Steps
1. Click New in the Find Organization window.

2. Enter the name for the Organization

3. Select Business Unit from the list of values (LOV) in the Type field.

The current date populates the From Date field.

4. Enter the Organization location details from the LOV.

5. Save your work.

6. In the Organization Classification region, select the classification from the LOV.

7. Select the Enabled check box.

8. Save your work.

9. Click Others for additional information on the classification you selected.

10. Save your work.

2.3.6 Creating a Customer
Perform the following steps to create a new customer, with an address and contact 
information in the Oracle ERP Accounts Receivables application.

Reference
Oracle Receivables User’s Guide, See Chapter 3, Customers
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Prerequisites
None

Responsibility
Receivables Manager

Navigation
Navigate to Customers > Standard.

Steps
1. In the Find/Enter Customers window, select Person from the Customer Type 

drop-down list.

2. Enter the name of the customer in the Name column.

3. Click Find to ascertain if the customer already exists.

As this customer does not exist, the New button is enabled in the Decisions 
window.

4. Click New.

The Customer-Standard window opens.

5. On the Address tab, click New to create a new address.

The Customer Addresses window opens.

6. Fill in the necessary information. Yellow fields are mandatory.

7. On the Business Purpose tab, fill in the Usage, Location and select the Primary 
check box. For example:

�  Usage: Marketing

�  Location: 6op9

�  Primary: Yes

8. On the Contacts: Telephones tab, enter a new contact and phone number.

9. Save your work.

Verify Your Information
To verify that the process worked properly, perform the following steps.

1. Open the Customer-Standard window again.
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2. Enter the company name you entered above.

3. Click Find to query for the record you created in the Match Results window.

4. If the record is found, click the Contacts: Telephone tab.

5. Place the cursor in the Last Name field.

6. From the menu, navigate to View > Query by Example > Enter.

7. Enter the contacts last name as the search criteria.

8. Select View > Query by Example > Run.

If the record for your contact name is populated, then you have successfully 
created a customer with an address and a contact person for the customer.

2.3.7 Creating a New Organization
Perform the following steps to create a new organization, with an address and 
contact information in the Oracle ERP Accounts Receivables application.

Reference
Oracle Receivables User’s Guide, See Chapter 3, Customers

Prerequisites
None

Responsibility
Receivables Manager

Navigation
Navigate to Customers > Standards.

Steps
1. In the Find/Enter Customer window, select Organization from the Customer 

Type drop-down list.

2. Enter the name of a test corporation in the Name field.

3. Click Find to ascertain if the customer already exists.

As this customer does not exist, the New button is enabled.

4. Click New.
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The Customer-Standard window opens.

5. On the Address tab, click New to create a new address.

The Customer Addresses window opens displaying the same business purpose 
table as on the first tab.

6. Fill in the necessary information. Yellow fields are mandatory.

7. On the Business Purpose tab, fill in the Usage, Location and select the Primary 
check box. For example:

�  Usage: Marketing

�  Location: 6op9

�  Primary: Yes

8. On the Contacts: Telephones sub-tab, enter a new contact and phone number.

9. Save your work.

2.3.8 Creating a Workflow With Notifications
Perform the following steps to create and run a workflow with notifications.

Reference
Oracle Workflow Developer’s Guide, See Chapter 3, Defining a Workflow Process and 
Chapter 4, Defining Workflow Process Components

Prerequisites
None

Responsibility
Workflow Administrator

Navigation
Navigate to Workflow > Launch Processes.

Steps
1. In the Launch Processes window, In the Item Type column, click Document 

Management. If you have renamed the item types, this option appears in the 
Internal Name column as WFDM.
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The Initiate Workflow-WFDM page opens.

2. Enter values in the following fields:

� Item Key: Enter your name plus a sequence number (for example, jdoe1001)

� User Key: You may copy the value in the Item Key field

� Process Name: Enter Document Review

� Process Owner: Your logged in user name populates automatically

� Send Document: Leave blank

� Document Owner: Select a valid resource name

� Document Reviewer: Choose one from the list of values

� Comments: Enter Workflow Verification

� Response Document: Leave blank

3. Click OK.

The Activities List page opens to show workflow statuses. The status of the 
workflow you just initiated should be Active.

4. If the status of the workflow is Error, click Exception in the Result column to see 
an explanation of the error.

5. Click View Diagram to see a graphical representation of the workflow process.

Leave the View Diagram window open as you continue to check the workflow.

6. Save your work.

To Review the Progress of a Workflow
Use the following procedure to verify that the Workflow notification is sent.

Steps
1. Login to your Personal Home Page.

2. In the list of Self Service Apps, choose the Workflow User Web Application 
responsibility.

3. In the Navigator, choose Workflow >Find Notifications.

The Find Notifications page opens.
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4. In the Type field, enter Document Management. In the To field, enter the 
document reviewer.

5. Click Find.

The Worklist window opens.

6. Click Subject to open the notification.

If you see the notification, then workflow is set up correctly.

7. Click Approve to return to the Worklist window.

Further Verification
You may go back to the View Diagram window that you opened earlier. Click 
Reload in the browser window to refresh the contents of the window. After the 
workflow process completes successfully, you can see a green line from the Start 
icon to the End (Approve) icon.

2.3.9 Defining Categories
You can use categories and category sets to group items for various reports and 
programs. Perform the following steps to define categories.

Reference
Oracle Inventory User’s Guide, See Chapter 4, Item Setup and Control

Prerequisites
The categories you assign to a category set must have the same flexfield structure as 
the set itself. This is true even if you choose not to validate the category list.

Responsibility
Inventory

Note: Category sets may be used as a means to develop custom 
lists of items on which to report and sort. You can also create other 
category sets such as John’s Priority or Jane’s Priority, with 
categories like high, medium, and low.
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Navigation
Navigate to Setup > Items > Categories > Category Sets.

Steps
1. Select the appropriate organization name in the Organization window, if 

necessary.

2. In the Category Sets window, enter a unique category set name and description 
information.

3. Enter a flexfield structure.

4. Select a control level.

� Master Level: Item assigned to this category set has the same category value 
in all organizations where it is assigned.

� Org Level: Item assigned to this category set may have a different category 
value in each organization where it is assigned.

5. Select a default category.

This is the default category used when assigning an item to the category set. For 
example, a category set may have a default category called New. After an item 
is assigned to New, you can override the default category and choose another 
relevant category for each item.

6. Decide whether or not an item can be assigned to multiple categories within 
this category set. 

� Enable: You can assign an item to multiple categories within a category set. 
For example, you may define a Hazard category set. In this case, an item 
may be assigned to both the Poison and Corrosive categories. 

� Not Enable: You can assign an item to exactly one category. For example, 
you may define a Web Display category set. In this case, an item can be 
assigned to only one default display category.

7. Decide whether or not to enforce the list of valid categories.

� Enable: You can assign an item only to those categories defined as valid 
categories for this category set. For Oracle Purchasing, this check box is not 
applicable, and you can assign items only to categories defined as valid for 
this category set.

� Not Enable: You can assign an item to any defined category that uses the 
same flexfield structure as this category set.
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8. Select a list of valid categories.

The list of values here includes only categories that use the same flexfield 
structure as the category set you are defining.

9. Save your work.

2.3.10 Defining Products and Platforms
You define and rate products and platforms in Oracle Inventory in order to set 
resource skill levels in the HTML Resource Manager. See the Oracle Inventory User’s 
Guide, See Chapter 5, Items for more information on how to define products and 
platforms.

Reference
Oracle Inventory User’s Guide, See Chapter 5, Items

2.3.11 Defining Unit of Measure Classes
Perform the following steps to define a unit of measure class.

Reference
Oracle Inventory User’s Guide, See Chapter 3 Units of Measure

Prerequisites
None

Responsibility
Inventory

Navigation
Navigate to Setup > Units of Measure > Classes.

Steps
1. In the Units of Measure Classes window, select File > New.

2. Enter a unique name for the unit of measure class.

3. Enter a description for the UOM class.

4. Define the base unit of measure for this class.
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5. Enter a unique abbreviation for the unit of measure with a maximum length of 
three characters. Examples include, EA for each or HRS for hours.

6. Select the "inactive on" date from the date picker.

7. Save your work.

2.3.12 Defining Units of Measure
Units of measure are used by a variety of functions and transactions to express the 
quantity of items. The values defined in the Units of Measure window provide the 
list of values available in unit of measure fields in other windows. Units of measure 
are not organization–specific. Perform the following steps to define units of 
measure.

Reference
Oracle Inventory User’s Guide, See Chapter 3 Units of Measure

Prerequisites
At least one unit of measure class must exist.

Responsibility
Inventory

Navigation
Navigate to Setup > Units of Measure > Units of Measure.

Steps
1. With the Units of Measure window open, select File > New.

2. Enter a unique name for the unit of measure.

3. Enter a unique abbreviation for the unit of measure with a maximum length of 
three characters. Examples include, EA for each or HRS for hours.

4. Enter a Description for the UOM.

5. Select the check box if this is the base unit of measure for the unit of measure 
class.

6. Enter a unit of measure class.

7. Select an "inactive on" date from the date picker.
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8. Save your work.

2.3.13 Creating a Supplier Contact
Set up suppliers in the Suppliers window to record information about individuals 
and organizations from whom you purchase goods and services. You can also enter 
employees whom you reimburse for expense reports. When you enter a supplier 
that does business from multiple locations, you store supplier information only 
once, and enter supplier sites for each location. You can designate supplier sites as 
pay sites, purchasing sites, RFQ only sites, or procurement card sites. For example, 
for a single supplier, you can buy from several different sites and send payments to 
several different sites. Most supplier information automatically defaults to all 
supplier sites to facilitate supplier site entry. However, you can override these 
defaults and have unique information for each site.

The system uses information you enter for suppliers and supplier sites to enter 
default values when you later enter transactions for a supplier site. Most 
information you enter in the Suppliers window is used only to enter defaults in the 
Supplier Sites window. When the system enters that information in a later 
transaction, it only uses supplier site information as a default, even if the supplier 
site value is null and the supplier has a value. If you update information at the 
supplier level, existing supplier sites are not updated.

When you enter a supplier, you can also record information for your own reference, 
such as names of contacts or the customer number your supplier has assigned to 
you. Perform the following steps to create a supplier contact.

Reference
Oracle Public Sector Purchasing User’s Guide, Chapter 5, Supply Base Management

Prerequisites
� Verify that the supplier does not exist in the system. Use the Suppliers Report 

and Supplier Audit Report.

� Define the following lookups in the Oracle Purchasing Lookups window: Pay 
Group, Supplier Type, Minority Group.

� Define Supplier Types in the Oracle Payables Lookups window.

� If you have installed Purchasing, complete Purchasing setup.

� If you use Oracle Purchasing, define Supplier Types in the Oracle Payables 
Lookups window.
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� If you use Oracle Purchasing, define FOB codes, Minority Groups, and Freight 
Terms codes in the Oracle Purchasing Lookups window.

� If you use Oracle Purchasing, define Ship Via codes in the Defining Freight 
Carriers window.

Responsibility
Purchasing

Navigation
Navigate to Supply Base > Suppliers.

Steps
1. In the Suppliers window, enter a unique Supplier Name.

2. If the Supplier Number Entry option in the Financials Options window is set to 
Automatic, Payables automatically enters a Supplier Number for you. If this 
option is set to Manual, you must enter a unique Supplier Number.

3. (Optional) Enter the supplier's tax identification number in the Taxpayer ID 
field; for example, an individual's social security number, or a corporation or 
partnership's federal identification number/federal tax ID.

4. (Optional) Enter the value-added tax (VAT) registration number in the Tax 
Registration Number field if you are entering a VAT supplier.

If you want to prevent invoice or purchase order entry for this supplier after a 
certain date, then enter the date in the Inactive On field.

5. Enter supplier information in the appropriate tabs of the Suppliers window.

6. In the Suppliers window, choose the Sites button to navigate to the Supplier 
Sites window. Enter at least one supplier site name and address.

7. Save your work.

2.3.14 Defining Sales Credit Types
Order Management uses sales credit types to determine if the sales credit for an 
order is a quota or non-quota amount. Perform the following steps to define sales 
credit types.

Reference
Oracle Order Management User’s Guide, See Chapter 1, Setting up
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Prerequisites
None

Responsibility
Order Management Super User

Navigation
Navigate to Setup > Sales > Credit Types.

Steps
1. Navigate to the Sales Credit Types window.

2. In the Sales Credit Type window, enter the Credit Type Name and Description 
for the credit type.

3. Select the Quota check box if the sales credit type applies to revenue quota sales 
credit that you assign to salespeople.

4. Select the Enabled check box to activate the sales credit type.

5. Save your work.

2.3.15 Setting Up Accounting Flexfields
Use descriptive flexfields to tailor General Ledger to fit your unique information 
needs. For example, you may want to collect additional information on budget 
organizations, such as the manager and the size of the organization. You can even 
define context–sensitive flexfields that prompt you for additional information based 
on your previous entries. Perform the following steps to set up accounting 
flexfields.

Reference
Oracle General Ledger User’s Guide, Chapter 9, Setup

Prerequisites
Use the Value Sets window to define any value sets you need.

Note: You only need to set up accounting flexfields if you are 
using the Freight, Revenue, or Receivables Account fields, in the 
Resource Manager Receivables tab.
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Responsibility
General Ledger Super User

Navigation
Navigate to Setup > Financials > Flexfields > Descriptive > Segments.

Steps
Consult the following manuals for more information:

� Oracle General Ledger User Guide

� Oracle Applications Flexfields Guide

2.4 Oracle Common Application Components Dependencies
Oracle Common Application Components integrates with other Oracle applications 
in the e-Business Suite to provide and extend its functionality. Some are mandatory 
and some are optional. You must set up the mandatory modules before the 
Common Application Components can run. Setting up the optional modules is not 
required; however, if they are not set up, then the additional functionality provided 
by these modules is not available.

Many of these modules are included in your general installation. The following list 
of modules or applications is included with your installation but if you have not 
licensed the entire suite, you will only have access to the functionalities and tables. 
In other words, you will not be able to access the user interface (UI) or APIs for the 
application.

For information on Oracle E-business Suite Release 11i system requirements and 
dependencies, consult the Oracle Applications Installing Oracle Applications Release 
11i manual.

Note: The exception to the previous paragraph is that some UIs 
are shared. An example of this is in Oracle HRMS which will 
"share" some of it’s Forms if you do not have HRMS set up.
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2.4.1 Mandatory Dependencies by Module

2.4.1.1 Resource Manager
� Oracle Application Object Library (AOL): Resource Manager uses AOL to 

manage responsibilities that are used in various modules, and set application 
profile options. (Required)

� Oracle Human Resources: Resource Manager uses Oracle Human Resources to 
create employee resources so that the employee resources can be imported into 
Resource Manager. In addition, business units used in multi-organization are 
also created in Oracle Human Resources. (Required)

� Oracle Purchasing: Resource Manager uses Oracle Purchasing to create 
supplier contacts. (Required)

� Oracle Inventory: HTML-based Resource Manager users rate their skills based 
on the product and platforms defined in Oracle Inventory. (Required)

� Oracle Receivables: Resource Manager uses Oracle Receivables to create 
customers that are of party or partner resource type. In addition, new 
organizations used in multi-organization are also created in Oracle Receivables. 
(Required)

� Oracle Workflow: Resource Manager uses Oracle Workflow to send workflow 
notifications. (Required)

2.4.1.2 Notes
� Oracle Application Object Library (AOL): Notes uses AOL to set necessary 

profile options and uses the AOL lookups window to create new note types. 
(Required)

2.4.1.3 Spreadtable
� Oracle Application Object Library (AOL): Spreadtable uses AOL to set 

necessary profile options. (Optional)

2.4.1.4 Assignment Manager
� Oracle Application Object Library (AOL): Assignment Manager uses AOL to 

set application profile options that are used in various modules. 

� TCF Server: It must be running and correctly configured to connect to 
Scheduler and for Gantt charts to display information and render properly. 
(Optional if Window to Promise and Intelligent options are used.)
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� Oracle Scheduler: It is used to show the lowest cost resources and travel time 
information for a resource while using the Intelligent and Window to Promise 
assignment options. These two resource assignment options are used primarily 
for service requests in Field Service. (Optional)

� Territory Manager: Assignment Manager uses Territory Manager to retrieve 
qualified resources identified in a territory. (Optional)

� Forms-based Calendar: It is used to provide the availability of qualified 
resources. The Forms-based Calendar provides the work shift information for a 
resource. (Optional)

� Oracle Contracts: Assignment Manager uses Oracle Contracts to retrieve 
preferred engineers defined in Contract. (Optional)

� Service Request: Assignment Manager uses Service Requests primarily to have 
a resource assigned by the Intelligent and Window to Promise assignment 
options. (Optional)

� Installed Base: Assignment Manager uses Installed Based to retrieve preferred 
engineers defined in Installed Base. (Optional)

2.4.1.5 Task Manager
� Oracle Application Object Library (AOL): Task Manager uses AOL to manage 

responsibilities and profile options that are used in various modules. (Required)

� TCA: Task Manager uses TCA to locate the customer contact information when 
creating a task. (Required)

� Oracle Workflow: Task Manager uses Oracle Workflow to send workflow 
notifications in order to notify personnel about task creation and changes. 
(Required)

� Notes: Task Manager uses Notes to create notes attached to a task. (Optional)

� Resource Manager: Task Manager queries Resource Manager to determine the 
owner and assignee of a resource. (Required)

� Assignment Manager: Task Manager uses Assignment Manager to assign 
qualified resources to a task. (Optional)

� Escalation Manager: Task Manager uses Escalation Manager to escalate a task. 
(Optional)
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2.4.1.6 Calendar (HTML-based)
� Oracle Application Object Library (AOL): HTML Calendar uses AOL to create 

FND users (for example, to create a calendar workflow administrator) with 
appropriate responsibilities, as well as set necessary profile options. (Required)

� HTML Tech Stack: Set up properties in Oracle HTML Stack for debug logging 
trails and cookie encryption. You also specify default roles and responsibilities 
for users in this module. (Required)

� Resource Manager: HTML-based Calendar queries the Resource Manager 
tables so that individual resources can make and be invited to appointments. 
(Required)

� Tasks: HTML-based Calendar uses the HTML-based Tasks to create repeating 
appointments. (Required)

� Notes: HTML-based Calendar uses the HTML-based Notes to create a note and 
attach it to an appointment. (Required)

2.4.1.7 Calendar (Forms-based)
� Oracle Application Object Library (AOL): The Forms-based Calendar module 

uses AOL to manage responsibilities that are used in various modules. 
(Required) 

� Task Manager: The Forms-based Calendar module uses Task Manager to create 
Todo Lists (tasks). (Required)

� Resource Manager: The Forms-based Calendar module uses Resource Manager   
to assign resources to a calendar. (Required

2.4.1.8 Escalation Manager
� Oracle Application Object Library (AOL): Escalation Manager uses AOL to set 

necessary profile options that are used in various modules. (Required)

� Oracle Workflow: Escalation Manager uses Oracle Workflow to send workflow 
notifications to relevant resources when an escalation document is created or 
updated. (Required)

� Service Request: Service requests can be manually escalated through Escalation 
Manager if necessary. (Optional)

� Oracle Quality Online (OQO): Defects created in the OQO (formerly known as 
the Defect Management System) can be manually escalated through Escalation 
Manager if necessary. (Optional)
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� Assignment Manager: Escalation Manager queries the escalation territory 
defined in Territory Manager through the Assignment Manager UI to determine 
the owner of an escalation. (Optional)

� Task Manager: Forms-based Task Manager is used to attach additional tasks to 
an escalation document. Tasks created in the Forms version can be manually 
escalated through Escalation Manager if necessary. (Optional)

� Notes: The Forms-based Notes module is used to attach additional notes 
information to an escalation document. (Optional)

2.4.1.9 Business Rule Monitor
� Oracle Application Object Library (AOL): The Business Rule Monitor uses 

AOL to set necessary profile options that are used in various modules and to 
create the BRM Workflow Administrator. (Required)

� Oracle Workflow: It is used by the seeded workflow processes to send out 
workflow notifications to relevant document owners. (Required)

� Service Request: Service Requests can be monitored and escalated based on 
your defined business rules. (Optional)

� Oracle Quality Online (OQO): Defects created in the OQO (formerly known as 
the Defect Management System) can be automatically escalated when a 
business rule is violated. (Optional)

� Escalation Manager: It is used by the seeded workflow processes to create an 
escalated document when a business rule is violated. (Required)

� Territory Manager: It is used to retrieve qualified resources identified in the 
escalation territories if the identity of a person who receives notifications 
defined in the Workflow Attributes window cannot be determined. (Optional)

� Task Manager: It is used by the seeded workflow processes to create an 
automated escalation task. This is generated through the seeded Automated 
Escalation Template Group for Task Manager (Service Request or Oracle 
Quality Online) defined in the Forms-based Task Manager. Tasks created in the 
Forms version can also be automatically escalated when a business rule is 
violated. (Optional)
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Implementation Overview

This chapter provides an overview of the Resource Manager implementation 
process. Topics include:

� Overview

� Phase I: Setting Up Resource Manager

� Phase II: Managing Resources

3.1 Overview
Resource Manager is used with other applications in the e-Business suite to define, 
access, and maintain different categories of resources including employees, supplier 
contacts, parties, and partners. Resource Manager enables you to perform these 
functions in a single application without having to access multiple repositories 
within the e-Business suite on an individual basis. Implementing Resource Manager 
takes place in two phases. In the first phase, you set up Resource Manager by 
importing resources from other e-Business applications, optionally defining roles 
and role types, setting profile options, configuring resource fields for update, and 
defining skill levels. In the second phase, you manage resources by finding and 
viewing resources, assigning roles and role types to resources, creating groups and 
teams to which resources can be assigned, and viewing resource reports. In addition 
to successfully completing these phases, you can troubleshoot any problems with 
Resource Manager as required. Before implementing Resource Manager, it is 
necessary to understand the definition of resources, how Resource Manager 
operates with other e-Business suite applications, and the functionality of both the 
Forms-based and HTML versions of the product.
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3.1.1 Resources
Resources are people who are identified by categories based on the business 
function they perform. These categories include employees, parties, partners, and 
supplier contacts each of which is initially created and maintained in a specific 
e-Business application database. Resource Manager typically mass imports different 
types of resources from the following e-Business application databases:

3.1.2 Resource Manager Functionality within the E-Business Suite
Resource Manager imports data from the HRMS, TCA, and PO databases and 
provides the resulting resource information to other e-Business applications. Figure 
3-1 illustrates Resource Manager interactions within e-Business and core 
applications. This diagram is explained in the table that follows.

E-Business Suite Application Resources

Resource Description E-Business Application

Employee A person hired to work for a 
company.

Human Resource Management System 
(HRMS)

Party An entity that can enter into 
a business relationship.

Trading Community Architecture (TCA)

Partner One of two or more people 
who contribute capital to 
establish or maintain a 
commercial venture and 
who usually share in the 
risks and profits.

TCA

Supplier Contact The contact information for 
a person or agency that sells 
raw material or goods.

Purchasing (PO)
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Figure 3–1 Interaction with Other E-Business and Core Applications

The following table describes Resource Manager Interactions with other e-Business 
Suite applications:
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Interaction with Other E-Business Applications

Application Type Resource Manager Interaction

Partners Online e-Business Partners Online uses Resource Manager to setup 
partners, parties, and relationships from TCA.

Contracts e-Business Contracts uses Resource Manager to tie contracts 
to employees. For example, a service contract 
may be tied to one or more preferred engineers.

Telesales e-Business Telesales uses Resource Manager to set up a sales 
hierarchy.

Receivables e-Business Salesreps defined in Resource Manager are used 
by Receivables.

Marketing e-Business Marketing uses Resource Manager to set up 
marketing groups, identify approvers, and 
execute marketing campaigns.

Service e-Business Service uses group and team lists of resources 
from Resource Manager for service request 
assignments.

iSupport e-Business iSupport uses Resource Manager to set up 
support groups to fulfill service and support 
needs.

Incentive 
Compensation

e-Business Incentive Compensation uses Resource Manager 
to set up sales representatives and sales 
compensation group hierarchies. 

Call Center e-Business Call Center uses Resource Manager for call 
center routing.

Sales Online e-Business Sales Online uses Resource Manager to set up a 
sales hierarchy.

Calendar e-Business Calendar uses Resource Manager to track the 
availability of resources.

Interaction History Common 
Application 
Components

Interaction History uses Resource Manager to 
provide touch points. 

Assignment Manager Common 
Application 
Components

Assignment Manager uses Resource Manager to 
provide a list of qualified resources.

Territory Manager Common 
Application 
Components

Territory Manager uses Resource Manager to 
select the resources for a particular territory.
3-4 Oracle Common Application Components Implementation Guide



Phase I: Setting Up Resource Manager
3.1.3 Forms-based and HTML Versions of Resource Manager
Resource Manager was initially a Forms-based application and was subsequently 
expanded to include an HTML version. A number of features are available in both 
versions of Resource Manager, however some features are available in only Forms 
or HTML. The HTML version of Resource Manager, has additional implementation 
requirements such as setting the necessary profile options for the application.

3.2 Phase I: Setting Up Resource Manager
Implementing Resource Manager takes place in two phases. In the first phase, you 
set up Resource Manager by defining and configuring required components. In the 
second phase, you use Resource Manager to manage your resources. This section 
summarizes the basic steps for Phase I: Setting up Resource Manager. Detailed 
instructions for these steps can be found in the subsequent Resource Manager 
chapters of the Implementation Guide. Before performing these steps, you should 
first determine that Resource Manger is installed and configured properly to work 
with other applications in the e-Business suite. 

3.2.1 Defining Resources
The first step in implementing Resource Manager is to define resources. Typically 
this is accomplished by mass importing resources from other Oracle e-Business 
applications or from legacy systems. In some cases, however, you may want to 

Task Manager Common 
Application 
Components

Task Manager uses Resource Manager to provide 
single, group, and team lists of resources for task 
assignments.

Trading Community 
Architecture (TCA)

e-Business Resources of category "Party" and "Partner" can 
be imported from Accounts Receivables (AR) to 
Resource Manager and subsequently defined as 
e-Business Suite resources.

 Purchasing e-Business Resources of category “Supplier Contact” can be 
imported as resources from Purchasing (PO). 

Human Resource 
Management Systems 
(HRMS)

e-Business Resources of category “Employee” can be 
imported as resources from Oracle Human 
Resource Management System (HRMS). 

Interaction with Other E-Business Applications

Application Type Resource Manager Interaction
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define an individual resources by importing it from the relevant e-Business 
application or by creating it directly in Resource Manager. 

3.2.1.1 Mass Import Resource From Other e-Business Applications
Mass importing resources is the most common method of defining resources that 
are stored in e-Business applications such as HRMS, TCA, or PO. This is 
accomplished using concurrent programs to synchronize data between Resource 
Manager and the HRMS, TCA, and PO databases.

3.2.1.2 Import Resources From Legacy Applications Using APIs
APIs are required to import resources from legacy HRMS, PO, or AR systems into 
Resource Manager. To accomplish this, you must use the APIs of your legacy 
system and the Resource Manager public Published APIs. 

3.2.1.3 Import Individual Resources From Other e-Business Applications
An individual resource can be imported into Resource Manager by logging in with 
the CRM Administrator responsibility, and selecting Resource Manager > Maintain 
Resources > Import Resources.

3.2.1.4 Create Individual Resources in Resource Manager
You can create an employee resource in the HTML version of Resource Manager 
and you can create an employee that is defined as a salesperson in the Forms-based 
version of Resource Manager. When you create Resources of these types in Resource 
Manager the information is written directly to the HRMS tables. If you want to 
create individual resources of other types, you must first create them in the 
appropriate application and then import them into Resource Manager.

3.2.2 Optionally Defining Roles Types and Roles
Resource Manager comes with seeded role types and roles that are used to better 
organize your resources. If you do not wish to use the seeded role types and roles, 
you can optionally create your own in Resource Manager.

3.2.2.1 Role Types
A role type is a broad descriptive category such as "Sales" that contains one or more 
detailed descriptive categories such as "Sales Representative" or "Sales Manager". 
Sales, Telesales, Marketing, Sales Compensation, Support, and Call Center are all 
examples of role types that are seeded by the different modules that access Resource 
Manager. You can also define custom role types for your business needs.
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Figure 3–2 Role Types Example

3.2.2.2 Roles
Roles are detailed descriptive categories that are grouped together within role 
types. A role can encompass one or more job descriptions and job titles that are used 
to assign responsibilities to resources, groups, and teams. For example, the Sales 
role type can encompass several roles including Sales Manager and Sales 
Representative. A resource named Linda who is a Sales manager can be assigned 
the Sales Manager Role while sales representatives, John, Mark, and Carol are 
assigned the Sales Representative role.

Figure 3–3 Roles Example

3.2.2.3 Role Attributes
When a role is created, it is associated with a specific role attribute. This enables 
different roles to be grouped together when defining a resource reporting hierarchy. 
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The hierarchy is used in sales product families to control data access privileges, 
sales forecast rollups, and incentive compensation plans. It is also used for 
workflow notifications and escalations. When defining a role, you must also specify 
its attribute by selecting one of the Resource Manager seeded role attributes:

� Member: This is the attribute for group members and is the default attribute for 
any group.

� Lead: This is the attribute for the team lead within a group.

� Admin: This attribute enables group members with the associated role to view 
and modify information about other group members. In the HTML Resource 
Manager, only a user in a group with either the Administrator or Manager 
group member role can update group member and group hierarchy 
information.

� Manager: This attribute is used to set up the group reporting hierarchy. For 
example, all the forecasts for a group of sales representatives will roll up to the 
person with the Manager role attribute in that group. If Linda is a sales 
manager who is assigned the Sales Manager role that is associated with the 
Manager attribute, then only Linda will receive forecasts for the group. In 
addition, a user with the Manager group member role can update the group 
member and group hierarchy information in the HTML Resource Manager.

Figure 3–4 Role Attributes Example
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3.2.3 Setting Profile Options for HTML
Profile options must be set for the HTML version of Resource Manager depending 
on your requirements. These include:

� Employee Resource Update Access

� Group Update Access

� Resource Lookup Audience

� Role Update Access

� Resource active days after termination of relationship

3.2.4 Modifying Resource Fields in HTML
In the HTML version of Resource Manager, the appropriate users or system 
administrators with the Resource Self Service Administrator responsibility must set 
up the Define Resource Fields for Update window. This determines which fields for 
the resource’s personal information can be updated and how the update should 
occur.

3.2.5 Defining Skill Levels in HTML
In the HTML version of Resource Manager, the appropriate users or system 
administrators with the Resource Self Service Administrator responsibility must set 
up the Define Skill Levels window. This determines the name of the skill level and 
its associated numeric value. Once this is specified, an individual resource can select 
an appropriate skill level from the LOV of the Level field in the Rate Skill window 
to rate their technical skills. These skill levels are standard regardless of whether the 
resource is rated at category, product, platform, or problem code level. The numeric 
values for the related skill levels can be a part of the calculation when selecting the 
optimal individual for a service request. 

3.2.6 Configuring Group and Team Member Notifications
Resource Manager enables group and Team members to receive Workflow 
notifications. This is particularly useful when important communications are sent to 
a group or team that require immediate dissemination to all of the their members. 
For example, if a support group or team receives a high priority service request then 
all members of the group or team can simultaneously be notified to ensure that 
immediate action is taken. Resource Manager accomplishes this by integrating 
resources, groups, group members, teams, and team members with Workflow roles. 
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When a resource is created or updated, its information, including relevant 
attributes, is stored in both Resource Manager and the corresponding Workflow role 
tables. Notifications can only be sent to all group or team members if the 
group-to-membership or team-to-membership relationship information stored in 
Resource Manger is in sync with the data stored in the corresponding Workflow 
role tables. To accomplish this, Resource Manager administrators must run the 
Synchronize Workflow Roles concurrent program on a periodic basis.

3.2.7 Publishing Business Events
Resource Manager publishes events such as creating and importing resources, 
updating resources, and deleting resources using the Oracle Workflow Business 
Event System. Applications that contain data directly affected by these events can 
subscribe to them and synchronize or modify their data accordingly. For example if 
a resource that is assigned to a Task is deleted, this action is published or "raised" as 
a business event. Task Manager, can consequently subscribe to this event and 
reassign the task to an available resource.

3.3 Phase II: Managing Resources with Resource Manager
After successfully setting up Resource Manager in Phase I, you can proceed to 
Phase II: Managing Resources with Resource Manager. In this phase, you can 
optionally find and view resources, modify resources with roles and role types, 
create groups and teams, view resource reports, sychronize imported resources with 
updated records in their database of origin, and troubleshoot Resource Manager if 
required.

3.3.1 Finding and Viewing Resources
After importing a resource into Resource Manager, you can find and view the 
resource and manage it by performing any of the actions described in the remainder 
of this chapter.

3.3.2 Defining Groups
A group is a unit of organization based on the similar function or roles of its 
members. It can consist of individual resources and resource groups and any 
resource can belong to multiple groups. For example, a manufacturing company has 
sales groups for different product models. A sales manager named Linda, leads the 
Model A Sales Group and has three sales representatives, John, Mark and, Carol 
who report directly to her. The Model A Sales Group can also contain another 
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resource group, Key Accounts West Group that handle sales in the west region for 
model A, and whose members also report to Linda.

Figure 3–5 Groups Example

3.3.2.1 Group Member Roles
Roles and responsibilities can be associated with all members of a resource group. 
For example, Linda is a sales manager; John, Mark, and Carol are sales 
representatives. The Sales Manager and the Sales Representative are job roles 
assigned to the Model A Sales Group. Each member can have multiple roles defined 
within a group or among groups. If the Key Accounts West Group only contains 
two resources, one of them can perform two roles, sales manager and field sales 
agent Or while Linda, the manager in the Model A Group, may also be a member of 
a group called Model B Group.

3.3.2.2 Group Usage
Group usage must also be specified. For example, the Model A Group can be used 
in Sales Compensation, Sales, and Telesales.

3.3.2.3 Dynamic Groups
Instead of assigning each individual or group resource to an existing group, you can 
create a dynamic group based on the criteria you define in SQL statements. For 
example, Oracle Interaction Center's Telephony Manager uses Dynamic Groups for 
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skill-based routing. In active mode, Oracle Telephony Manager routes calls 
according to defined rules. The active mode is the default mode of operation. In 
active mode, Oracle Telephony Manager uses skill-based routing, a dynamic call 
routing intelligence that delivers inbound calls to an agent who is appropriately 
skilled to meet the needs of the caller. When inbound calls arrive at the switch, the 
switch issues a routing request. Oracle Telephony Manager monitors the routing 
request, then applies skill-based routing rules, and identifies suitably skilled agents. 
Meanwhile, a representation of the call waits in the virtual queue within Oracle 
Telephony Manager. When a suitable agent becomes available, Oracle Telephony 
Manager responds to the routing request and instructs the switch to deliver the call 
to the agent’s extension through the Universal Work Queue (UWQ), where more 
specific pre-defined rules may apply in directing the call. In a dynamic group, the 
database automatically updates information about individual group members 
(dynamic routing executes the workflow/procedure to get an agent list). 

3.3.2.4 Group Hierarchy
Because individual resources can be assigned to a group, and a group can belong to 
another group or to multiple groups, resources can be organized in a group 
hierarchy with a parent-child relationship.

For example, Jack William and Frank Nelson are sales representatives who belong 
to the Product A group and report directly to Pat Smith, the sales manager of 
Product A; but they report indirectly to Jeff Walsh who leads the Field Sales group 
as field sales manager. The Field Sales group and the Product A group have a 
parent-child relationship.

You can use the group hierarchy to view direct reporting or all reporting 
information for a resource. For example, you can search for direct reporting 
information for the employee Jeff Walsh based on the above group hierarchy. You 
can see Pat Smith and Jim Breen listed as the results for direct reporting. Jack 
William and Frank Nelson are added to the list if it is for all the reporting 
information due to the parent-child relationship between these groups.
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Figure 3–6 Group Hierarchy Example

3.3.2.5 Group Member Notifications
You can configure groups to receive notifications to ensure that important 
communications reach all group members.

3.3.3 Managing Roles and Groups
You can manage roles and groups by viewing role details, assigning roles to 
resources, or assigning resources to groups.

3.3.4 Defining Teams
A team is a collection of groups and resources that is organized to accomplish a 
specific task or objective. Team members are chosen on the basis of their availability, 
qualifications, and location. For example, a manufacturing company wants to 
develop a new model that has the same features of a model called Model B. To 
accomplish this, the company sets up a new model development team can be 
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established to have a new product development group, a sales manager for model 
B, and a support engineer who specializes in model B. 

Figure 3–7 Teams Example

3.3.4.1 Team Member Roles
Each team member, whether it is an individual resource or a resource group, has a 
member role assigned to it. For example, the new model development group (a 
group resource) and the support engineer (an individual resource) can both have a 
development member team role. The Development Member role must be one of the 
group roles that have been assigned to the New Model Development Group. Like a 
group member, a team member can have multiple roles assigned to a team.
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3.3.4.2 Team Roles
You can assign multiple roles to a team. For example, the New Model Development 
Team will play a Development Member role, and a Support Manager role at the 
same time.

3.3.4.3 Team Usage
Specify the usage of your team. For example, the New Model Development Team 
can be used in Support, Telesales, and Service.

3.3.4.4 Team Member Notifications
You can configure teams to receive notifications to ensure that important 
communications reach all team members.

3.3.5 Running Reports
Resource Manager enables you to run Group Audit and Group Structure reports.

3.3.5.1 Group Audit Report
Resource Manager supports the ability to run an audit report detailing changes to 
resources and resource groups created within a date range. For example, any 
changes made to new members of a group are defined, but role change information 
is not. This provides an audit trail of the actions taken for specific groups, and 
resources. 

For example, a sales manager can use the Group Audit Report to verify and trace a 
specific sales group for its group members’ (sales representatives) change history 
information based on a specific time range. From the report, you can easily identify 
that Lisa Jones with her resource number has been changed from Key Accounts 
Central Group (group number 54) to Key Accounts Group (group number 43). This 
information can be an audit record for sales credits or compensation distribution.

Only the movement of a resource from a given group to another group is tracked. 
Resources changing roles within the same group are not reported in the Audit 
Report.

3.3.5.2 Group Structure Report
Resource Manager supports the ability to run a Group Structure Report. It displays 
only the group hierarchy and structure information. 
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For example, you can use the Group Structure Report to view the group hierarchy 
information for a specific group, such as Key Accounts Group. The group member’s 
name and its resource category information (such as employee resource), child 
group name (Key Accounts Central), and numbers of level down from the selected 
group (such as the Key Accounts Central child group is one level down from the 
selected Key Accounts Group) and effective date information are all visible in the 
report.
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Phase I: Setting Up Resource Manager

Implementing Resource Manager takes place in two phases. In the first phase, you 
set up Resource Manager by defining and configuring required components. In the 
second phase, you use Resource Manager to manage your resources. This chapter 
provides detailed instructions for Phase I: Setting up Resource Manager. Topics 
include:

� Overview of Setting up Resource Manager

� Mass Importing Resources From Other E-Business Applications

� Importing Resources From Legacy Applications

� Importing Individual Resources

� Creating an Employee Resource in HTML

� Creating a Salesperson in Forms

� Creating Salespersons in Multiple Organizations

� Defining Role Types

� Defining Roles in Forms

� Defining Roles in HTML

� Specifying Role Attributes

� Setting Profile Options for HTML

� Defining Skill Levels in HTML

� Configuring Group and Team Member Notifications

� Publishing Business Events
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4.1 Overview of Setting Up Resource Manager
This section contains a summary of the steps for setting up Resource Manager. 
Detailed instructions for these steps are provided in the subsequent sections.

4.1.1 Defining Resources
You define resource by either importing them into Resource Manager and then 
modifying them or by creating them in Resource Manager.

4.1.1.1 Importing Resources
Instructions for importing resources are contained in the following sections:

� Mass Importing Resources From Other E-Business Applications

� Importing Resources From Legacy Applications

� Importing Individual Resources

4.1.1.2 Creating Resources in HTML and Forms
You can create resource directly in Resource Manager, however, you are limited to 
creating specific types of Resources in either the HTML or Forms-based versions of 
the product. 

HTML. For example, you can create a salesperson in the HTML version of Resource 
Manager whose data is written directly to the HRMS tables. You cannot create a 
salesperson of type Other and TBH in HTML, although you can query them by 
choosing Preferred Resource in the Resource Advanced Search window. Detailed 
instructions for this step are provided in the Creating an Employee Resource in 
HTML section.

Forms. You can create a salesperson in the Forms-based version of Resource 
Manager and designate it as type Other or TBH (To Be Hired). Resources of this 
type are written directly to the Resource Manager tables and do not appear in the 
HRMS tables. You can also create a resource such as a salesperson in Forms by first 
creating the resource in HRMS and then importing the resource into resource 
manager and modifying it as required. If you have not licensed HRMS, you can 
create a resource using the Form windows that are shared with HRMS and then 
using Resource Manager to import the resource. Detailed instructions for these 
steps are provided in the following sections:

� Creating a Salesperson in Forms

� Creating Salespersons in Multiple Organizations
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4.1.2 Optionally Defining Role Types and Roles
After defining resource, you can organize them with roletypes and roles. A role type 
is a broad descriptive category such as "Sales" that contains one or more roles. A 
role is a more detailed descriptive categories such as "Sales Representative" or "Sales 
Manager". When a role is created, it is associated with a specific role attribute. This 
enables different roles to be grouped together when defining a resource reporting 
hierarchy. Detailed instructions for creating role types and roles and for assigning 
attributes to roles are provided in the following sections:

� Defining Role Types

� Defining Roles in Forms

� Defining Roles in HTML

� Specifying Role Attributes

4.1.3 Setting Profile Options for HTML
After defining resource and optionally creating defining roletypes and roles for 
those resources, the following profile options must be set to for the HTML version 
of Resource Manager:

� Employee Resource Update Access

� Group Update Access

� Resource Lookup Audience

� Role Update Access

� Resource active days after termination of relationship

Detailed configuration information for these profile options is provided in the 
Setting Profile Options for HTML section.

4.1.4 Defining Skill Levels in HTML
The final step in setting up Resource Manager is to define skill levels in the HTML 
version of Resource Manager. In the HTML version of Resource Manager, the 
appropriate users or system administrators with the Resource Self Service 
Administrator responsibility must set up the Define Skill Levels window. 
Instructions for performing this step are contained in the Defining Skill Levels in 
HTML section.
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4.1.5 Configuring Group and Team Member Notifications
Resource Manager enables group and team members to receive Workflow 
notifications. This is particularly useful when important communications are sent to 
a group or team that require immediate dissemination to all of their members. For 
example, if a support group or team receives a high priority service request then all 
members of the group or team can simultaneously be notified to ensure that 
immediate action is taken. Resource Manager accomplishes this by integrating 
resources, groups, group members, teams, and team members with Workflow roles. 
When a resource is created or updated, its information, including relevant 
attributes, is stored in both Resource Manager and the corresponding Workflow role 
tables. Notifications can only be sent to all group or team members if the 
group-to-membership or team-to-membership relationship information stored in 
Resource Manger is in sync with the data stored in the corresponding Workflow 
role tables. To accomplish this, Resource Manager administrators must run the 
Synchronize Workflow Roles concurrent program on a periodic basis. Instructions 
for performing this step are contained in the Configuring Group and Team Member 
Notifications section

4.1.6 Publishing Business Events
Resource Manager uses event subscriptions to publish events such as creating, 
updating, and deleting resources to enable resource manager users to subscribe to 
these events and perform their required business processes. An event subscription 
is a registration indicating that a particular event is significant to a particular system 
and specifying which processing to perform when the triggering event occurs. 
Instructions for performing this step are contained in the Publishing Business 
Events section.

Note: In addition to enabling group and team member 
notification, Resource Manager integration with Workflow roles 
also provides a framework for task security. The Tasks chapter in 
the Oracle Common Application Components User Guide provides 
a conceptual overview of task security features. The Tasks chapter 
in the Oracle Common Application Components Implementation 
Guide provides technical information including instructions for 
customizing security and granting access privileges to appropriate 
grantees or users.
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4.2 Mass Importing Resources From Other E-Business Applications
Mass importing resources is the most common method of defining resources that 
are stored in e-Business applications such as HRMS, TCA, or PO. This is 
accomplished using concurrent programs listed in the following table to 
synchronize data between Resource Manager and the HRMS, TCA, and PO 
databases. Oracle recommends that the system administrator run the concurrent 
programs, listed in the following table, on a regular basis, to synchronize data 
between the Resource Manager and other applications and to maintain data 
integrity.

Prerequisites
None

Responsibility
CRM Administrator or

System Administrator

Navigation
Navigate to the Navigator - CRM Administrator window, or

Navigate to the Navigator - System Administrator window

Steps
Run the Resource Manager concurrent programs listed in Appendix B: Concurrent 
Programs. Instructions for running the concurrent programs are contained in this 
appendix.

Note: Oracle strongly recommends that an employee, or party, or 
supplier contact not have more than one application user.

If a resource (employee, party, or supplier contact) is linked to two 
or more application users, and imported into Resource Manager, 
then one application user is selected at random and associated with 
that resource.
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4.3 Importing Resources From Legacy Applications
You can import resource from legacy application using the Resource Manager 
public published APIs. To accomplish this you must first use the APIs of your 
legacy system to import the legacy data into either the HRMS, TCA, or PO 
databases. Once this is accomplished, create a batch program that calls the Resource 
Manager public published APIs and uses them to transfer data from HRMS, TCA, 
or PO, to Resource Manager. See the Resource Manager chapter in the Oracle CRM 
API Reference Guide for more information about Resource Manager public 
published APIs.

4.4 Importing Individual Resources
In some cases, you may want to import individual resources from different 
application databases. You can accomplish this by selecting a resource based on its 
category and then identifying its role and eligibility dates before saving it to 
Resource Manager. 

Employees, Parties, Partners, and Supplier Contacts can be imported into the 
Resource Manager from Oracle HRMS, Purchasing and TCA, depending on the 
resource category you select. The only resource that you can create, but not import 
through the Resource window, is a salesperson with the resource category of 
OTHER, or TBH (to be hired) in Forms. Perform the following steps to import a 
resource.

Note:

� If Oracle HRMS is installed and you have a license for it, then 
you must create a resource in that application first before 
importing it.

� If you do not have HRMS installed and licensed, then create a 
resource using "shared" forms that the HRMS application uses. 
The navigation path to create a resource is:
Maintain Employee > Employee. 

� Whether or not you use HRMS, the data is written to the HRMS 
tables.

� For further details, consult the Oracle HRMS documentation.
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Prerequisites
None

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Maintain Resources > Import Resources.

2. In the Selection Criterion window, select from the list of values (LOV) in the 
Resource Category field. 

3. (Optional) Refine your resource search by selecting from the LOV in the 
available fields.

Different resource categories have different search field options.

4. Click Search.

The application populates the Category and Name fields in the Search Results 
region.

5. Choose a resource by deselecting the Select check boxes for the undesired 
resources and click Create Resource.

The Default Values window opens, and the application populates the Start Date 
field with the current date.

6. (Optional) Select an end date, managing employee, role, and role effective 
dates.

7. Click OK.

The Selected Resources window opens displaying the resource selections.

8. Deselect the undesired resource check boxes and click Save Resource if you 
want to save a resource to Resource Manager.

Resource importation and definition is complete.
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9. If you want to further define the resource roles, groups, teams, or other details 
use this procedure.

a. Click Details.

b. Define the resource information from the tab options.

c. Choose File > Save.

Guidelines
Before importing an individual resource, you should understand the following:

� Resource Manager does not require transaction numbers to import a resource.

� The Comments field in the Selected Resources window indicates whether or not 
the resource entry is a new record, duplicate record, or has a new role 
definition. 

� When synchronizing an employee resource imported from HR using the 
Synchronize Employees concurrent program, the end date will not be modified. 
To synchronize the end date in Resource Manager, you must modify it manually 
with the correct information. If you have imported a large number of employees 
and do not want to end date them manually, you can write a script that calls the 
Update_Resource API and passes the required value to the p_end_date_active 
parameter.

See Also
See the Synchronize Employees concurrent program in Appendix B: Concurrent 
Programs.

4.5 Creating an Employee Resource in HTML
When you create an employee resource which is a salesperson, the information is 
recorded in the HR tables. Users with the Resource Self Service Administrator 
responsibility can see the Create button shown in the Employees window. 
Therefore, they can create a new employee resource and specify the required sales 
information for compensation. When an employee resource is created in the HTML 
Resource Manager, this information is also recorded in Oracle Human Resources 
Management System (HRMS) and is automatically imported into the Forms-based 
Resource Manager. Perform the following steps to create an employee resource.
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Prerequisites
The JTFRS: Employee Update Access profile must be set to "Any" for the system 
Administrator to be able to update other employee’s information.

Responsibility
Resource Self Service Administrator

Navigation
Navigate to the HTML Resource manager and login as the administrator.

Steps
1. In the Employees window, click Create.

The Create An Employee Resource window opens.

2. Enter the employee’s last, first, and middle name in the specified fields.

Note:

� If changes are made to the Manager field (assign or update 
manager information for an employee), then the Flatten 
Employee Hierarchy concurrent program needs to be run in 
order to reflect the changes in the organization chart.

� A salesperson number can be either numeric numbers or letters 
or a combination of both. It can also be the same number as the 
employee number. After saving or updating resource 
information, validation occurs to verify that no duplicate 
salesperson numbers are created.

� You can update Resource information in the HTML-based 
version without running the concurrent program Synchronize 
Employees as you would if you updated information in the 
HRMS application. 

� If a resource (who first was a salesperson with a salesperson’s 
number) changes jobs within the same company (and is no 
longer a salesperson), you must end date the first resource and 
create a new resource with new settings. You cannot delete a 
salesperson’s number once it is assigned.
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3. Use the drop-down list to select the employee’s title, for example, Ms.

4. Enter a username for the new employee.

5. Enter personal information for the employee:

a. Enter your work phone number in any format, for example 555.5555 or 
555-5555.

b. Enter search criteria for your Job Title (at least three characters) and click 
Go to search for matching titles.

The Select a Job Title window opens.

c. Click your job title to populate the field.

d. Enter your email address.

No validation is made to determine if the email address is correct or even 
exists.

e. Enter your salesperson number.

f. Use the drop-down list to select a sales credit type.

The category (Employee), employee number, and resource number are 
automatically populated.

6. Enter your location information.

a. Use the drop-down to select their work address.

b. Enter your mailstop.

c. Enter your office number.

d. Enter your office location.

7. Enter search criteria for your manager’s name (at least three character’s) and 
click Go.

8. Click your Manager’s name to populate the field.

9. Click Create.

The employee resource is created. The password is emailed to the user.
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4.6 Creating a Salesperson in Forms
You can designate a resource as a salesperson in the Receivables tab of the 
Forms-based interface. A resource designated as a salesperson in this manner is 
organization specific, although in general, resources are not.

The following table describes the types of tasks that you can perform in the 
Resource window.

Note: In the HTML version, Salesperson Number and Sales Credit 
Type fields are required when you create an employee resource in 
the Create An Employee Resource window. This is because the 
HTML Resource Manager is primarily used by Oracle Sales Online 
and employee resources created here are salespeople.

Note:

� You can only create a resource of category Other, or TBH (to be 
hired), through the Resource window. If your resource is of 
another category, it must be imported.

� If a salesperson is defined with category TBH, then this 
salesperson is not visible within Accounts Receivable. A 
Salesperson defined in this manner can be viewed only within 
CRM.

� Users are not allowed to create a new user that is associated to 
a resource/employee. It is only the first time during the "Create 
Employee" process that user can specify a non-existing user 
name.

� If you make any changes to a resource in HRMS, then you must 
run the appropriate concurrent programs to synchronize 
resource information. See the chapter on Concurrent Programs 
in the Implementation Guide appendix.

� If a resource (who first was a salesperson with a salesperson’s 
number) changes jobs within the same company (and is no 
longer a salesperson), you must end date the first resource and 
create a new resource with new settings. You cannot delete a 
salesperson’s number once it is assigned.
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Perform the following steps to create a salesperson.

Prerequisites
None

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Maintain Resources > Resources.

The Find Resources window opens.

2. Click New in the Find Resource window.

The Resource window opens.

3. Select either TBH or Other for the Category.

4. You must enter a valid value for the Salesperson Number for the Salesperson to 
be created. Although it can accept a 0 value, it is not recommended.

5. Enter the new salespersons name in the Name field.

6. Enter a Start Date for the new salesperson.

You must enter at least a start date here. The end date defaults to an open end 
data and is optional.

Table 4–1 Tasks Available through the Resource Window

Task Performing the Task

Create (define) a new salesperson of 
type Other or TBH

Use the following steps outlined after the table.

Update a resource definition Modify the resource definition as desired.

View resource details View the resource details as desired.
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7. Select the Receivables tab.

For an explanation of each tab, see the Guidelines following this procedure.

a. Enter the range of dates that this salesperson is to be active. 

The Date Active (start date) is a required field and defaults as the current 
date. However, you can change it by accessing the calendar through the list 
of values (LOV). If you do not enter a Date Active (end date), this 
salesperson is active indefinitely. The Date Active cannot precede the Start 
Date.

If the salesperson's status is Active but the transaction date that you enter is 
not within this date range, Receivables does not display this salesperson in 
the LOV in the Transactions window. 

b. (Optional) Enter the new salespersons Email address.

c. (Optional) Enter a Geo Override value for this salesperson. This value 
associates the salesperson with a unique tax jurisdiction.

The Geo Override and Inside City Limits fields are available only if you 
have installed a sales tax vendor of type Taxware Sales/Use Tax System or 
Vertex Quantum.

If you entered a value in the Geo Override field and the tax jurisdiction for 
this address is within city limits, select the Inside City Limits check box. 
This check box is enabled only if your sales tax vendor is Vertex Quantum.

For additional information, see the following: 

Integrating Oracle Receivables with Taxware Sales/Use Tax System, Release 11i.

Integrating Oracle Receivables with Vertex Quantum, Release 11i.

d. Check the Active for Receivables check box to indicate that this resource is 
a salesperson. 

e. Enter a quota Sales Credit Type. 

Oracle Order Management uses this information to determine if the sales 
credit for an order is a quota or non-quota amount. You can define 
additional sales credit types in Oracle Order Management. However, you 
can only assign Sales Credit Types that are of type 'Quota' to salespersons in 
Receivables.

f. (Optional) Enter the Accounting Flexfield for your Revenue, Freight, and 
Receivable Accounts.
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Receivables can use this information, along with your AutoAccounting 
rules, to determine the revenue, freight, and receivable accounts for 
invoices you assign to this salesperson. 

g. (Optional) Assign a territory to this salesperson. 

The Territory Flexfield must be set up before an assignment is made. 

h. (Optional) If you assigned a territory to this salesperson, then enter the 
range of dates that this territory is to be assigned to this salesperson.

The Start Date defaults as the current date, but you can change it. If you do 
not enter an End Date, this salesperson is active indefinitely, or as long as 
the territory is active.

8. (Optional) Enter more information in the other tabs to further specify the 
resource.

9. Choose File > Save to save your work. 

This action populates the Resource Number field with the automatically 
generated resource tracking number.

Guidelines
The following table describes the tabs available in the Resource window, and 
describes how the tabs are used.

Table 4–2 Resource Tab Descriptions

Tab Description

Roles Use this tab to view, assign, and modify information about roles and role types. The role 
type is the actual role a resource plays, for example, Administrator or Contractor. These 
roles, role types, and role attributes check boxes are defined in the Setup window. The 
Start Date default is the current date, and it can be modified.

Groups Use this tab to view, assign, and modify information about groups. Groups are not 
necessarily one person, and a resource can belong to more than one group. The Groups 
tab reveals in detail which groups the resource belongs to, and the role in the group. 
Resources can play multiple roles in a group. Click the group name to display the group 
member roles if this resource has group member roles assigned. 

Teams Use this tab to view, assign, and modify information about teams. Teams can comprise 
multiple groups and combinations of groups and individuals. Click the team name to 
view the Team Member Roles. 

Service Use this tab to define the Cost per Hour and Time Zone information. The Support Site 
field is not operational, and not used at this time. You define the currency type in the 
Compensation tab.
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The following table describes fields located in the Receivables tab, in the Resource 
window, which are used to define a salesperson.

Interaction Center Use this tab to view, assign, and modify the email addresses and the Agent ID numbers 
of resources associated with the eMail Center or Call Center modules. This tab is used 
primarily by the Call Center and eMail Center modules. All fields are read-only. If the 
resource is not associated with either center, these fields are blank. 

(Optional) Enter the Scripting Agent Login if the employee uses Oracle Scripting. Use 
the Telephony Parameters region to enter middleware configuration, parameters, and 
values for the agent. Which telephony parameters are required and which values to 
specify depend on the types of switch and CTI middleware used in the Call Center.

Compensation Use this tab to view or define the Currency Type corresponding to the Cost per Hour 
listed on the Service tab. 

Receivables Use this tab to define a salesperson and assign a territory. 

Miscellaneous Use this tab to view personal information about the resource. The fields in this tab are 
read-only.

Table 4–3 Field Descriptions for the Receivables tab in the Resource Window

Field Description

Date Active Enter the range of dates that this salesperson is to be active. Date Active (start 
date) is a required field, the Date Active (end date) is optional. If you do not enter 
an end date, this salesperson is active indefinitely.

Geo Override and Inside 
City Limits

The Geo Override value associates the salesperson with a unique tax jurisdiction. 
Both fields are available only if you have installed a sales tax vendor of type 
Taxware Sales. Oracle recommends you use Tax System or Vertex Quantu.

Accounting Flexfield The accounting flexfield includes Revenue, Freight, and Receivable Accounts. 
Receivables can use this information, along with your AutoAccounting rules, to 
determine the revenue, freight, and receivable accounts for invoices that you 
assign to this salesperson.

Territory Flexfield If you want to assign a territory to this salesperson, then enter the range of dates 
that this territory is to be assigned to this salesperson. The Start Date defaults as 
the current date, but you can change it. If you do not enter an End Date, this 
territory is active for this salesperson infinitely. 

Territory consists of geographic criteria a salesperson is responsible for.

Table 4–2 Resource Tab Descriptions

Tab Description
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4.7 Creating Salespersons in Multiple Organizations
A business unit such as a corporation can have multiple separate organizations 
within its structure that are also known as MULTI-ORGS. A salesperson can cover 
areas in multiple organizations. In order to receive the appropriate compensation 
from each organization, the salesperson must belong to both organizations. The 
salesperson has one employee number, but multiple salesperson numbers that 
correspond to each organization that the salesperson belongs to.

To add a salesperson to another organization requires two steps:

1. First set the multiple organization profile option MO: Operating Unit to the 
appropriate organization using the drop down menu provided in the 
Responsibility field. Use the System Administrator responsibility and select 
Profile > System. In the Find System Profile Values window, select the 
appropriate Responsibility and enter the MO: Operating Unit profile option. 
Save your work and log in using your user ID.

2. Query the resource in Resource Manager and assign a salesperson’s number as 
well as the other required actions outlined in the following steps.

Example
Business World Enterprises is a global company consisting of several organizations 
including Business World, USA, and Business World, Canada. You are a salesperson 
for Business World, USA. Your coverage encompasses parts of Western Canada and 
Mexico. In order to receive financial compensation in both US and Canadian 
dollars, as well as Mexican pesos, you must be a salesperson for Business World, 
USA, Business World, Canada, and Business World, Mexico. Your employee 
number is #0001 and your salesperson number in Business World USA is #0001US. 
Your employee number for Business World, Canada is #0001CAN and for Business 
World, Mexico #0001MEX.

Any changes pertaining to your Canadian and Mexican compensation packages can 
be handled by the Resource Administrators in Business World, Canada and 
Business World, Mexico. In other words, regional changes that affect you are 
handled by that organization. Changes that affect you on a global level, such as if 
you receive a promotion and becomes a Senior Salesperson, would be handled by 
the parent company, Business World Enterprises. 

The following table lists the sample data.
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Perform the following steps in Forms to make an existing salesperson visible from 
one organization to another organization.

Prerequisites
� The salesperson must exist in one organization in Resource Manager.

� The profile value for the administrator (for example, the profile value at the 
user level) for 'MO: Operating Unit' must correspond to the targeted 
organization before you set the salesperson in that organization. Set the profile 
option before using Resource Manager.

Responsibility
� CRM Administrator or 

� CRM Resource Administrator

Navigation
Navigate to the Define Resource window.

Steps
1. Query the imported resource for the selected employee. 

2. Click Resource Details.

The Resource window opens and is populated with your selection.

3. Specify a salesperson number for the resource. Since you have changed your 
profile option, it is empty.

4. In the Receivables tab, verify that the default Date Active is the correct one. 

5. Enter the information for Sales Credit type.

6. Save your work.

Table 4–4 Example Data

Country MO:Operating Unit Salesperson ID Number

United States Vision Corporation 0001US

Canada Vision Canada 0001CAN

Mexico Vision Mexico 0001MEX
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The employee is a salesperson in both organizations. 

7. (Optional) Repeat the entire procedure including first resetting the profile 
option to assign the salesperson to an additional organization.

Guidelines
You can also create a salesperson in multiple organizations using the HTML-based 
Resource Manager, but you first must set your profile option in Forms.

4.8 Defining Role Types

A role type is a broad descriptive category such as "Sales" that contains one or more 
roles. A role is a more detailed descriptive categories such as "Sales Representative" 
or "Sales Manager". Resource Manager is delivered with pre-defined Role Types for 
all CRM modules. Perform the following steps to define additional custom Role 
Types for your company. Make sure that a role type exists with which you can 
associate the new role.

Prerequisites
None

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Setup > Role Types.

The Application Object Library: JTF_RS_ROLE_TYPES Lookups window 
displays existing Role Types.

Note: You must save the Resource first before defining a Role 
Type.
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2. Use the down arrow to scroll to the bottom of the list of Role Types.

3. Select the last entry in the record and choose File > New to add a blank field.

4. Enter the name of the new Role Type in the blank field at the bottom of the list. 

5. In the Meaning field, enter the CRM module for which this Role Type is created.

6. Choose File > Save to complete the Role Type definition.

4.9 Defining Roles in Forms 
A Role may encompass one or more job descriptions and job titles. Use Roles to 
assign responsibilities to resources, resource groups and resource teams. Resource 
Manager is delivered with pre-defined Roles for all CRM modules. Perform the 
following steps in Forms to define additional custom Roles for your enterprise.

Prerequisites
Make sure that a Role Type exists with which you can associate the new Role.

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Setup > Roles.

2. Enter your values in the Code and Name fields. Choose a Role Type from the 
list of values (LOV).

Note: When a sales role is associated with a resource that is 
attached to a group with no group member role, the OIC 
application may provide the sales representative with incorrect 
compensation and may incorrectly roll up the hierarchy.
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3. Select the Active box to make the Role active. Select one or more of the role 
attribute check boxes–Member, Lead, Admin, Manager–to associate the Role to 
a responsibility. See the Resource Roles Attributes table in the Guidelines 
section for descriptions of these role attributes.

4. Use one or more Job names in the job region to describe jobs associated with the 
Role.

5. Select File > Save to complete the Role definition.

The new role name registers in the Role Name field in Resource Manager. The 
following table describes resource role attributes.

Guidelines
The following table describes resource role attributes used in the Resource Manager.

4.10 Defining Roles in HTML

A Role Type is a category of roles associated with a particular CRM module. 
Resource Manager is delivered with pre-defined Role Types for all CRM modules. 
Perform the following steps in HTML to define additional custom Roles for your 
enterprise. Ensure that a role type exists with which you can associate the new role.

Prerequisites
None

Table 4–5 Resource Role Attributes

Check Box Action

Member Identifies the role name as a member of the role.

Lead Identifies the role name as a lead for the role.

Active Identifies the role as active.

Admin Identifies the role as administrative.

Manager Identifies the role as managerial.

Seeded (Read-only) Identifies the role as seeded.

Note: You must save the Resource first before defining a Role 
Type.
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Responsibility
Resource Self Service Administrator

Navigation
Navigate to the People tab in HTML.

Steps
1. Select the Roles subtab.

2. Click Create.

The Create Role window opens.

3. Enter text in the Role Name, Role Code, and Description fields.

4. Select the Role Type from the drop-down list.

5. Select the attributes.

6. Click Create.

4.11 Specifying Role Attributes
Attributes aid in grouping different roles together when defining a resource 
reporting hierarchy. This hierarchy is used in sales product families, such as Sales 
Online and Telesales, to control the data access privilege (customer, sales lead, and 
sales opportunity) as well as sales forecast rollup and incentive compensation plan. 
It is also used for workflow notifications and escalations. You can have more than 
one attribute such as Admin and Manager as each has different functions. However, 
you would not select Lead and Manager, for example, because Lead is a subset of 
Manager. 

Example
You set up an escalation for service requests and tasks, notifications for members of 
groups go to the manager. Therefore, besides defining a role, you also need to 
specify the role attribute information for this new role by selecting the following 
seeded role attribute check boxes:

� Member: Default when another attribute is not chosen (Lead, Administrator, 
Manager). 

� Lead: Used in the context of team lead. 
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� Admin: Used to view and modify information about other group members. In 
the HTML Resource Manager, only a user in a group with either the 
Administrator or Manager group member role can update group member and 
group hierarchy information.

� Manager: Used to set up the group reporting hierarchy. For example, all the 
forecasts for a group of sales representatives roll up to the person with the 
Manager role attribute in that group. In addition, a user with the Manager 
group member role can update the group member and group hierarchy 
information in the HTML Resource Manager.

Perform the following steps to view roles and role attributes.

Prerequisites
A role must exist before it can be viewed.

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Setup > Roles.

2. On the application tool bar, click View > Find All. 

Information populates the window. 

3. Use the up and down arrows to move through the various role definitions.

As the role type changes, you can also view the responsibilities associated with 
each role.

4.12 Setting Profile Options for HTML
The following profile options must be set to specify functional behavior for the 
HTML version of Resource Manager. Each profile option is specific for HTML-based 
functionality.
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Table 4–6 Resource Manager Profile Options

Name
Default 
Value Level Description Outcome

Employee Resource 
Update Access

Self Site This profile option sets 
the security around 
updating employee 
information in the 
Resource Manager. 

If set to Self, only the employee 
can update their own 
information. 

If set to Any, others, including a 
System Administrator, can 
update the employee 
information, including 
overriding any previous values 
in the profile option: Resource 
Lookup Audience.

Group Update 
Access

None Site This profile option sets 
the security around 
updating groups, 
including hierarchies.

If set to None, then only the 
Administrator or manager can 
update their group and any 
other group following their 
group in the hierarchy. 

If set to All, then the user can 
update any group hierarchy in 
the site.

Resource Lookup 
Audience

General Site This profile option 
controls what the user 
views in the Resource 
Details window and in 
the Advanced Search.

If set to Admin, then the user 
can query in the Advanced 
Search using the additional 
fields of Resource number and 
Salesperson number.

If set to General, then the user is 
sees and searches on limited 
fields.

Role Update Access None Site This profile is used to 
control the access to the 
Role HTML windows.

The Resource Self Service 
Administrator 
responsibility level is set 
to the All value.

If set to None, then it is 
Read-Only access to the Role 
windows. You can search and 
view all the roles.

If set to All, then the user can 
create, update non-seeded roles, 
delete non-seeded roles, search, 
and view roles.
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4.13 Defining Skill Levels in HTML
 Defining skill levels in HTML is accomplished by assigning a numeric value to a 
skill rating and changing the value of the skill rating if required. Instruction for 
performing these steps are contained in the following sections:

� Assigning a Numeric Value to a Skill Rating

� Changing Skill Rating Values

4.14 Assigning a Numeric Value to a Skill Rating
Use the Define Skill Levels window in HTML to enter the name of the skill level 
and its associated numeric value. Once this is specified, an individual resource can 
select an appropriate skill level from the list of values of the Level field in the Rate 
Skill window to rate his technical skills. These skill levels are standard regardless of 
whether or not the resource is rated at product, platform, or problem code level. The 
numeric values for the related skill levels can be a part of the calculation when 
selecting the optimal individual for a service request. 

Use the following rules to define skill level information:

� No two skill ratings can have the same numeric value or the same name.

� Only positive integers are acceptable in the Numeric Value field.

� There is no change to the numeric value of “Not Applicable” (N/A).

� The sorting order depends on the numbers assigned to the values.

Resource active 
days after 
termination of 
relationship

30 days Site This profile is used when 
end dating a resource of 
type Partner. It allows a 
set period of days for the 
resource to stay active 
after termination. Set at 
Site level.

When set to x days the resource 
has that many days to stay 
active in the system.

Note: See Appendix A: Profile Options for instruction on setting 
the above listed profile options.

Table 4–6 Resource Manager Profile Options

Name
Default 
Value Level Description Outcome
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Perform the following steps to assign a numeric value to a skill rating.

Prerequisites
None

Responsibility
Resource Self Service Administrator

Navigation
Navigate to the HTML Resource Manager and login as the administrator.

Steps
1. Select the Administration tab on the main navigation bar.

The Define Resource Fields for Update window opens.

2. Click Skill Levels on the main navigation bar.

The Define Skill Levels window opens.

3. Enter a numeric value in the skill rating you want to modify.

4. Click Update to modify the information or click Restore to reset the original 
values in the window.

4.15 Changing the Name of a Skill Rating
The skill levels are editable, but you cannot delete any of them without entering a 
new name or value. Otherwise, an error message occurs saying “Level Name cannot 

Note: You can define skills using the following combinations:

� Product

� Product and component

� Product and problem code

� Problem code

� Problem code and category

� Platform

� Platform and Category
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be null” or “Numeric Value cannot be null.” Perform the following steps to change 
the name of a skill rating.

Prerequisites
None

Responsibility
Resource Self Service Administrator

Navigation
Navigate to the HTML Resource manager and login as the administrator.

Steps
1. Select the Administration tab on the main navigation bar.

The Define Resource Fields for Update window opens.

2. Click Skill Levels on the main navigation bar.

The Define Skill Levels window opens.

3. Select the skills rating you want to modify and enter a new name in the text 
field.

4. Click Update to modify the information or click Restore to reset the original 
values in the window.

4.16 Configuring Group and Team Member Notifications
Resource Manager enables Workflow notifications to be sent to group and team 
members integrating groups, teams, and their members with workflow roles. The 
Synchronize Workflow Roles concurrent program must be run on a periodic basis to 
ensure that the group-to-membership and team-to-membership relationship 
information stored in Resource Manger is in sync with the data stored in the 
corresponding Workflow role tables. 

4.16.1 Group Example
The integration of resources, groups, and group members with Workflow roles can 
be demonstrated by creating a sample group with four members. When the sample 
group and its members are created in Resource Manager, the Resource Manager 
4-26 Oracle Common Application Components Implementation Guide



Configuring Group and Team Member Notifications
APIs call wrapper APIs that subsequently populates the corresponding Workflow 
tables with the required information.

Step 1: Creating a Group
Begin by creating a sample group called My Group. Information for this group is 
stored in the JTF_RS_GROUPS_VL table in Resource Manager. Assume that 
creating this group generates a group ID number 10011.

When you create a group with the preceding information, the wrapper APIs create 
new records in the Workflow WF_LOCAL_ROLES and WF_LOCAL_USER_ROLES 
tables. These records contain the original group information and additional data 
required by Workflow.

Step 2: Defining Resources to Add to the Group
Next, you must define the four resources that you will subsequently add to the 
group as group members. Information for these resources will be stored differently 
in the Workflow tables depending on their category and whether or not their user id 
is null. 

Table 4–7 Group Information

Group ID Group Name

10011 My Group

Table 4–8 Group Information Stored in WF_LOCAL_ROLES table

Role Name Orig System Orig System

JRES_GRP:10011 JRES_GRP 10011

Table 4–9 Group Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

JRES_GRP:10011 JRES_GRP 10011 JRES_GRP:10011 JRES_GRP 10011
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Resource Johnson. To define the resource "Johnson" as an employee first create a 
new record in HRMS using the Define Employee screen. Then create an FND_USER 
employee using the Define User screen whose user ID is 101 and user name is 
"johnson". Import this employee in to Resource Manager using the Import Resource 
form. Resource Manager will not create a corresponding record for this employee in 
the Workflow tables since the WF_USERS table will already contain a record 
corresponding to the one in FND_USER. The FND_USER information will be stored 
in the following Workflow tables:

Resource Jones. To define the resource "Jones" as an employee, first create a new 
record in HRMS using the Define Employee screen, then import it into Resource 
Manager using Import Resource form. Information for the resource "jones" will be 
stored in the Workflow tables as follows since the user ID is null.

Table 4–10 Resources To Be Added to My Group

Resource ID Resource Name Category User ID

10001 johnson employee 101

10002 jones employee null

10003 lewis other null

10004 smith party null

Table 4–11 Resource Johnson Information Stored in WF_LOCAL_ROLES table

Role Name Orig System Orig System ID

johnson FND_USER 101

Table 4–12 Resource Johnson Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

johnson FND_USER 101 johnson FND_USER 101

Table 4–13 Resource Jones Information Stored in WF_LOCAL_ROLES table

Role Name Orig System Orig System ID

JRES_IND:10002 JRES_IND 10002
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Resource Lewis. To define a resource "Lewis" as a resource of type Other, create a 
new resource in Resource Manager using the Define Resource form. Information for 
the resource "lewis" will be stored in the Workflow tables as follows since the 
resource is of type other. 

Resource Smith. To define a resource "Smith" as a party, first create a new record in 
TCA and then import in into Resource Manager using the Import Resource form. 
Information for the resource "smith" will be stored in the Workflow tables as follows 
since the user ID is null.

Table 4–14 Resource Jones Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

JRES_IND:10002 JRES_IND 10002 JRES_IND:10002 JRES_IND 10002

Table 4–15 Resource Lewis Information Stored in WF_LOCAL_ROLES table

Role Name Orig System Orig System ID

JRES_IND:10003 JRES_IND 10003

Table 4–16 Resource Lewis Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

JRES_IND:10003 JRES_IND 10003 JRES_IND:10003 JRES_IND 10003

Table 4–17 Resource Smith Information Stored in WF_LOCAL_ROLES table

Role Name Orig System Orig System ID

JRES_IND:10004 JRES_IND 10004
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Step 3: Adding Resources to the Group
After creating the required resources, you must add them to My Group. To 
accomplish this, query up "My Group" in the Define Groups form and add all the 
above members in the member region. Information for the group members will be 
stored in the Workflow tables as follows since the user id is null for this resource:

4.16.2 Team Example
The integration of resources, teams, and team members with Workflow roles can be 
demonstrated by a sample team with three individual members and one group 
member. When the sample team and its members are created in Resource Manager, 
the Resource Manager APIs call wrapper APIs that subsequently populates the 
corresponding Workflow tables with the required information.

Step 1: Creating a Team
Begin by creating a sample team called My Team. Information for this team is stored 
in the JTF_RS_TEAMS_VL table in Resource Manager. Assume that creating this 
team generates a team ID number 10011.

Table 4–18 Resource Smith Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

JRES_IND:10004 JRES_IND 10004 JRES_IND:10004 JRES_IND 10004

Table 4–19 Group Member Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

JOHNSON FND_USER 101 JRES_GRP:10011 JRES_GRP 10011

JRES_IND:10002 JRES_IND 10002 JRES_GRP:10011 JRES_GRP 10011

JRES_IND:10003 JRES_IND 10003 JRES_GRP:10011 JRES_GRP 10011

JRES_IND:10004 JRES_IND 10004 JRES_GRP:10011 JRES_GRP 10011
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Step 2: Defining Resources and a Group to Add to the Team
Next, you must define the three resources and one group that you will subsequently 
add to the team as team members. Information for the resources and group will be 
stored differently in the Workflow tables depending on their category and whether 
or not their user id is null. 

Resource Johnson. To define the resource "Johnson" as an employee first create a 
new record in HRMS using the Define Employee screen. Then create an FND_USER 
employee using the Define User screen whose user ID is 101 and user name is 
"johnson". Import this employee in to Resource Manager using the Import Resource 
form. Resource Manager will not create a corresponding record for this employee in 
the Workflow tables since the WF_USERS table will already contain a record 
corresponding to the one in FND_USER. The FND_USER information will be stored 
in the following Workflow tables:

Table 4–20 Team Information

Team ID Team Name

10011 My Team

Table 4–21 Team Information Stored in WF_LOCAL_ROLES table

Role Name Orig System Orig System

JRES_TEAM:10011 JRES_TEAM 10011

Table 4–22 Team Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

JRES_TEAM:10011 JRES_TEAM 10011 JRES_TEAM:10011 JRES_TEAM 10011

Table 4–23 Resources To Be Added to My Team

Resource ID Resource Name Category User ID

10001 johnson employee 101

10002 jones employee null

10003 lewis other null
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Table 4–25 Resource Johnson Information Stored in the WF_LOCAL_USER_ROLES table

Resource Jones. To define the resource "Jones" as an employee, first create a new 
record in HRMS using the Define Employee screen, then import it into Resource 
Manager using Import Resource form. Information for the resource "jones" will be 
stored in the Workflow tables as follows since the user ID is null.

Resource Lewis. To define a resource "Lewis" as a resource of type Other, create a 
new resource in Resource Manager using the Define Resource form. Information for 
the resource "lewis" will be stored in the Workflow tables as follows since the 
resource is of type other. 

Table 4–24 Resource Johnson Information Stored in WF_LOCAL_ROLES table

Role Name Orig System Orig System ID

johnson FND_USER 101

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

johnson FND_USER 101 johnson FND_USER 101

Table 4–26 Resource Jones Information Stored in WF_LOCAL_ROLES table

Role Name Orig System Orig System ID

JRES_IND:10002 JRES_IND 10002

Table 4–27 Resource Jones Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

JRES_IND:10002 JRES_IND 10002 JRES_IND:10002 JRES_IND 10002
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Resource Smith. To define a resource "Smith" as a party, first create a new record in 
TCA and then import in into Resource Manager using the Import Resource form. 
Information for the resource "smith" will be stored in the Workflow tables as follows 
since the user ID is null.

Group My Group. Next. create a sample group called "My Group". Information for 
this group is stored in the JTF_RS_GROUPS_VL table in Resource Manager. Assume 
that creating this group generates a group ID number 10012.

When you create a group with the preceding information, the wrapper APIs create 
new records in the Workflow WF_LOCAL_ROLES and WF_LOCAL_USER_ROLES 
tables. These records contain the original group information and additional data 
required by Workflow.

Table 4–28 Resource Lewis Information Stored in WF_LOCAL_ROLES table

Role Name Orig System Orig System ID

JRES_IND:10003 JRES_IND 10003

Table 4–29 Resource Lewis Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

JRES_IND:10003 JRES_IND 10003 JRES_IND:10003 JRES_IND 10003

Table 4–30 Resource Smith Information Stored in WF_LOCAL_ROLES Table

Role Names Orig System Orig System ID

JRES_IND:10004 JRES_IND 10004

Table 4–31 Group to be added to My Team

Group ID Group Name

10012 My Group
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Step 3: Adding the Group and Resources to the Team
After creating the required group and resources, you must add them to My Team. 
To accomplish this, query up "My Team" in the Define Teams form and add all the 
above members in the member region. Information for the team members will be 
stored in the Workflow tables as follows since the user id is null for this resource:

Prerequisites
None

Responsibility
CRM Administrator or

System Administrator

Navigation
Navigate to the Navigator - CRM Administrator window, or

Navigate to the Navigator - System Administrator window

Table 4–32 Group Information Stored in WF_LOCAL_ROLES table

Role Name Orig System Orig System

JRES_GRP:10012 JRES_GRP 10012

Table 4–33 Group Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name Role Orig System

Role Orig
System ID

JRES_GRP:10012 JRES_GRP 10012 JRES_GRP:10012 JRES_GRP 10012

Table 4–34 Group Member Information Stored in the WF_LOCAL_USER_ROLES table

User Name
User Orig
System

User Orig
System ID Role Name

Role Orig 
System

Role Orig
System ID

JOHNSON FND_USER 101 JRES_TEAM:1001 JRES_TEAM 10011

JRES_IND:10002 JRES_IND 10002 JRES_TEAM:1001 JRES_TEAM 10011

JRES_IND:10003 JRES_IND 10003 JRES_TEAM:1001 JRES_TEAM 10011

JRES_GRP:10012 JRES_GRP 10012 JRES_TEAM:1001 JRES_TEAM 10011
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Steps
Follow the steps in Appendix B: Concurrent Programs to run the following 
concurrent program. Choose the appropriate parameter depending on whether you 
are synchronizing groups and group members, teams and team members or both 
with Workflow roles.

4.17 Publishing Business Events
Resource Manager publishes events such as creating and importing resources, 
updating resources, and deleting resources using the Oracle Workflow Business 
Event System. Applications that contain data directly affected by these events can 
subscribe to them and synchronize or modify their data accordingly. For example if 
a resource that is assigned to a Task is deleted, this action is published or "raised" as 

Table 4–35 Synchronize Workflow Roles Concurrent Programs

Name Description Frequency Notes

Synchronize 
Workflow Roles 

This program synchronizes all 
attributes and records in the 
workflow wf_local_* tables with the 
mismatching records in Resource 
manager.

The Synchronize Workflow For 
parameter enables you specify which 
of the following Resource Manager 
entities you wish to synchronize with 
Workflow roles:

� Groups and Group Members 
synchronizes Resource Manager 
groups and group members with 
the appropriate Workflow roles 
tables.

� Teams and Team Members 
synchronizes Resource Manager 
teams and team members with 
the appropriate Workflow roles 
tables.

� All synchronizes Resource 
Manager groups, group 
members, teams, and team 
members with the appropriate 
Workflow roles tables.

As needed This program should be run as 
follows:

� The first time group or team 
notification functionality is 
implemented in Resource 
Manager.

� When groups, teams, or 
resources that were not 
active at the time of their 
creation have become 
activated.

� If online transactions 
encounter a Workflow error.

� When the Synchronize 
Employees concurrent 
program is run.

� When the Synchronize 
Parties and Partners 
concurrent program is run. 

� When the Synchronize 
Supplier Contact concurrent 
program is run.
Phase I: Setting Up Resource Manager 4-35



Publishing Business Events
a business event. Task Manager, can consequently subscribe to this event and 
reassign the task to an available resource.

4.17.1 The Oracle Workflow Business Event System
The Oracle Workflow Business Event System is an application service that leverages 
the Oracle Advanced Queuing (AQ) infrastructure to communicate business events 
between systems. The Business Event System consists of the Event Manager and 
workflow process event activities. 

The Event Manager contains a registry of business events, systems, named 
communication agents within those systems, and subscriptions indicating that an 
event is significant to a particular system. Events can be raised locally or received 
from an external system or the local system through AQ. When a local event occurs, 
the subscribing code is executed in the same transaction as the code that raised the 
event, unless the subscriptions are deferred.

4.17.2 Resource Manager Events
When a resource is created, imported, updated, or deleted, the Resource Manager 
APIs call wrapper APIs that raise the following events:

Table 4–36 Resource Manager Events

Event Description

Resource Create This event is raised for all newly created and imported resources.

Resource Update User This event is raised for resources whose USER_ID data has changed.
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4.17.3 Example: Importing a Resource
In this example, the Oracle Mobile Field Sales team wants to populate its temporary 
table with all newly imported/created resources in Resource Manager. This process 
is accomplished as follows:

1. A new employee is hired to fill an open position within the organization.

2. Resource Manager conducts its weekly import of new resources from HRM. 

Resource Update dateEffectivity This event is raised for all resources that have a modified start date active 
or end date active.

Resource Update Attribute This event is raised for all the resources that have a changes in the 
following attributes:

� RESOURCE_NAME

� TIME_ZONE

� COST_PER_HR

� PRIMARY_LANGUAGE

� SECONDARY_LANGUAGE

� IES_AGENT_LOGIN

� SERVER_GROUP_ID

� ASSIGNED_TO_GROUP_ID

� COST_CENTER

� CHARGE_TO_COST_CENTER

� COMPENSATION_CURRENCY_CODE

� COMMISSIONABLE_FLAG

� HOLD_REASON_CODE

� HOLD_PAYMENT

� COMP_SERVICE_TEAM_ID

� SUPPORT_SITE_ID

Resource Delete This event is raised for deleted resources.

Table 4–36 Resource Manager Events

Event Description
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3. The new employee is imported into Resource Manager and the following new 
record is created as an employee resource in the table 
JTF_RS_RESOURCE_EXTNS_VL:

4. Importing the resources into Resource Manager raises the following Resource 
Create event in the Oracle workflow event Manager:

5. Oracle Mobile Field Sales subscribes to the Resource Create event, every time a 
user syncs from a remote location to determine whether any new records have 
been created in Resource Manager. Because the field sales application is used 
mostly offline, new resource records may not be replicated into the local 
database, there fore, by subscribing to the event, field sales can get up to date 
records when a user syncs to replicate the online database.

The Oracle Mobile Field Sales team owns the rule function, 
OracleMobileFieldSales.ResourceCreated, and has the logic to populate their 
temporary table with all newly imported or newly created resources in Resource 
Manager.

6. The sales manager with the open position syncs the sales manager’s laptop to 
replicate its data with the system's data using the temporary table. After 
completing the sync, the sales manager sees the new employee record and is 
able to assign the open opportunities to the new salesrep as well as adding the 
new salesrep to the manager’s sales group.

Table 4–37 Imported Resource Johnson Record

Resource Id Resource Name Category User Id

10001 Johnson Employee 101

Table 4–38 Resource Create Event

Event Name Event Key

oracle.apps.jtf.jres.resource.create oracle.apps.jtf.jres.resource.create-1001

Table 4–39 Subscription for Resource Create Event

Event Filter Phase Status Rule Function

oracle.apps.jtf.jres.resource.create >100 Enabled OracleMobileFieldSales.ResourceCreated
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4.17.4 Example: Updating a Resource
In this example, Oracle Service only assigns the following resources to a Service 
Request if the resource is attached to an FND user:
 

4.17.4.1 Updating the USER_ID Value
If the Service Request is already assigned to a resource that has a USER_ID value 
attached and Resource Manager changes the USER_ID value to NULL, then Oracle 
Service must reassign the Service Request to a different resource. 

1. Resource Johnson is attached to a valid FND user and is assigned to the 
following Service Request:

2. The FND user record with USER_ID value 101 is deleted in FND Applications. 

3. Resource Manager performs the following steps to update the record for the 
resource, Johnson:

a. Resource Manger executes the 'Synchronize Application user name' 
Concurrent Program to update the USER_ID attached to 'Johnson' to NULL

b. Resource Manager simultaneously raises the Business event, 
oracle.apps.jtf.jres.resource.update.user with the following parameters:

Table 4–40 Resource Johnson Data

Resource Id
Resource 
Name Category User Id Start Date End Date Time Zone

10001 Johnson Employee 101 01-01-2002 None Pacific

Table 4–41 Service Request for Resource Johnson

Service Request Id Service Request Name Assignee Id Assignee Name

1001 Software Problem 10001 Johnson

Table 4–42 Updated Record for User Johnson

Resource Id Resource Name Category User Id

10001 Johnson Employee NULL
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4. The service request subscribes to the resource update event with the following 
details:

Oracle Service owns the rule function OracleService.ResourceUserUpdated that 
contains the logic to reassign the resource to a resource that has a valid USER_ID 
attached.

4.17.4.2 When START_DATE_ACTIVE and/or End_DATE_ACTIVE is Changed
In this example, Oracle Service only assigns the resources to a Service Request if the 
resource is valid in Resource Manager because the service request assignment 
period exists within the Resource start date and end date. If the Service Request is 
already assigned to a resource and Resource Manager changes the date effectivity of 
that resource, Oracle Service must reassign the Service Request to some other 
resource.

1. Resource Johnson is assigned to the following Service Request from 08-01-2002 
to 08-01-2003:

2. The Resource Johnson is updated and a business event is raised.

a. Resource, Johnson is end dated in Resource Manager with the end date, 
'08-01-2002:

Table 4–43 Resource Update Event

Parameter Name Parameter Value

RESOURCE_ID 10001

CATEGORY EMPLOYEE

OLD_USER_ID 101

NEW_USER_ID NULL

Table 4–44 Subscription for Resource Update Event

Event Filter Phase Status Rule Function

oracle.apps.jtf.jres.resource.update.user >100 Enabled OracleService.ResourceUserUpdated

Table 4–45 Service Request for Resource Johnson

Service Request Id Service Request Name Assignee Id Start Date End Date

1001 Software Problem 10001 08-01-2002 08-01-2003
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b. Resource Manager raises the event, 
oracle.apps.jtf.jres.resource.update.effectivedate with the following 
parameters:

3. Service request subscribes to the resource update event with the following 
details.

 

Oracle Service owns the rule function OracleService.ResourceDateUpdated and 
has the logic to reassign the resource to a resource with a valid date effectivity.

4.17.4.3 When Resource Time Zone is Changed
In this example, Oracle Service assigns the resources to a service request that 
depends on the time zone of the resource. If the Service Request is already assigned 
to a resource and Resource Manager changes the time zone of that resource, Oracle 
Service must reassign the Service Request to some other resource.

Table 4–46 Modified Record for Resource Johnson

Resource Id Resource Name Category Start Date End Date

10001 Johnson Employee 01-01-2002 08-01-2002

Table 4–47 Resource Update Event

Parameter Name Parameter Value

RESOURCE_ID 10001

CATEGORY EMPLOYEE

RESOURCE_NAME Johnson

OLD_START_DATE_ACTIVE 01-01-2002

OLD_END_DATE_ACTIVE NULL

NEW_START_DATE_ACTIVE 01-01-2002

NEW_END_DATE_ACTIVE 08-01-2002

Table 4–48 Subscription for Resource Update Event

Event Filter Phase Status Rule Function

oracle.apps.jtf.jres.resource.update.effectivedate >100 Enabled OracleService.ResourceDateUpdated
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1. Resource Johnson is assigned to the following Service Request that has a time 
zone 'Pacific':

2. The resource is modified as follows:

a. Time zone for the resource, Johnson is changes from 'Pacific' to 'Central':

b. Resource Manager simultaneously raises the Business event, 
oracle.apps.jtf.jres.resource.update.attributes with the following 
parameters:

3. Service request subscribes to the resource update event with the following 
details:

Table 4–49 Service Request Assignment

Service Request Id Service Request Name Assignee Id Time Zone

1001 Software Problem 10001 Pacific

Table 4–50 Modified Service Request Assignment

Service Request Id Service Request Name Assignee Id Time Zone

1001 Software Problem 10001 Central

Table 4–51 Resource Update Event

Parameter Name Parameter Value

RESOURCE_ID 10001

CATEGORY EMPLOYEE

RESOURCE_NAME Johnson

OLD_ TIME_ZONE Pacific

NEW_ TIME_ZONE Central

Table 4–52 Subscription to Resource Update Event

Event Filter Phase Status Rule Function

oracle.apps.jtf.jres.resource.update.attributes >100 Enabled OracleService.ResourceTimeoneUpdated
4-42 Oracle Common Application Components Implementation Guide



Publishing Business Events
Oracle Service owns the rule function, OracleService.ResourceTimeoneUpdated 
that contains the logic to reassign the resource to a resource that has a required time 
zone.

4.17.5 Example: Deleting a Resource
In this example, only Resource of type 'TBH' such as the following resource can be 
deleted using the delete resource API:

Task Manager assigns the resources to a Task only if that resource exists in Resource 
manager. If the Task is already assigned to a resource and Resource Manager deletes 
that resource, Task Manager needs to reassign that Task to some other existing 
resource.

1. Resource Abraham is assigned to the following Task from 08-01-2002 to 
08-01-2003:

2. Resource, Abraham is deleted using the API Resource Public API
 jtf_rs_resource_pub.delete_resource. 

3. Because resource, Abraham is deleted, Task Manager must reassign the task to a 
different resource. To accomplish this, Resource Manager raises the Business 
event, oracle.apps.jtf.jres.resource.delete with the following parameters:

4. Task Manager subscribes to the resource update event with the following 
details:

Table 4–53 Resource Abraham Example

Resource Id Resource Name Category User Id Start Date End Date

10002 Abraham Other NULL 01-01-2002 NULL

Table 4–54 Task Assignment

 Task Id Task Name Resource Id Resource Name Start Date End Date

1002 Product Presentation 10002 Abraham 08-01-2002 08-01-2003

Table 4–55 Resource Delete Event

Parameter Name Parameter Value

RESOURCE_ID 10001
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Task Manager owns the rule function, TaskManager.ResourceDeleted is the Rule 
function that contains the logic to reassign the resource to an existing resource.

4.17.6 Steps
This section provides instructions for publishing Resource Manager business 
events.

4.17.6.1 Create Resource
Perform the following to raise a business event using the 
jtf_rs_wf_event_pub.create_resource wrapper API:

1. Add the following parameters into the parameter list using, 
wf_event.AddParameterToList

� RESOURCE_ID

� RESOURCE_NAME

� CATEGORY

� USER_ID

� START_DATE_ACTIVE

� END_DATE_ACTIVE

2. Event_key will be 
’oracle.apps.jtf.jres.resource.create-'||jtf_rs_wf_event_guid_s.nextval.

3. Raise the Event, oracle.apps.jtf.jres.resource.create using the workflow API, Wf_
event.Raise.

4.17.6.2 Update Resource
Perform the following to raise a business event using the
jtf_rs_wf_event_pub.update_resource API:

Table 4–56 Resource Delete Event Subscription

Event Filter Phase Status Rule Function

oracle.apps.jtf.jres.resource.delete >100 Enabled TaskManager.ResourceDeleted
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When the user_id is updated
1. Add the following parameters into the parameter list using, 

wf_event.AddParameterToList.

� RESOURCE_ID

� CATEGORY

� RESOURCE_NAME

� OLD_USER_ID

� NEW_USER_ID

2. Event_key will be
 'oracle.apps.jtf.jres.resource.update.user-'||jtf_rs_wf_event_guid_s.nextval.

3. Raise the Event, oracle.apps.jtf.jres.resource.update.user using the workflow 
API, Wf_event.Raise.

When Start Date Active or End Date Active is changed
1. Add the following parameters into the parameter list using, 

wf_event.AddParameterToList

� RESOURCE_ID

� CATEGORY

� RESOURCE_NAME

� OLD_START_DATE_ACTIVE

� OLD_END_DATE_ACTIVE

� NEW_START_DATE_ACTIVE

� NEW_END_DATE_ACTIVE

2. Event_key will be
 'oracle.apps.jtf.jres.resource.update.effectivedate-'||
jtf_rs_wf_event_guid_s.nextval.

3. Raise the Event, oracle.apps.jtf.jres.resource.update.effectivedate using the 
workflow API, Wf_event.Raise.

When any of the following attributes changed
RESOURCE_NAME
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� TIME_ZONE

� COST_PER_HR

� PRIMARY_LANGUAGE

� SECONDARY_LANGUAGE

� IES_AGENT_LOGIN

� SERVER_GROUP_ID

� ASSIGNED_TO_GROUP_ID

� COST_CENTER

� CHARGE_TO_COST_CENTER

� COMPENSATION_CURRENCY_CODE

� COMMISSIONABLE_FLAG

� HOLD_REASON_CODE

� HOLD_PAYMENT

� COMP_SERVICE_TEAM_ID

� SUPPORT_SITE_ID

1. Add the following parameters into the parameter list using, 
wf_event.AddParameterToList

� RESOURCE_ID

� CATEGORY

� OLD_RESOURCE_NAME

� OLD_TIME_ZONE

� OLD_COST_PER_HR

� OLD_PRIMARY_LANGUAGE

� OLD_SECONDARY_LANGUAGE

� OLD_IES_AGENT_LOGIN

� OLD_SERVER_GROUP_ID

� OLD_ASSIGNED_TO_GROUP_ID

� OLD_COST_CENTER
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� OLD_CHARGE_TO_COST_CENTER

� OLD_COMPENSATION_CURRENCY_CODE

� OLD_COMMISSIONABLE_FLAG

� OLD_HOLD_REASON_CODE

� OLD_HOLD_PAYMENT

� OLD_COMP_SERVICE_TEAM_ID

� OLD_SUPPORT_SITE_ID

� NEW_RESOURCE_NAME

� NEW_TIME_ZONE

� NEW _COST_PER_HR

� NEW _PRIMARY_LANGUAGE

� NEW _SECONDARY_LANGUAGE

� NEW _IES_AGENT_LOGIN

� NEW _SERVER_GROUP_ID

� NEW _ASSIGNED_TO_GROUP_ID

� NEW _COST_CENTER

� NEW _CHARGE_TO_COST_CENTER

� NEW_COMPENSATION_CURRENCY_CODE

� NEW _COMMISSIONABLE_FLAG

� NEW _HOLD_REASON_CODE

� NEW _HOLD_PAYMENT

� NEW _COMP_SERVICE_TEAM_ID

� NEW _SUPPORT_SITE_ID

2. Event_key will be 
'oracle.apps.jtf.jres.resource.update.attributes-'||
jtf_rs_wf_event_guid_s.nextval.

3. Raise the Event oracle.apps.jtf.jres.resource.update.attributes using the 
workflow API, Wf_event.Raise.
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4.17.6.3  Delete Resource
Perform the following to raise a business event using the 
 jtf_rs_wf_event_pub.delete_resource API.

1. Add the RESOURCE_ID parameter into the parameter list using, 
wf_event.AddParameterToList

2. Event_key will be
 'oracle.apps.jtf.jres.resource.delete-' || jtf_rs_wf_event_guid_s.nextval.

3. Raise the Event, oracle.apps.jtf.jres.resource.delete using the workflow API, Wf_
event.Raise.

4. Only Resource of 'TBH' can be deleted using the delete resource API.
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Phase II: Managing Resources

Implementing Resource Manager takes place in two phases. In the first phase, you 
set up Resource Manager by defining and configuring required components. In the 
second phase, you use Resource Manager to manage your resources. This chapter 
provides detailed instructions for Phase II: Managing Resources. Topics include:

� Overview of Managing Resources

� Finding a Resource in Forms

� Finding a Resource in HTML

� Configuring Resource Fields for Updates

� Assigning Additional Resource Attributes

� Synchronizing End Dates for Partner and Employee Resources

� Creating Groups in Forms

� Creating Groups in HTML

� Defining Dynamic Groups

� Viewing Group Hierarchy

� Viewing Role Details

� Assigning Roles to Resources

� Assigning Resources to Groups

� Defining Teams

� Running an Audit Report

� Viewing an Audit Report

� Running a Group Structure Report
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� Viewing a Group Structure Report

� Running Resource Skills Report

� Viewing Resource Skills Report

5.1 Overview of Managing Resources
This section contains a summary of the steps for managing resources with Resource 
Manager. Detailed instructions for these steps are provided in the subsequent 
sections.

5.1.1 Finding and Viewing Resources
After importing a resource into Resource Manager, you can find and view the 
resource and manage it by performing any of the actions described in the remainder 
of this chapter. Instructions for finding and viewing resources are contained in the 
following sections:

� Finding a Resource in Forms

� Finding a Resource in HTML

5.1.2 Modifying Resources
You can modify resources by configuring resource fields for updates in HTML, 
assigning additional attributes to resources in Forms, or synchronizing end dates for 
partner relationship resources in Forms.

5.1.2.1 Configuring Resource Fields for Updates
If you are using the HTML version of Resource Manager, then the appropriate users 
or system administrators with the Resource Self Service Administrator 
responsibility must set up the Define Resource Fields for Update window. This is 
used to determine which fields for the resource’s personal information can be 
updated and how the update should occur. Instructions for performing this step are 
contained in the Configuring Resource Fields for Updates section.

5.1.2.2 Assigning Additional Resource Attributes
In the Forms-based version of Resource Manager, you can add additional attribute 
information if the resource is used by one of the following e-Business applications:

� Service
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� Interaction Center

� Compensation

� Receivables

Instructions for performing this step are contained in the Assigning Additional 
Resource Attributes section.

5.1.2.3 Synchronizing End Dates for Partner Relationship Resources
Resource Manager enables you to synchronize the end date of an imported partner 
relationship resource with the end date of the partner relationship resource from 
which it was imported. For instance, if you import a partnership resource from an 
application such as OSO and the end date for that partnership resource is 
subsequently changed in OSO, you must reflect this change in the imported 
resource. Instructions for pilfering this step are contained in the Synchronizing End 
Dates for Partner Relationship Resources section.

5.1.3 Defining Groups
You can organize and manage your resources by defining groups to which they can 
be assigned. You can create groups in the Forms-based or HTML versions of 
Resource Manager, define dynamic groups, and view group hierarchy.

5.1.3.1 Creating Groups in Forms
The Forms-based version of Resource Manager enables you to create groups, to 
assign them roles, and to use the exclusive flag feature. You can only assign existing 
roles to a resource group in Forms. Instructions for this step are contained in the 
Creating Groups in Forms section.

5.1.3.2 Creating Groups in HTML
The HTML version of Resource Manager enables you to create groups and to assign 
new or existing roles to those groups. You cannot, however use the exclusive flag 
feature in HTML. Instructions for this step are contained in the Creating Groups in 
HTML section.

5.1.3.3 Defining Dynamic Groups
You can define a dynamic group based on criteria specified in a SQL statement. 
Instructions for this step are contained in the Defining Dynamic Groups section.
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5.1.3.4 Viewing Group Hierarchy
Resource Manager enables you to view group hierarchy including managers and 
subordinates for a group or resource. Instructions for this step are contained n the 
Viewing Group Hierarchy section.

5.1.4 Managing Roles and Groups
You can manage roles and groups by viewing role details, assigning roles and group 
membership to resources, and setting up group member notification.

5.1.4.1 Viewing Role Details
Instructions for this step are contained in the Viewing Role Details section.

5.1.4.2 Assigning Roles to Resources
In HTML, you can attach a roles to resources. A Role is comprised of a Role Type, a 
Role, and a start and end date. Instructions for this step are contained in the 
Assigning Roles to Resources section.

5.1.4.3 Assigning Resources to Groups
In HTML, you can assign resources to a Group. Group membership is comprised of 
a Group, Role Type, Role, and a start and end date. Instructions for this step are 
contained in the Assigning Resources to Groups section.

5.1.5 Defining Teams
You can organize resource and groups by organizing them in teams. A team is a 
collection of groups and resources that is organized to accomplish a specific task or 
objective. Instructions for this step are contained in the Defining Teams section.

5.1.6 Running Reports
Resource Manager enables you to obtain a variety of information about resources, 
groups and skills by running the following reports:

� Running an Audit Report

� Viewing an Audit Report

� Running a Group Structure Report

� Viewing a Group Structure Report
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� Running Resource Skills Report

� Viewing Resource Skills Report

5.2 Finding a Resource in Forms
In Forms, use the Find Resources window to perform the following actions:

� Defining a search criteria to find one or more resource summaries

� Defining a Salesperson

You can search for a resource on any single or combination of fields. Perform the 
following steps to find one or more resource summaries.

Prerequisites
Create or Import a Resource

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Maintain Resources > Resources.

2. Choose one or more parameters upon which to search. 

Typical search parameters are:

� Number

� Category

� Transaction Number

� Name

3. (Optional) Enter the required dates for the resource in the Start Date and End 
Date fields.

4. Click Find.
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The Resource Search Results window opens with a list of resources that met 
your criteria.

5. Select your resource and click Resource Details.

The Resource window opens. From here, you can select the appropriate tab to 
view more details for the selected resource.

5.3 Finding a Resource in HTML
In HTML, use the Resource Search Results window to select a resource for detailed 
viewing. 

Prerequisites
Perform a resource search before you can view the summary results.

Responsibility
� CRM Application Foundation User

� Resource Self Service Administrator (for administrative purposes)

Navigation
Navigate to People tab.

Steps
1. Perform your search either using the Quick Find or the Advanced Search 

feature.

2. The resources will be listed in the Employees window.

3. Click on the desired resource from the Preferred Name column.

4. From the Details window, you can view or update existing resource information 
if it is your own or you are an administrator.

5.4 Configuring Resource Fields for Updates
Administrators can set up resource fields for to be updated as follows:

� Full Update: Anyone can update the field without approval or workflow 
notification.
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� Update With Notification: Anyone can update the field but it requires that a 
workflow notification be sent to the appropriate individual.

� Update With Approval: Anyone can update the field but it requires an 
approval first.

� No Update: No one can ever update the field.

By using the previous four update options, administrators can define the following 
specific fields that can and cannot be changed, as well as how those fields can be 
modified (with approval or with notification only):

� Preferred Name: Resources can enter and maintain their full name information.

� Resource Address: Resources can enter and maintain their work address 
information.

� Work Phone Number: Resources can enter and maintain their work phone 
number.

� E-mail Address: Resources can enter and maintain their e-mail address 
information.

Perform the following steps to add or modify field updates for a resource.

Prerequisites
You must have the Resource Self Service Administrator responsibility.

Responsibility
Resource Self Service Administrator

Navigation
Navigate to the HTML Resource Manager.

Steps
1. Select the Administration tab on the main navigation bar.

The Define Resource Fields for Update window opens.

2. Modify preferences for each field by selecting the option button for the type of 
update you want to define. 

3. Click Update.

The Acknowledgment window opens confirming your changes.
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4. Click Edit Details to return to the Define Resource Fields for Update window or 
click the People tab to return to the Employee summary window.

Guidelines 
Users with the Resource Self Service Administrator responsibility can determine 
which fields (preferred name, resource address, work phone number, and e-mail 
address) can be updated and how the update should occur, such as full update, 
update with notification, update with approval, or no update. Detailed information 
is covered in the 11i Implement Common Application Components course.

5.5 Assigning Additional Resource Attributes
In Forms, you can assign or view additional resource information if the resource is 
used by other applications. In the following tabs you can add additional 
information:

� Service: You define the time zone for resources and cost per hour. You can enter 
or view the Support Site information. This information populates automatically 
in the Assignment Manager if the resource is selected. Note that you define the 
currency type in the Compensation tab.

� Interaction Center: You can view the e-mail addresses and the agent IDs of 
resources associated with the eMail Center or Interaction Center modules here. 
This tab is used primarily by the Interaction Center and eMail Center modules. 
Optionally, enter the Scripting Agent Login if the employee uses Oracle 
Scripting. Use the Telephony Parameters region to enter middleware 
configuration, parameters, and values for the agent. Which telephony 
parameters are required and which values to specify depend on the types of 
switch and CTI middleware used in the Interaction Center. Optionally, use the 
Email Parameters region to specify the Interaction Center Agent’s e-mail 
account, parameter, and value if the agent uses Oracle eMail Center to work 
with e-mail work items. All fields are read-only. If the resource is not associated 
with either center, these fields are blank.

� Compensation: Either view or define the Currency Type corresponding to the 
Cost per Hour listed on the Service tab. This information is primarily used by 
the Sales application.

� Receivables: Identify a salesperson by entering additional information in the 
Receivables tab. The attributes defined here are used by Oracle Accounts 
Receivables. 
5-8 Oracle Common Application Components Implementation Guide



Synchronizing End Dates for Partner and Employee Resources
You can view only personal information about the resource in the Miscellaneous 
tab. 

You can search for a resource on any single or combination of fields. Perform the 
following steps to find one or more resource summaries.

Prerequisites
A Resource has been created or imported.

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Maintain Resources > Resources.

2. Choose one or more parameters upon which to search. 

3. Click Find.

The Resource Search Results window opens with a list of resources that met 
your criteria.

4. Select your resource and Click Resource Details.

The Resource window opens. From here, you can select the appropriate tab to 
add more details for the selected resource.

5. Save your work.

Guidelines
For complete instructions, refer to “Setting Up Telephony Parameters” in 
Implementing Oracle Telephony Manager. 

5.6 Synchronizing End Dates for Partner and Employee Resources
This section provides instructions for synchronizing the end date of an imported 
partnership or employee resource in Resource Manager with the original 
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partnership or employee resource in the application from which it was imported. 
The synchronization process also enables you to augment the end date with a unit 
of time specified in the appropriate profile option. This provides additional time to 
process the termination of the partnership or employee resource instead of doing so 
on the end date.

Prerequisites
A partner or employee relationship must be created in an environment such as OSO 
and imported by Resource Manager. The partner or employee relationship must 
subsequently be end dated in the application from which it was imported, either by 
specifying an end date or by making the partner relationship resource inactive. 

Responsibility
CRM Administrator

Resource Self Service Administrator

Navigation
Log in to the Forms interface and access the navigator. 

Steps
1. Navigate to Resource Manager>Others>Profile and select the "Resource active 

days after termination of relationship" profile option.

2. Specify the number of days after the end date that you want to terminate the 
partner or employee relationship, and save your work.

3. Navigate to Resource Manager>Others>Requests>Run and select the option 
for running a single request.

4. Locate and run the appropriate concurrent program:

� For partnership resources run the "Synchronize Parties and Partners" 
concurrent program. 

� For employee resources, run the "Synchronize Employees" concurrent 
program.

5. Check the partner or employee relationship resource to ensure that the end date 
has been synchronized according.

See Also
� Importing Individual Resources
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� Mass Importing Resources from other e-Business Applications

� Setting Profile Options

� Running Concurrent Programs

5.7 Creating Groups in Forms
In this Forms-based procedure, an individual or group resource can belong to more 
than one group. Either search for an existing group or create a new group; then 
define the group’s members, roles, usages, and relations. Perform the following 
steps to define a resource group.

Prerequisites
None

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Maintain Resources > Groups.

2. (Optional) To find an existing resource group, use this procedure.

a. On the application tool bar, click View > Find.

b. In the Find Group window, select a group name from the list of values 
(LOV) in the Group Name field and click Find.

The application populates the Results region with the group name search 
results.

c. Select a group name in the Results table and click OK.

Note: To view a group in HTML that was created in Forms, you 
must specify a member role.
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The application populates the Define Groups window with the group 
information.

3. To create a new resource group, then use this procedure.

a. Enter a group name in the Name field.

b. Enter a brief description of the group in the Description field.

c. Enter the effective dates for the team in the Start and End fields.

4. (Optional) Select the Exclusive Flag check box to assign resources to this group 
with a particular member role and usage that is not assigned to any other 
exclusive group with the same member role and usage, in the same time frame.

5. In the Members tab, select a resource category and member number from the 
LOV in the Category and Number fields.

The application populates the Name field with the member’s name and 
affiliated organization.

6. (Optional) Select a member name and click one of the available buttons.

For a detailed description of the group member button options, see the 
Resource Group Member Buttons table in the Guidelines section.

7. In the Roles tab, select a role type and role name from the LOV in the Role Type 
and Role fields.

The roles relationship to its category is indicated by the role attributes check 
box selections.

8. In the Usages tab, select one or more usage descriptions from the LOV in the 
Usage field.

9. Choose File > Save.

10. Select either the Parent Group or Child Group tab depending on the relation 
type.

11. Select a group number from the LOV in the Group Number field of the selected 
tab.

The application populates the Group Name field of the Parent Group or Child 
Group tab.

12. Select effective dates for the relation from the LOV in the Start and End Date 
fields.

13. Choose File > Save to save the group definition.
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The new group is accessible from the Group tab in the Resource window.

Guidelines
The following table describes the Resource Group member buttons.

The following table describes the Define Group tabs.

5.8 Creating Groups in HTML
A group is based on the similar functionality or roles of its members. It can consist 
of individual resources and resource groups.

Note: If the reporting hierarchy needs to be changed, it is better to 
delete a group member role rather than end dating it.

Table 5–1 Resource Group Member Buttons

Button Action

Member 
Details

Opens the main Resource window and record of the member

Move Member Opens the Move Member window, where you can assign the 
member to another group

Member Roles Opens the Member Roles window, where you can define the 
member role type, name, and effective dates

Table 5–2 Define Group Tab Descriptions

Tab Description

Members Use this tab to define the member category and member 
number of the group.You can also view a members details, 
assign the member to another group, and view a members role 
type in this tab.

Roles Use this tab to define roles and role types for the group.

Usages Use this tab to determine what CRM modules use the group.

Parent Group Use this tab to define a group as a parent group. 

Child Group Use this tab to define a group as a child group. 
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Example
Vision Motor Corporation has several sales groups for different models. Linda, as a 
sales manager, leads the Vision Model A Sales Group. She has three sales 
representatives, John, Mark, and Carol, directly working for her. This Vision Model 
A Sales Group can also consist of another resource group, Key Accounts West 
Group, to handle sales in the west region for model A. A resource can belong to 
multiple groups. For example, as a sales manager for model A, Linda may belong to 
another sales group to provide model A information. 

You can then create a new resource group, identify parent group name and group 
usage, as well as assign group member information. Perform the following steps in 
HTML to create an Group resource.

Prerequisites
The JTFRS: Group Update Access profile must be set to "None."

Responsibility
Resource Self Service Administrator

Navigation
Navigate to the People tab.

Note:

� If the row contains a Remove check box, you can select the 
check box and update the window to delete the record. If the 
row contains a Remove icon, click it to clear the row.

� You should not modify an HTML Calendar in the Resource 
Manager or add either Calendar Group usages (PUBLIC 
CALENDAR or HTML GROUP CALENDAR) to a new or 
existing Resource Manager Group. 

� Only one parent record can be specified for a specific period of 
time. However, several child records can be active at once.

� Group role functionality is defined in the Forms version only. 
The group role is particularly useful when a group is assigned 
to a team.
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Steps
1. Select the Groups sub-tab.

2. In the Group window, click Create.

3. In the Create Groups window, enter the Group name.

4. Enter a description for the group.

5. Enter an email address for the group.

No validation is made to determine if the email address is correct or even exists.

6. Enter the start (which defaults to the current date) and the end dates in the 
specified field or click the Date Picker icon to select a date. The date format 
must be in the following format: 28-Jul-2001.

7. Use the drop-down list to select the group usage.

8. Define the group membership information.

a. Use the drop-down list to select a resource category. Options include: 
Employee, Other, Partner, Party, Supplier Contact, and To Be Hired.

b. Enter at least three characters or enter "%%%" to search all resources.

c. In the Select a Resource window, click the resource to populate the field.

d. Use the drop-down list to select a Role Type.

e. Enter at least three characters or enter "%%%" to search all roles.

The Select a Role window opens. The roles that appear in the window 
correspond with the role type you selected. Check marks in the table cells 
define role responsibility. If you select a role with the role type of Admin or 
manager, the resource can edit their group hierarchy as well as the group 
structure of the child groups of the parent group that they are a member.

f. Click the role to populate the field.

g. Enter the start (which defaults to the current date) and the end dates in the 
specified field or click the Date Picker icon to select a date. The date format 
must be in the following format: 28-Jul-2001.

9. Click Create.

The Group Detail window opens with the new group information.
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5.9 Defining Dynamic Groups
Use the Dynamic Groups window to define a group based on your criteria by using 
a SQL statement in the SQL Statement field. You cannot assign members to a 
dynamic group, nor can they be hierarchical.

After entering group name and usage information, you can then enter SQL 
statements in the SQL Statement field. Click the Check Syntax button to check your 
code for syntax errors before saving your work. This action creates a dynamic 
group, but not an actual group which you would find in the list of values. 

A dynamic group is not a substitute for creating or updating a resource group and 
you can have both: a dynamic and a resource group which are named the same and 
may have the same members. 

Example
Interaction Center's Telephony Manager uses Dynamic Groups for skill-based 
routing. In active mode, Oracle Telephony Manager routes calls according to 
defined rules. The active mode is the default mode of operation. In active mode, 
Oracle Telephony Manager uses skill-based routing, a dynamic call routing 
intelligence that delivers inbound calls to an agent who is appropriately skilled to 
meet the needs of the caller. When inbound calls arrive at the switch, the switch 
issues a routing request. Oracle Telephony Manager monitors the routing request, 
then applies skill-based routing rules, and identifies suitably skilled agents. 
Meanwhile, a representation of the call waits in the virtual queue within Oracle 
Telephony Manager. When a suitable agent becomes available, Oracle Telephony 
Manager responds to the routing request and instructs the switch to deliver the call 
to the agent’s extension through the Universal Work Queue, where more specific 
pre-defined rules may apply in directing the call. In a dynamic group, the database 
automatically updates information about individual group members. 

The following code example shows how a dynamic group is created and the type of 
information returned, which is the dynamic routing executes the 
workflow/procedure to get an agent list.

          Select Resource_ID from 
          JTF_IH_INTERACTIONS 
          where Party_ID=:CUSTOMER_ID 
          order by Last_update_date desc
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Perform the following steps to define a dynamic group.

Prerequisites
Resource Manager must be configured with Call Center usage. 

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Maintain Resources > Dynamic Groups.

2. In the Dynamic Groups window, enter a group name in the Name field. 

3. Select a group usage from the Usage field.

4. Select the effective dates for the group from the list of values (LOV) in the Start 
and End fields.

5. Enter a brief description of the group name and usage in the Description field.

6. Enter the SQL statement to define a group.

7. Click Check Syntax to check the code for syntax errors.

8. Choose File > Save to save the group.

The new group name registers in the Group Name field in Resource Manager.

5.10 Viewing Group Hierarchy
Use the group hierarchy feature in Forms to view both the subordinates and a direct 
manager for a specific resource. For example, you can view only those resources 
that report directly, or you can view all resources that report to a particular person. 

Note: Interaction Center is the only application that should use 
Dynamic Groups. 
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This feature does not identify who the manager is and who the subordinates are for 
the resource. You can restrict your view by resource category. Perform the following 
steps to view the hierarchy of a group.

Prerequisites
None

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Maintain Resources > Group Hierarchy.

2. In the Group Hierarchy window, select a resource from the list of values (LOV) 
in the Name field and click View to view the groups of a particular resource 
member.

The application populates the Groups region with the member’s groups and 
effective enrollment dates.

3. Select a resource category from the Category LOV and click View to view the 
groups and members of a resource category.

The application populates the Groups and Members regions with the group and 
member names and effective enrollment dates.

4. Select All from the Category LOV and click View if you want to view all the 
resource groups and members in the database.

The application populates the Groups and Members regions with all the groups 
and their members and their effective enrollment dates.

Guidelines
Selecting Reports Directly from the LOV in the View By field searches the database 
for members that report directly to a specific resource.
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5.11 Viewing Role Details
The Role Details window provides information on a selected role such as the code, 
name, type, description, and the selected attributes.

Attributes aid in grouping different roles together when defining a resource 
reporting hierarchy. This hierarchy is used in sales product families, such as Sales 
Online and Telesales, to control the data access privilege (customer, sales lead, and 
sales opportunity) as well as sales forecast rollup and incentive compensation plan. 
It is also used for workflow notifications and escalations. You can have more than 
one attribute such as Admin and Manager as each has different functions. However, 
you would not select Lead and Manager, for example, because Lead is a subset of 
Manager. Perform the following steps to view a role’s details.

Prerequisites
A role must exist before it can be viewed.

Responsibility
Resource Self Service Administrator

Navigation
Navigate to the People tab in HTML.

Steps
1. Select the Roles subtab.

2. Narrow your search criteria by entering values in either the Role Code, Role 
Name, or Role Type fields. You can search all fields, or just one. You can also 
use wildcards to aid your search.

3. Click Search.

The Role Summary window opens with a list of role types based on your search 
criteria.

4. Click the hyperlink of your preferred role.

The Role Detail window opens.

5.12 Assigning Roles to Resources
 Perform the following steps, in HTML, to attach a Role to a resource.
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Prerequisites
Make sure that a Role Type exists with which you can associate the new Role.

Responsibility
Resource Self Service Administrator

Navigation
Navigate to the People tab in HTML.

Steps
1. Select the resource under the Preferred Name column. (If you are assigning a 

role to an individual other than yourself, you can use the Quick Find or 
Advanced Search feature to locate the resource.)

2. Scroll to the bottom of the window to view the Resource Role section and 
perform the following:

a. Select the Role Type from the drop-down menu.

b. Select the Role from the drop-down menu.

c. The Start Date defaults to the current date and you can leave the End Date 
blank.

3. Click Update to save your work.

5.13 Assigning Resources to Groups
Perform the following to assign a resource to a group.

Prerequisites
None

Responsibility
Resource Self Service Administrator

Navigation
Navigate to the People tab in HTML.
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Steps
1. Select the resource under the Preferred Name column. (If you are assigning a 

role or group membership to an individual other than yourself, you can use the 
Quick Find or Advanced Search feature to locate the resource.)

2. Scroll to the bottom of the window that contains a Group Membership section 
and perform the following:

a. Select the Group from the drop-down menu.

a. Select the Role Type from the drop-down menu.

b. Select the Role from the drop-down menu.

c. The Start Date defaults to the current date and you can leave the End Date 
blank.

3. Click Update to save your work.

5.14 Defining Teams
You can only create a team in Forms. Perform the following steps to define a team.

Prerequisites
You must define a resource group.

Responsibility
� CRM Administrator or

� CRM Resource Manager

Navigation
Navigate to the Navigator - CRM (or CRM Resource Manager) Administrator 
window.

Steps
1. Select Resource Manager > Maintain Resources > Teams.

2. (Optional) Use the following procedure to find an existing resource team.

a. On the application tool bar, click View > Find.

b. In the Find Team window, select a team name from the list of values (LOV) 
in the Name field and click Find.
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The application populates the Results region with the team name search 
results.

c. Select a team name in the Results table and click OK.

The application populates the Define Teams window with the group 
information.

3. Enter a team name in the Name field.

4. (Optional) Select the Exclusive Flag check box to assign resources to this team 
with a particular member role and team usage that is not assigned to any other 
exclusive team with the same role and usage, in the same time frame.

5. Enter a brief description of the team in the Description field.

6. Enter the effective dates for the team in the Start and End fields.

7. In the Members tab, select a category and member from the LOV in Category, 
and Number fields. For a detailed description of the group member button 
options, see the Resource Group Member Buttons table in the Guidelines 
section.

The application populates the Name field with the member’s name.

8. (Optional) Click Member Roles to assign team member roles to a team.

9. (Optional) Select a member name and click Member Details to view specific 
member information.

10. In the Roles tab, select from the LOV in the Role Type and Role fields.

The roles relationship to its category is indicated by the role attributes check 
box selections.

11. In the Usages tab, select from the LOV in the Name field.

12. Choose File > Save to save the team definition.

The new team is accessible from the Team tab in the Resource window.

Guidelines
The following table gives a description of the tabs located in the Define Team 
window.
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5.15 Running a Group Audit Report
Use Resource Manager to run audit reports detailing changes to resources and 
resource groups created within a defined date. For example, any changes made to 
new members of a group are defined, but role change information is not. This 
provides an audit trail of the actions taken for specific groups and resources. 
Perform the following steps to run an Audit Report.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to the Navigator - CRM Administrator window.

Steps
1. Select Resource Manager > Others > Requests > Run.

2. Select Single Request and click OK.

3. Use the Name list of values (LOV) to select a report.

4. In the Reports window, select Group Audit Report from the list of reports and 
click OK.

5. Enter parameters for the report. 

Table 5–3 Define Team Tab Descriptions

Tab Description

Members Use this tab to define members of a team.

Roles Use this tab to define the team roles and role types. 

Usages Use this tab to determine what CRM modules use the team.

Note: Only the movement of a resource from a given group to 
another group is tracked. Resources changing roles within the same 
group are not reported in the Audit Report.
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In order for an Audit Report to run successfully, it is necessary to define both 
Report Based On and Date Range/No. of Days for the report. The report runs 
based on the information you enter for the following criteria.

� Report Based On

� Group

� Resource

� Updated By

� Date Range/No. of Days

� Start Date

� End Date

� Number of Days for

6. (Optional) Change the time frame the report is suppose to run by clicking 
Schedule.

7. Select the time frame when you want the report to run:

� As soon as possible

� Once

� Periodically

� On specific days

8. Click OK.

9. (Optional) Click Options to determine who should be notified when the report 
is complete and where you want to print the output to.

10. Click Submit.

11. A dialog opens confirming your request was submitted.

5.16 Viewing an Audit Report
You can monitor the status of an audit report to verify completion. Perform the 
following steps to view an Audit report.

Prerequisites
A Group Audit Report must run successfully.
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Responsibility
CRM Administrator

Navigation
Navigate to the Navigator - CRM Administrator window.

Steps
1. Select Requests > Run > View.

2. In the Find Requests window, select the All My Requests option button and 
click Find.

3. In the Requests window, select a Group Audit Report to view.

4. Click View Log to display the results of the report. 

The report details opens in an HTML window along with a log file for the 
report.

5.17 Running a Group Structure Report
Use Resource Manager to run a Group Structure report detailing any changes made 
to a specific Parent or Child relationship of a resource group. The report details a 
reliable audit trail of the actions taken for a specific group. Group name changes, or 
any resource changes within the same group, are not detailed in this report. Perform 
the following steps to run a Group Structure report.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to the Navigator - CRM Administrator window.

Steps
1. Select Resource Manager > Others > Requests > Run.

2. Select Single Request and click OK.
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3. Use the Name list of values (LOV) to select a report.

4. In the Reports window, select Group Structure Report from the list of reports 
and click OK.

5. Select the group you want to run the report on from the list of values (LOV) and 
click OK.

6. (Optional) Change the time frame the report runs by clicking Schedule.

The Schedule window opens.

7. Select the time frame when you want the report to run:

� As soon as possible

� Once

� Periodically

� On specific days

8. Click OK.

9. (Optional) Click Options to determine who should be notified when the report 
is complete and where you want to print the output.

10. Click Submit.

5.18 Viewing a Group Structure Report
You can monitor the status of an audit report to verify completion. Perform the 
following steps to view your Group Structure report.

Prerequisites
You must first run a Group Structure Report successfully.

Responsibility
CRM Administrator

Navigation
Navigate to the Navigator - CRM Administrator window.

Steps
1. Select Requests > Run > View.
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2. Select the All My Requests option button.

3. Click Find.

4. In the Requests window, select the Group Structure Report.

5. Click View Log to display the results of the report. 

The report details opens in an HTML window along with a log file for the 
report.

5.19 Running Resource Skills Report
This report displays the skills a resource has listed using the HTML-based Resource 
Manager. You can run a Skills Report either by resource or group. If you choose to 
run a Skills Report by resource, then any direct reports under the resource will be 
included in the report. If you choose to run a Skills Report by group, then the entire 
group’s skill set will be displayed.

Prerequisites
Your resources must have:

a. Skills listed using the HTML-based Resource Manager

b. Have a manager listed if you are running a report based on resource.

Responsibility
CRM Administrator

Navigation
Navigate to the CRM Administrator window.

Steps
1. Select Resource Manager > Others > Requests > Run.

2. Select Single Request and click OK.

3. Use the Name list of values (LOV) to select the Resource Skills Report and click 
OK.

4. Use the LOV in the Report Type field to select either Resource or Group and 
click OK.
Phase II: Managing Resources 5-27



Viewing Resource Skills Report
5. Depending on your choice, use the LOV in the corresponding Resource or 
Group field to find your selection.

6. (Optional) If you do not want the report to run as soon as possible, click 
Schedule to change the time frame when you want the report to run.

7. (Optional) Click Options to determine who should be notified when the report 
is complete and where you want to print the output.

8. Click Submit.

5.20 Viewing Resource Skills Report
You can monitor the status of an audit report to see when it has been successfully 
completed. Perform the following steps to view your Resource Skills report.

Prerequisites
You must first run the Resource Skills Report successfully.

Responsibility
CRM Administrator

Navigation
Navigate to the CRM Administrator window.

Steps
1. Select Requests > Run > View.

2. Select the All My Requests option button.

3. Click Find.

4. Select your Group Structure Report and click View Log. 
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6

Troubleshooting Resource Manager

This section covers the following topics:

� Common Implementation Errors

� Error Messages

� Frequently Asked Questions (FAQs)

6.1 Common Implementation Errors

This section contains information on some of the common implementation errors 
associated with implementing Resource Manager.

6.1.1 Unable to Import a Resource
Action: Perform the following procedures:

1. Run the concurrent program "Resource Manager Diagnostics" available under 
CRM Administrator Responsibility. If it is not available, then perform the 
following:

a. Log on using the System Administrator responsibility.

Note: The Oracle CRM Diagnostic Tool is useful in pinpointing 
problems with the setup and configuration of the many CRM 
modules. It is available through the CRM System Administration 
Console.

This section is by no means exhaustive and should be referenced 
with each release.
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b. In the "Executable" option, under "Concurrent Program", query for 
"Resource Manager Diagnostics."

c. Enable it by checking the checkbox. 

2. After the concurrent program completes, view the log file generated by pressing 
the "View Log" button. See if any errors are reported. 

3. Correct any errors as reported in the concurrent program log. Then, import 
again. 

6.1.2 Unable to Import a Resource From Human Resources
Cause: Form JTFRSSEC does not compile after applying the latest patch. 

Action: Compile the Form based on following steps. 

cd $AU_TOP/forms/us 
f60gen module=JTFRSSEC.fmb userid=apps/apps 
mv JTFRSSEC.fmx $JTF_TOP/forms/US 
cd $AU_TOP/resource/US 
f60gen module=JTFRSSEC.pll userid=apps/apps module_type=library 
chmod 755 JTFRSSEC.plx 

6.1.3 Unable to Save a Resource 
Action: Performing the following checks:

1. In SQL*Plus, connecting as apps/apps, enter the following:

SQL> desc xmlgen

If this returns the statement that object xmlgen does not exist, then ensure that "apps" 
has execute privilege on "xmlgen." 

2. In SQL*Plus, connecting as apps/apps, enter the following:

SQL> select status from all_objects where object_name = 'JTF_USR_HKS';

If this returns a status of ’INVALID,’ then alter package JTF_USR_HKS and compile 
the body. Repeat this check until the status becomes 'VALID.’

3. In SQL*Plus, connecting as apps/apps, enter the following:

SQL> select status from all_objects where object_name = 'JTF_RESOURCE_UTL';

If this returns a status of ’INVALID,’ then create this view in the apps schema 
and compile the JTF_RESOURCE_UTL package body. 

Create or replace view IEM_EMAIL_ACCOUNTS_V as:
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SQL> select b.server_group_id interaction_center_id, 
            a.account_name config_name, 
            to_char(a.email_account_id) value_type
     from iem.iem_email_accounts a, iem.iem_email_icntr_maps b 
     where a.email_account_id=b.email_account_id;

6.1.4 Unable to See Resource Name
Cause: This problem can occur in the CRM or Common Application Components 
modules, the LOVs, and in other similar items.

Action: In SQL*Plus, connecting as apps/apps, enter the following:

SQL> select count(*) from jtf_rs_resource_extns where source_name is null; 

If count(*) is non-zero then run the concurrent program "Synchronize Employees" 
using the CRM Administrator responsibility. 

6.1.5 Cannot Invoke Salesperson Form from AR Menu
Cause: This problem occurs when invoking the Salesperson form from the Accounts 
Receivables menu. It occurs under the following circumstances:

(Navigation path: Setup > Transactions > Salesperson)

� Double click from the navigator menu and a small blue window with a red 
bar(row) is received with no legible fields or label markings. 

� Press the Tab or Enter key and a calendar window appears also with no legible 
fields/label markings. 

In either case, the user is unable to close the form or application unless the File > 
Close or Exit toolbar menu option is used.

Action: apply patch 1799597. Read the README mentioned in the patch. 

6.1.6 Accounting Flexfield LOV Display Parent Values 
Action: Perform the following steps to define the accounting flexfield: 

1. Navigate to the General Ledger module: GL > Setup > Financials > Flexfields 
> Key > Values.

In Find form, check for find values by Key flexfield. In the Title Field, choose 
from the list of values "accounting flexfield" and click Find. There is an 
extensive list of values. To the right, there is a box called "Effective" title. Check 
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for it’s other title "Hierarchy, Qualifiers." A parent check box is checked for 
some of the values and not checked for others.

2. You can add values and check them as parent but this is not necessary, you can 
simply write down a few values that are checked as parents. (For example, the 
first value 1000- Total asset is checked as one.)

3. Navigate to Accounts Receivables: Setup > Transactions > Autoinvoice > 
Salespersons.

Receivables uses the general ledger accounts that you enter there in 
combination with your AutoAccounting rules to determine the default revenue, 
freight, and receivable accounts for your invoices.

4. Create a new salesperson. Enter a name and a sales credit type from the list. In 
the next three fields enter the Accounting Flexfield for your Revenue, Freight, 
and Receivables Accounts.

If you open the list and see account aliases, click OK. A form in which you can 
enter a department value and an account value appears.

In the account values list, verify the parent values observed in step 2. (For 
example, the first value might be 1000- Total asset.)

5. You can choose this value and save the transaction.

It must be emphasized again that the parent values should not appear in the list and 
you should not be able to select them. These are only summary accounts and not 
accounts you can use for regular processes, which means you cannot enter amounts 
to accounts which are checked as parents.

6.1.7 List of Values (LOV) Are Not Populated in the Hold Reasons Field
Cause: Incentive Compensation uses Resource Manager to set up sales 
representatives and sales compensation group hierarchies. If the Hold Reason field 
is not populated in the Compensation tab, then create a lookup type. 

Action: Perform the following steps:

1. Navigate to the Application Object Library Lookups window.

2. Enter in the type field: "JTF_RS_HOLD_REASON_TYPE"

3. In the User Name field, enter the same value again.

4. In the Application field, select CRM Foundation from the LOV. 

5. In the Access Level radio group, select User. 
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6. In the detail block, enter suitable values for Code, Meaning, and Description 
fields. 

Note that what you enter in the Meaning field is what the LOV for Hold Reason 
field in the Define Resource form will display. 

6.1.8 List of Values (LOV) Are Not Populated in the Support Site Fields
Cause: Support site information, which displays in Assignment Manager, is actually 
attached to a resource in Resource Manager. You can attach the information from an 
LOV in either the HTML or Forms-based module. The List of values are populated 
from several sources including Teleservice with the Customer Support 
responsibility. 

Action: Add support sites based on previously defined addresses. The city of the 
address will populate the LOVs. Perform the following: 

1. Navigate to the Navigator > Customer Support window.

2. Select Customer Management > Contact Center.

3. In the Caller Type field, select either Organization or Person.

4. In the Organization field, select your organization.

5. Select the Address tab.

6. In the Status column, select Active.

7. In the Address1 column, select the appropriate address from the LOV.

The City field automatically populates.

8. In the Usage field, select Support Site.

9. Select Active in the Usage Status field.

10. Save your work.

6.1.9 JTF-Post Vertical User Hook
Cause: This error occurs when attaching a role type of Sales Compensation to a 
resource. 

Action: First determine whether or not the resource has been saved. If the result is:

� No, then save the resource, then try again. 
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� Yes, then assign a different role type such as Service, or, Sales and Telesales to 
the resource, and confirm whether or not you are able to save. If you are able to 
assign a role other than Sales Compensation to a "saved" resource, but, are 
unable to assign the Sales Compensation role, then log a bug against Oracle 
Sales Compensation application. 

6.1.10 Same Resource Showing Twice in Define Resource Form
Cause: In this case, both resources have the same transaction number, but one 
record displays the salesperson number, and the other does not. 

To verify this problem, perform the following steps:

1. In the Define Resource form, note the resource number for both the records. 

2. If the resource number is the same (for example, 10015), then run the following 
query: 

SQL> select res.resource_id,sr.salesrep_id,sr.org_id 
     from jtf_rs_resource_extns res,jtf_rs_salesreps sr 
     where res.resource_id = sr.resource_id 
     and res.resource_number = 10015; 

3. If the output of this query results in two or more records with the same 
resource_id, and the same org_id, but, different salesrep_id then it is bad data. 
For example, the sample output following would be considered bad data; 

RESOURCE_ID       SALESREP_ID          ORG_ID 
----------------- -----------------    ---------- 
100000016         100000019            2 
100000016         100000054            2 

This type of data can never be created using the Define Resource form, or any of 
the Resource Manager public APIs. 

Action: To clean up the data, perform the following steps:

1. There are two records, one, for example, with a salesrep number non NULL 
value and other with a NULL value. Identify which is the one you want to 
remove. To Identify the IDs, run the following statement:

SQL> select res.resource_id,sr.salesrep_id,sr.org_id,
         sr.salesrep_number 
     from jtf_rs_resource_extns res,jtf_rs_salesreps sr 
     where res.resource_id = sr.resource_id 
     and res.resource_number = 10015; 
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This will return two records. Note down the resource_id, salesrep_id, and the 
org_id of the record which you want to delete. 

2. Run the following delete statement. Assuming, you decided to delete record 
with salesrep_id 100000019, org_id 2, it would look like:

SQL> delete from jtf_rs_salesreps 
     where salesrep_id = 100000019 
     and org_id = 2 
     and resource_id = 100000016; 

This should cleanup all bad data. 

6.1.11 JTF_RS_TERR_EDDT_GRTR_SRP_EDDT
Cause: This is a data problem. This error occurs when the territory Start and End 
dates are out of range with salesperson dates.

Action: Perform the following steps: 

1. Find out the maximum Start_date_active value and minimum End_date_active 
value for a salesrep_id across all org_id from JTF_RS_SALESREPS table. (Be 
aware that the end_date_active value can be NULL.)

2. For the salesrep_id in step 1, find the Start_date_active and End_Date_active 
from RA_SALESREP_TERRITORIES table. (Be aware that the Start_date_active 
and end_date_active values can be NULL.) You may get multiple records. 

3. For every record in step 2, verify whether or not the dates fall within the dates 
in Step 1. 

� If yes, then no further action required.

� If no, then: 

a. Update the Start_date_active, End Date_active in RA_SALESREP_
TERRITORIES Table with the Dates from Step1. 

WARNING: You are actually deleting physical records from the 
database. This has the RISK of leaving behind dangling foreign 
keys in other tables in other applications. Confirm the check for 
FOREIGN KEYS before deleting records as suggested above. 
Otherwise, you may end up corrupting your database. 

Contact Oracle Support in case of any doubt.
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b. Repeat Steps 1 through 4 for all the salesrep_id in JTF_RS_SALESREPS 
table. 

6.1.12 Invalid User Error
Invalid User- Resource link, Contact Your System Administrator

This problem has been observed in the Service Request form, however, it could 
occur in other places too. While creating or updating a Service Request in the 
"Owner" field, it is possible to pick a resource from the LOV, and get the "Invalid 
User - Resource link" error.

Cause: This problem occurs if the currently logged in user (as defined in FND_
USER), is not mapped to a proper resource who you are trying to update the SR 
with. 

Action: Ensure that the user ID of the resource that you select in the LOV matches 
with the one that the user is currently logged in as. This restriction is due to the fact 
that in trying to create interactions, there is a validation that the user must be a 
resource.

6.1.13 Product Name Displays Improperly
When selecting a product, the product appears as "X" instead of displaying the 
product name.

Cause: When setting up Inventory, the item flexfield segment was not compiled.

Action: Compile the item flexfield segment by performing the following:

1. Log in to the Forms interface with System Administrator responsibility.

2. Select Flexfield>Key>Segments.

3. Run a query for Application "Oracle Inventory" and Flexfield Title "System 
Items" by performing the following:

a. Select View>Query by Example>Enter. 

b. In the newly hilighted Application and Flexfield Title fields enter "Oracle 
Inventory" and System Items".

c. Select View>Query by Example>Run. 

4. In the Structures menu, select "SYSTEM_ITEMS" and click the Compile button.
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6.1.14 Performance Issue When Selecting the Resource Details Button
Cause: When selecting the Resource Details button, forms do not display for up to 
thirty minutes.

Action: A fix for this problem is available in a patch release. Details about this patch 
and its availability are found on the metalink Web site. As an interim solution, you 
can run the Synchronize Employees concurrent program and set the Get New 
Employees parameter to "Yes".

6.1.15 Synchronize Employee Concurrent Program Does not End Date Resources
Cause: End date for terminated resources does not display properly when running 
the Synchronize Employees Concurrent program.

Action: A fix for this problem is available in a patch release. Details about this patch 
and its availability are found on the metalink Web site. When running the 
Synchronize Employees concurrent program, you must run the concurrent program 
when the employee is no longer active. For example, if the employee is today and 
inactive starting tomorrow, you must run the concurrent program tomorrow, to end 
date the resource in Resource Manager. If the Employee is end dated in HR with a 
previous date, then run the concurrent program today, resource will be end dated 
with sysdate-1.

6.2 Error Messages
This section contains information on some of the error messages associated with 
implementing Resource Manager. 

6.2.1 APP-FND-00668
Routine FDFBKS found no row in FND_ID_FLEX_SEGMENT. 

Cause: This is a flexfield issue. 

Action: 

1. Define the Territory Flex field. 

2. Recompile. 
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6.2.2 APP-FND-01934: ORA-01400
Cannot insert NULL into ("CN"."CN_ROLE_QUOTA_CATES"."ROLE_MODEL_
ID") in Package CN_ROLE_QUOTA_CATE_PVT

Cause: This error can occur when trying to save a new role.

Procedure Create_Role_Quota_Cate 

Action:

1. Verify whether or not CN_ROLE_QUOTA_CATE_PVT is valid in the database. 

2. Select status, owner, object_type from dba_objects where object_name='CN_
ROLE_QUOTA_CATE_PVT '; 

3. If invalid, compile it and try again. 

4. If valid then, make ROLE_MODEL_ID column null in the following tables:

� CN_ROLE_QUOTA_CATES

� CN_SRP_QUOTA_CATES_ALL

� CN_SRP_ROLE_DTLS_ALL 

5. Recompile and re-run.

6.2.3 APP-PER-50022
 APP-PER-50022: Oracle HR could not retrieve a value for the User Type profile 
option. 

Cause: This error occurs when pressing the "View" Button in Define Resource Form.

Action: Verify that it is set properly for your responsibility. Ensure that the current 
resource is of type "Employee." Update the profile "HR: User Type" at the 
application level by selecting a valid value from the LOV. If you select "HR User", 
then verify that the user currently logged in has the "US HRMS Manager" 
responsibility. 

Note: If this error continues, refer to the OIC (Oracle Incentive 
Compensation) Implementation documentation for additional 
troubleshooting under the topic: Assign Resources to Roles and 
Groups.
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6.2.4 APP-PER-500022
Cause: This error can occur when trying to access employee information:

APP-PER-500022 Oracle Human Resources could not retrieve a value for the user 
type profile option. 

Action: Ensure that the profile option HR: User Type is set correctly for your 
responsibility. This occurs when there is a shared installation of HR, and the value 
for profile option HR:User Type in corresponding responsibility level is not 
properly set. 

Set up profile option HR: User Type to HR user in responsibility level. If the profile 
option cannot be updated in responsibility level, then update it in the responsibility 
level from application developer responsibility. 

6.2.5 HTTP 404
Cause: This error occurs while trying to log in to an HTML application. It is an 
environment issue. Perform the following steps to correct the problem.

Action: 

1. Close Netscape. 

2. Remove fat.db, netscape.hst, and cookies.txt. 

3. Clear disk cache and memory cache. 

4. Log in again. 

6.2.6 ORA-01422
Cause: This error can also occur when invoking the Accounts Receivables forms.

� FRM-40735: PRE-FORM Trigger Raised Unhandled Exception ORA-01422

� ORA-01422: Exact fetch returns more than requested number of rows.

Action: Perform the following procedures:

1. In SQL*Plus, connecting as apps/apps, enter the following:

SQL> set pages 999 
SQL> set long 9999 
SQL> select text from dba_views where view_name = 'RA_SALESREPS'; 

Check to see if the results of the FROM clause in the view definition list any of 
the following tables or views:
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� RA_SALESREPS_ALL RA

� AS_SALESFORCE ASF

� RA_CUSTOMERS RACUS

� PER_PEOPLE_X HR

� AS_LOOKUPS ASL 

If so, then log a bug against Accounts Receivable.

2. In SQL*Plus, connecting as apps/apps, enter the following:

SQL> select table_name 
     from all_synonyms 
     where synonym_name ='RA_SALESREPS_ALL' and owner = 'APPS'; 

� If the result of this query returns RA_SALESREPS_ALL, then Salesperson 
migration has not happened. If you do want the migration to happen, then 
apply the following patches: 

– 1638958

– 1757827

or else, log a bug against Accounts Receivable.

� If the result of this query returns JTF_RS_SALESREPS, then the salesperson 
migration has occurred. In this case, run the following in SQL*Plus 
connected as apps/apps: 

SQL> delete from jtf_rs_salesreps 
     where salesrep_id=-3 and org_id is null; 

If the previous command deletes one record, then perform a COMMIT, 
otherwise, perform a ROLLBACK operation.

WARNING: You are actually deleting physical records from the 
database. This has the RISK of leaving behind dangling foreign 
keys in other tables in other applications. Confirm the check for 
FOREIGN KEYS before deleting records as suggested above. 
Otherwise, you may end up corrupting your database. 

Contact Oracle Support if you have any questions.
6-12 Oracle Common Application Components Implementation Guide



Error Messages
6.2.7 ORA-01422
ORA-01422: Exact fetch returns more than requested numbers of rows. 

Cause: This occurs while adding a group role to a resource in Define Resource 
Form, and indicates that an unexpected error was encountered in INSERT_REP_
MANAGER.

Action: To resolve this, contact your system administrator.

Alternate Cause: This problem can occur when there is more than one snapshot 
view log on JTF_RS_REP_MANAGERS table. 

Alternate Action: To confirm, run the following query in SQL*Plus, connected as 
apps/apps: 

SQL> insert into rep_temp 
       (denorm_mgr_id, 
        resource_id, 
        person_id, category,
        manager_person_id, 
        group_id, 
        hierarchy_type, 
        created_by, 
        creation_date, 
        last_updated_by, 
        last_update_date,  
        last_update_login, 
        reports_to_flag, 
        start_date_active, 
        end_date_active, 
        par_role_relate_id, 
        child_role_relate_id,  
        object_version_number) 
     values 
       (-9, 1, 1, 'employee', null, 1, ’x', -1, sysdate, -1, sysdate,
        -1, 'y', sysdate, null, -1, -1, 1); 

If the result is: 

ORA-01422: Exact fetch returns more than requested numbers of rows,

then more than one snapshot log exists. There should be only one snapshot log on 
the table MLOG$_JTF_RS_REP_MANAGERS. Verify if there are more, and drop 
them. If after ensuring that there is only one snapshots of log MLOG$_JTF_RS_
REP_MANAGERS, and the error still occurs, log a bug against Oracle Sales.
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6.2.8 ORA-20002
Cause: There are several issues that can affect migration of salesperson data. Errors 
can occur when accessing the following Accounts Receivables forms: 

� ARXTWMAI

Transaction Entry: FRM-40735 Pre-form trigger raised unhandled exception 
ORA-20002.

� ARXRWMAI

Receipt Entry: FRM-40735 New form instance trigger raised unhandled 
exception ORA-20002.

� ARXCWMAI

Account Detail: FRM-40735 WHEN-NEW-FORM-INSTANCE trigger raised 
unhandled exception ORA-20002.

Action: To diagnose and resolve, perform the following checks:

1. In SQL*Plus, connecting as apps/apps, enter the following:

SQL> set pages 999 
SQL> set long 9999 
SQL> select text from dba_views where view_name = 'RA_SALESREPS'; 

Check to see if the results of the FROM clause in the view definition list any of 
the following tables or views:

� RA_SALESREPS_ALL RA

� AS_SALESFORCE ASF

� RA_CUSTOMERS RACUS

� PER_PEOPLE_X HR

� AS_LOOKUPS ASL 

If so, then log a bug against Accounts Receivable.

2. In SQL*Plus, connecting as apps/apps, enter the following:

SQL>select table_name 
   from all_synonyms 
   where synonym_name ='RA_SALESREPS_ALL' and owner = 'APPS’;

If the result of this query is RA_SALESREPS_ALL, then the salesperson 
migration has not happened. If you do want the migration to happen, then you 
must apply the following patches: 
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� 1638958

� 1757827

or else, log a bug against Accounts Receivable.

6.2.9 ORA-4062
ORA-4062: Signature of package "APPS.JTF_RS_RESOURCE_PVT" has been 
changed. 

Cause: This is an environment error in which the package body and spec are out of 
sync.

Action: Recompile all JTF forms and libraries. This process will not work if 
directories contain invalid characters.

Problem: Ran the API Jtf_Rs_Role_Relate_Pub.create_resource_role_relate and it 
stops with an error: 

6.2.10 ORA-20000
The API JTF_RS_ROLE_RELATE_PUB.CREATE_RESOURCE_ROLE_RELATE, 
generates the following error message: ORA-20000 buffer overflow.

Cause: This error is caused by the table space being full. 

Action: A future release will contain more specific error message such as the 
following:

ORA 01653: Unable to extend table CN.CN_SRP_QUOTA RULES_ALL by 515 in 
tablespace CND 

6.3 Frequently Asked Questions (FAQs)
The following are frequently asked questions. Answers to these questions may help 
you in troubleshooting problems with the Resource Manager.

6.3.1 Does JTF_RS_REP_MANAGERS Table Denormalize RESOURCE_ID?
Answer: Yes, in the PARENT_RESOURCE_ID column in this table. 
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6.3.2 How Are Role Types Associated to the Applications?
Where do you define the role type? In the Meaning field for defining the Role Type? 
If yes, how is this controlled as the field doesn't contain an LOV and it is a free form 
entry. Also should the customer use one of the defined meanings for the 
application/Role Type association? 

Answer: Navigation steps to define a Role Type: 

With the CRM Administrator responsibility, select Resource Manager > Setup > 
Role Types. 

The content in the "Meaning" field is what is displayed in all LOV for Role Type. 

When you invoke the "Role Types" form, you see a numerous records. Many of 
them are shipped out-of-the-box as seeded values. Customer can add new Role 
Types, or, change the Meaning, Description, or Dates of the seeded ones. But, 
customers cannot delete seeded values. To determine which ones are seeded, and 
which ones are added by the Customer, navigate to each Role Type record, and see 
if the "Delete" option in the tool bar is enabled. It is enabled for new records, not for 
seeded values.

6.3.3 How is the Role Associated to the Application? 
Is this done by the Type (Role Type) on the Roles definition form? 

Answer: Roles are associated one-to-many with a Role Type. Just like Role Type, we 
ship quite a few Roles for each Role Type out-of-the-box. Individual Applications 
use both Role Type and Role. Some applications use it as a filter mechanism, while 
some use it for reporting. 

Example: If you have 100,000 Employee Resources in the system, and you are only 
interested in the subgroup Salespersons, then an application such as Oracle Sales 
and Marketing assigns a Role of type Oracle Sales to the those resources and write 
logic to only display those salespersons in their application LOVs.

There is no association necessarily between Role Type and an Application; except 
that the names of the Role Types appear like Application Names.

6.3.4 Are Resources Org Striped?
How about Salespersons? 

Answer: Resources are NOT org striped, but salespersons are. 
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Example: If you have an Employee Resource R1 who is a Salesrep in multiple orgs 
(lets say org_id 100, 200, 300), then in the Define Resource window, when you query 
the Resource in the context of Org 100, you see the Resource information, and the 
Salesrep information for Org 100. However, if you are in the context of Org 150, 
then only the Resource displays, but none of the Salesrep information such as 
Salesrep Number or Sales Credit Type displays in the header and the Receivables 
tab. 

The same is true with all other types of Resources like Party, Partner, Supplier 
Contact, Other, and To-Be-Hired. 

6.3.5 IS There a One to One Mapping Between an FND_USER and Resource?
Answer: Use the "Define User" window in AOL to assign an Employee, Party, and 
Supplier Contact to the same FND User. 

6.3.6 What Can I Import into Resource Manager?
Answer: Even though its possible to attach an Employee, Party, Supplier, or Contact 
to the SAME FND User, you cannot import all of them into Resource Manager. You 
can only import one: Employee, Party, or Supplier Contact. 

6.3.7 How Do I Send Notifications?
I've attached a Resource Group to a Task. How can I send notifications to all 
members of this group?

Resource Groups are not tied to Workflow groups. So, when a workflow is in setup, 
for example, in Task Manager, to send notification to the Task Owner, how can I 
ensure that if a Resource Group is assigned an owner to the Task, then the 
notification will be sent to all the members of that Resource Group automatically?

Answer:   Examine the example of Task Manager. 

Decide which workflow process to launch by defining a new workflow process 
under the workflow item: JTFTASK (User name for seeded workflow: Workflow for 
Task Manager.) Within the new workflow process, call a workflow (and PL/SQL) 
function in a loop, which retrieves the members of the group and send the 
notification to all the members. 

An example of SQL code to get all the GROUPS and RESOURCES, under one 
GROUP (one hierarchical level): 

SELECT  group_id  group_id,  resource_id  group_resource_id,  'INDIVIDUAL'  
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resource_type 
FROM jtf_rs_group_members UNION 
SELECT rgm.group_id  group_id,  rgr.group_id  group_resource_id,  'GROUP'   
resource_type 
FROM jtf_rs_group_members rgm, jtf_rs_grp_relations rgr 
WHERE rgm.group_id = rgr.related_group_id; 

The query results appear like the following: 

            GROUP_IDGROUP_RESOURCE_IDRESOURCE_TYPE 

                   5                                15                         GROUP 

                   5                                21                         INDIVIDUAL 

                   5                                175                       GROUP 

                   5                                199                       INDIVIDUAL 

                  15                               1                           INDIVIDUAL 

                  15                               5                           GROUP 

                  15                               689                       INDIVIDUAL 

6.3.8 Why Are Party and Partner Treated Differently?
Why are Party, and Partner treated as separate Resource Categories in Resource 
Manager? Should they not be combined into just one category? 

Answer: The parties of party_type 'PARTY_RELATIONSHIP' can be imported as a 
resource of category 'PARTY' or 'PARTNER'. But there are some other party types 
that can be brought in only as category PARTY (for example, PERSON) and those 
that can be brought in only as PARTNER (for example, Organization.) The 
categories need to exist independently rather than being merged. 

Note: The GROUP_RESOURCE_ID stores RESOURCE_ID for 
Resource_type = 'INDIVIDUAL', and Group_ID for Resource_type 
= 'GROUP'). 
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6.3.9 What is the Geo Override and Inside City Limits Fields?
What is the significance of fields "Geo Override", and "Inside City Limits"? How 
should these fields be used in the Define Resource window when defining a 
Salesperson? 

Answer: The Geo Override value associates the salesperson with a unique tax 
jurisdiction. Both fields should normally be used if you have installed a sales tax 
vendor of type Vertex Taxware Sales. Oracle recommends you use Tax System or 
Vertex Quantu. 

If you entered a value in the Geo Override field and the tax jurisdiction for this 
address is within city limits, select the "Inside City Limits" check box. This check 
box should typically be enabled only if your sales tax vendor is Vertex Quantum. 

Geocodes are used by tax engine to identify taxing jurisdiction. A geocode is 
typically needed when the state, zip, and city fields of an address do not uniquely 
identify the exact taxing jurisdiction. For example, same city and zip can be found 
in multiple counties. Inside city limits adds more to that geocodes. For example a 
city has different tax rates for city limit, in this case the city will have two different 
jurisdictions: one inner city and another that is outer city. The tax will be calculated 
accordingly. 

Third party tax engines like vertex and taxware recognize such complicated 
geocode. 

For additional information, see the following: 

� Integrating Oracle Receivables with Taxware Sales/Use Tax System, Release 11i.   

� Integrating Oracle Receivables with Vertex Quantum, Release 11i. 

6.3.10 Where Can I Set Up Sales Credit Types?
In the Define Resource Form, under "Receivables" tab, there is a field labeled 
"Sales Credit Type". Where do values in the LOV for this field come from? 

Answer: They come from Order Management. Navigate to: Order Management > 
Set up > Sales > Credit Types. 

6.3.11 What are the Attributes of an Employee Resource?
What are the attributes of an Employee Resource that are kept in SYNC with HR? 
What is the list of all HR denormalized columns in Resource Manager. 

Answer: 
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SOURCE_ID    (mapped to Person Id in HR) 
MANAGING_EMPLOYEE_ID 
SOURCE_NAME 
SOURCE_NUMBER 
SOURCE_JOB_TITLE 
SOURCE_EMAIL 
SOURCE_PHONE 
SOURCE_ORG_ID 
SOURCE_ORG_NAME 
SOURCE_ADDRESS1 
SOURCE_ADDRESS2 
SOURCE_ADDRESS3 
SOURCE_ADDRESS4 
SOURCE_CITY 
SOURCE_POSTAL_CODE 
SOURCE_STATE 
SOURCE_PROVINCE 
SOURCE_COUNTY 
SOURCE_COUNTRY 
SOURCE_MGR_ID 
SOURCE_MGR_NAME 
SOURCE_BUSINESS_GRP_ID 
SOURCE_BUSINESS_GRP_NAME 
SOURCE_FIRST_NAME 
SOURCE_MIDDLE_NAME 
SOURCE_LAST_NAME 
SOURCE_CATEGORY 
SOURCE_STATUS 
SOURCE_OFFICE 
SOURCE_LOCATION 
SOURCE_MAILSTOP 

6.3.12 What Are the Responsibilities Associated With Resource Manager?
What are the responsibilities associated with Resource Self Service (HTML) 
functionality? What are the Responsibility names for "Super User", and "Regular 
User"? 

Answer: 

� Super User: Resource Self Service Administrator

� Regular User: CRM Application Foundation User
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6.3.13 How Does the Employee Button in the Resource Summary Page Appear?
Answer: If the user is logged in with "Resource Self Service Administrator" 
responsibility, and if the value of the profile "JTFRS: Employee Resource Update 
Access" is set to "ANY," then, the Create button for Employee will appear in the 
Resource Summary page. 

6.3.14 How Does the Create Button in the Groups Summary Page Appear?
Answer: If the user is logged in with "Resource Self Service Administrator" 
responsibility, AND if the value of the profile "JTFRS: Group Update Access is set to 
"ALL" then, the Create button for Groups will appear in the Resource Groups 
Summary page. 

6.3.15 How are Supplier Contact Type Resources Set Up?
Explain the detailed steps in defining a supplier contact resource such that it can 
be imported in Resource Manager. 

Answer: Perform the following steps.

Responsibility: Purchasing, Vision Operations (USA) 

Navigation: Supply Base > Suppliers 

Steps:

1. When the appropriate supplier record has been found, select the 'Supplier' icon 
at the bottom right hand corner. 

2. In the 'Contacts' tab, enter the supplier contact name, telephone number and 
their email address in the Mail Stop field. 

3. Switch responsibility to CRM Administrator.

4. Select Resource Manager > Maintain Resources > Import Resources -> Select 
Resource category.

5. Supplier Contact > choose Contact as previously created. Find, then Create 
resource. View using Resource details. 

6.3.16 How are Support Site IDs in Resources Set Up? 
Explain the detailed steps in defining a support site such that it can be associated 
to a Resource Manager. 

Answer: Perform the following steps.
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Responsibility: Customer Support. 

Navigation: Customer Management > Contact Center 

Steps:

1. In the Caller Type field, select either Organization or Person. 

2. In the Organization field, select your organization. 

3. Select the Address tab. 

4. In the Status column, select Active. 

5. In the Address1 column, select the appropriate address from the LOV. 

6. The City field automatically populates. 

7. In the Usage field, select Support Site. 

8. Select Active in the Usage Status field. 

9. Save your work. 

6.3.17 How is Data in JTF_RS_GROUPS_DENORM Populated? 
Explain the detailed steps by which resource group hierarchy information is 
denormalized / flattened in this table. 

Answer: The following example illustrates the answer. 

Example: 

� Group G1 is a parent of group G2 

� Group G2 is a parent of group G3 

� Group G3 is a parent of group G4 

� Group G1 is a parent of group G5 

� Group G5 is a parent of group G6 

The following table depicts group information.
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6.3.18 How Are Records Populated?
How are records populated in JTF_RS_GROUPS_DENORM table for the 
previous example? 

Answer:

Table 6–1 Group Information

Group Name Group ID

G1 100000001

G2 100000002

G3 100000003

G4 100000004

G5 100000005

G6 100000006

Table 6–2 Group Data

Group_Id Parent_Group_Id Immediate_parent_flag Denorm_Level 

100000001 100000001 N 0 

100000002 100000002 N 0 

100000003 100000003 N 0 

100000004 100000004 N 0 

100000005 100000005 N 0 

100000006 100000006 N 0 

100000002 100000001 Y 1 

100000003 100000002 Y 1 

100000003 100000001 N 2 

100000004 100000003 Y 1 

100000004 100000002 N 2 

100000004 100000001 N 3 

100000005 100000001 Y 1 
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6.3.19 How Can Employee Number Generation Be Controlled?
Explain the steps by which Employee Number can be manually entered while 
creating an Employee Resource. 

Answer: Perform the following steps:

Responsibility: US HRMS

Navigation: Work Structures > Organization > Description.

Steps:

1. Query the Business Group you want to control the generation of Employee 
number. 

2. In the Organization Classification section Select "Business Group" 

3. Click on Others Button. 

4. Chose Business Group info. This will invoke a Flex Field. 

In the flexfield one segment is defined as Employee number generation. Depending 
on the value of this segment the system decides whether or not the number needs to 
be manually entered/or be automatically generated. 

6.3.20 Can I Use Netscape’s Back Button in Resource Manager?
There is a bug in the Netscape browser that can affect Resource Manager. Do not 
use the Back button, as you may loose your data. It is recommended that you use 
the Resource Manager user interface (UI). The Internet Explorer browser does not 
have this issue.

100000006 100000005 Y 1 

100000006 100000001 N 2 

Note: DENORM_LEVEL column is new in our current release. It 
DOES NOT exist in CRM 11.5.6 Family Pack.

Table 6–2 Group Data

Group_Id Parent_Group_Id Immediate_parent_flag Denorm_Level 
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6.3.21 How Many Contacts Can Be Imported For a Supplier Site?
Can you import contacts for just one supplier site?

Answer: If you want to import a supplier contact, you must enter the supplier name 
and site. In the Payables Supplier Form, you can specify contacts for each supplier 
site.

Responsibility: Customer Support

Navigation: Resource Management > Maintain Resources > Import Resources

Steps:

1. Select Supplier Contact from the Resource Category field.

2. Select your chosen name from the list of values (LOVs).

3. Select your chosen address from the LOVs.

4. Select your chosen Supplier Contact from the LOVs.

If there are multiple addresses and supplier contacts, then you can only select one to 
import into Resource Manager at a time.

Required fields are Supplier Name and Supplier Site. 

6.3.22 How Can I Import Salesrep Information?
How can I import Salesrep information from a legacy or third party system?

Answer: Use the API of your HR system and Resource Manager public API, JTF_
RS_RESOURCE_PUB. Create_Resource ( ), to import employees if you want to 
import employee data from a legacy HR system. For details of Resource Manager 
public APIs, see Oracle Common Application Components API Reference Guide.

6.3.23 Which API Returns all Workflow Roles for a Specific Resource ID?
Which API Returns all Workflow roles for a resource when provided with a 
specific resource ID?

Answer: The get_wf_role procedure in package JTF_RS_WF_INTEGRATION_PUB 
returns all workflow roles for a resource when provided with a specific resource ID. 
This procedure contains the following function:

FUNCTION get_wf_role(p_resource_id IN number) RETURN varchar2
 IS
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    l_role_name         wf_local_roles.name%TYPE;
    l_orig_system       wf_local_roles.orig_system%TYPE;
    l_orig_system_id    wf_local_roles.orig_system_id%TYPE;
When the user ID is provided as an input value, the function returns the name of 
the Workflow role, its original system, and its original system identification.

6.3.24 How do I display Flexfields in a JSP/HTML page within Resource Manager:
What are the steps to display a flexfield in a JSP/HTML page within the HTML 
version of Resource Manager?

Answer: You cannot perform this action because the HTML version of Resource 
Manager does not support Flexfields.

6.3.25 Which Partner Categories Are Terminated in Resource Manager?
Which partner categories are terminated in Resource Manager after running the 
Number of Days profile option?

Answer: The Number of Days profile option terminates resources in Resource 
Manager a specified number of days after they have been terminated in Human 
Resources. This profile option only terminates the partner category of resources.

6.3.26 How do I Enable Flexfields for the HTML Version of Resource Manager?
Is there a different set of steps to enable flexfields for the HTML version of 
Resource Manager? Enabled flexfields in the 'Groups' and 'Employees' region of 
Resource Manager. When user navigates to the Groups and Employees regions in 
the Forms-based interface, enabled flexfields are displayed. However, they are not 
displayed under the Employee and Groups tab of the JSP generated HTML page.

Answer: Resource Manager HTML currently does not support Flexfields. However, 
this feature will be available in a future release.

6.3.27 Why does the Synchronize Employee Concurrent Program Always update 
every record’s last_update_date parameter?

 The Synchronize Employee concurrent program updates every record's 
last_update_date even if the record is not changed. Is this a bug?

Answer: No. The program is designed that way to update the entire set using a 
single SQL command, which results in the observed behavior.
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6.3.28 Error Encountered When Running the Synchronize Employee Concurrent 
Program

The Synchronize employee concurrent program imports new employees into 
Resource Manager. When attempting to modify the new resource encountered 
error:

" Resource End Date out of range for the salesperson related End dates of the 
resource"

The new resource cannot be modified until the 31-DEC-4712 has been manually 
removed.

Answer: There are two answers to this problem:

1. When running the concurrent program, use the mass import by organization 
function since it does not populate the date field.

2. If you cannot delete all the imported records, then nullify the 31-DEC-4712 date 
in the JTF_RS_RESOURCE_EXTNS table.

6.3.29 Deactivated Role Still Appears
Why does a role that is made inactive still appear as a valid role with no end date 
on the resource record?

Resolution: Currently the resource role is not affected when a role is made inactive. 
A future release will address the issue of preventing inactive roles from being 
specified for resources when adding resources to groups.

6.3.30 What is the Correct Public API Sequence for Creating a Sales Rep?
What is the correct sequence for using pubic published Resource Manager APIs 
to create a sales rep?

Answer: To create a salesrep, must first create it as a resource using
JTF_RS_RESOURCE_PUB API. Then, create a salesrep using 
JTF_RS_SALESREPS_PUB API.
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6.3.31 How do I set the org_context to Properly Call the Create_Salesrep and 
Update_Salesrep APIs using SQL*Plus

What are the requirements for setting the org context and passing the org_id as a 
parameter when using SQL*Plus to call the Create_Salesrep and Update_Salesrep 
APIs?

Answer: Use the following command in your scripts when setting the org_context 
to call the Create_Salesrep and Update_Salesrep APIs:

mo_global.set_org_context(999, NULL);

where 999 is the org_id parameter value to which the context is set. This should be 
done every time you call the Create_Salesrep and Update_Salesrep APIs.
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Implementation Overview

This chapter provides an overview of the Notes module implementation process.

7.1 Overview
A note is free-form text attached to an object that records descriptive information 
about business transactions and that can be referenced across modules. It can be 
created by an agent, sales, or service representative, to capture a chronological log 
of information for business needs. The Notes module provides a common look and 
feel across applications and can be used as a communication tool to record business 
information throughout Oracle e-Business Suite.

Notes can be further defined by setting up note types, and note statuses. A note 
type is used to classify notes or indicate the type of notes, such as a general note 
type or an interaction note type. In addition to the seeded note types, the 
implementor or system administrator can create note types to further categorize 
notes if necessary. Note types can be mapped to a source object to limit the selection 
in a drop-down list. A note status is used to determine note accessibility, such as a 
private note with note status Personal. The value of a note status can be set by a 
profile option during Notes implementation. 

In addition, the Notes module provides a flexible security system that the 
implementor or system administrator can further customize the notes data and then 
grant appropriate users or user groups with read only or full privilege to access 
particular notes.

Before implementing Notes, however, it is necessary to understand the functionality 
of both the Forms-based and HTML versions of Notes.
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7.1.1 Forms-based and HTML Versions of Notes
Notes was initially a Forms-based application, and was subsequently expanded to 
include an HTML version. The functionality of both versions is almost identical. 
The only difference is that the Forms-based Notes module is not a stand-alone 
module and it can be accessed only through integrated applications, such as notes 
created for a service request or task. HTML Notes can be used as a stand-alone 
module to create personal notes or integrated with other applications, like the 
Forms-based Notes, to create context sensitive notes.

As Notes can have both HTML and Forms-based functionalities, both versions 
require the same setup steps and all steps are performed in Forms.

7.2 Steps
This section provides an overview of the required steps for implementing Notes 
including setting up Notes, customizing HTML Notes security, and troubleshooting 
Notes. Detailed instructions for these steps are contained in the subsequent Notes 
chapters.

� Setting Up Notes

– Setting Up Note Types

– Mapping Note Types to a Source

– Defining Notes Reference Mapping

– Setting Up the Source Object Code and Context

– Setting Profile Options

� Customizing HTML Notes Security

� Troubleshooting Notes

7.2.1 Setting Up Notes
This chapter contains basic instruction for setting up the Notes components in the 
following topics:

7.2.1.1 Setting Up Note Types
In addition to the seeded note types, the implementor or system administrator can 
create new note types to categorize a note, such as a General note type for a general 
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note, or an Interaction note type for a note created specifically for an interaction or 
activity.

7.2.1.2 Mapping Note Types to a Source
After creating note types, the implementor or system administrator can map these 
note types to a source object, such as Task Manager, or Sales Lead, or a specific 
resource category, such as Employee Resource. This limits the visibility of the note 
type appearing in the Note Type list of values only to the mapped specific source 
object or resource category. 

7.2.1.3 Defining Notes Reference Mapping
In addition to mapping note types to a source, implementors can also map 
references to a source object. This narrows down the References drop-down list to 
objects that are actually relevant to a document's source object. 

The Mapping Objects window used to define reference mapping is for both Task 
Manager and Notes modules. Therefore, implementors need to locate the setup 
screen under the Task and Escalation Manager navigation node.

7.2.1.4 Setting Up the Source Object Code and Context
The implementor or system administrator can add additional data in the JTF objects 
table if necessary. For example, if a document is newly defined or integrated with 
Notes, such as Task Manager, then the new document must be associated with 
Notes usage. As a result, the document name (Task Manager) appears in the Source 
list when a note is created for task 1150. Each item in the source list has an 
associated related object (task 1150), which appears in the Related To list.

7.2.1.5 Setting Profile Options
The implementor or system administrator can use the Notes: Default Note Status 
profile option to set the default value for note status at site, application, 
responsibility, or user level based on business needs.

7.2.2  Customizing HTML Notes Security
The HTML Notes module contains a security model used to restrict data access to 
appropriate users through a specific authorization process. This Notes security 
model, leveraged the Application Object Library (AOL) data security model, 
provides a flexible mechanism for notes security access. It allows Notes 
implementor or system administrator to customize notes data, and then grant 
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specific notes to appropriate users or user groups with right access privileges. This 
includes granting users the ability to view a note, create a note, update a regular 
note, update a large note, update a note’s secondary information (such as note type, 
status, relation and attachment), and restrict "note type" list of values. This 
functionality is only enforced in the HTML Notes, not the Forms-based Notes.

7.2.3 Troubleshooting Notes
In addition to the implementation steps, some troubleshooting information is also 
addressed in a separate chapter. This includes common implementation errors and 
frequently asked questions (FAQs) for implementing Notes.
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Setting Up Notes

This chapter covers the following topics:

� Setting Up Note Types

� Mapping Note Types to a Source

� Defining Notes Reference Mapping

� Setting Up the Source Object Code and Context 

� Setting Profile Options

8.1 Setting Up Note Types
In addition to using seeded note types, implementor or system administrator can 
create new note types to categorize notes for specific business needs. For example, if 
a note is created for a general purpose, then a note type for this note can be 
“General.” If a note is created specifically for an interaction or activity, then a note 
type for the interaction note or the activity note can be “Interaction” or “Activity”.

To create a new type, enter the Code name of your application (such as KB_Action 
for Knowledge Base note with note type called Action), and this code name must be 
unique and cannot have a duplicate record in the system. In addition, enter note 
type name (such as Action) in the Meaning field. Select the Enabled check box 
before using the new note type.

In order to hide an existing note type, implementor or system administrator can 
assign an end date to that note type. 

Perform the following steps in Forms to create new note types.
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Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Notes Setup > Note Type Setup.

Steps
1. In the Application Object Library: Note Types Lookups window, place your 

cursor in the code field and select File > New to enter new note type.

2. Enter the code, meaning, and description information for the new type.

3. Select the Enable check box to activate the new note type.

4. Chose File > Save to save your work.

See Also
� Mapping Note Types to a Source

� Defining Notes Reference Mapping

� Setting Up the Source Object Code and Context

� Setting Profile Options

8.2 Mapping Note Types to a Source
After creating a note type, the implementor or system administrator can map a note 
type to a source object in order to limit the selection of note type list of values for 
the mapped source.

What is a Source Object?

A source object is a business object that initiates the creation of a note. If a note is 
created for a service request or party, then the service request or party is the source 
object of that note. A note must have a source object.

Be aware of the difference between a source object and related object. A related 
object is an object related to a note, but is not the source of the note. A note may be 
created for a task, source object, but it can be related to a party, opportunity, and 
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employee as well. These party, opportunity, and employee resource are related 
objects for that note. Related objects are not mandatory, instead they are nice to have 
information for a note.

Mapping Note Types to a Source

Use the Mapping Objects window to map note types to a source. For example, if 
closure, activity, and interaction note types are mapped to Task Manager, a source 
object, then when users create a note from a task, they can see these three note types 
displayed in the list of values. If the same note types are not mapped to another 
source, Campaign Schedule for Marketing, then they will not see them while 
attaching a note to a campaign schedule. 

In addition, implementors or system administrators can set an end date for a 
mapped note type if necessary.

Perform the following steps in Forms to map a note type to a source object.

Prerequisites
A new note type must exist.

Responsibility
CRM Administrator

Navigation
Navigate to Notes Setup > Source and Note Type Mapping.

Steps
1. To search for existing data for a source object, navigate to View > Query by 

Example > Enter and enter your query in the Source Object field.

2. Select View > Query by Example > Run to run your query or select View > 
Find All to search for all records.

The information appears in the Mapping Objects window.

3. Select the Source Object from the list of values (LOV), for example, Task 
Manager.

Note: This Mapping Note Types to a Source functionality is not 
enforced in the Forms version.
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4. Select the Note Type you want to map to the drop-down list from the LOV, for 
example Call Back.

5. (Optionally) Enter an end date or use the calendar LOV to select a date.

The seeded check box is not editable.

6. Click Save. The Call Back note type will now appear in the note type 
drop-down when you create a note in Task Manager.

See Also
� Setting Up Note Types

� Defining Notes Reference Mapping

� Setting Up the Source Object Code and Context

� Setting Profile Options

8.3 Defining Notes Reference Mapping
Use the Mapping Objects window to map a reference type to a source object. This 
narrows down the References list of values (LOV) to the mapped object. For 
example, when creating a note for a Sales Opportunity, users typically don't want to 
see such objects as Service Request or Defect in the References list of values. Instead, 
they only want to see Lead, Forecast, Quote, and Sale Organization. Therefore, 
implementors or system administrators must map note references such as Lead, 
Forecast, Quote, and Sales Organization, to the source object, Sales Opportunity.

Be aware that the Mapping Objects window is used to define reference mapping for 
both Task Manager and Notes. To locate the reference mapping screen, select the 
Task and Escalation Manager, not Notes navigation node.

Perform the following steps in Forms to map note references.

Prerequisites
Your source object must exist.

Note: This window defines reference mapping for both the Task 
Manager and the Notes module.
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Responsibility
CRM Administrator

Navigation
Navigate to CRM Administrator > Task and Escalation Manager > Setup > Task & 
Note References.

Steps
1. In the Mapping Objects window, select your source object from the list of 

values, for example, Sales Opportunity.

2. Select the References you want to appear in the LOV.

3. Optionally select an end date for the mapped reference.

4. Select the application where you want to extract your additional data from and 
click Save.

5. Repeat these steps for every object that you want to appear in the References 
LOV for your source object.

See Also
� Setting Up Note Types

� Mapping Note Types to a Source

� Setting Up the Source Object Code and Context

� Setting Profile Options

8.4 Setting Up the Source Object Code and Context
When defining a new document, Notes implementor or system administrators must 
associate Notes usage to the new document. In the Forms-based Notes, the 
document name appears in the Source list. Each item in the Source list has an 
associated related object, which appears in the Related To list. 

How to enter each field for different tabs, see the detailed step by step instruction in 
the Setting Up Metadata Objects section, Setting Up Task Manager chapter of the 
Oracle Common Application Components Implementation Guide.

Perform the following steps in Forms to define the source code usage as NOTES.
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Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Task and Escalation Manager > Setup > Objects Meta-data.

Steps
1. In the Tasks Setup: Object Types window opens, perform one of the following 

tasks:

a. If the source object code you want to seed already exists, then define the 
usage as NOTES.

b. If the source object code is not defined, then you must define the source 
object code, the name, and select its details and usage. (Usage should be 
NOTES.)

2. For detailed instruction on how to enter each field, please see Setting Up 
Metadata Objects.

See Also
� Setting Up Note Types

� Defining Notes Reference Mapping

� Mapping Note Types to a Source

� Setting Profile Options

8.5 Setting Profile Options
The following table describes the profile option used by Notes.
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Table 8–1 Notes Profile Options

Name
Default 
Value Level Description Outcome

Notes: Default 
Note Status

Public Site This profile option 
sets the default note 
status. Profile option 
values include 
private, public, or 
publish.

If you select Publish, then that is the 
default value shown in the Status 
drop-down list when creating a new note.

If no profile option is set, default is 
Public.

Note: See Appendix A, Profiles Options, for details on how these 
profile options can be set.
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Customizing HTML Notes Security

This chapter covers the following topics:

� HTML Notes Security Overview

� Terms and Definitions

– Users (User Groups)

– Objects

– Object Instances

– Object Instance Sets

– Functions (Privileges)

– Menus (Roles)

– Grants (Authorizations)

– Global Grants

� Steps for Customizing HTML Notes Security

– Identifying Users or User Groups

– Defining Object Instance Sets

– Defining Menus

– Disabling Existing Grants

– Adding New Grants
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9.1 HTML Notes Security Overview
By leveraging the Application Object Library (AOL) data security model, HTML 
Notes module provides a flexible mechanism for notes security access. This security 
model provides the ability to restrict data access to appropriate users through a 
specific authorization process.

For example, in the past, almost all users can create new notes, but now only the 
users who are granted access to the create note function would be able to create 
notes. The same theory can be applied to the creation or deletion of attachments, or 
note modifications.

With the new security model, based on the AOL security model, HTML Notes 
module uses the concepts of objects, instances, and instance sets to further group all 
data in HTML Notes into different units or sets. The biggest unit is Notes that is 
considered as an object in AOL term. Within the object Notes, multiple notes can be 
grouped into different subsets (or object instance sets), such as all notes with status 
"private", all notes of type "offer", or all notes not of type "offer". Based on the 
definition of these subsets, a private note, or a note of type "offer" then becomes the 
smallest unit of the Notes object and is called the object instance.

With these data object concepts, information entered in HTML Notes can be further 
restricted to the data level, customized for your business needs, and then securely 
granted to resources and resource groups.

As HTML Notes security is based on the AOL security model, therefore, relevant 
AOL data security concept and terminology will be introduced first. How to 
customize the notes security is addressed later.

Information on AOL data security framework, refer to Oracle Applications System 
Administrator's Guide.

9.2 Terms and Definitions
This section explains the various terms used in the HTML Notes security:

� Users (User Groups)

� Objects

Note: Even you define the data security rules in the HTML Notes, 
these rules will not be enforced in the Forms-based Notes module.
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� Object Instances

� Object Instance Sets

� Functions (Privileges)

� Menus (Roles)

� Grants (Authorizations)

� Global Grants

Users (User Groups)
A user is a single person with an account on the system (represented by a row entry 
in FND_USER). Users can be grouped into groups. Therefore, a user role may 
represent a user or group of users. A user group is any grouping of FND_USERS 
who are exposed through the WF_ROLES view. 

Users and user groups can be referred as Grantee if they are the subjects of a data 
security grant. These users and user groups must be exposed in the WF_USER/WF_
ROLES.

Objects
An object is a type of thing on which security can be managed. Notes is an         
example of an object. 

In a technical definition, each object must be registered in the FND_OBJECTS tables. 
Every object definition will contain related database object (table or view) and 
primary key information for the object.

There are two seeded objects used in Notes security:

� JTF_NOTES

� JTF_NOTE_TYPES

Object Instances
An object instance is a specific entity of an object. This generally corresponds to a 
row (or related set of rows) in the database. If Notes is considered an object, then 
the Note with number 1541 is an object instance. 

In a technical explanation, object instances are derived from the primary key values. 
The primary key values should be set for the registered object in the FND_OBJECTS 
and FND_GRANTS.
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Object Instance Sets
An object instance set is a group of multiple object instances. For example, all notes 
with a number smaller than 5 could be considered as an object instance set. 

In a technical definition, object instance set definition is stored in the FND_
OBJECT_INSTANCE_SET table. The definition contains a SQL where clause, the 
predicate, that combined with the object definition will return all the object 
instances that are part of the object instance set. 

Use the following examples to understand the concept of object instance sets. Please 
note that all words after where clause in Italic style are defined in the FND_
OBJECT_INSTANCE_SET table. In addition, to avoid processing issues all the 
columns used in the where clause should be prefixed with "&TABLE_ALIAS" in the 
object instance set definition.

� All notes with a number smaller than 5:

SELECT jtf_note_id
FROM jtf_notes_b  
WHERE &TABLE_ALIAS.jtf_note_id < 5

� All non private notes:

SELECT jtf_note_id
FROM jtf_notes_b  
WHERE &TABLE_ALIAS.note_status <> 'P'

� All notes that are not confidential

SELECT jtf_note_id
FROM jtf_notes_b  
WHERE &TABLE_ALIAS.note_type <> 'CONFIDENTIAL'

� All notes that are confidential

SELECT jtf_note_id
FROM jtf_notes_b  
WHERE &TABLE_ALIAS.note_type = 'CONFIDENTIAL'

All columns exposed through the FND_OBJECTS.DATABASE_OBJECT_NAME 
table/view can be used to create instance sets, although basic performance rule 
should be taken into account. 
9-4 Oracle Common Application Components Implementation Guide



Terms and Definitions
Functions (Privileges)
A function is an action that can be performed on an object or object instance. It is the 
smallest unit of secured product functionality. It can be granted to a user or user 
group which means gives them permission to perform that function. Therefore, it 
can also be referred as a permission or privilege from a user’s point of view.

For example, a note can be created; CREATE_NOTE could be considered a function. 
A note can be updated; UPDATE_NOTE again could be considered a function. 
Functions can be secured through the AOL security model. Notes has the following 
functions defined for the Notes object:

� JTF_NOTE_SELECT, the ability to view a note

� JTF_NOTE_TYPE_SELECT, the ability to view a note type

� JTF_NOTE_CREATE, the ability to create a note including a regular note, large 
note (detailed note) and an attachment for a note

� JTF_NOTE_UPDATE_NOTES, the ability to update a note's text (regular note)

� JTF_NOTE_UPDATE_NOTE_DETAILS, the ability to update a note's details (a 
large or detailed note)

� JTF_NOTE_UPDATE_SECONDARY, the ability to update a note's type, status, 
relation (relate to), and attachment information

These functions are defined in the FND_FORM_FUNCTIONS table since they are 
referenced in the actual code. Therefore, they cannot be changed or extended.

In addition, functions (privileges) can be grouped into menus (roles) to reduce the 
granting overhead.

Menus (Roles)
A menu is a grouping of functions. It is required to group functions into related sets 
of menus necessary to perform a particular job role on an object instance. A good 
example is an "Administrator" menu, which might include many functions required 
for a user with an administrator role to perform his job. Therefore, menus can also 
be referred as roles. 

In addition, menus can have multiple hierarchies and this menu structure is built 
upon logical groups of functions. 

The following menus (roles) are defined for Notes security:

� JTF_NOTES_USER

– JTF_NOTE_SELECT
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– JTF_NOTE_UPDATE_SECONDARY

� JTF_NOTES_CREATOR

– JTF_NOTE_CREATE

Please note that menus are user definable, the seeded menus only exist to ensure 
backward compatibility.

Grants (Authorization)
A grant is an authorization for the grantee (users or user groups) to perform the 
specified object role on the specified object instance or object instance set. Therefore, 
grants are what tie the whole thing together. A grant consists of the following three 
components:

� Object. Any object instance or object instance set, for instance, all non-private 
notes.

� Grantee. Any user or user group, for instance, "JDOE" for John Doe

� Menu. Any menu, for instance, "JTF_NOTES_USER"

These three components would grant the user, John Doe, the ability to select and 
update all non-private notes. 

In addition, all grants should be registered in table FND_GRANTS.

Please note that when using AOL security a user will by default not be able to do 
anything unless explicitly granted.

Global Grants
To reduce the administration of grants, authorizations can be granted globally to the 
following:

� The "Global" user or user group (grantee)

� The "Global" object instance (object)

9.3 Steps for Customizing HTML Notes Security
After understanding of how data can be organized in HTML Notes based on the 
AOL security model, system administrator can further customize the HTML Notes 
security rules by granting users with appropriate data access permissions using the 
concept of object instance sets.
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To better explain how the customization can be done, use the following business 
scenario to lead you through the possible customization steps.

Business Scenario
A company’s Sales department wants sales managers to be able to create confidential notes 
for their sales leads. These confidential notes will be of note type "Confidential" and should 
be invisible to normal sales representatives. In addition, only sales managers should be able 
to create confidential notes.

To customize HTML Notes security which is, in other words, to create grants based 
on the business scenario. Before starting a new grant, the following three 
components should be identified first:

� Identifying Users or User Groups (Grantee)

� Defining Object Instance Sets (Object)

� Defining Menus (Menu)

Once the grant components (who has what privileges to access which objects) are 
identified, the administrator can start the granting process:

� Disabling Existing Grants

� Adding New Grants

9.3.1 Identifying Users or User Groups
Users need to be identified so that appropriate access privileges can be granted to 
them. In general, a user can be a single resource, resource group, or all members of a 
resource group.

Based on the scenario, sales mangers and sales representatives are the grantees who 
will be given appropriate access permissions should be first identified. It can be 
done in the Resource Manager by creating a resource group "SalesReps" containing 
all the sales representatives, and another group "SalesMan" containing all sales 
managers. How to create a resource group, refer to Resource Manager of the Oracle 
Common Application Components Implementation Guide.

See Also
� Defining Object Instance Sets

� Defining Menus

� Disabling Existing Grants
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� Adding New Grants

9.3.2 Defining Object Instance Sets
Use an object instance set to specify a parameterized set of rows for the Notes object 
so that it can be granted to appropriate users. 

An object instance set is a subset of data resided within an object, therefore an object 
must exist first before you are able to create an object instance set for that object. 

The Notes module uses two seeded objects, JTF_NOTES and JTF_NOTE_TYPES. 
Each object can be customized by creating object instance sets to provide users with 
specific sets of Notes data if necessary. For example, notes (JTF_NOTES object) can 
be customized to have different object instance sets, such as all confidential notes. 
Note types (JTF_NOTE_TYPES object) list of values (LOV) can also be customized 
for different users.

Based on our scenario, in order to grant sales managers the permission to create 
confidential notes, and make sure sales representatives cannot create confidential 
notes, the following object instance sets should be created for JTF_NOTES:

� All confidential notes

� All non-confidential notes

Additional object instance sets should be created for JTF_NOTE_TYPES so that sales 
manager, not sales representatives, can see the confidential note type. To do so, you 
can filter the list of available note types:

� All confidential note types

� Sales representative note types (all note types except the confidential note type)

Use the following steps to define object instance sets:

Note: The creation of object instance set is meta data driven, all 
data required to ensure backward compatibility with current note 
security model are seeded.

Note: The note type LOV uses the internal API and appends the 
returned where clause to the base query to provide security data 
access.
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Prerequisites
An object must be in place.

Responsibility
FND Security Administration (Self Service Application)

Navigation
Objects

Steps
Tips: First locate the object that you want a new instance set created for, then enter 
necessary information for the set. 

Detailed information on how to define object instance sets, see Oracle Applications 
System Administrator's Guide.

1. Enter necessary search information in the Find Objects window to locate the 
JTF_NOTES and JTF_NOTE_TYPES objects. Search results should be listed after 
executing the search. 

2. Click the object name hyperlink for which you want the new instance set to be 
created from the search result to open the Find Object Instance Set window.

3. Existing instance sets for the selected object are also listed here. Click Create 
New Instance.

4. Enter instance set detail information including instance set name, display name, 
description and predicate.

5. Save your work.

See Also
� Identifying Users or User Groups

� Defining Menus

� Disabling Existing Grants

� Adding New Grants

9.3.3 Defining Menus
A menu is a hierarchical arrangement of functions and menus of functions. If a 
grant just involves a single function, such as grant the create notes function (JTF_
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NOTE_CREATE) to a user, then there is no need to define menus. As mentioned 
earlier, the purpose of using menus is to reduce the administrative tasks. If multiple 
functions need to be given to a user, it is necessary to group them into a menu or 
menu structure.

In our scenario, sales mangers require the following functions in a menu format:

� JTF_NOTE_SELECT

� JTF_NOTE_CREATE

� JTF_NOTE_UPDATE_NOTES

� JTF_NOTE_UPDATE_SECONDARY

� JTF_NOTE_TYPE_SELECT

In addition, create another menu for sales representatives including the following 
functions:

� JTF_NOTE_SELECT

� JTF_NOTE_CREATE

� JTF_NOTE_UPDATE_SECONDARY

� JTF_NOTE_TYPE_SELECT

Prerequisites
None

Responsibility
System Administrator

Navigation
Application > Menu

Steps
1. Enter the menu name that describes the purpose of your menu, such as 

"SalesMan" or "Salesrep" in the Menu and User Menu Name fields.

The User Menu Name is used when a responsibility calls a menu or when one 
menu calls another.

2. Select an appropriate menu type and enter description information:

� Standard. For menus that would be used in the Navigator form
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� Tab. For menus used in self service applications tabs

� Security. For menus that are used to aggregate functions for data security or 
specific function security purposes, but would not be used in the Navigator 
form

3. Enter required functions for this menu including:

� Sequence. Enter an integer here.

� Navigation prompt. Enter a user-friendly, intuitive prompt your menu 
displays for this menu entry. This menu prompt appears in the hierarchy 
list of the Navigator window.

� Submenu name. Enter a submenu name if applies. This calls another menu 
and allows users to select menu entries from that menu.

� Function name and description. Enter a function name that you wish to 
include in the menu. Descriptions appear in a field at the top of the 
Navigate window when a menu entry is highlighted.

� Grant check box. This should always be checked which indicates that this 
function is automatically enabled for the user. If this is not checked, then 
the function must be enabled using additional data security rules.

4. Click View Tree... to see menu’s hierarchical structure.

Refer to Oracle Applications System Administrator's Guide for more information 
regarding how to define a menu.

See Also
� Identifying Users or User Groups

� Defining Object Instance Sets

� Disabling Existing Grants

� Adding New Grants

9.3.4 Disabling Existing Grants
The purpose of disabling existing grants is to make sure that all seeded global 
grants are revoked so that they don't interfere with the new grants. To disable a 
grant, you can set an end date for the grant, instead of deleting it completely. 
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Prerequisites
None

Responsibility
FND Security Administration (Self Service Application)

Navigation
Grants

Steps
1. Search the existing grants that you want to disable by entering search criteria in 

the Search Grants window.

2. Click Go to retrieve the grants that match your search criteria.

3. Select the grant that you want to disable from the search result.

4. Set an end date in the Context window and click Finish to disable the grant.

More information on how to disable existing grants, see Oracle Applications System 
Administrator's Guide.

See Also
� Identifying Users or User Groups

� Defining Object Instance Sets

� Defining Menus

� Adding New Grants

9.3.5 Adding New Grants
A new grant must take place when there is a need to authorize access privileges for 
a user so that the user can perform certain functions, or to have more specific 
actions on a designated instance set. Therefore, based on the data access levels, 
there are two types of grants: Function Grants (such as "Administrator" menu) and 
Data Grants (such as the note type LOV data)

For function grant, it applies to all objects and consists of the following windows:

1. Grantee: There are three grantee types appeared in radio buttons. Only one of 
them should be selected as a grantee. 
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� All users (global)

� Group of users (group)

� Single user (user)

In the case of a group or a single user is selected, the corresponding group or 
user name should be further identified. The selected grantee will be validated 
against WF_ROLES table.

2. Function Set: A function set (or a menu) can be selected from the LOV so that an 
appropriate function set can be granted to a specified grantee. 

3. Context: The screen provides grant attributes information including 
organization, responsibility, start and end dates, program name, and program 
tag fields. This is the place where a grant can be disabled by entering an end 
date.

For data grant, a specific object and instance set information need to be further 
identified. It consists of the following windows in a sequential order:

1. Object: A specific object name needs to be specified for this grant.

2. Grantee: Like the function grant, grantee can be a user, a group, or all users. 

3. Function Set: Like the function grant, a function set needs to be specified in 
order to authorize it to a specified grantee.

4. Data Set: There are three types of instance. Only one of them should be selected:

� All rows of the object (global): When it is selected, the Data Set Details 
window will be skipped and you are directed to the Context window.

� A specific row of the object (instance)

� A parameterized set of rows (instance set): When it is selected, the instance 
set name needs to be further identified.

5. Data Set Details: In the case of instance or instance set is selected in the Data Set 
window, more data or data set details will be displayed in this window. If 
instance is selected, then this page will have associated primary key values 
displayed. If instance set is selected, then this page will have parameter 
columns displayed with the associated predicate information for the selected 
instance set.

6. Context: Like the function grant, additional grant attributes can be addressed 
here. Use the end date field to revoke a grant.

Based on the scenario we have, the following grants need to be authorized:
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� Grant all sales representatives the access to all non-confidential notes

� Grant all sales mangers the access to all non-confidential notes

� Grant all sales mangers the access to all confidential notes

� Grant all sales representatives the access to sales representative note types

� Grant all sales managers the access to all confidential note types

� Grant all sales managers the access to sales representative note types

Use the following steps to add a new grant. Detailed information on how to add 
new grants, see Oracle Applications System Administrator's Guide.

Prerequisites
None

Responsibility
FND Security Administration (Self Service Application)

Navigation
Grants

Steps
1. Select Create Data Grant to add new grants to sales managers or sales 

representatives.

2. In the Object window, select JTF_NOTES as the object name.

3. In the Grantee window, select the Group of Users radio button. Additionally, 
specify appropriate group name.

4. In the Function Set window, specify a menu name for either sales managers or 
sales representatives.

5. In the Data Set window, select the A parameterized set of rows (Data Set) radio 
button. Furthermore, specify the object instance set that you have defined 
earlier.

6. In the Data Set Details window, enter appropriate primary key values.

7. In the Context window, enter appropriate organization, responsibility and start 
date information. Leave the End Data field blank.

8. Enter JTF_NOTES in the Program Name field.
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9. Enter JTF_SALES_NOTES or JTF_SALES_NOTETYPES in the Program Tag field 
depending on the selected object instance set.

10. Click Finish. Once this process is successfully completed, the confirmation page 
opens with the message saying that the grant has been created.

See Also
� Identifying Users or User Groups

� Defining Object Instance Sets

� Defining Menus

� Disabling Existing Grants
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Troubleshooting Notes

This chapter covers the following topics:

� Error Messages

� Answers to Frequently Asked Questions (FAQs)

10.1 Errors Messages

10.1.1 ORA-20000
InterMedia Text error: ORA-01722: invalid number ORA-06512: at 
"CTXSYS.DRUE", line 126 ORA-06512: at "CTXSYS.TEXTINDEXMETHODS", 
line 226 ORA-06512: at line 1.

Cause: Script Failure Error

Action: To resolve this issue, configure your environment to include Intermedia 
text. For more information, refer to the Oracle 8i Intermedia Text Installation Manuals 
FAQ or contact Oracle Support.

10.1.2 Script Failed Error
The following error message can occur:

ORA-29856: error occurred in the execution of ODCIINDEXDROP routine.

ORA-20000: interMedia Text error: ORA-01722: invalid number ORA-06512: 
at "CTXSYS.DRUE", line 126 ORA-06512: at 
"CTXSYS.TEXTINDEXMETHODS", line 226 ORA-06512: at line 1.
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Configure your environment to include Intermedia text. For more information, 
refer to the Oracle 8i Intermedia Text Installation Manuals FAQ or contact Oracle 
Support.

See Also
� Setting Up Note Types

� Mapping Note Types to a Source

� Setting Up the Source Object Code and Context

� Setting Profile Options

10.2 Answers to Frequently Asked Questions (FAQs)
The following are frequently asked questions. Answers to these questions may 
help you in troubleshooting problems with the Notes module.

10.2.1 Can You Delete or End Date Seeded Note Types?
Seeded data cannot be end dated or deleted. However, users can define new 
note types. 
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Spreadtable

This chapter of the Oracle Common Application Components Implementation 
Guide contains the following chapters:
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� Implementation Tasks
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Implementation Overview

This chapter provides an overview of the Spreadtable implementation process. 

11.1 Overview
A spreadtable is a metadata driven user interface component that contains rows, 
columns, and column headers set in a grid that can display dynamic content at run 
time. Spreadtable can be embedded into an Oracle form. Oracle Common 
Application Components use Spreadtable to provide flexibility in displaying and 
handling data through an interactive way. It allows users to sort, search, copy and 
export data, and customize the display through the features of resize, resequence, 
and hide and show columns.

Before implementing Spreadtable, it is necessary to understand the functionality of 
the Spreadtable including sorting, searching, customizing layout, and copying and 
exporting.

� Sorting

� Searching

� Copying and Exporting

� Customizing Layout

11.1.1 Sorting
Spreadtable provide users to sort data in the following two ways:

1. Click the grey dot in a column header in order to sort a category.

The arrow that replaces the grey dot indicates a direction of order, for example, 
ascending or descending alphabetical or chronological order, where applicable. 
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Re-sort in the opposite direction by clicking the header arrow again.

2. Right-click on a cell and select Sort in the table from the pop-up menu that 
appears. This action opens a dialog box in which you can select up to three 
columns for sorting.

11.1.2 Searching
Spreadtables allows users to search for specific information in the spreadtable. To 
perform a search, right-click on a cell in the spreadtable and select Find from the 
pop-up menu that appears. 

Find a matching value by typing the desired sequence of characters into an 
appropriate text field. Indicate whether or not to match case, and select the direction 
of the search, backward or forward.

11.1.3 Copying and Exporting
In addition to sorting and searching, users can use the spreadtable to copy 
necessary information and then export the data into a spreadsheet application, such 
as Microsoft Excel.

Users can copy a cell, selected rows, or all rows in the spreadtable to a clipboard by 
right-clicking in the cell and then selecting the appropriate option from the menu.

When users insert the copied selection into a spreadsheet application, such as 
Microsoft Excel, the appropriate headers automatically migrate with the selection 
and appear as its first row. Rows are copied in a tab-delimited format.

Cells that display values as check marks or X display differently when copied and 
exported: positive values are expressed as asterisks (*) and negative values do not 
display.

11.1.4 Customizing the Layout
Spreadtables allow users to adjust the table layout in order to accommodate 
different business needs in the following ways:

� Make changes to the column width, sequence, visibility, and sort order.

� Resize the columns or rows to display text as you wish.

Note: Hidden information does not migrate with exported data.
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� Resize the window depending on the application you use. The spreadtable 
display will adjust accordingly.

� Resequence the columns by clicking the header that you want to be 
resequenced and holding mouse until a black box appears. Move the header to 
the selected position. 

� Hide columns to make irrelevant or confidential information invisible. This can 
be done by right-clicking the header of the column you wish to hide and then 
selecting Hide Column from the pop-up menu. Hidden information does not 
migrate when data is copied to the clipboard.

� Show columns by using the Show Column option. This option lists a submenu 
that has currently hidden columns. Select all or only those you wish to display.

� Preserve or restore the changes you make to the table layout. This can be done 
by right-clicking a column header and clicking Customizations. Click Save 
from its submenu to save the changes. Click Clear to restore default settings.

11.2 Steps
This section provides an overview of the required steps for implementing 
Spreadtable including creating a new spreadtable and setting profile options. 
Detailed instructions for these steps are contained in the subsequent chapters.

� Creating a New Spreadtable

� Setting Profile Options

11.2.1 Creating a New Spreadtable
The implementor or system administrator can create a new spreadtable by defining 
a new datasource (a set of metadata) that can plug into an Oracle Forms bean area 
container. Metadata is information that defines what data is retrieved at run time 
and how that information is presented. After entering required data in a newly 
defined spreadtable, the implementor can test the functions of this new spreadtable 
before actually use it.

11.2.2 Setting Profile Options
After defining a new spreadtable, the implementor or system administrator must 
set up necessary profile options in order to specify whether or not images are visible 
in the spreadtable. These include displaying images in grid column headers, header 
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popup, row header images in the grid, grid popup, checkbox images, custom 
images, and long wait images.
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Implementation Tasks for Spreadtable

This section covers the following topics:

� Creating a New Spreadtable

� Setting Profile Options

12.1 Creating a New Spreadtable
Use the Spreadtable Meta Data Administration window to design spreadtables that 
plug into an Oracle Forms bean area container. 

� A spreadtable is the user interface component that contains rows, columns, and 
column headers set in a grid that can be embedded into an Oracle form.

� Oracle Forms-based Common Application Components use the spreadtable to 
display and format dynamically retrieved data at run time. This is 
accomplished by predefined metadata definitions.

� Metadata is information that defines what data is retrieved at run time and how 
that information is presented.
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The following table describes the Spreadtable Meta Data Administration tabs.

Table 12–1  Spreadtable Meta Data Administration Tab Descriptions

Tab Description

Database Use the Database tab to set column type and order, datatype, sequence, and 
default sort order.

Display Use the Display tab to set column label, visibility, display sequence, and display 
width.

Alignment and Formatting Use the Alignment and Formatting tab to set type of header and cell alignment, 
as well as display type and format.

Custom Format Masks and 
Mappings

Use the Custom Format Masks and Mappings tab to set how data shows. This 
applies to columns with datatype of number, check box, and images. For 
example, a spreadtable can display data values as a percent.

Query The Query tab is for internal use only. It is used exclusively by the Universal 
Work Queue.

Sort Order Use the Sort Order tab to set the overall sort order of the columns for the 
spreadtable. For example, you may set the primary sort order to be alphabetical 
based on column A, and set a secondary sort order to be numerical based on 
column B if B is defined as number in the database.

Test Use the Test tab to test the newly defined spreadtable.

WARNING: Oracle does not support custom development of new 
forms using the spreadtable interface.

� Do not delete currently existing columns when modifying an 
existing spreadtable. Instead, use the Freeze Visible State 
property in the Display tab to make the column invisible to 
the user. 

� Do not delete any existing metadata definitions.

� If you modify existing metadata definitions, these changes 
may be overwritten by subsequent patches.
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Perform the following steps to create a new spreadtable.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to the Spreadtable Administration window.

Steps
1. In the Spreadtable Meta Data Administration window, define a new datasource 

(a set of metadata) by entering the following:

� Datasource Name: The unique name that identifies a set a metadata. It 
must always be <Application Prefix>_<Name>.

� Application: The name of your product. 

� Title: A descriptive name for this set of metadata.

� Relational View Name: Select, from the LOV, the name of the view from 
which information is to be retrieved to populate the spreadtable.

� Lines/Rows: Enter how many lines of text are to display per row.

� WHERE Clause: (Optional) Enter a SQL statement here if desired. Use this 
field to enter filtering criteria. Note the following:

– Do not start the SQL statement with the keyword WHERE, as this is 
automatically prepended to the statement. 

– Always use bind variables if the value changes at runtime.

� Fetch Size: Enter how many rows to be fetched each time. The default is set 
to 200 rows if it is not specified.

2. Select the Database tab, if it is not already selected, and enter the following 
information for each column that you want to be visible in the spreadtable:

� Column Alias: The column alias becomes part of the primary key, therefore 
it must be a unique name. 
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� View Column/ Function: Select from the LOV the desired name of the View 
Column.

� Datatype: Select from the LOV either character, number, or date.

� Query Sequence: The sequence value determines the order in which 
columns are extracted from the database. You could start with 1, but in 
actual practice, it is a good idea to leave gaps in the sequence for ease of 
row insertion later. To improve performance, begin with the columns that 
you will refer to in your code, typically the primary key columns to execute 
a query in a detail block.

� Fire Post Query Flag: Select this flag to fire the post query event when the 
row is displayed or used.

� Sortable: Select this check box allows the user to sort on this column.

� Sort Column: Select from the LOV the desired column name that you want 
to use for sorting. If this field is specified, then a user can sort on criteria 
(the specified column name as sorting criteria) other than the actual data. If 
it is not specified, then the View Column is used to sort data. For example, 
if Priority is selected in this field and it is associated with a code ('High' - 1, 
'Medium' - 2, 'Low' - 3), then the priority code can be used to sort the 
Priority column values.

� Default Sort Order: Sort in ascending or descending default order.

3. Select the Display tab, and enter the following for each column that you defined 
previously:

� Column Alias: The column alias field is filled automatically.

� Label: This field is supplied automatically to identify the column header 
information once the Column Alias field is identified. You can change the 
label information if desired. 

� Visible: Select to make this column visible in the spreadtable.

� Freeze Visible Property: Select if you want the end user to be able to 
change the visible properties (show/hide) at run time for this column.

� Display Sequence: The value determines the order in which the columns 
show in the spreadtable.

� Display Width: Set the width (in pixels) of the displayed column. 

4. Select the Alignment and Formatting tab, and enter the following:

� Header Alignment: Select, from the LOV, either Center, End, Right, or Start.
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� Cell Alignment: Select, from the LOV, either Center, End, Right, or Start.

� Display Type: Select, from the LOV, either Check Box, Hyperlink, Text, or 
Image.

� Display Format: (Optional) Select, from the LOV, either Currency, Date, or 
Date Time.

5. Select the Custom Format Masks and Mappings tab.

� Column Alias: The column alias field is filled automatically.

� Check box Mappings: These options apply only if the display type field in 
the Alignments and Formatting tab is set to Check Box.

* Checked: Select this check box to represent a column value as a selected 
check box, not its corresponding image. 

* Unchecked: Select this check box to represent a column value as an 
unselected check box, not its corresponding image. 

* Other: Select this check box to represent a column value as neither 
checked nor unchecked.

� Format Mask: Use this column to set how columns with a datatype of 
Number display data. For example, a spreadtable can display data values as 
a percent.However, you should set this only in rare cases. 

� Image Description Column: Uses this column as a tool tip for an image. 
For every column defined as image, if the Image Description Column is not 
Null (left blank), then both the View Column and the Image Description 
Column are retrieved. If it is left blank, then only the View Column is 
retrieved. Users can position mouse over an image to see the image 
description information if it is specified.

� Currency Column: Uses this column to point to the database View Column 
where the currency code for the current column is stored. This applies only 
if the display format is set to Currency. 

6. Select the Sort Order tab, and perform the following:

� Choose the Primary Sort key from the LOVs. 

� You can optionally select a second or third Sort key from the LOV.

7. Click the Save icon on the toolbar. (The icon looks like a floppy disk.)

8. Select the Test tab, and click Test. Your table appears. You can customize your 
spreadtable display or copy and export data if necessary.
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12.2 Setting Profile Options
Images are used in the spreadtable to improve usability. These include displaying 
images in grid column headers, header popup, row header images in the grid, grid 
popup, checkbox images, custom images, and long wait images.

While these images improve the visual effectiveness of the spreadtable they do not, 
in reality, contribute to its functionality and hence, can be removed if needed. 

Use the following profile options to control whether or not any of these images are 
visible:

� JTA_GRID_DISPLAY_IMAGES (JTA Display images in the grid)

This profile option is a global setting, which can be overridden by setting the 
following profile options.

� JTA_GRID_DISPLAY_CHEADER_IMAGES (JTA Display images in grid 
column headers) 

� JTA_GRID_DISPLAY_HEADER_POPUP_IMAGES (JTA Display header popup 
images)

� JTA_GRID_DISPLAY_RHEADER_IMAGES (JTA Display row header images in 
the grid)

� JTA_GRID_DISPLAY_GRID_POPUP _IMAGES (JTA Display grid popup 
images)

� JTA_GRID_DISPLAY_CHECKBOX_IMAGES (JTA Display checkbox images)

� JTA_GRID_DISPLAY_CUSTOM_IMAGES (JTA Display custom images)

� JTA_GRID_DISPLAY_LONGWAIT_IMAGES (JTA Display long wait images)

Note: The browser must be restarted for changes to these settings 
to take effect.
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Table 12–2 Spreadtable Profile Options

Name
Default 
Value Level Description Outcome

JTA Display images 
in the grid

Null User This profile options 
sets whether or not 
images are visible in 
the spreadtable. (This 
is a global setting, 
which can be 
overridden by setting 
the following profile 
options.)

Possible values are 
Null, Yes, or No.

If Null (left blank), the value is treated as 
Yes.

If set to Yes, all images are visible. This is 
a global setting for all spreadtable 
images.

If set to No all images are turned off. 

JTA Display images 
in grid column 
headers

Null User This profile options 
sets whether or not 
column header 
images are visible in 
the spreadtable. 

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all column header images are 
visible. 

If set to No all column header images are 
turned off.

JTA Display header 
popup images

Null User This profile options 
sets whether or not 
header popup 
images are visible in 
the spreadtable. 

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all header popup images are 
visible. 

If set to No, all header popup images are 
turned off.

JTA Display row 
header images in 
the grid

Null User This profile options 
sets whether or not 
row header images 
are visible in the 
spreadtable. 

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all row header images are 
visible. 

If set to No, all row header images are 
turned off.

JTA Display grid 
popup images

Null User This profile options 
sets whether or not 
grid popup images 
are visible in the 
spreadtable. 

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all header popup images are 
visible. 

If set to No, all header popup images are 
turned off.
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JTA Display 
checkbox images

Null User This profile options 
sets whether or not 
images in cells 
defined as check 
boxes are visible in 
the spreadtable.

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all check box images are 
visible. 

If set to No, an asterick (*) is used for 
True and Null (blank) for False

JTA Display 
custom images

Null User This profile options 
sets whether or not 
custom images in 
cells defined as 
"Image" are visible in 
the spreadtable.

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all cell images are visible. 

If set to No, the image description is used 
in place of the image.

JTA Display long 
wait images

Null User This profile options 
sets whether or not 
long wait images are 
visible in the 
spreadtable.

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all long wait images are 
visible. 

If set to No, no long wait images are 
visible.

Note: See Appendix A, Profiles Options, for details on how these 
profile options can be set.

Table 12–2 Spreadtable Profile Options

Name
Default 
Value Level Description Outcome
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Implementation Overview

This chapter provides an overview of the Assignment Manager implementation 
process.

13.1 Overview
Assignment Manager is a tool used to select qualified resources and to designate 
them to a document or a task. It is also used to assign ownership to a document or a 
task. Assignment Manager is accessed from other modules and applications, and 
does not function as a stand-alone module. It supports all resource categories 
defined in Resource Manager.

13.2 Steps
This section provides an overview of the required steps for implementing 
Assignment Manager. Detailed instructions for these steps are contained in the 
chapter that follows.

13.2.1 Verifying the TCF Server is Correctly Installed and Running
The implementor or system administrator verifies that the TCF (Thin Client 
Framework) server is installed and functions properly. The Thin Client Framework 
Server connects to Scheduler and aids the Gantt chart to display and render 
information.

Note: Documents can be leads, opportunities, service requests, 
defects, or escalations. Once a document is created, it can require 
multiple tasks to fulfill the requirements.
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13.2.2 Setting Profile Options
After verifying that the TCF server installed and running properly, the implementor 
or system administrator must set the required profile options for Assignment 
Manager. Profile options enable Assignment Manager to retrieve preferred resource 
information including scheduling options.

13.2.3 Verifying Additional Setup Dependencies
Assignment Manager does not operate as a standalone application but is integrated 
with other components from the e-Business suite and from ERP (Enterprise 
Resource Planning). As a result, the implementor or system administrator must 
verify that all of the following components are installed and configured properly to 
operate with Assignment Manager:

� Territory Manager

� Forms-based Calendar

� Service Request

� Oracle Contracts 

� Installed Base

13.2.4 Configuring Color Coded Tasks
Assignment Manager uses different colors to identify scheduled functions such as 
shifts, assigned tasks, escalations, and available time slots when a planned time 
period is indicated by the calling application. In addition to providing a default set 
of colors that denote available times slots for specific functions, Assignment 
Manager also enables implementor and administrators to configure their own color 
coded functions. This feature simplifies the operation of applications that require 
intensive manual tasks to assign resources. For example, a support representative 
using a support or service application can easily determine the availability of 
qualified technicians to answer a support call if their shifts, tasks, and availability 
are denoted by color.

13.2.5 Customizing the Assignment Manager UI
Assignment Manager is used by different applications each of which generally 
requires a limited subset of its total available fields and options. For this reason, 
when implementing Assignment Manager, the implementor or system 
administrator can customize its UI based on their application requirements. The 
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Assignment Manager UI can be customized to meet the individual requirements of 
the following applications:

� Tasks

� Service Requests

� Service Request Tasks 

� Escalations

13.2.6 Setting Up Enhanced Planning Options
Assignment Manager enables you to configure time planning options that use the 
SYSDATE and TIME functions to indicate the start of a shift instead of defaulting to 
the task’s start date. This is useful in situations where the task’s start date precedes 
the date and time in which the shift is assigned and consequently predates the 
resource’s shift assignment. Enhanced planning options are configured using the 
JTFAM:Use systime for Assignments profile option which is set to Yes or No at the 
site level. When set to Yes, the profile option enables the SYSDATE and TIME 
functions to determine the start of a shift. When set to No, the profile enables the 
task start date and time to represent the start of a shift.

Note: If patch FND.D or higher is installed, do not perform the 
TCF verification steps listed above. They are not necessary. Instead, 
consult Note: 164766.1, available on MetaLink.
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Implementation Tasks for Assignment

Manager

This chapter covers the following topics:

� Setting Up the TCF Servers for Gantt

� Setting Profile Options

� Setting Up Other Dependencies

� Configuring Color Coded Tasks

� Customizing the Assignment Manager UI

� Setting Up Enhanced Planning Options

14.1 Setting Up the TCF Servers for Gantt
Assignment Manager uses Gantt to display tasks that are assigned, available, or 
escalated and for scheduling. The Thin Client Framework (TCF) server must be 
running and correctly configured for Gantt to display information and render it 
properly.

14.1.1 What is a Gantt Chart?
A Gantt chart displays tasks or other time bound entities in relation to their 
associated resources and is typically used for scheduling purposes. A manager can 

Note: Setting up the TCF servers is only required if you are using 
the Gantt chart in the Intelligent and the Window to Promise 
options or using the Field Service product.
nt Manager 14-1



Setting Up the TCF Servers for Gantt
use a Gantt chart to view a team’s current workload. Based on this information, the 
manger can make real-time decisions about task assignments, or can adjust and 
reassign tasks. A Gantt chart can only display and render information properly if 
the TCF server is running and is correctly configured.

Gantt charts are used by the following CRM modules:

� Field Service (Dispatch Center)

� Assignment Manager

14.1.2 What is the TCF Server?
The Thin Client Framework (TCF) server is a middle tier process that enables some 
Oracle Applications user interface Java components to communicate with the 
middle tier and database tier. The following CRM user interface Java components 
use the TCF server to communicate the middle tier and database tier:

� Field Service Scheduler

� JTF Gantt Chart

� JTF Assignment Manager

The TCF server process should always be running in a production installation. 

The Socket Server Class
The TCF server uses the Socket Server class (in the oracle.apps.fnd.tcf package) to 
handle incoming connections. Administration of the TCF server is typically handled 
through the ServerControl class (in the same package), which basically provides a 
clean interface around all the different TCF server functions that an administrator 
might perform (for example, starting, stopping, updating, and other similar tasks). 
Oracle recommends using the ServerControl class for most purposes.

Proxy Objects and Dispatchers

TCF is comprised of the following:

� A pair of Dispatcher classes which own the network connection

Note: The order and list of parameters for the ServerControl class, 
and the SocketServer class are not the same. Refer to the 
Administering the TCF Server (11i) documentation for a complete list. 
You can access this document on Metalink (Note 123689.1).
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� An interface called Proxy which enables an object to use the TCF network 
connection

� An Item class which serializes data for transmission

Generally, the client application or applet creates a number of Proxy objects at the 
same time, and then requests the Dispatchers to connect these objects to peer objects 
on the middle tier. During this process the following occur:

� Proxies are implemented in pairs, one for the client, and one for the middle tier. 

� The Dispatchers maintain a list of connected proxy pairs and handle the routing 
of messages. 

� Proxies communicate by writing messages to a buffer maintained by a 
Dispatcher, and then instructing the Dispatcher to send these messages. 

� Several proxies can share a round trip by waiting to call "send" until after each 
has had an opportunity to write its messages. 

� The Dispatchers deliver these messages by invoking the read Item method of 
Proxy.

14.1.3 Configuring the TCF Servers

Configuring the TCF servers is a complex process with specific prerequisites. The 
following table lists the required steps and sequence for configuring the TCF server.

Note: If patch FND.D or higher is installed, do not perform the 
TCF configuration steps listed. They are not necessary. Instead, 
consult Note: 164766.1, available on MetaLink.

WARNING: These instructions for implementing the TCF servers 
are NOT valid if the AOL TCF Server patch (bug # 1699404) has 
been installed. 

This patch is owned by the Oracle Applications Object Library 
(AOL). Contact AOL support for issues with this patch.
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14.1.3.1 Step 1: Installing any Required Patches
Begin configuring the TCF server by installing any patches required for the correct 
performance of your system.

Patch 135908
You must apply patch 135908 if you have set up the Oracle Applications to use 
HTTP protocol for communicating between a client browser and Oracle Forms and 
TCF servers.

135908 HTTP mode fails with: "java.io.IOException: Invalid HTTP Packet 
received" when using TCF APIs.

Patch 1473057
You must apply patch 1473067 if you created the database using a non-US7ASCII 
and non-WE8ISO8859P1 character set.

1473057 NLS enabled JDBC drivers. This is required for non-US7ASCII and 
non-WE8ISO8859P1 character sets.

14.1.3.2 Step 2: Performing Post Install Steps
There are several post install steps that you need to perform after installing the 
patches listed in Step 1: Installing any Required Patches. These steps are described 
in this section.

Table 14–1 TCF Configuration Steps

Step Description

1 Apply any necessary patches.

2 Perform the necessary post-install steps.

3 Configure the servers.

4 Verify the server configuration.

5 Troubleshoot any subsequent problems

WARNING: If you have installed the TCF server on an IBM AIX 
machine, then you MUST perform the steps listed in the AIX Port 
Instructions section.
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Post Install Steps
The patches described in section Step 1: Installing Any Required Patches contain 
both client and mid-tier Java code. After applying any of these patches, perform the 
following steps:

1. Stop and start the TCF server. 

The TCF server does not pick up the latest code until it is bounced. 

2. Close the browsers on the client machines.

3. Clear out the JInitiator Jackie directory on the client machines.

4. Restart the client browsers. You must do this to force the regenerated JAR files 
to be downloaded after you apply the patch.

AIX Port Instructions
If the TCF server is installed on an IBM AIX machine, then you must also do the 
following:

1. Perform the port specific instructions provided in the JDBC 8.1.6 Release notes. 
These Release Notes can be found on Metalling, note 114464.1.

In addition to the environment variables specified in the JDBC release notes, 
you must update adovars.env with the following environment variable: 

   <JAVA_COMPILER> 

set to:

<NONE>

Omitting this step causes the problem described in bug 1510941 to occur, 
thereby causing the Gantt chart to fail.

2. Shut down the TCF server and restart it to force the changes to take effect.

14.1.3.3 Step 3: Configuring the Servers

In order for the TCF server and client to establish a connection over the network, 
you should set up the following using the same communication protocol. 

WARNING: Setting the communication protocol correctly is 
extremely critical. If this step is performed incorrectly, the 
client/server communication will not work.
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� Forms servers

� File appsweb.cfg

� TCF servers

The following table lists the valid communication protocols that you can use in 
setting up and starting the Forms and TCF servers.

Forms Servers
If starting the Forms server from the command line (on UNIX), then you must 
include the Forms "mode" argument:

f60ctl { start | stop } port=port_num pool=pool_num log=log_file 
mode={http|https|socket} exe=exe_name

Valid Forms modes are:

� http

� taps

� socket

File appsweb.cfg
Modify the appsweb.cfg file (usually found under $APPL_TOP/html/bin) so that it 
includes the following:

connectMode=<protocol>

The connect mode parameter must indicate the same protocol as that which you set 
for the Forms server. Again, valid protocols are:

� http

� https

� socket

Table 14–2 Communication Protocols

Forms Mode TCF Protocol

http HTTP

https SSL

socket SOCKETS
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TCF Servers
Configure the TCF servers to start and run in the same communication protocol 
mode as that which you set for the Forms servers and indicated in the appsweb.cfg 
file.

Configuring the TCF Server Protocol
For details on configuring TCF servers, refer to the Administering the TCF Server (11i) 
documentation for a complete list of the configuration settings. It is available on 
Metalink (Note 123689.1).

Starting the TCF Servers

Start the TCF server from the command line (on UNIX) using the following 
arguments:

jre oracle.apps.fnd.tcf.ServerControl [START|STOP|STATUS|UPDATE]
<portnumber|default=10021> [<param=value>]

Valid parameters are listed and described in the previously mentioned 
Administering the TCF Server (11i) documentation.

Note the following:

1. Oracle strongly recommends that you start the TCF server with the PROTOCOL 
parameter set to the same value that you set for the Forms mode argument, as 
described in the Forms servers section.

2. The DBC file parameter is required.

3. At server startup, the TCF:HOST and TCF:PORT profile options are updated 
with the information passed into ServerControl.

a. If the TCF server is started using HTTP protocol, then the TCF:HOST 
profile is prefixed with "http://".

b. If the TCF server is started using SOCKETS protocol, then the TCF:HOST 
profile is set without the "http://" prefix.

Note: Oracle Applications provide a script to start and stop a TCF 
server. Refer to the Installing Oracle Applications guide, section 
"Review Server Process Control Scripts" for the name and location 
of this file.
Implementation Tasks for Assignment Manager 14-7



Setting Up the TCF Servers for Gantt
14.1.3.4 Step 4: Verifying the Server Configurations
The following table lists the required steps for verifying that the servers are 
configured correctly.

Each of these steps is described in detail in the following sections.

Step 4a: Verify Mandatory Setups
Verify that you have correctly performed all the steps listed in the previous sections:

� Step 1: Installing any Required Patches

� Step 2: Performing the Post Install Steps

� Step 3: Configuring the Servers

If necessary, repeat any steps that were not performed correctly.

Step 4b: Verify TCF Host Name and Port Number
Perform the following steps to verify that the TCF host name and port number have 
been set correctly.

1. Log in to your Personal Home Page (PHP) and select the System Administrator 
responsibility.

2. In the Navigator, select Application > Menu.

The Menus window opens.

3. Select Diagnostics > Examine from the Help menu.

A password protect dialog box opens. 

Table 14–3 Steps to Verify Server Configuration

Step Action

4a Verify that the mandatory setup steps were performed correctly.

4b Verify the TCF Host Name and Port Number.

4c Verify the TCF Connection.

4d Verify that resources exist in the system.

4e Verify that the Assignment Manager is set up correctly.
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4. Enter a valid password. 

If necessary, contact your system administrator for a valid password. After the 
password is authenticated, the Examine Field and Variable Values window 
opens.

5. Enter the following search parameters:

� Block: $PROFILES$

� Field: TCF:HOST

The Value field should now display the host name of the TCF server.

a. If the TCF server is started using HTTP protocol, then the host name must 
be prefixed with "http://." If this is not the case, then one of the following 
has occurred:

– The TCF server was not started in HTTP mode.

– The SocketServer class was used instead of ServerControl class to start the 
TCF server.

– The system level TCF:HOST profile has been overridden at the application 
or user level.

– The system level TCF:HOST profile has been manually changed on the 
system level.

b. If the TCF server is started using the SOCKETS protocol, then the host 
name must not be prefixed with "http://."

If the ServerControl class (not the SocketServer class) is used to start the TCF 
server, then it automatically sets the system level profile options. These profile 
option values can also be set manually at the system, application, or user level 
in Forms through the Profile menu, using the System Administrator 
responsibility.

6. Perform a new search, changing the value of Field to TCF:PORT.

WARNING: Exercise extreme caution if you manually change 
these values. Setting these values incorrectly may cause the 
Oracle Applications client code to not be able to establish a 
connection to the TCF server.
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The Value field should reflect the number of the port on which the TCF was 
started.

Step 4c: Verify the TCF Connection
Using the Menu Tree Viewer, perform the following steps to verify that the TCF 
connection is working properly:

1. Log in to your Personal Home Page (PHP), if you are not already there, and 
select the Application Developer responsibility.

2. Select Application > Menu.

3. Query up the JTF_NAVIGATE Menu item.

a. Select View > Query by Example > Enter.

b. Enter JTF_NAVIGATE in the Menu field.

c. Select View > Query by Example > Run.

The Menus window populates with the information.

4. Click View Tree.

You should see a tree like structure that corresponds to the Navigator hierarchy 
for the CRM Administrator responsibility. 

If you get an error after clicking View Tree, then the TCF Server has not been set up 
properly. The error may read - The application was unable to establish a network 
connection with the TCF SocketServer listening on port: <#####> on host: http:/// 
Please contact your system administrator.

Step 4d: Verify Resources Exist
Perform the following to verify that resources are available in the system.

Note: If you are unable to establish a TCF connection, then a 
generic TCF setup problem could exist. Contact your System 
Administrator or Oracle Support representative to resolve the issue. 
Until this issue is resolved, Gantt will not work properly.

The Menu and View Tree forms are owned by the Oracle 
Application Object Library (AOL). It could be that this is an issue 
that needs to be resolved within that context.
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Log on as the APPS user using SQL*Plus and run the following SQL statement. This 
returns resources that you can use to query in the Assignment Manager: Unassisted 
mode:

SELECT jtf_task_utl.get_owner(r.resource_type ,r.resource_id) 
       resource_name
      ,r.resource_id
      ,r.resource_type
      ,o.name -- This is a descriptive name of the resource type
FROM ( select resource_id
      ,decode(category,'EMPLOYEE','RS_EMPLOYEE'
      ,'PARTNER','RS_PARTNER'
      ,'SUPPLIER_CONTACT','RS_SUPPLIER'
      ,'PARTY','RS_PARTY'
      ,'OTHER','RS_OTHER') resource_type
FROM jtf_rs_resource_extns) r
      ,jtf_objects_vl o
      ,jtf_object_usages u
WHERE r.resource_type  = o.object_code
AND o.object_code      = u.object_code
AND u.object_user_code = 'RESOURCES';

The result of running this query is a list of the defined resources that you can use to 
verify that the Gantt chart is set up correctly.

Step 4e: Verify the Assignment Manager Setup
Perform the following steps to verify that all the installation and setup steps for the 
Oracle Common Application Components Assignment Manager have been 
performed correctly.

Note: Refer to the Oracle Common Application Components User 
Guide, and the Oracle Common Application Components 
Implementation Guide for details on setting up and configuring the 
Resource Manager

Note: Refer to the Oracle Common Application Components User 
Guide, and the Oracle Common Application Components 
Implementation Guide for details on setting up and configuring the 
Assignment Manager.
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1. Log in to your Personal Home Page (PHP) and select the CRM Administrator 
responsibility.

2. In the Navigator menu, select Task and Escalation Manager > Manage 
Escalations.

3. Enter sample text into the Escalation Summary field.

4. Click Assign.

The Assignment Manager window opens.

5. Select the Unassisted option button.

6. In the Resource Partial Name field, enter the first few letters from one of the 
names returned by the SQL statement in the previous section (Step 4d: Verify 
Resources Exist) and suffix the name with a percent "%" character.

7. Click Search.

� If the Gantt and TCF servers are working and have been set up correctly, 
then you will see the resource name at the left side of the Gantt chart. If the 
Forms-based Calendar module is defined correctly, then you also see Shifts 
(yellow background color) and Tasks (blue and red bars). 

For a task to be visible, it must exist, and have a scheduled start date and 
end date that fall within the visible time range, and be assigned to a 
resource.

� If an "APP-JTF-210807: No Resources Found. Please Try Again." message is 
returned, then you have entered a name that does not exist, or alternatively 
there may be a problem in Assignment Manager.

� If nothing is returned, check the JInitiator Console Window for exceptions.
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Step 5: Troubleshoot Any Subsequent Problems 
If any subsequent problems develop in configuring the TCF Server, consult the 
Assignment Manger Troubleshooting Chapter for more information.

14.2 Setting Profile Options
The following table lists the profile options used for implementing Assignment 
Manager. You can set these options in any sequence.

Note: Another reason for no resource found could be caused by:

Patch 1883463 was applied and enable TCF to run as a servlet. Files 
zone.properties and jserv.properties were configured incorrectly. 

Resolution:

1. The file zone.properties under the Apache install configuration 
directory (/Apache/Jserv/etc) should include the lines:

servlets.default.initArgs=FND_
TOP=servlets.startup=oracle.apps.fnd.tcf.SocketServer 

2. The file jserv.properties (also under /Apache/Jserv/etc) should 
include the lines: wrapper.classpath=<8.0.6 oracle 
home>/forms60/java/f60srv.jar 

Table 14–4 Assignment Manager Profile Options

Name
Default 
Value Level Description Outcome

Activate Auto 
Selection of 
Resources

Yes Application This profile option is set to activate 
the auto-selection of resources by the 
Assignment Manager engine. The 
engine uses this profile option setting 
to determine where the user needs to 
make a selection from the provided 
list of resources, or if this task is 
performed automatically by the 
Assignment Manager engine itself.

If you set this profile 
option to No, the 
Assignment 
Manager engine will 
automatically make 
a selection from the 
provided list of 
resources.
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Activate Contracts 
Preferred 
Resources

No Application This profile option is set to retrieve 
the preferred resource information 
from the Contracts module. The 
engine uses this profile option setting 
to determine whether the Contracts 
Preferred Engineers are picked up 
automatically by the Assignment 
Manager engine or not.

If you set this profile 
option to No, it will 
uncheck the 
Contracts check box 
in the Assignment 
Manager.

Activate Installed 
Base Preferred 
Resources

No Application This profile option is set to retrieve 
the preferred resource information 
from the Installed Base module. The 
engine uses the profile option setting 
to determine whether the Installed 
Base Preferred Engineers are picked 
automatically by the engine.

If you set this profile 
option to No, it will 
uncheck the 
Installed Base check 
box in the 
Assignment 
Manager.

Activate Workflow 
Name

No 
default 
value

Application This profile option is set to a 
user-defined workflow procedure 
name. This workflow procedure is 
user-programmed code for further 
filtering the resources. The engine 
retrieves the procedure name from 
this profile option, and uses it to 
process the user’s request.

This profile option is 
an additional filter 
based on the user’s 
criteria.

JTFAM: Resource 
Type for Unassisted 
Mode

Employee 
Resource

Site This profile option sets the default 
value for resource type in the 
unassisted mode.

This profile option is 
a convenience to the 
user who wants the 
resource type to be 
the defaulted value 
in the unassisted 
mode.

Table 14–4 Assignment Manager Profile Options

Name
Default 
Value Level Description Outcome
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JTFAM:Use systime 
for Assignments

Yes Site This profile option enables the start 
time for a resource’s shift to be 
determined by either the SYSDATE or 
the start date and time of the relevant 
task.

When set to Yes, the 
Assignment 
Manager uses the 
SYSDATE and TIME 
functions to 
determine the start 
of a resource’s shift.

When set to No, 
Assignment 
Manager uses the 
task start date and 
time to determine 
the start of the shift

Table 14–4 Assignment Manager Profile Options

Name
Default 
Value Level Description Outcome
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JTFAM: Resource 
Search Order

Contracts 
Preferred 
Resource

Site This profile option sets the default 
order for resource selection between 
Contracts and Installed Base if both 
check boxes are selected in the 
Assignment Manager for a service 
request assignment. 

If Contracts 
Preferred Resource 
is selected, then 
Assignment 
Manager engine 
checks Contracts 
preferred resources 
first. If a Contracts 
preferred resource is 
found, then stop the 
process. If not, then 
check the Installed 
Base preferred 
resources. If a 
Installed Base 
preferred resource is 
found, and stop the 
process. If not, then 
continue check the 
territories. 

If Installed Base 
Preferred Resource 
is selected, then 
Installed Base 
preferred resources 
are checked first, if a 
resource is found, 
then stop the 
process. If not, then 
continue check the 
Contracts. 

If "Both Contracts 
and Installed Base" 
is selected, then 
Assignment 
Manager checks 
both preferred 
resources 
simultaneously 
before retrieving 
qualified resources 
from winning 
territories.

Table 14–4 Assignment Manager Profile Options

Name
Default 
Value Level Description Outcome
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14.3 Setting Up Other Dependencies
The following components must be properly configured to ensure full use of the 
Assignment Manager selection criteria:

� Territory Manager retrieves qualified resources specified in territories. Make 
sure that transaction qualifiers are set up correctly and qualified resources are 
specified when defining territories. Territories should be set up properly in 
order to use the Assisted assignment option or the Intelligent and Window to 
Promise assignment options in the Field Service Dispatch Center.

� Forms-based Calendar displays the work shift information of qualified 
resources. Resources’ shift schedules should be defined in the Forms-based 
Calendar module in order to use the Resource Availability for the Assisted 
assignment option or the Intelligent and Window to Promise assignment 
options in the Field Service Dispatch Center.

JTFAM: Usage for 
Groups and Teams

All Site This profile option sets the default 
value for the group and team 
resource selection used in a service 
request assignment.

If it is set to All, then 
all group or team 
resources, regardless 
of its usage, are all 
displayed in the 
Gantt chart. If it is 
set to Support, then 
only the group or 
team with Support 
usage can then be 
retrieved for a 
service request 
assignment.

Note: See Appendix A, Profiles Options, for details on how these 
profile options can be set.

Note: Log in with the CRM Administrator responsibility and 
select Calendar > Calendar Setup to access the calendar setup 
windows. 

Table 14–4 Assignment Manager Profile Options

Name
Default 
Value Level Description Outcome
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� Service Request designates a resource as Web available or unavailable. It 
assigns the resource Web availability by using the Territory Assisted assignment 
option and assigns resources by using the Intelligent and Window to Promise 
assignment options in the Field Service Dispatch Center. 

� Oracle Contracts specify preferred engineers defined in Contracts. This 
components enables the use of Contracts preferred resources in the Assisted 
assignment option or the Intelligent and Window to Promise assignment 
options in the Field Service Dispatch Center.

� Installed Base specifies preferred resources defined in Installed Base. This 
components enables the use of Installed Base preferred resources in the Assisted 
assignment option or the Intelligent and Window to Promise assignment 
options in the Field Service Dispatch Center.

14.4 Configuring Color Coded Tasks
Assignment Manager displays a resource’s tasks for a specified time period in the 
Gantt chart. The time period for each task is color coded according to a set of rules 
stored in the color configuration table. Each row in this table contains rules for a 
unique color values. Assignment Manager accesses a Task Manager table with 
seeded color values that can be retained in their original state or modified. You can 
also configure additional color values. When Assignment Manger obtains the list of 
tasks to display for a resource, the Assignment Manager engine calls the Tasks 
public API: JTF_TASK_CUSTOM_COLORS_PUB.GET_TASK_BGCOLORS. The API 
receives information about the task, task type, assignment status, and priority, and 
returns the background color value for each record in decimal format. The 
Assignment Manger UI interprets the color’s decimal value and displays it in 
standard color format.

14.4.1 Color Configuration Table
The attributes that determine a task color can be registered with those of the 
currently displayed color in the color configuration table. The following table 
contains the color configuration table columns and their corresponding attributes:
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Table 14–5 Assignment Manager Color Configuration Table

Column Function
Primary 
Key Mandatory Data Type

RULE_ID Provides a unique identifier 
for each rule.

Yes Yes Number

OBJECT_VERSION_NUMBER Maintains the revisions of 
each table row.

No Yes Number

COLOR_DETERMINATION_PRIORITY Provides a numeric value for 
determining the order in 
which the color will be 
evaluated by the 
GET_TASK_BGCOLORS 
procedure.

No Yes Number

TYPE_ID Identifies the task type. No No Number

PRIORITY_ID Determines the priority level. No No Number

ASSIGNMENT_STATUS_ID Determines the task 
assignment status.

No No Number

ESCALATED_TASK Specifies whether or not the 
task is escalated.

No No Varchar2(1)

BACKGROUND_COL_DEC Provides a decimal version of 
the color.

No Yes Number

BACKGROUND_COL_RGB Provides an RGB virions of 
the color.

No Yes Varchar2(12)

CREATED_BY Provides the identity of the 
individual who created the 
task color.

No Yes Number

CREATION_DATE Provides the date on which 
the task color was created

No Yes Date

LAST_UPDATED_BY Provides the identity of the 
individual who last updated 
data for the task color.

No Yes Number
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14.4.2 Seeded Color Configuration Data
Assignment Manger provides seeded data for red, golden yellow, and blue 
background colors. These colors represent specific functions based on the following 
business logic:

These colors can be used, modified, or flagged for nonuse as required but should 
not be removed from the color configuration table. If you do not want to use a 
seeded color, you must flag it for nonuse by setting the ACTIVE_FLAG column in 
the color configuration table to "N". If you modify seeded data, then it will not be 
overwritten by any subsequent patch installations. If, however, you do not modify 
seeded data, then it will be overwritten by the seed data of any subsequently 
installed patches. The following table contains Assignment Manager seeded color 
data information:

LST_UPDATE_DATE Provides the date on which 
the task color data was last 
updated.

No Yes Date

LAST_UPDATE_LOGIN Displays the login 
information of the last person 
to update the record.

No No Number

ACTIVE_FLAG Specifies whether the task 
color is active or not. If the 
task color is not active, then 
its information can be 
overwritten by subsequent 
patch installations.

No Yes Varchar2(1)

Table 14–6 Assignment Manager Seeded Colors

Color Function

Red Displays escalations.

Golden Yellow Displays shifts

Blue Displays assigned tasks.

Table 14–5 Assignment Manager Color Configuration Table

Column Function
Primary 
Key Mandatory Data Type
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14.4.3 Hard Coded Colors
In addition to providing seeded colors, Assignment Manager contains two hard 
coded colors that cannot be modified. These colors are reserved for specific 
Assignment Manager business logic and should not be duplicated in the color 
configuration table:

14.4.4 Guidelines
To properly configure color coded tasks in Assignment Manger you must adhere to 
the following guidelines:

14.4.4.1 Determining Task Color Per Resource
Assignment manager determines the task color for each resource. The color of 
multiple tasks can be determined in one API call, however, some applications such 
as Field Service determine the color by using an inline function call in a SQL 
statement. 

Table 14–7 Assignment Manager Seeded Colors Data

Color Configuration Table Column Red Data Golden Yellow Data Blue Data

RULE_ID 1 2 3

COLOR_DETERMINATION_PRIORITY 10 20 100

TYPE_ID Null Null Null

PRIORITY_ID Null Null Null

ASSIGNMENT_STATUS_ID Null 5 Null

ESCALATED_TASK Y N Null

BACKGROUND_COL_DEC 16711680 16776960 3342591

BACKGROUND_COL_RGB Red GoldenYellow Blue

ACTIVE_FLAG Y Y Y

Table 14–8 Assignment Manager Hard Coded Colors

Color Decimal Value Function

Green 44370 Displays available time slots.

Yellow 16776960 Task assignments that are in status 
Working.
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14.4.4.2 Evaluating Color Prioritization
Each record in the color configuration table contains rules for displaying a unique 
task color. The GET_TASK_BGCOLORS procedure evaluates these rules for each 
row in ascending order beginning with the row that contains the lowest value in the 
COLOR_DETERMINATION_PRIORITY column. When creating or modifying 
colors, consider the order in which you want them evaluated and insert values in 
the COLOR_DETERMINATION_PRIORITY column accordingly.

14.4.4.3 Creating Values for the RULE_ID Column
The RULE_ID column must contain unique sequential values. This is accomplished 
by using the sequence JTF_TASK_CUSTOM_COLOR_S.

14.4.4.4 Creating Values for the COLOR_DETERMINATION_PRIORITY Column
The value of the column COLOR_DETERMINATION_PRIORITY must be a unique 
number between 0 and 100.

14.4.4.5 Creating Values for the LAST_UPDATED_BY Column
If seed data is modified, then the value of column LAST_UPDATED_BY should be 
set to a value other than 0 and 1.

14.4.4.6 Using Unique Colors for Each Function
If you use the same color to represent availability, shifts, task load, or escalations 
you will not be able to differentiate between each function. For this reason, each 
function must be represented with a unique color.

14.4.4.7 Using Different Background and Foreground Colors
If you use identical background and foreground colors it will be difficult to infer if 
the colors actually correspond to a given task. Because Assignment Manger 
currently does not perform validation for separate background and foreground 
colors, it is the implementor’s responsibility to ensure that they are not identical.

14.4.4.8 Reserving Assignment Manager Hard Coded Colors
Do not create custom color values for the hard for the green and yellow hard coded 
colors that ship with Assignment Manager.
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14.4.5 Examples
This section contains examples for creating two new task colors to denote high 
priority and low priority tasks that have been rejected. In this example, the 
implementor wants the high priority rejected tasks to be evaluated and displayed in 
Assignment Manger before the low priority rejected tasks.

14.4.5.1 Creating Violet Color for High Priority Rejected Tasks
Assume that the implementor creates a record for the color DarkViolet that 
represents high priority rejected tasks. The following table contains data for the 
color DarkViolet that is used to denote high priority rejected tasks. Since the value 
in the COLOR_DETERMINATION_PRIORITY column is 5, the rules for this task 
color will be evaluated by the GET_TASK_BGCOLORS procedure before any task 
color with a value in this column of 6 or higher.

SQL Script
The following script creates a record for the DarkViolet color in the color 
configuration table:

SET SERVEROUTPUT ON
DECLARE
   l_rowid      ROWID;
   l_color_id   NUMBER;
BEGIN
   fnd_global.apps_initialize (

Table 14–9 DarkViolet Color Example Data

Color Configuration Table Column Violet Color Data

RULE_ID 101

COLOR_DETERMINATION_PRIORITY 5

TYPE_ID Null

PRIORITY_ID 1

ASSIGNMENT_STATUS_ID 4

BACKGROUND_COL_DEC 9400D3

ESCALATED_TASK N

BACKGROUND_COL_RGB DarkViolet

ACTIVE_FLAG Y
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      user_id => 100001746, -- login user id 
      resp_id => 0,  --- responsibility id
      resp_appl_id => 0,
      security_group_id => 0
   );

   SELECT jtf_task_custom_colors_s.nextval
     INTO l_color_id
     FROM dual;

   jtf_task_custom_colors_pkg.insert_row (
      x_rowid => l_rowid,
      x_rule_id => l_color_id,   ---101
      x_color_determination_priority => 5,
      x_type_id => null,   
      x_priority_id => 1,
      x_assignment_status_id => 4,
      x_escalated_task => 'Y',
      x_active_flag => 'Y',
      x_background_col_dec => 9400D3,
      x_background_col_rgb => 'r148g000b211',  --DarkViolet
      x_creation_date => SYSDATE,
      x_created_by => fnd_global.user_id,
      x_last_update_date => SYSDATE,
      x_last_updated_by => fnd_global.user_id,
      x_last_update_login => 0
   );
END;
/
COMMIT;
EXIT;

14.4.5.2 Creating Lime Green Color for Low Priority Rejected Tasks
Assume that the implementor creates a record for the color LimeGreen that 
represents low priority rejected tasks. The following table contains data for the color 
LimeGreen that is used to denote low priority rejected tasks. Since the value in the 
COLOR_DETERMINATION_PRIORITY column is 7, the rules for this task color 
will be evaluated by the GET_TASK_BGCOLORS procedure after those of the high 
priority rejected task color in the preceding example.
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SQL Script
The following script creates a record for the LimeGreen color in the color 
configuration table:

SET SERVEROUTPUT ON
DECLARE
   l_rowid      ROWID;
   l_color_id   NUMBER;
BEGIN
   fnd_global.apps_initialize (
      user_id => 100001746, -- login user id 
      resp_id => 0,  --- responsibility id
      resp_appl_id => 0,
      security_group_id => 0
   );

   SELECT jtf_task_custom_colors_s.nextval
     INTO l_color_id
     FROM dual;

   jtf_task_custom_colors_pkg.insert_row (
      x_rowid => l_rowid,
      x_rule_id => l_color_id,   ---102
      x_color_determination_priority => 7,
      x_type_id => null,   
      x_priority_id => NULL,

Table 14–10 Lime Green Color Example Data

Color Configuration Table Column Violet Color Data

RULE_ID 102

COLOR_DETERMINATION_PRIORITY 7

TYPE_ID Null

PRIORITY_ID Null

ASSIGNMENT_STATUS_ID 4

ESCALATED_TASK N

BACKGROUND_COL_DEC 00FF00

BACKGROUND_COL_RGB LimeGreen

ACTIVE_FLAG Y
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      x_assignment_status_id => 4,
      x_escalated_task => 'Y',
      x_active_flag => 'Y',
      x_background_col_dec => 00FF00,
      x_background_col_rgb => 'r50g205b50',   --LimeGreen
      x_creation_date => SYSDATE,
      x_created_by => fnd_global.user_id,
      x_last_update_date => SYSDATE,
      x_last_updated_by => fnd_global.user_id,
      x_last_update_login => 0
   );
END;
/
COMMIT;
EXIT;

14.5 Customizing the Assignment Manager UI
The Assignment Manager UI can be customized to better suit the requirements of 
the applications with which it is integrated. These applications which include Tasks, 
Service Requests as well as Service Request Tasks, and Escalations generally require 
a limited subset of the total fields and options available in the Assignment Manager 
UI. Assignment Manager renders the UI based on seeded data in the table 
JTF_AM_SCREEN_SETUPS_B. When implementing Assignment Manager, you can 
customize its UI by modifying data in this table.

14.5.1 Table JTF_AM_SCREEN_SETUPS_B
 The following table describes JTF_AM_SCREEN_SETUPS_B including Who 
columns and Flex field columns. Columns directly related to modifying the 
Assignment Manager UI are indicated accordingly:

Table 14–11 Table: JTF_AM_SCREEN_SETUPS_B

Column Name Data Type Not Null Default Description

SCREEN_SETUP_ID Number N N UI Related. Specifies the unique ID for 
the table.

DOCUMENT_TYPE Varchar2(30) N N UI Related. Specifies the document 
from which Assignment Manager is 
called, such as SR (Service Request). 
This will be unique for the table.
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MODE_ASSIST Varchar2(1) N Y UI Related. Determines whether or not 
the UI displays the Assisted mode radio 
button. Valid values are Y/N.

MODE_UNASSIST Varchar2(1) N Y UI Related. Determines whether or not 
the UI displays the Unassisted mode 
radio button. Valid values are Y/N.

CONTRACTS Varchar2(1) N Y UI Related. Determines whether or not 
the UI displays the Contracts checkbox. 
Valid values are Y/N.

INSTALLED_BASE Varchar2(1) N Y UI Related. Determines whether or not 
the UI displays the Install Base 
checkbox. Valid values are Y/N.

TERRITORY Varchar2(1) N Y UI Related. Determines whether or not 
the UI displays the Territories checkbox. 
Valid values are Y/N.

AVAILABILITY Varchar2(1) N Y UI Related. Determines whether or not 
the UI displays the Resource Availability 
checkbox. Valid values are Y/N.

DOC_DETAILS Varchar2(1) N UI Related. Determines whether or not 
the UI displays Document Details. Valid 
values are Y/N.

WINDOW_WIDTH Number N 7 UI Related. Determines the width of the 
window for the Assignment Manager 
screen in inches.

WINDOW_HEIGHT Number N 5 UI Related. Determines the height of the 
window for the Assignment Manager 
screen in inches.

WINDOW_X_POSITION Number N 0 UI Related. Specifies the Assignment 
Manager screen position's X 
co-ordinates.

WINDOW_Y_POSITION Number N 0 UI Related. Specifies the Assignment 
Manager screen position's Y 
co-ordinates.

DOC_DTLS_USER_VALUES Varchar2(1) N N UI Related. Provides the Products team 
the flexibility to customize what the UI 
displays in the Document Details 
section. Valid values are Y/N. This 
setting only works if the 
DOC_DETAILS column is set to Y. 

Column Name Data Type Not Null Default Description
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SHOW_SELECTED_TIME Varchar2(1) N Y UI Related. Determines whether or not 
the UI displays the selected resource's 
start and end time. Valid values for this 
column are Y/N.

OBJECT_VERSION_NUMBER Number Y N The object version number.

USER_ID Number N N The user ID.

ATTRIBUTE1 Varchar2(150) N N Flex field.

ATTRIBUTE2 Varchar2(150) N N Flex field.

ATTRIBUTE3 Varchar2(150) N N Flex field.

ATTRIBUTE4 Varchar2(150) N N Flex field.

ATTRIBUTE5 Varchar2(150) N N Flex field.

ATTRIBUTE6 Varchar2(150) N N Flex field.

ATTRIBUTE7 Varchar2(150) N N Flex field.

ATTRIBUTE8 Varchar2(150) N N Flex field.

ATTRIBUTE9 Varchar2(150) N N Flex field.

ATTRIBUTE10 Varchar2(150) N N Flex field.

ATTRIBUTE10 Varchar2(150) N N Flex field.

ATTRIBUTE12 Varchar2(150) N N Flex field.

ATTRIBUTE13 Varchar2(150) N N Flex field.

ATTRIBUTE14 Varchar2(150) N N Flex field.

ATTRIBUTE15 Varchar2(150) N N Flex field.

ATTRIBUTE_CATEGORY Varchar2(150) N N

CREATED_BY Number Y N

CREATION_DATE Date Y N

LAST_UPDATED_BY Number Y N

LAST_UPDATE_DATE Date Y N

LAST_UPDATE_LOGIN Number Y N

SECURITY_GROUP_ID Number N N

Column Name Data Type Not Null Default Description
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14.5.2 Supported Document Types
Assignment Manager supports document types in FND_LOOKUPS
(LOOKUP_TYPE = JTF_AM_DOCUMENT_TYPE) as follows:

14.5.3 UI Layout Rules
The Assignment Manager UI must be customized according to a specific set of 
rules. These rules specify how the UI is rendered and which columns in the table 
JTF_AM_SCREEN_SETUPS_B contain information that is based on the values of 
other columns in this table.

14.5.3.1 Document Type
The document type must be unique across the table. A unique constraint is enforced 
using a unique index on the DOCUMENT_TYPE column. Based on the 
DOCUMENT_TYPE data passed in the new AM_UI_TYPE parameter in forms, the 
UI is rendered accordingly. If no data is passed in the AM_UI_TYPE parameter, then 
the UI is rendered based on value of the existing AM_CALLING_DOC_TYPE 
parameter.

14.5.3.2 Assisted and Unassisted Mode
Assignment Manager displays the Mode window and its corresponding options 
depending on the value of the MODE_ASSIST and MODE_UNASSIST columns 
based on the following rules:

Table 14–12 Assignment Manager Supported Document Types

Document Type Definition

SR Service Request

TASK Tasks

SR_TASK Service Request Task

ESC Escalations

DEF Defects

LEAD Leads

OPPR Opportunities

ACC Accounts
Implementation Tasks for Assignment Manager 14-29



Customizing the Assignment Manager UI
Assisted Mode
In case of assisted mode, at least one of the following search options should be 
enabled in the table:

� Contracts

� Installed Base

� Territories

� Availability

If for example, the value of the MODE_ASSIST column is 'Y' then at least one of the 
preceding four values must also be 'Y'.

14.5.3.3 Intelligent and Window to Promise modes
Because the Intelligent and Window to Promise modes are not supported in the post 
11.5.6 version of the Assignment Manager UI, neither one can be customized.

14.5.3.4 Document Details 
Document Details can be customized based on the values entered in the 
DOC_DETAILS and DOC_DTLS_USER_VALUES columns according to the 
following rules:

Table 14–13 Assisted and Unassisted Mode Rules

MODE_UNASSIST MODE_ASSIST Remarks

N N Both the modes cannot be set to 'N' at the same 
time. If this combination is set for any document 
type then the UI will not be rendered when called 
for that document.

N Y 1. Mode window will not appear.

2. Only Assisted Mode's corresponding fields will 
be shown.

Y N 1. Mode window will not appear.

2. Only Unassisted Mode's corresponding fields 
will be shown.

Y Y The UI will default to the existing UI layout and 
will show both Assisted and Unassisted modes as 
well as their corresponding field.
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Record Type JTFAMSR.DOC_DETAILS_REC_TYPE
The calling document can only customize the Document details section and display 
a set of name/value pairs in that section, if the 
JTFAMSR.DOC_DETAILS_REC_TYPE is populated with the appropriate values. 
The record type is defined as follows:

TYPE DOC_DETAILS_REC_TYPE IS RECORD_TYPE
 (
Field_prompt1varchar2 (20):= NULL,
Field_value1varchar2 (150) := NULL,
Field_prompt2varchar2 (20):= NULL,
Field_value2varchar2 (150) := NULL,
Field_prompt3varchar2 (20):= NULL,
Field_value3varchar2 (150) := NULL,
Field_prompt4varchar2 (20):= NULL,
Field_value4varchar2 (150) := NULL,
Field_prompt5varchar2 (20):= NULL,
Field_value5varchar2 (150) := NULL
)

Table 14–14 Document Details Rules

DOC_DETAILS DOC_DTLS_USER_VALUES Remarks

N N/Y The UI will not show document details at all. 
It will disregard the values entered for 
DOC_DTLS_USER_VALUES column.

Y N 1. Document Details will be displayed.

2. The content of Document details will be the 
default layout content i.e. it will continue to 
display whatever it is displaying in existing 
version of AM UI. 

Y Y 1. Document Details will be displayed.

2. The content of Document details will be the 
name-value pairs passed to AM UI from the 
product team using record type JTF_ASSIGN_
PUB.DOC_DETAILS_REC.

3. If DOC_DTLS_USER_VALUES is set to Y 
but no data is passed in record, then the 
document details box will be displayed with 
null value.
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14.5.3.5 Selected Resource Details 
When a user double clicks a resource from the list of resources, it is selected for 
assignment and the Resource Details fields subsequently contain the following:

� Resource Name

� Resource Type

� Start Time

� End Time

The Start Time and End Time display is determined by the value in the value 
SHOW_SELECTED_TIME column according to the following rules:

14.5.3.6 Width and Height
The width and height of the Assignment Manager window is specified according to 
the following rules:

� The value of the WINDOW_WIDTH and WINDOW_HEIGHT columns cannot 
be a negative number or 0. When a negative number or 0 are entered as the 
value of these columns, Assignment Manager uses the default window size 
values.

� When valid values are populated in these columns, the Assignment Manager UI 
either resizes accordingly or reverts to the default values of 7 inches for width 
and 5 inches for height.

14.5.3.7 Window Position
The position of the Assignment Manager window is specified according to the 
following rules:

� The value of the WINDOW_X_POSITION and WINDOW_Y_POSITION 
columns cannot be negative.

Table 14–15 Start Time and End Time Display Rules

SHOW_SELECTED_TIME Remarks

N The UI will show only Resource Name and Resource 
Type.

Y The UI will show Resource Name, Resource Type, Start 
Time, and End Time.
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� If no values are specified for the WINDOW_X_POSITION and 
WINDOW_Y_POSITION columns, they revert to the default value of 0

14.5.4 Customization Guidelines
The Assignment Manager UI must be customized according to specific guidelines.

14.5.4.1 Add Required Values to LAST_UPDATED_BY Column
When customizing the Assignment Manager UI, the implementor or System 
Administrator should always update the LAST_UPDATED_BY column with the 
appropriate user ID. Customized rows must not have values of 0 or 1 in the 
LAST_UPDATED_BY column, otherwise the data will be lost when a new patch is 
applied.

Example
In the following example, text marked in bold will change depending on the value 
added by the implementor or system administrator. The LAST_UPDATED_BY 
column contains an appropriate values that is neither 0 or 1:

UPDATE     JTF_AM_SCREEN_SETUPS_B
SET           mode_assist= 'N'
        , last_update_date = sysdate
 , last_updated_by = 100
, object_version_number = object_version_number + 1
        WHERE document_type = 'TASK'
/

14.5.4.2 Populate the LAST_UPDATED_BY Column with the Required Sequence
To insert the data in the table JTF_AM_SCREEN_SETUPS_B, the sequence 
JTF_AM_SCREEN_SETUPS_S.NXTVAL should be used for SCREEN_SETUP_ID 
column. For inserts in the table, the data MUST be entered in both JTF_AM_
SCREEN_SETUPS_B and JTF_AM_SCREEN_SETUPS_TL tableS.

14.5.4.3 Modify Assignment Manager UI Seeded Data as Required
Seeded data for the Assignment Manger UI is stored in the tables 
JTF_AM_SCREEN_SETUPS_B and JTF_AM_SCREEN_SETUPS_TL. To customize 
the Assignment Manager UI, you must modify the seeded data as required. The 
following tables list the seeded Assignment Manager UI values for each calling 
document:
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Table 14–16 Assignment Manager UI Seeded Data in JTF_AM_SCREEN_SETUPS_B 

Columns Tasks Service Request Escalations
Service Request 
Tasks

SCREEN_SETUP_ID 1 2 3 4

DOCUMENT_TYPE TASK SR ESC SR_TASK

MODE_ASSIST Y Y Y Y

MODE_UNASSIST Y Y Y Y

CONTRACTS Y Y Y Y

INSTALLED_BASE Y Y Y Y

TERRITORY Y Y Y Y

AVAILABILITY Y Y Y Y

DOC_DETAILS Y Y Y Y

WINDOW_WIDTH 7.7 7.7 7.7 7.7

WINDOW_HEIGHT 6.4 6.4 6.4 6.4

WINDOW_X_POSITION 0 0 0 0

WINDOW_Y_POSITION 0 0 0 0

DOC_DTLS_USER_
VALUES

N N N N

SHOW_SELECTED_TIME Y Y Y Y

CREATED_BY 1 1 1 1

CREATION_DATE 1-OCT-02 1-OCT-02 1-OCT-02 1-OCT-02

LAST_UPDATED_BY 1 1 1 1

LAST_UPDATE_DATE 1-OCT-02 1-OCT-02 1-OCT-02 1-OCT-02

OBJECT_VERSION_
NUMBER

1 1 1 1
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14.5.5  Examples
This section provides examples of customizing the Assignment Manager UI for 
different calling documents. 

14.5.5.1 Service Request
When the calling document is a Service Request, the default Assignment Manager 
UI includes the Assisted Mode and Unassisted Mode radio buttons, the Start Time 
and End Time fields, as well as the default Document Details fields.

Table 14–17 JTF_AM_SCREEN_SETUPS_TL

Columns Tasks Service Request Escalations
Service Request 
Tasks

SCREEN_SETUP_ID 1 2 3 4

PREFERENCE_NAME Default Task Default Service 
Request

Default 
Escalations

Default Service 
Request Task

CREATED_BY 1 1 1 1

CREATION_DATE 1-OCT-02 1-OCT-02 1-OCT-02 1-OCT-02

LAST_UPDATED_BY 1 1 1 1

LAST_UPDATE_DATE 1-OCT-02 1-OCT-02 1-OCT-02 1-OCT-02

SOURCE_LANG US US US US

LANGUAGE US US US US
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Figure 14–1 Default Service Request Screen

Since the Assisted Mode and Unassisted Mode radio buttons, the Start Time and 
End Time fields, are not required by the Service Request application, you can 
modify the table JTF_AM_SCREEN_SETUPS_B to render the Assignment Manager 
UI without these features. You can also modify the Document Details section with 
your own custom fields. The following SQL script customizes the Assignment 
Manager UI in this manner:

UPDATE jtf_am_screen_setups_b
SET     mode_unassist            = 'N'
      ,doc_dtls_user_values = 'Y'
      ,show_selected_time   = 'N'
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      ,last_updated_by          = 123 -- userid of user who is updating 
      ,last_update_date         = SYSDATE
      ,object_version_number= object_version_number + 1
WHERE  document_type = 'SR'

Figure 14–2 Customized Service Request Screen

Note: Changing the DOC_DTLS_USER_VALUES column 
enables you to display custom fields in the Document Detail 
section. These fields will not appear, however, unless you populate 
the 
JTFAMSR.DOC_DETAILS_REC_TYPE with the appropriate 
name/value pairs.
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14.5.5.2 Service Request Task
When the calling document is a Service Request Task, the default Assignment 
Manager UI includes the Assisted Mode and Unassisted Mode radio buttons.

Figure 14–3 Default Service Request Task Screen

Since the Assisted Mode and Unassisted Mode radio buttons are not required by the 
Service Request application, you can modify the table 
JTF_AM_SCREEN_SETUPS_B to render the Assignment Manager UI without these 
features. The following SQL script customizes the Assignment Manager UI in this 
manner:
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UPDATE jtf_am_screen_setups_b
SET     mode_unassist            = 'N'
      ,last_updated_by          = 123 -- userid of user who is updating 
      ,last_update_date         = SYSDATE
      ,object_version_number= object_version_number + 1
WHERE  document_type = 'SR_TASK'

Figure 14–4 Customized Service Request Task Screen

14.5.5.3 Escalations UI
When the calling document is an Escalation, the default Assignment Manager UI 
includes the Assisted Mode and Unassisted Mode radio buttons, the Start Time and 
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End Time fields, selection criteria for Contracts, Install Base, Territories, and 
Resource Availability as well as the Document Details fields.

Figure 14–5 Default Escalations Screen

Since the Assisted Mode and Unassisted Mode radio buttons, the Start Time and 
End Time fields, selection criteria for Contracts, Install Base, Territories, and 
Resource Availability as well as the Document Details fields are not required by the 
Escalations application, you can modify the table JTF_AM_SCREEN_SETUPS_B to 
render the Assignment Manager UI without these features. The following SQL 
script customizes the Assignment Manager UI in this manner:
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UPDATE jtf_am_screen_setups_b
SET     mode_assist                = 'N'
,contracts    = 'N'
,installed_base    = 'N'
,territory    = 'N'
,availability    = 'N'
,show_selected_time   = 'N'
,doc_details    = 'N'
      ,last_updated_by          = 123 -- userid of user who is updating 
      ,last_update_date         = SYSDATE
      ,object_version_number= object_version_number + 1
WHERE  document_type = 'ESC'

Figure 14–6 Customized Escalations Screen
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14.5.6 Backward Compatibility
For any document type not defined in the table JTF_AM_SCREEN_SETUPS_B, 
Assignment Manager uses its default values. A calling document can insert data 
into JTF_AM_SCREEN_SETUPS_B without altering the Assignment Manager UI, if 
it inserts the default values into the appropriate columns. For example, if the calling 
document inserts a new document type called DEFAULT_EXAMPLE into 
JTF_AM_SCREEN_SETUPS_B that retains the default UI settings, then the columns 
will contain the following values: 

The default values for a new document type appear in the table
JTF_AM_SCREEN_SETUPS_TL as follows:

Table 14–18 Backward Compatibility Data Example: JTF_AM_SCREEN_SETUPS_B

Column Name Column Value Description

SCREEN_SETUP_ID 1001 Specifies a unique screen setup ID.

DOCUMENT_TYPE DEFAULT_EXAMPLE The name of the new document type that contains 
the default Assignment Manager UI values.

MODE_ASSIST Y Retains the Assisted Mode radio button.

MODE_UNASSIST Y Retains the Unassisted Mode radio button.

CONTRACTS Y Retains the Contracts checkbox

INSTALLED_BASE Y Retains the Install Base checkbox

TERRITORY Y Retains the Territories checkbox

AVAILABILITY Y Retains the Resource Availability checkbox

DOC_DETAILS Y Retains the Document Details component.

WINDOW_WIDTH 7 Specifies the default window width of 7 inches.

WINDOW_HEIGHT 5 Specifies the default window height of 5 inches.

WINDOW_X_POSITION 0 Specifies no X coordinate for positioning the 
window.

WINDOW_Y_POSITION 0 Specifies no Y coordinate for positioning the 
window.

DOC_DTLS_USER_
VALUES

N Retains the default Document Details fields by 
disabling the ability to add custom fields.

SHOW_SELECTED_TIME Y Displays the Start Time and End Time fields.
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14.6 Setting Up Enhanced Planning Options
Assignment Manager enables you to configure time panning options that use the 
SYSDATE and TIME functions to indicate the start of a shift instead of defaulting to 
the task’s start date. Enhanced planning options are configured using the 
JTFAM:Use systime for Assignments profile option which is set to Yes or No at the 
site level. When set to Yes, the profile option enables the SYSDATE and TIME 
functions to determine the start of a shift. When set to No, the profile enables the 
task start date and time to represent the start of a shift.

14.6.1 Examples
The following cases provide examples of setting up backward planning in 
Assignment Manager.

14.6.1.1 Case 1
Case 1 assumes that the current SYSDATE value is 15 Aug 2003, 10:00:00. A 
resource, R1 is assigned a calendar for the month August 2003, with shifts starting 
from 8 am to 6 pm everyday of the week. 

Step 1: Assign a Resource and shift to a Calendar
Assign Resources and shifts to a calendar by performing the following:

� Create a calendar by performing the following:

� Creating a Calendar called Test Cal using the Define Calendar Form.

� Create a Shift called Test Shift using the Define Shifts Form. Shift should have 
working hours from Monday to Friday. Start time should be 8 am, duration 10 
hours.

Table 14–19 JTF_AM_SCREEN_SETUPS_TL Sample Data

Column Name Column Value Description

SCREEN_SETUP_ID 1001 Specifies a unique screen setup ID.

PREFERENCE_NAME User's Preference Name Specifies the user’s preference name.

SOURCE_LANG US Specifies the source language

LANGUAGE US Specifies the language.
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� Assigning the Resource R1 to the calendar Test Cal from 1st August 2003 to 30th 
December 2003, using the Assign Resource to Calendar form.

� Assigning Test Shift to the calendar Test Cal using the Assign Shift/Exception 
form.

Step 2: Assign the Resource to a Territory
Assign resource R1 to a territory where Task Priority = High. To accomplish this, 
navigate to Territory Manager -> Territory Administration and enter the following 
values:

� Territory = Service Request and Task

� Transaction Qualifier = Task Priority

� Value = High

� Resource assigned = R1

Step 3: Create the Service Request
Create Service Request SR1 with Task T1 using the Create Service Request form 
available with the Customer Support responsibility:

� Planned Start time for T1 = 1st Jan 2003,08:00:00

� Planned End Date = 30th Aug, 2003, 08:00:00 

� Duration = 2 Hours.

Step 4: View the Results in Assignment Manager
Invoke the Assignment Manager form by clicking the icon adjacent to the Assignee 
filed for the Service Request Task. Ensure that the Territories check box is selected 
while the remaining check boxes are not selected. Assignment Manager will 
perform the following:

� Search for Resource R1's availability from 15 Aug 2003, 10:00:00 to 29 Aug 2003, 
10:00:00.

� Display resource R1 rendering the shifts in yellow and the first available slot in 
green.

� Double clicking the resource will select the resource, which can be returned to 
the SR Task by clicking OK.

� Assignment Manager will return resource R1, from 15 Aug 2003, 10:00:00 to 15 
Aug 2003, 12:00:00.
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14.6.1.2 Case 2
Create a calendar and assign shifts in the same manner as Case 1, Step 1 and 
consider the following:

� SYSDATE = 15 Aug 2003, 10:00:00

� Resource R1 has been assigned a calendar for the month August 2003, with 
shifts starting from 8 am to 6 pm everyday of the week.

� R1 is assigned to a territory for Task Priority = High.

� Service Request SR1 has a Task T2. Planned Start time for T2 is 1st Aug 2003, 
10:00:00and Planned End Date is 25 Aug 2003, 10:00:00 for duration = 2 Hours.

Assignment Manager will search for Resource R1's availability from 15 Aug 2003, 
10:00:00 to 29 Aug 2003, 10:00:00, since the range from 29th Aug 2003, 10:00:00 - 15th 
Aug 2003 10:00:00 is greater than the range 25th Aug 2003, 10:00:00 - 15th Aug 2003 
10:00:00.

Assignment Manager will subsequently return 15 Aug 2003, 10:00:00 to 15 Aug 
2003, 12:00:00.

14.6.1.3 Case 3
Create a calendar and assign shifts in the same manner as Case 1, Step 1 and 
consider the following:

� SYSDATE = 15 Aug 2003, 10:00:00

� Resource R1 has been assigned a calendar for the month August 2003, with 
shifts starting from 8 am to 6 pm everyday of the week.

� R1 is assigned to a territory for Task Priority = High.

� Service Request SR1 has a Task T3. Planned Start time for T3 is null, Planned 
End Date is null and for duration = null.

Assignment Manager will search for Resource R1's availability from 15 Aug 2003, 
10:00:00 to 29 Aug 2003, 10:00:00 for a duration of 1 Hour and will return 15 Aug 
2003, 10:00:00 to 15 Aug 2003, 11:00:00.
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Troubleshooting Assignment Manager

This chapter covers the following topics:

� Assignment Manager

– Common Implementation Errors

– Error Messages

– Additional Tips for Assignment Manager

� Gantt

– Troubleshooting Tips for Gantt

– Frequently Asked Questions (FAQs)

15.1 Common Implementation Errors for Assignment Manager
In order to use the full functionality of the Assignment Manager selection criteria, 
Assignment Manager depends on other setup tasks outlined in the section of   
Setting up other dependencies. 

This section contains information on some of the common implementation errors 
associated with implementing Assignment Manager.

15.1.1 Unable to Find Resources
Action: Use the following solutions to return resources:

� Verify If Territories Are Set Up Correctly

� Recompile JTF_SEEDED_QUAL_USGS_V View

� Delete Duplicate Qualifiers
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15.1.1.1 Verify If Territories Are Set Up Correctly
1. Create new territories for your testing and have a test plan.

For example, Which territories and resources should be returned? This will help 
in debugging real problems.

2. Make sure that territories are ranked correctly. Territory Manager uses rank to 
determine the picking order for territories.

3. Make sure that you have the correct transaction types defined for the territories. 
If you want a territory to be used for service request and task, then make sure 
you have "Service Request" and "Task" as transaction types. If a territory is used 
for a task created within a service request, then you need to select "Service 
Request and Task" as the transaction type.

4.  Make sure that you have resource(s) attached to the territory.

Rules of Territories: If there are no resources attached to a territory and the 
effective dates are active, then the territory will be considered a place holder 
territory. That is, it will not qualify as a winning territory.

5. Make sure that you have given the right access to resources, if you have decided 
to make use of the Access Type feature.

For example: A "CA Territory" with transaction types "Service Request" and 
"Task". If you add a resource "John Doe" and select "Service Request" only in the 
Access Type field, then even if this territory qualifies for a task assignment, it 
will not return the resource "John Doe", since he does not have "Task" access 
type selected, but "Service Request" access only. 

However, if the Access Type field is left blank, then this resource is eligible for 
receiving both task and service request assignments. Notice that this resource 
will not be selected for a task assignment created within a service request 
because the transaction type "Service Request and Task" is not selected in the 
Overview tab when defining the territory.

6. Make sure that you run the Generate Territory Package concurrent program 
once you are satisfied with your territory setup and updates. Unless you do 
this, changes will not take effect.

Note: If you make changes to territories, make sure that you run 
the Generate Territory Package concurrent program to reflect the 
changes made to the territories.
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7. Make sure to delete and re-attach the resources again to the territories that have 
resource roles added later in the Resource Manager after territory creation.

For a resource attached to a territory, we store the resource-id, resource type, 
and role associated with that resource. However, for few of them, the role is 
blank (NULL), as there was no role defined in Resource Manager at the time 
you created the territory. But at some point later, someone added roles to these   
resources in Resource Manager and then the Territory stopped returning these 
resources as there was no corresponding record in Resource View (Join Failed). 
In order to fix the problem, you need to delete and re-attach the resources to the 
territory.

The API will return the resource, but the role will be blank even though you 
may see a role in Resource Manager for that resource.

8. Make sure that TCF server is up and running by using the script - adtcfctl.sh 
stop/start.

15.1.1.2 Recompile JTF_SEEDED_QUAL_USGS_V View
Ask your database administrator to recompile the form where Assignment Manager 
is invoked if an error message FRM-92000:ORA:1403 occurs. This refreshes the view 
so that data could be populated in JTF_SEEDED_QUAL_USGS_V view.

15.1.1.3 Delete Duplicate Qualifiers
It is possible that all of the territory qualifiers were duplicated. 

Action: Clear the duplicate Transaction Type field in the Overview tab and 
manually delete duplicate qualifiers. Test this action first by copying one of the 
existing territories and then use the following steps to delete duplicate qualifiers:

1. Log in with the CRM Administrator responsibility. Select Territory Manager > 
Territory Administration to open the Navigator window.

2. Open your territory and clear one of the duplicate transaction types in the Type 
field on the Overview tab.

3. Select the Transaction Qualifiers tab and manually delete one of the duplicate 
qualifiers.

4. Save your changes.

5. Close the Territory Details window and then re-open it.

6. Click the Transaction Qualifiers tab and see if there are still have duplicated 
qualifiers.
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7. Repeat the previous steps for all territories.

15.1.2 Displaying Start and End Date Time Incorrectly for a Selected Resource
The Assignment Manager displays the start and end date/time incorrectly for a 
selected resource. 

Cause: This will happen on all 11i CRM products if Oracle Inventory setup steps 
aren’t performed properly. 

Action: Use the following steps for resolution: 

1. In the Task tab of the Service Requests window, select Hour in the Planned 
Efforts field.

2. Click the Assignment Manager icon in the Task tab of the Service Requests 
window to launch the Assignment Manager.

3. In the Document Details region of the Assignment Manager window, make sure 
that you see "HR" populates in the Duration field after the number information, 
such as 9 "HR" for 9 hours.

If you do not see "HR" as the value in the Duration field, then follow the given 
steps to set up correct units of measure information: 

a. Log in with the Inventory Superuser responsibility. Select Setup > Units of 
Measure > Units of Measure. 

b. Choose your organization. 

c. Query for Time in the Class field. 

d. Add the following record:

* Enter Hour-Task in the Name field.

* Enter HR in the UOM field.

* Enter Hour-Task in the Description field.

* Leave the Base Unit field bank.

* Enter Time in the Class field.

Note: The Units of Measure (UOM) "HR" is the only value used 
for task assignment.
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e. Save the record. 

After changing the setting of UOM, use the following steps for verification:

f. In the Task tab of the Service Requests window, select Hour-Task in the 
Planned Efforts field. 

g. Try to assign this task to a resource using Assignment Manager. In the 
Document Details region of the Assignment Manager window, make sure 
that you see "HR" populates in the Duration field after the number 
information.

4. Double-click the resource that you want to assign to a task.

5. Verify if the start and end date/time information are properly displayed in the 
Assignment Manager window as you expected. 

15.1.3 Returning Individual Resources for a Group Owner
Cause: This problem can be caused by the following reasons:

� The selected group resource does not have Support group usage defined in 
Resource Manager.

� After selecting a group type in the Service Requests window, your cursor is not 
placed in the Group Owner field so that the Assign Group button is not 
enabled. Therefore, click Assign Owner instead to launch the Assignment 
Manager.

Background Analysis: When Assignment Manager tries to retrieve group or team 
resources, it checks the usage value (such as Support usage) set in the JTFAM: 
Usage for Groups and Teams profile option. Based on the value (Support usage), 
Assignment Manager then searches for the matched groups or teams with the same 
usage identified in Resource Manager. Those matched group or team resources can 
then be displayed in the Assignment Manager. However, if there is no Support 
usage specified in Resource Manager for any groups or teams, then Assignment 
Manager returns no group resource. 

Additionally, make sure to position your cursor in the Group Owner field after 
selecting a group type so as to enable the Assign Group button. Otherwise, the 
Assign Owner is enabled if your cursor is in the Owner field. Click Assign Group 
to launch Assignment Manager to retrieve group resources.

Action: Perform the following steps to set up Support group usage in Resource 
Manager:

1. Log in with the CRM Administrator responsibility.
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2. Select Resource Manager > Maintain Resources > Groups to open the Define 
Groups window. 

3. Query up your group first.

4. Select the Usages tab.

5. Use the LOV in the Usage field and select Support for the group usage.

6. Save your information.

15.2 Error Messages for Assignment Manager
This section contains information on some of the error messages associated with 
implementing Assignment Manager. 

15.2.1 APP-JTF-210807
APP-JTF-210807: No Resource Found. Please try again.

Cause: This error usually occurs because the territories are not set up correctly.

Action: Verify territory setup process by using the procedure outlined in the Verify 
If Territories Are Setup Correctly section.

15.2.2 FRM-92000:ORA:1403
FRM-92000: ORA:1403: No data found

Cause: This error occurs while invoking Assignment Manager. This may happen 
when data is missing from the JTF_SEEDED_QUAL_USGS_V view.

Action: Ask your database administrator to recompile the form where Assignment 
Manager is invoked. This refreshes the view so that data could be populated in JTF_
SEEDED_QUAL_USGS_V view.

15.3 Additional Tips for Assignment Manager
1. Assignment Manager supports the following resource categories used in 

Resource Manager: 

� Employees

� Parties

� Partners
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� Groups

� Teams

� Supplier Contacts

Refer to Resource Manager for detailed information on resource categories.

2. If the Unassisted assignment option is selected, predefined search criteria such 
as preferred resources, territories, and resource availability will not be available.

3. Shift schedules displayed in the Gantt chart with yellow background are 
defined in the Forms-based Calendar module. 

4. No end dated resources are selected in the Assignment Manager with the 
Unassisted and Assisted assignment options. All the resources that are 
displayed in the Assignment Manager are valid and active resources. 

15.4 Troubleshooting Tips for Gantt
In many cases, if the Gantt chart in the Assignment Manager window does not 
work properly, the problem stems from an incorrect configuration of the TCF server.

15.4.1 Common Issues
In general, problems with the configuration and setup of the Gantt chart fall into the 
following categories. They are:

� Gantt Chart Does Not Appear

� Cannot Connect To TCF Server

� No Resources Are Visible

Resolution If you are experiencing problems with the Gantt chart, then do the 
following:

1. First perform the steps listed under General Advice.

2. If this does not clear up the problem, then see the individual sections for the 
listed problems.

Note: If patch FND.D or higher is installed, first consult Note: 
164766.1, available on MetaLink.
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15.4.2 General Advice
The following items are general suggestions to follow in troubleshooting problems 
relating to the Gantt chart.

1. Clear out the JInitiator jcache directory, close and restart the browser, and try 
again. Old, cached JAR files could be causing the problem. 

2. Shut down and restart the TCF server. If a patch is applied, then the new code is 
not picked up by the runtime engine until the TCF server is restarted. 

3. Check the JInitiator Console Window for exceptions or informational messages. 
You can activate the Console Window by selecting the “Show Console” check 
box in the JInitiator Control Panel. You must then close and restart the browser. 

4. Ensure that there are no invalid objects in the database. You can use the 
adadmin utility for this purpose. 

5. If an invalid object is found, correct the problem, then make sure that the 
offending form is recompiled (along with its libraries). This can be done 
through the adadmin utility. 

6. If problems continue, then perform the steps listed in the following sections as 
appropriate:

� Gantt Chart Does Not Appear

� Cannot Connect To TCF Server

� No Resources Are Visible

15.4.3 Gantt Chart Does Not Appear
One of the most common problems is that a Form does not display the Gantt chart 
properly. One, or both, of the following symptoms can occur:

1. The Form displays an empty blue or gray area where the Gantt chart should 
reside.

WARNING: These instructions for implementing the TCF servers 
are NOT valid if the AOL TCF Server patch (bug # 1699404) has 
been installed. 

This patch is owned by the Oracle Applications Object Library 
(AOL). Contact AOL support for issues with this patch.
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2. The JInitiator console window throws a ClassNotFoundException, referring to 
classes in oracle.apps.jtf.gantt.

Causes The following are some of the possible causes for this condition:

1. The jtfgantt.jar file has not been downloaded onto the client machine. The 
JInitiator console window must include a line similar to the following: 

Opening http://<serverHost>/OA_JAVA/oracle/apps/jtf/jar/jtfgantt.jar no 
proxy 

It should not read: 

Unable to contact http://<serverHost>/OA_JAVA/<some path>/jtfgantt.jar 

2. Class files are missing from jtfgantt.jar or fndlist.jar.

3. An old version of jtfgantt.jar resides in the JInitiator jcache directory.

4. The appsweb.cfg file is customized and does not include an entry for /OA_
JAVA/oracle/apps/jtf/jar/jtfgantt.jar.

5. The appsbase.html file, or the HTML page used to launch applications, is 
customized and does not pick up the archive tag from appsweb.cfg.

15.4.3.1 Actions to Take
1. Clear out the JInitiator jcache directory on the client and restart browser. 

2. Verify that jtfgantt.lst is included in fndlist.jar. 

a. First take a copy of fndlist.jar, then rename it to fndlist.zip, and use Win Zip 
to open the file. 

b. Verify that jtfgantt.lst in fndlist.jar lists approximately 26 class files. 

3. Perform the actions described in step 2, but for jtfgantt.jar and verify that it 
contains the files listed in jtfgantt.lst.

4. Ensure that the JInitiator console window does not list any class files as being 
individually downloaded. 

If this is the case something is wrong in the installation. Class files should be 
downloaded within JAR files and nowhere else. 

5. If Actions 2 through 5 do not verify properly, then perform the following 
additional actions:

a. Force the regeneration of the FND and JTF JAR files through the adadmin 
utility. 
Troubleshooting Assignment Manager 15-9



Troubleshooting Tips for Gantt
b. Restart the Forms (web) listener and the Forms server. Clear out the 
JInitiator cache directory, and restart the browser.

c. Try Actions 2 through 5 again. 

6. Critical! Verify that all high priority FND (AOL) patches as listed in Metalink 
are applied. 

7. For the items listed as 4 and 5 in this section, launch the applications. In 
Netscape Navigator, select "View Source" and verify that /OA_
JAVA/oracle/apps/jtf/jar/jtfgantt.jar is included in the archive tag. 

If it is not included, then add the entry to files appsweb.cfg and appsbase.html.

15.4.4 Cannot Connect to TCF Server

There are several different errors that you could encounter when attempting to 
connect to the TCF server, and several different reasons each error could occur. 

In general, there are three basic types of errors that can affect server connection:

� The client application is unable to connect to the TCF server.

� The TCF server is unable to connect to the database.

� The application hangs upon connecting to the TCF server.

Each type of error is discussed in the following sections.

Unable to Connect to the TCF Server The standard error message for this is: 

"The application was unable to establish a network connection with the TCF 
SocketServer listening on port: <port> on host: <host>. Contact your system 
administrator." 

The exact message may vary slightly between versions and products.

You may also see the following:

"Unable to connect to dispatcher."

Note: If you are unable to establish a TCF connection, then a 
generic TCF setup problem could exist. Contact your System 
Administrator or Oracle Support representative to resolve the issue. 
Until this issue is resolved, Gantt will not work properly.
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Items to check:

� Was the TCF server ever started? 

The system administrator should be able to check if the process is running.

� What host and port names were used to start the server?

Verify that the profiles TCF:HOST and TCF:PORT on the client point to the TCF 
server to which you are trying to connect. The best way to check them is to use 
the Help > Diagnostics > Examine utility to check profiles just before launching 
the TCF application. Verify the user-level profiles, also, as well as the site-level 
profile options. See Step 4b: Verify the TCF Host Name and Port Number for 
details of this process.

� Is the TCF server host machine accessible from the client? 

 Open a TELNET to the host to see if it is reachable.

15.4.5 Unable to Connect to the Database
The standard error message for this is:

"The TCF SocketServer running at <host>:<port> was unable to make a JDBC 
connection to database <dbname>. This may reflect heavy load on the system, or 
a problem with the indicated database. If this problem persists, contact your 
system administrator."

You may also see the following:

"Unable to set context."

Items to check:

� Is there a ClassNotFoundException or OutOfMemoryError raised?

Check the server logs to see if either of these errors occurred. Sometimes a 
ClassNotFoundException or a OutOfMemoryError is raised while the server is 
attempting to connect will result in this error. The former are usually 
configuration issues, the latter suggests that it is advisable to start your TCF 
server with more memory. 

� Is the database actually up and running?

Try connecting from SQL*Plus to verify.

� Are you connecting using DBC files?
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For release 11.5 versions and above, it is now required that DBC files be used to 
connect to the database. The TCF server must be started with a new argument 
"DBC=", pointing to a .dbc file that should be located under $FND_TOP/secure. 
This command should read:

jre oracle.apps.fnd.tcf.SocketServer <port#> DBC=$FND_TOP/secure/xxx.dbc

It is important that the path to the .dbc file be specified. Because the TCF server 
can connect to multiple databases, it does not depend on the specific .dbc file 
you pass in, rather it relies on the path where those .dbc files are located to look 
up multiple .dbc files.

If the TCF server is not started with the DBC argument or it cannot find the .dbc 
file in the specified directory, this type of error might occur. Remember that the 
TCF server could be looking for a different .dbc file than that with which you 
started it. Check the server logs and see if it reports any errors while trying to 
load the .dbc file.

� Are the .dbc files properly formatted?

A similar type of error can also occur if the .dbc file was improperly formatted. 

A very common error to see on the server when this happens is:

ld.so.1: ... libocijdbc8.so: open failed: No such file or directory 
(libocijdbc8.so)

This indicates that the server is attempting to use the THICK JDBC drivers to 
connect to the database, which is not supported. Verify that the .dbc file 
specifies that the THIN drivers be used. The .dbc file must contain the line:

APPS_JDBC_DRIVER_TYPE=THIN

The .dbc file also needs to contain the following variables that identify the 
database to use:

DB_HOST=
DB_PORT=
DB_NAME=

These variables correspond to the database information in the tnsnames files. 
The THIN drivers cannot use the TWO_TASK to resolve the database name, 
you must provide this information explicitly. (The DB_NAME is actually 
optional if the TWO_TASK variable and database SID are the same, but it's 
good practice to use it, in any case.) 
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15.4.6 Application Hangs Upon Connecting to the TCF Server
Try connecting using the ServerControl class if hanging problems are reported. If it 
still hangs, then typically this indicates one of the following:

1. There is a bug in the code, or that there is an environment setup problem.

Check the debug output on the server to see if there is anything obvious that 
needs to be corrected, and check the bug database to see if this type of problem 
has been previously reported.

2. The wrong protocol was used to establish the connection.

Ensure the TCF server is speaking the same protocol as the client. Supported 
protocols are SOCKETS, HTTP, and SSL. The client must use the same protocol 
as the Forms server. 

3. The TCF server attempts to exit the loop in which it accepts connections from 
the client, but does not really do so.

This type of error is probably the most common. In release 11.5.2 and beyond, if 
the TCF server stops accepting connections from the client, then it closes the 
socket and exits immediately. 

Unfortunately, this does not explain why the TCF server stopped accepting 
connections in the first place. Determining the reason is a more involved 
process. One very possible reason is the TCF server ran out of memory. The 
most useful thing to do in this case is to check the debug output and see if any 
errors are logged.

15.4.7 No Resources Are Visible
If you experience problems with the proper display of resources in the Gantt chart, 
then perform the steps listed in the following table.

Table 15–1 Trouble Shooting the TCF Server

Tip Description

View the JInitiator console window 
error messages.

View the JInitiator console window error messages 
and the exceptions thrown.

Consult the TCF server log file. View the TCF server log file for relevant information.

Verify the TCF server status. Use the ServerControl class to check whether or not 
the TCF server is accepting connections on the host 
and port on which it was started.
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15.4.8  View the JInitiator Console Window Error Messages
The single most useful thing that you can do to do to troubleshoot server problems 
is check the JInitiator Console window on the client machine. Some debug 
information is output by default, and errors raised here are often very descriptive 
and give a good indication of what the problem is.

If that window is no longer available, then restart the browser, set the "Show 
Console" check box in the JInitiator control panel, and restart the application.

The following listed items are a few of the exceptions that can be thrown, and 
reported in the JInitiator Console window.

1. java.net.ConnectException: Connection refused

Usually this means that the TCF server is not running, or that the TCF:HOST / 
TCF:PORT profile options are pointing to a wrong server or port.

2. Gantt TCF HOST:<http://hostname> PORT:<port#>

This refers to the TCF:HOST/PORT settings passed into the Gantt chart.

As described in Step 4b: Verify the TCF Host Name and Port Number:

� If the host name is prefixed with "http://", then the client attempts to 
connect to the TCF server using the HTTP protocol. 

� If this prefix is missing, then the client attempts to contact the server using 
the SOCKETS protocol.

3. gantt: tcfSetAppsContext <filename>.dbc 

The <filename> listed in the error must exactly match the filename that was 
specified in the DBC parameter when starting the TCF server. If this is not the 
case, then rename the file to match that specified in the DBC parameter.

4. java.lang.ClassNotFoundException:javax.net.ssl.SSLSocket

The client side SSL libraries are meant to be included with JInitiator. However, 
in some older versions of JInitiator, this did not happen due to US export 
restrictions that have since been lifted. 

WARNING: If the TCF server and client do not use the same 
mode, then the client cannot establish a connection.
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If this exception occurs, then you must install the latest version of JInitiator 
(1.1.7.32 or higher). If necessary, contact Oracle Support for help with this step. 

5. java.io.EOFException     
.... < 3-5 lines of text>      at
oracle.apps.fnd.tcf.net.SocketServerConnection.readBigUTF(
SocketServerConnection.java)

This exception usually occurs after the client tries to connect to the TCF server 
using the wrong communication protocol. The message indicates that the 
TCF:HOST profile is not set correctly. Refer to Step 4b: Verify the TCF Host 
Name and Port Number for details.

6. gantt: addbar failed, resource not found (<Resource Type> - <Resource Id>)

One common cause for this exception is described in bug 1414546, which is 
dependant on the Forms-based Calendar bug 1415863 for resolution. If this is 
the case, then ensure that the resource does not have a Calendar Exception 
assigned that spans the entire duration of a shift.

7. java.net.UnknownHostException: <host>

This exception is thrown when the TCF:HOST profile is set to a server that is 
not recognized by the client. 

Verify that the TCF:HOST profile is set correctly, and that the client machine can 
access the server using the <host> displayed in the exception. 

One way to check is to open a DOS window (on a Microsoft Windows machine) 
and type in "ping <host>." If the host is inaccessible from the client, then the 
response returns a "Bad IP address <host>" message. 

15.4.9 Consult the TCF Server Log
You can view the TCF server log to obtain further information. To set up the log file 
for automatic logging, perform the following steps:

1. Add the following to the command line:

OUTPUTFILE=/tmp/<logfile>.log LOGLEVEL=STATEMENT

2. Bounce (stop and restart) the TCF server.

3. Run the application again.

4. Check the log file to see if there is anything in the log file that may indicate 
what the problem may be. 
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Errors of the following type can be due to bug 1510941. View the AIX Port 
Instructions, in the Step 2: Performing the Post Install Steps section for details 
on how to correct this problem.

java.lang.NullPointerException
at oracle.jdbc.oracore.OracleTypeNUMBER.unpicklerec(Compiled Code)
at oracle.jdbc.oracore.OracleType.unpicklerec(Compiled Code)
at oracle.jdbc.oracore.OracleTypeCOLLECTION.unpicklerec(Compiled Code
at oracle.jdbc.oracore.OracleTypeCOLLECTION.unpickle(Compiled Code)
at oracle.jdbc.oracore.OracleTypeCOLLECTION.unpickle(Compiled Code)
at oracle.jdbc.oracore.OracleTypeADT.unlinearize(Compiled Code)
at oracle.sql.ArrayDescriptor.length(Compiled Code)
at oracle.sql.ARRAY.length(Compiled Code)
at oracle.sql.ARRAY.getArray(Compiled Code)
at oracle.apps.jtf.gantt.server.GanttDataServer.getShifts

15.4.10 Verify the TCF Server Status
You can also use the ServerControl class to check whether or not the TCF server is 
accepting connections on the host and port on which it was started.

To do this, log onto the machine where it was started and run:

jre oracle.apps.fnd.tcf.ServerControl STATUS <port#>

One of the following can occur:

� If the result is some variant of "Unable to connect," the server most likely was 
not started properly. See: Cannot Connect To TCF Server and Unable to Connect 
to the Database for details of how to solve this problem.

� If the application hangs upon connecting, the server has stopped accepting 
connections for some reason and must be bounced. See Application Hangs 
Upon Connecting to the TCF Server.

� If you are able to connect from the ServerControl but not from an application, it 
might be an application-specific problem, or it may be that the client JAR files 
are not set up correctly. 

15.4.11 TCF Server and Forms Server Mode 
Make sure the TCF Server and Forms Server runs in the same mode (Socket or Http) 
to get the Gantt and Assignment Manager to work properly.

Resolution:
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To check what modes they are running in check the following files in the 
$COMMON_TOP/admin/scripts: 

adtcfctl.sh for TCF Server 

adfmsctl.sh for Forms Server (The Forms Server should run in the mode that is 
defined in appsweb.cfg) 

15.5 Frequently Asked Questions (FAQs)
The following are frequently asked questions. Answers to these questions may help 
you in troubleshooting problems with TCF Server.

15.5.1 How to Check the Status of the TCF Server? 
Answer: Execute the script ‘adtcfctl.sh status’ or use the server control class to check 
jre oracle.apps.fnd.tcf.ServerControl STATUS 

15.5.2 How Do I Start or Stop the TCF Server? 
If TCF Server is not running it could be the reason the Assignment Manager will not 
function properly 

Action: In Unix under $OAH_TOP/admin/script execute adtcfctl.sh stop/start.

Checking the TCF:HOST and TCF:PORT profile options 

What type of values should they contain? 

 Resolution:

a. If connectMode=http, set profile option TCF:Host to 'http://.' TCF:Host 
http://:/oa_servlets TCF:HOST is automatically updated to the same value 
as the APPS_SERVLET_AGENT Profile option. If the APPS_SERVLET_
AGENT profile contained a value ending with the virtual directory OA_
HTML, it should end with the name of a valid servlet zone.

b. If connectMode=socket, set profile option TCF:Host to just '.' -- omit 
'http://' 

c. Make sure that the profile option value of TCF:Port is the port that the TCF 
Socket Server is listening on. TCF:PORT -1.

Note: Remember to bounce the Apache Server after changes are 
made for the changes to take effect.
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Implementation Overview

This chapter provides an overview of the Task Manager implementation process.

16.1 Overview
Task Manager provides an effective mechanism for organizations to create tasks, 
assign resources to tasks, schedule tasks, and manage tasks, as well as to track task 
assignments.

Depending on your business needs, Task Manager can be used as a stand-alone 
module to create personal tasks and private to-dos, or it can be integrated with 
other applications in the e-Business Suite to create context sensitive tasks, such as 
tasks created for a sales opportunity. No matter how Task Manager is used, the 
implementation steps for Tasks would be the same.

In general, to implement Task Manager, the implementor or system administrator 
need to set up basic task components, such as task types, priorities, statuses, 
reference mapping, date types, profile options, concurrent programs, and metadata 
objects if necessary. If task templates or task template groups will be used later in 
the application, then the implementor can create them first so that users can have an 
option to create multiple tasks simultaneously. In addition, Task Manager allows 
implementor or system administrator to further customize the task security rules so 
that appropriate users can be authorized with right access privileges to particular 
tasks. 

Before implementing Task Manager, it is necessary to understand the following 
concepts:

� Setup Dependencies

� Forms-based and HTML Versions of Task Manager
 Overview 16-1



Steps
16.1.1 Setup Dependencies
To be able to use the full functionality of Task Manager, the following components 
must be set up properly:

� Trading Community Architecture (TCA). Use TCA to locate the customer 
contact information when creating a task against a customer.

� Oracle Workflow. Use Oracle Workflow to send workflow notifications in order 
to notify personnel about task creation and changes.

� Notes. Use Notes to add additional information attached to a task.

� Resource Manager. Use Resource Manager to locate resources (task owner and 
assignee) for a task.

� HTML Calendar. Use HTML Calendar to define personal preferences for tasks 
including task category and other calendar preferences. 

� Escalation Manager. Use Escalation Manager to escalate a task created in the 
Forms-based Task Manager. 

� Assignment Manager. Use Assignment Manager to assist in locating the 
qualified resources (task owner and assignee) for a task created in the 
Forms-based Task Manager.

16.1.2 Forms-based and HTML Versions of Task Manager
Task Manager was initially a Forms-based application, and was subsequently 
expanded to include an HTML version. A number of features are available in both 
versions; however, some features are available in only Forms or HTML. As a result, 
most of implementation steps for each version are nearly identical and performed in 
Forms. Additional steps that apply only to Forms or HTML version are discussed in 
the next section.

16.2 Steps
This section provides an overview of the required steps for implementing Task 
Manager including setting up basic task components, defining task templates, 
customizing HTML Task security, and troubleshooting Task Manager. Detailed 
instructions for these steps are contained in the subsequent chapters.

� Setting Up Task Manager

– Defining Task Types
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– Defining Task Status and Status Transition Rules

– Defining Task Priorities

– Defining Task Date Types (Forms only)

– Defining Task and Notes Reference Mapping (HTML only)

– Registering Mass Task Reassignment Window (HTML only)

– Setting Profile Options

– Running the Task Manager Concurrent Program

– Setting Up Metadata Objects

� Working with Task Templates (Forms only)

� Customizing HTML Task Data Security (HTML only)

� Troubleshooting Task Manager

16.2.1 Setting Up Task Manager
This chapter provides instructions for setting up essential task elements in the 
following topics:

16.2.1.1 Defining Task Types
In addition to the seeded task types, the implementor or system administrator can 
create new task types to specify the purpose of a task creation, such as a Follow-up 
task or an Appointment task. They can also map task types to a source object or a 
specific resource category. This way, users will see the task types that are mapped to 
the source object from the Task Type list of values when creating a task.

16.2.1.2 Defining Task Statuses and Status Transition Rules
The implementor or system administrator can create new task statuses to specify 
the progress of a task, such as Complete, or Work. In addition, to regulate task 
status change, the implementor or administrator can also set the status change rules 
and define appropriate rule access through responsibilities.

16.2.1.3 Defining Task Priorities
The implementor or system administrator can create additional task priorities to 
determine an importance rating for a task, such as Low, High, and Critical. In 
addition, like task types, task priorities can be mapped to a source object. This 
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allows users to see only the task priorities that are mapped to the source object from 
the Task Priority list of values when creating a task.

16.2.1.4 Defining Task Date Types (Forms only)
In addition to the planned, scheduled, and actual dates, the implementor or system 
administrator can create new date types for users to track task progress, such as 
setting a date for a major milestone (like task creation, or completion). Date Types 
can also be mapped to a source object. 

Users can see the additional date types shown in the list of values only in the Dates 
tab of the Forms-based Task Details window.

16.2.1.5 Defining Task and Notes Reference Mapping (HTML only)
 The implementor or system administrator can map reference types to a source 
object, such as Task Manager. This limits the selection of Reference Type list of 
values shown in the HTML Task Manager.

16.2.1.6 Registering Mass Task Reassignment Window (HTML only)
The functionality for performing mass reassign tasks is only available in the HTML 
Task Manager. Therefore, the implementor or system administrator must register 
the Task Mass Reassignment window in business flows if the HTML Task Manager 
is used.

16.2.1.7 Setting Profile Option
The implementor or system administrator must set necessary profile options used 
in Task Manager to set default values for task status, priority, types, as well as 
owner and assignee statuses. Other profile options determine the client time zone, 
unit of measure, data truncation, and task security access.

16.2.1.8 Running the Concurrent Program
In order to retrieve new and updated tasks from quick find search, the system 
administrator must run the Rebuilding Intermedia Index for Task Names 
concurrent program periodically.

16.2.1.9 Setting Up Metadata Objects
The implementor or system administrator can add additional data in the JTF objects 
table if necessary. For example, if a document (such as Service Request) is newly 
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defined or integrated with Task Manager, then the new document must be 
associated with Tasks usage. 

16.2.2 Working with Task Templates (Forms only)
The Forms-based Task Manager allows implementor or system administrator to 
create task templates or task template groups. Instead of creating tasks individually, 
users can have an option to create multiple tasks simultaneously based on a selected 
template or template group.

16.2.3 Customizing HTML Task Data Security
With the continuous support of the existing task security rules, HTML Task 
Manager leverages the Application Object Library (AOL) data security model to 
provide a flexible mechanism for task security access. The new security model 
allows the implementor or system administrator to customize task data, and then 
grant specific tasks to appropriate users or user groups with right access privileges. 
It includes customizing contextual task rules by using a profile option, building 
security around resource list of values, and allowing group managers to access his 
or her direct’s tasks.

This functionality only applies to the HTML Tasks, not the Forms-based Tasks.

16.2.4 Troubleshooting Task Manager
The troubleshooting chapter includes common implementation errors and 
frequently asked questions (FAQs) for implementing Task Manager.
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Setting Up Task Manager

This chapter covers the following topics:

� Defining Task Types

� Defining Task Statuses and Status Transition Rules

� Defining Task Priorities

� Defining Task Date Types

� Defining Task and Notes Reference Mapping

� Registering Mass Task Reassignment Window

� Setting Profile Options

� Running the Task Manager Concurrent Program

� Setting Up Metadata Objects

17.1 Defining Task Types
In addition to seeded task types, the system administrator can define new task 
types in the Forms-based Task module. 

The section covers the following topics:

� Defining Task Types

� Mapping Task Types to A Source Object

� Associating Task Types to Resources

� Enabling Task Workflows
 Manager 17-1



Defining Task Types
17.1.1 Defining Task Types
Task types are used to further classify tasks. For example, a task can be created 
relating to a meeting regarding a service request. It can be a follow-up task for a 
sales or a marketing campaign or a callback to an existing customer. The “Meeting,” 
“Follow up action,” and “Callback” can be the task type used to categorize similar 
tasks with the same creation purposes. 

After specifying the task type name, description, effective dates, unit of measure, 
and duration effort, the administrator can also specify appropriate type flags for the 
new types.

Please note that the Private task flag in the Forms-based version of Task Manager is 
not supported at this time. This functionality will be removed in a future release. 
The new HTML-based Task Manager does support both Private and Public tasks.

Task Rules
WARNING: Do not try to define new task rules. Task type rules that are available in 
the system (Field Service and Oracle Marketing) are the only rules that can be used 
in Task Manager.

You can modify or delete items that you created, but not those that are seeded.

17.1.2 Mapping Task Types to A Source Object
Use the task type mapping functionality to map task types to a source object. This 
limits the visibility of task types shown in the task type list of values for a mapped 
source object. After mapping types to a source, you will see only the mapped task 
types displayed in the list of values. All other unmapped types will not be in the 
list.

Table 17–1 Task Type Flag Definitions

Flag Description/Action

Notification This flag launches the notification workflow 
automatically if the auto notification check box is selected 
in forms, or the Notify check box is selected in HTML.

Schedulable This flag reserves the resource through the Scheduler.

Private This flag is reserved for future use.

Seeded This flag is seeded task type and is not editable.
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For example, after mapping task types to an object, you can only see the task types 
that are mapped to your source object displayed in the list of values. Any 
unmapped task types to your source object are now dynamically excluded from the 
lists. In addition, if none of the types is mapped to your source object, then you will 
see all task types from the list of values. Therefore, any user-defined task types need 
to be mapped to your source object. Otherwise, you will not see them from the list 
after defining them.

17.1.3 Associating Task Types to Resources
After defining your new task type, use the Resource Requirements window to 
associate a specific resource requirement that is necessary to complete a task with 
the specified task type. 

For example, you can associate employee resources with task type "CallBack". As a 
result, when assigning a task with type "CallBack", you will only see employee 
resources from the resources list of values.

17.1.4 Enabling Task Workflows
Task Manager contains one pre-defined workflow, JTFTASK, which is used to send 
workflow notifications automatically to notify personnel about task creation and 
changes. This workflow can also send notifications to employee resources, groups, 
and teams. If you do not want to use the default workflow process, you can define a 
new workflow for Task Manager by using Oracle Workflow. 

JTFTASK is automatically launched under the following circumstances:

� In HTML, the preferences are set to Yes in the Issue Notification drop-down list.

� The Task Type Notification flag is set to Y (Yes). 

� The Auto Notification flag in the Task window is set to Y (Yes).

� Task creations or updates use the task type with the Notification flag checked.

By turning on or off the Notification flag for each task type in the Task Types 
window, you can control whether or not tasks of that task type should launch a 
workflow process automatically. For more information, see Starting Workflow 
Processes.

If workflow fails to launch automatically, verify that both the task Auto 
Notification check box in the Tasks window and the Notification check box in the 
Task Types window are selected. If you do not set the workflow process, 
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notifications are not sent. The workflow is set using the standard applications 
concurrent manager.

Perform the following steps to define a new task type.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Task and Escalation Manager > Setup > Task Types.

Steps
1. Select File > New.

2. In the Task Types window, enter a name for the new task type.

3. Select from the list of values (LOV) in the Workflow field. This field is used to 
assign the workflow process to a task. 

The corresponding workflow process information populates the Task Workflow 
and Description fields. If you do not want to use the default process, you can 
define a new workflow process for JTFTASK using Oracle Workflow.

4. You can associate a task type with a seeded task rule but you cannot define new 
rule. You can only use seeded task rules in Task Manager.

5. Enter the effective dates in the From and To fields.

The Effective To field is read-only for seeded task types. This field is only active 
if you are defining a new task type.

6. Select a unit of measurement for effort from the UOM LOV. Options include 
day, hour, minute, month, week, and year.

Use a measure of time to determine the UOM value.

7. Enter a number for the quantity of effort in the Qty field.

Note: For more information on setting up Oracle Workflow, see 
the Oracle Workflow Administrator’s Guide 2.5.
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8. Select task type flags.

9. Select the Notification check box if you want notifications to be sent 
automatically when a task is created with the new task type.

Mapping Task Types to A Source Object

10. If you want the new task type to appear in the task type LOV for a specific 
source object, you must map the task type to that source.

a. Click Map Types in the Task Types window. 

The Mapping Objects window opens.

b. Select the source object from the list of values (LOV), for example, 
appointment.

c. Select the task type from the LOV, for example, critical.

d. Select the end date from the LOV.

e. Select the application from the LOV, for example, FND, Application Object 
Library.

f. The Seeded check box is not editable.

g. Click Save.

Associating Task Types to A Resource Type 

11. In the Task Types window, select the newly created task type and click 
Resource Requirement.

The Resource Requirements window opens.

12. Select a resource type from the list of values (LOV).

13. Enter the number of resources needed in the Required Units field.

Selecting the Enabled Flag activates the resource type for the corresponding 
task type.

14. Click OK.

The required resource information is saved with the task type and appears in 
the corresponding LOV in the user interface (UI) if enabled.

15. Save your task type.

See Also
� Defining Task Statuses and Status Transition Rules
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� Defining Task Priorities

� Defining Task Date Types

� Designing Task Templates

� Defining Template Details

� Setting Up Metadata Objects

� Defining Task and Notes Reference Mapping

� Setting Profile Options

� Running the Task Manager Concurrent Program

17.2 Defining Task Statuses and Status Transition Rules
Use the Forms-based Task Manager to define task statuses and status transition 
rules. Task statuses are used to define the progress of tasks, such as open, working, 
and completed. To be able to regulate task status change, Task Manager uses the 
Status Transition window to set the status change rules and to define appropriate 
rule for a specific application access through responsibilities. After defining the 
status transition rule, the implementor or system administrator must associate the 
profile option "Task Manager: Default Task Status" with the status transition rule. 
As a result, the default task status will match the status rule for a specific 
application.

The section covers the following topics:

� Defining Task Statues

� Defining Task Status Transition Rules

� Link the Profile Option "Task Manager: Default Task Status" to the Status 
Transition Rules

17.2.1 Defining Task Statuses
In addition to the seeded task statuses, the system administrator can use the 
Forms-based Task Manager to define new task statuses for specific business needs. 

After specifying the status name, description, effective dates, and status usage for 
Task, not Escalation, the administrator also needs to identify appropriate status 
flags for the new task status.

Please note that all seeded task statuses cannot be updated.
17-6 Oracle Common Application Components Implementation Guide



Defining Task Statuses and Status Transition Rules
17.2.2 Defining Status Transition Rules
Use task status transition rules to define the possible task status change rule for a 
task, as well as to define appropriate access to the rule through responsibilities.

For example, an open task (Open Status) can be assigned to a resource (Assigned 
Status) and then the assigned task can be closed (Closed Status) once the task is 
completed. However, the open task cannot be closed without first being assigned.

As each status change sequence is identified in a status transition rule, it limits the 
user’s selection of task statuses that appear in the list of status options. The rule also 
determines the type of resource that has access to each status type.

Table 17–2 Task Status Flag Definitions

Flag Description

Assignment 
Status

The status is displayed in the Assignment Status field.

Task Status The status is displayed in the Task Status field.

Assigned The task is assigned to a resource.

Working The task is in progress.

Schedulable The task can be used through Scheduler.

Accepted The task is accepted.

Rejected The task is rejected.

On Hold The task is currently not active.

Approved The task is approved.

Completed The task is completed.

Cancelled The task is cancelled.

Delete Allowed The task can be deleted without cancellation.

Closed The task is completed and closed.

Seeded The task status is pre-defined and cannot be updated.

Note: Refer to the Setting Escalation Status section for information 
regarding Escalation Manager.
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In addition to defining the status transition rules, you can also associate rules with 
certain responsibilities. As a result, a manager may have more privileges than an 
agent to access or change certain statuses, such as approved or cancelled, if defined 
in your rules. Only one transition rule can be mapped to a task.

Use the following two tabs to define your status transition rules:

� Rule tab: Use Rule tab to define the status transition rule name, its associated 
application, and status transition values.

For example, Oracle Field Service uses the status transition rule to regulate the 
status transition for a service request. Therefore, "Service Request Rule” can be the 
rule name, and it is associated with the Field Service Application. In addition, 
identify the appropriate status for the Current Status and Next Status for the rule. 
The Next Status field is used to define the task status that immediately follows the 
task status in the Current Status field.

� Responsibility tab: Use Responsibility tab to associate your rules with specific 
responsibilities. 

For example, after defining the “Service Request Rule”, you can associate it with the 
Field Service Dispatcher, Field Service Manager, or Customer Support 
responsibility. The Field Service Manager responsibility can also be associated with 
another transition rule if necessary. As a result, a field service manager may have 
more privileges than a support agent to access or change certain statuses, such as 
Approved or Cancelled, if defined in the rules. 

17.2.3 Link the Profile Option “Task Manager: Default Task Status” to Status 
Transition Rules 

In order for the state transitions to work, after defining the status transition rule and 
assigning it to the responsibility, make sure that you also set the value in the “Task 
Manager: Default Task Status” profile option to the initial state (the First Current 
State) of the rule at site, responsibility or user level.

For example, you define a rule and assign it to the CRM Administrator 
responsibility with the following values:

Note: Do not confuse the status transition rule that you define 
here with the task type rule. The task type rule can only be 
associated with the task type while defining a new task type.
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You must set the “Task Manager: Default Task Status” profile option to Open, the 
first current state of the rule.

If there are no rules assigned to a responsibility, then all the statuses will show up in 
the Status list of values. In this case, the value specified in the profile option will not 
necessarily be the initial state of a rule.

Perform the following steps to define a new task status.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Task and Escalation Manager > Setup > Task Status.

Steps
Defining a New Task Status

1. Select File > New to enter new task status in the Task and Escalation Status 
window.

2. Enter a task status name.

3. Enter a brief description of the task status in the Description field.

4. Enter the effective dates in the From and To fields.

The Effective To field is read-only for seeded statuses. This field is only active if 
you are defining a new task status.

Table 17–3 Status Transition Rule Example

Current State Next State

Open Planning

Planning Working

Working Completed
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5. The usage is automatically set to Task and cannot be changed. If you are 
defining an Escalation status, you must access the window from the Define 
Escalation Status link in the navigator.

6. Select appropriate task status flags.

Defining Status Transition Rules

7. In the Task and Escalation Status window, click Define Transition.

The Status Transition window opens. 

8. In the Rule tab, enter a name in the Rule Name field.

9. Enter appropriate application name for the rule.

10. Enter appropriate values for the current and next statuses for the rule.

11. Click the Responsibility tab to assign a rule to a responsibility and click OK. 

Setting the Default Task Status Profile Option

12. Log in with the System Administrator responsibility, select Profile > System.

13. Set the Task Manager: Default Task Status profile option value to the initial 
status of the status transition rule, for example, Open.

14. Save your work.

See Also
� Defining Task Priorities

� Defining Task Types

� Defining Task Date Types

� Designing Task Templates

� Defining Template Details

� Setting Up Metadata Objects

� Defining Task and Notes Reference Mapping

� Setting Profile Options

� Running the Task Manager Concurrent Program
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17.3 Defining Task Priorities
In addition to seeded task priorities, the system administrator can define new task 
priorities in the Forms-based Task module. Task priorities are used to determine an 
importance rating for a task. Priorities define varying levels of urgency for tasks, 
such as low, high, and critical. 

Please note that you can modify or delete items that you created, but not those that 
are seeded.

Mapping Task Priorities to A Source Object
Use the task priority mapping functionality to map task priorities to a source object. 
This limits the visibility of task priorities shown in the task priority list of values for 
a mapped source object. After mapping priorities to a source, you will see only the 
mapped task priorities displayed in the list of values. All other unmapped priorities 
will not be in the list.

For example, after mapping task priorities to an object, you can only see the task 
priorities that are mapped to your source object displayed in the list of values. Any 
unmapped task priorities to your source object are now dynamically excluded from 
the lists. In addition, if none of the priorities is mapped to your source object, then 
you will see all task priorities from the list of values. Therefore, any user-defined 
task priorities must be mapped to your source object. Otherwise, you will not see 
them from the list after defining them.

Perform the following steps to define a new task priority:

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Task and Escalation Manager > Setup > Task Priority.

Steps
1. Select File > New to enter a new task priority in the Task Priority window.

2. Enter a name in the Priority field.
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3. Enter a numerical value in the Importance field.

4. Enter a brief description for the priority.

5. Enter the effective dates in the From and To fields.

The Effective To field is read-only for seeded priorities. This field is only active 
if you are defining a new task priority.

6. Save your task priority.

The new task priority appears in the Priority list of values LOV in the UI.

7. To map task priorities to a source:

a. In the Map Priority window, click Map Priority.

The Mapping Objects window opens.

b. Select the source object from the LOV, for example, appointment.

c. Select the task priority from the LOV, for example, critical.

d. Select the end date from the LOV.

e. Select the application from the LOV, for example, FND, Application Object 
Library.

The Seeded check box is not editable.

f. Click Save.

See Also
� Defining Task Statuses and Status Transition Rules

� Defining Task Types

� Defining Task Date Types

� Designing Task Templates

� Defining Template Details

� Setting Up Metadata Objects

� Defining Task and Notes Reference Mapping

� Setting Profile Options

� Running the Task Manager Concurrent Program
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17.4 Defining Task Date Types
In addition to the seeded date types (planned dates, scheduled dates and actual 
dates), you can use task date types to define other dates to track task progress, such 
as milestone and follow up dates. This functionality is used in the Forms-based 
Tasks only.

Mapping Task Date Types to A Source
You can limit the selection of the LOV shown in the Date Type field by mapping 
them to a source. For example, you can set the selection of date types from the LOV 
for a service request (source object) to be only “Due Date” and “Follow Up Date.” 

Where to Use These Date Types
After defining additional date types, you can identify more date types from the 
LOV if clicking the Dates tab in the Task Details window in Tasks Forms. 

Perform the following steps to define a task date type.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Task and Escalation Manager > Setup > Task Date Types.

Steps
1. In the Task Date Types window, enter the task date type.

2. Enter a description for the task date type.

3. Enter a numeric value for the Sequence.

4. Define the Application field as the application that is seeding the data, for 
example, FND (Application Object Library). This field is not relevant to external 
customers.

5. If you want to limit the selection of the LOV shown in the Date Type field by 
mapping the task date types to a source:
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a. In the Task Types window, click Map Date Types.

The Mapping Objects window opens.

b. Select the source object from the list of values (LOV), for example, 
appointment.

c. Select the task type from the LOV, for example, critical.

d. Optionally set the end date for the task date type.

e. Define the application field as the application that is seeding the data, for 
example, FND (Application Object Library). This field is not relevant to 
external customers.

The Seeded check box is not editable.

f. Click Save.

See Also
� Defining Task Statuses and Status Transition Rules

� Defining Task Priorities

� Defining Task Types

� Designing Task Templates

� Defining Template Details

� Setting Up Metadata Objects

� Defining Task and Notes Reference Mapping

� Setting Profile Options

� Running the Task Manager Concurrent Program

17.5 Defining Task and Notes Reference Mapping
Use the Mapping Objects window to map a reference type to a source object. This 
allows you to narrow down the References drop-down list to objects that are 
actually relevant to a document's source object. 

For example, you can map a sales lead to Task Manager (or Note Type). This limits 
the selection of list of values shown in the Reference Type (or Relate To) field in the 
HTML Task Manager (or HTML Notes) when you relate a task (or a note) to a 
business object. In addition, when creating a note for a Sales Opportunity, users 
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typically don't want to see such objects as Service Request or Defect in the 
References drop-down list. Instead, they would only want to see Lead, Forecast, 
Quote, and Sale Organization. Therefore, Notes implementors can map Lead, 
Forecast, Quote, and Sales Organization to the source object Sales Opportunity.

Please note that new task references for the Forms-based Task Manager can be 
created by logging with the CRM Administrator responsibility and selecting Task 
and Escalation Manager > Setup > Define Reference Type. These new task 
references are visible from the LOV in the Type field of the References tab located in 
the Task Details window (Forms version). 

Perform the following steps in Forms to define the objects that appear in the 
Reference drop-down list for a specific source object.

Prerequisites
Your source object must exist.

Responsibility
CRM Administrator

Navigation
Navigate to CRM Administrator > Task and Escalation Manager > Setup > Task & 
Note References

Steps
1. In the Mapping Objects window, select your source object from the LOV, for 

example, Sales Opportunity.

2. Select the References you want to appear in the drop-down list from the LOV.

3. Select an end date from the LOV.

4. Select the application where you want to extract your additional data from and 
click Save.

5. Repeat these steps for every object that you want to appear in the References 
LOV for your source object.

Note: This window defines reference mapping for both the Task 
Manager and the Notes module.
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See Also
� Mapping Note Types to a Source

� Setting Up Note Types

� Defining Task Statuses and Status Transition Rules

� Defining Task Priorities

� Defining Task Types

� Defining Task Date Types

� Designing Task Templates

� Defining Template Details

� Setting Profile Options

� Running the Task Manager Concurrent Program

17.6 Registering Task Mass Reassignment Screen
The Task Mass Reassignment window used to mass reassign tasks to different 
resources is Declarative Page Flows (DPF) enabled. It can link several pages 
together to represent a business flow. The Task Mass Reassignment window needs 
to be registered in business flows.

How to register the screen in business flows, see Oracle Applications CRM System 
Administrator’s Guide for details.

17.7 Setting Profile Options
Task Manager has a number of optional profile options. You can set default statuses, 
priorities, dates, and types, as well as defaults for owner and assignee statuses. 
Other profile options determine the client time zone, unit of measure, data 
truncation, and workflow. Profile values must be set in the Profile Values window 
by a System Administrator. 

The following table describes the profile options that are specific to Task Manager.
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Table 17–4 Task Manager Profile Options

Name
Default 
Value Level Description Outcome

Task Manager: 
Default Task Type

No 
default 
value

Site Use the Default Task Type 
profile option to set the 
default task type. Possible 
values include appointment 
and lead.

Set the value to the task type that 
you want to appear in the task 
type drop-down list when you are 
creating a task. 

Task Manager: 
Default Task Status

Open Site Use the Default Task Status 
profile option to set the 
default task status. Possible 
values include open and 
completed.

Set the value to the task status that 
you want to appear in the task 
status drop-down list when you 
are creating a task. 

Task Manager: 
Default Task 
Priority 

Medium Site Use the Default Task Priority 
profile option to set the 
default task priority. Possible 
values include critical and 
medium.

Set the value to the task priority 
that you want to appear in the task 
priority drop-down list when you 
are creating a task.

Task Manager: 
Default Task 
Owner

No 
default 
value

Site Use the Default Task Owner 
profile option to set the 
default task owner.

Set the value to the name of the 
default task owner.

Task Manager: 
Owner Type for 
Task

No 
default 
value

Site Use the Owner Type for Task 
profile option to set the 
default owner type. Possible 
values include employee 
resource and party.

Set the value to the owner type for 
the task.

Task Manager: 
Default Assignee 
Status

Accepted Site Use the Default Assignee 
Status profile option to set 
the default assignee status.

Set the value to the assignee status 
that you want to appear in the 
Assign To Status drop-down list 
when you are creating a task.

Task Manager: JTF 
Tasks Default Date 
Selected

Scheduled Site Use the JTF Tasks Default 
Date Selected profile option 
to set the default date 
selected. Possible values 
include Planned, Scheduled, 
or Actual. 

Set the value to the default date 
that you want to default in the 
Create Task window.

Task Manager: Task 
APIs to Determine 
if Security is 
Implemented

No 
default 
value

Site The Task APIs to Determine 
if Security is Implemented 
profile option is reserved for 
future use.

The value of this profile option 
should always be set to No.
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Time Unit of 
Measure Class

Time Site Use the Time Unit of 
Measure Class profile option 
to define the time unit of 
measure class in the 
inventory module.

Depending on the time unit 
of measure class, you will 
see the list of UOM codes in 
the Tasks module.

Depending upon the value of this 
profile, the Time UOM codes are 
shown in the list of values. If the 
value of this profile changes, then 
there will be a discrepancy 
between the existing data and the 
new LOV shown for the new Time 
UOM class. 

Oracle strongly recommends the 
value of this profile should NOT 
be changed after the system in the 
production

Task Manager: 
View All Task 
Privileges

Yes Site The View All Task Privileges 
profile option is reserved for 
future use.

Do not change the value of this 
profile option.

Task Manager: 
Delete Any Task 
Privileges

No Site The Delete Any Task 
Privileges profile option is 
reserved for future use.

Do not change the value of this 
profile option.

Task Manager: Use 
the Indicator of 
Data Truncation

... Site Use the Indicator of Data 
Truncation profile option to 
store a three-character code 
which is appended to the 
source object name of a Task 
when it has been truncated. 
The default value of this 
profile option is '...'.

For example, if the source of 
a Task is a Party, the name 
may be too large to store in 
the source_object_name 
column. If the name: "This is 
a very long name to test the 
truncation indicator 
functionality" (71 chars) is 
passed to the Task API as the 
source object name, it is 
written to the Task record as: 
"This is a very long name to 
test the truncation 
indicator..." (60 chars). The 
default value of this profile 
option is '...'.

Set the value that is appended to 
the source object name of a Task 
when it has been truncated.

Table 17–4 Task Manager Profile Options

Name
Default 
Value Level Description Outcome
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Task Manager: 
Create Quick Task

No 
default 
value

Site Use the Create Quick Task 
profile option to display the 
quick create button on the 
Tasks Summary window.

Set the value to Yes if you want the 
Quick Create button to appear in 
the Task Summary.

Set the Value to No if you do not 
want the button to appear in the 
window.

Client Timezone America/
Los_
Angeles

Site The Client Time zone profile 
option is used by Calendar 
to set the default time zone 
for the client in the Create 
Appointment window.

Set the value to the location where 
your appointments take place.

Setting the time zone from the 
profile link in the Calendar UI is 
another way to set and update this 
profile value.

Task Manager: 
Send Notifications 
to Group or Team 
Members

No Site The Task Manager: Send 
Notifications to Group and 
Team Members profile 
option provides the ability to 
notify either the Owner or 
the Assignee of a Group or 
Team resource, when a task 
is modified.

This profile option is for 
workflow only.

If the value is set to No, then no 
notification will be sent to group 
or team members. 

If the profile option is set to Yes, 
then the system looks at any 
resources of type Group or Team 
and expand them to include any of 
their members whose resource 
type is RS_EMPLOYEE, RS_
PARTY or PARTY_PERSON.

When adding a resource to the 
notify list, the system checks to see 
if the resource is already on the list 
before adding it.

Task Manager: 
Enable Automated 
Task Workflow 
Functionality

No Site The Task Manager: Enable 
Automated Task Workflow 
Functionality profile option 
is used to determine 
whether to send the 
automatic notifications or 
not.

Set the value to No, for the task 
workflows not to be initiated by 
the API.

If the value is set to Yes, then task 
workflows are initiated by the API. 
The default value is No.

Task Manager: 
Abort Previous 
Task Workflow if it 
is still active

No Site The Task Manager: Abort 
Previous Task Workflow if it 
is still active profile option is 
used to determine whether 
to abort the previous 
workflow processes before 
starting the next one.

If the value is set to No, then the 
previous Task Workflows that are 
still active are not aborted.

If the value is set to Yes, then the 
previous Task Workflows that are 
still active are aborted.

Table 17–4 Task Manager Profile Options

Name
Default 
Value Level Description Outcome
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JTF_TASK_
SUMMARY_
SOURCE

Source User The JTF_TASK_SUMMARY_
SOURCE profile option sets 
the view drop-down list 
value in the Task Summary 
context sensitive window. 
Possible values are Source 
and All.

Set the value to Source to have all 
tasks created with a particular 
source appear by default in the 
contextual window. 

Set the value to All to have all 
tasks created with a source as well 
as those which refer to that source 
appear by default in the context 
sensitive Task Summary.

Task Manager: 
Mass Task Reassign 
Access

No Site Use the Task Manager: Mass 
Task Reassign Access profile 
option to display the Task 
Reassignment window.

If the profile option is set to Yes, 
the Task Reassignment window is 
accessible and the administrator is 
able to reassign tasks. If the value 
is set to No, then the Task 
Reassignment window is not 
accessible and a relevant message 
is shown.

JTF Sync: Category 
Value

Oracle 
Business

System This profile option is used in 
the Palm and Outlook 
synchronization process. 

It is to set the default value 
for the category while trying 
to download business 
contacts to the offline device. 

All business contacts downloaded 
to the offline device will be created 
with this category. If the category 
does not exist in the offline device, 
then it will be created upon 
synchronization.

Task Manager: 
Copy Task Start 
Date to End Date

Yes Site This profile option is used to 
control the task start and 
end date for the Palm and 
Outlook synchronization.

If it is set to Yes, the task start date 
is defaulted from the system date 
and the task end date is defaulted 
to the task start date. 

For example, if it is set to Yes, then 
any changes the user made to the 
task start date while the user is in 
the task creation screen will 
automatically be populated to the 
task end date field.

Table 17–4 Task Manager Profile Options

Name
Default 
Value Level Description Outcome
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17.8 Running the Task Manager Concurrent Program
Task Manager uses one concurrent program, Rebuilding Intermedia Index for Task 
Names. This concurrent program rebuilds the intermedia index. In order for a user 
to see new and updated tasks and appointments when they use the quick find 
search, or have the ability to search on a task name, system administrator must run 
this concurrent program periodically. 

Perform the following steps in Forms to run the Rebuilding Intermedia Index for 
Task Names concurrent program.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Requests > Run.

Steps
1. In the Find Request window, click Submit a New Request.

The Submit a New Request window opens.

Task Manager: Set 
Context Data 
Security

Full 
Access

Site Use the Task Manager: Set 
Context Data Security profile 
option to set task data 
security for the context 
sensitive task instances.

If Full Access is selected, then all 
the tasks related to the context can 
be viewed, updated, and deleted. 
If Security Access is selected, then 
whether the task for that context 
can be updateable is based on the 
privileges granted to the user. 

Note: See Appendix A, Profiles Options, for details on how these 
profile options can be set.

Table 17–4 Task Manager Profile Options

Name
Default 
Value Level Description Outcome
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2. Select the Single Request option button and click OK.

The Submit Request window opens.

3. Select the concurrent program: Rebuilding Intermedia Index for Task Names 
from the list of values (LOV).

The Parameters window opens.

4. Enter the following information in the window:

� JTF User’s password

� Apps User’s password

� CTX User’s password

5. Click Schedule in the At These Times region.

6. Select the job to run periodically, in the Run the Job region.

7. Enter the start date and leave the end date blank to run the program 
indefinitely.

8. Define the interval in minutes, that you want the program to run and click OK.

9. Click Yes in the caution window if you selected for the program to run 
indefinitely.

10. Click Submit to confirm.

11. Click No to exit.

Guidelines
The following table describes the Rebuilding Intermedia Index for Task Names 
concurrent program.

17.9 Setting Up Metadata Objects
You can add additional data in the JTF objects table. Metadata source objects have 
static definitions to dynamically retrieve data during runtime. This allows for the 

Table 17–5 Task Manager Seeded Concurrent Programs

Name Description Frequency

Rebuilding Intermedia 
Index for Task Names

This program is used to rebuild the intermedia index 
so a user can use the quick find to search for new and 
updated tasks as well as to search by task name.

As needed
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code to call the metadata source name, instead of writing the code out in every 
location.

Perform the following steps to add data in JTF objects for use in Tasks Manager.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Task and Escalation Manager > Setup > Objects Meta-data.

Steps
1. Enter a name, description, and unique object code.

2. Enter or select information in the fields for all sections that are needed for this 
source.

� Seeded check box: It indicates that the data is seeded. It cannot be updated 
by users.

� From task check box: Select this check box if tasks can be created using the 
stand-alone Task Manager.

� Start Date: Enter a start date that the object code is available in the text field.

� End Date: Enter an end date that the object code is unavailable in the text 
field.

� Application: Select the Application name from the list of values.

3. Enter the following information in the Lunch Details tab:

� Function Name: Select the form function name registered as type, "FORM" 
from the LOV.

Note: In some instances, Customer Profiles and Service Request 
notes, require a specific prefix or code name.
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� Parameter: Enter the parameters to be passed to the form function to open 
the source form. The following parameters are passed to open the source 
form.

– ID - Source_object_id

– NAME - Source_object_name

The rest of the parameters should be hard coded.

� Launch Method: Use the drop-down list to select the Launch method. The 
Launch method is only for forms. They are:

– FND_FUNCTION: Executes a specified form function only if the form 
is attached. It always starts a new instance of the form.

– APP_NAVIGATE: Executes a specified form function only if the form is 
attached and also allows a form to be restarted if it is invoked a second 
time.

� URL: Enter the URL for the application.

� Web Function: Select the web function from the LOV. This is the JSP 
Function Name. It should be registered in Functions as type JSP.

� Web Parameters: Enter the web parameters in the text field. These are the 
parameters to be passed to the JSP page. The following parameters are 
passed to open the source form.

– ID - Source_object_id

– NAME - Source_object_name

The rest of the parameters should be hard coded.

4. Enter the following database information in the Select Statement Details tab:

� ID Column: Enter the ID value to be fetched from a given table in the text 
field, such as task_id. The ID identifies the unique column that is stored as 
the records place holder.

� Name Column: Enter the NAME value to be fetched from a given table in 
the text field, such as task_number. This column shows as the main 
search/result column value a user uses to select data.

� Details Column: Enter the details value to be fetched from given a table, 
such as description. The details column gives user more information on the 
column to choose from in the LOV listing.

Enter your select statement:
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� From: Enter the name of the table where the data is obtained, such as jtf_
tasks_vl.

� Where: Enter any Conditions of the selected data in the where clause, such 
as source_object_type_code = "TASK".

� Order By: Enter the order by which the records should be sorted, such as 
task_number.

� Select Statement: This read-only text field displays your select statement 
when clicking the Check Syntax button to validate the syntax of your 
statement before it is saved.

5. Enter the following information in the LOV and Data Security tab: 

In the LOV region:

� Window: Enter a title for the List of values window in the text field. This is 
the Title that appears for the LOV generated for this source object.

� Name: Enter the column name for List of values specified in the Select 
Statement Detail's "Name Column" field.

� Details: Enter the Title for details column for List of values specified in the 
Select Statement Detail's "Detail Columns" field.

In the Data Security Setup region:

� Object Name: The name for a corresponding JTF_OBJECTS code. This name 
serves as the foreign key to FND_OBJECTS. This field is not required and 
can be empty (null). 

� Predicate Alias: This field adds security information to application query. It 
should only be used to avoid ambiguity when LOV query contains more 
than one table joined by data object primary key(s) values. For example, 
two tables ("jtf_tasks_b" and "jtf_tasks_tl") are used, then it must be entered 
with either "jtf_tasks_b" or "jtf_tasks_tl". Otherwise Oracle DBMS will 
report ambiguous task_id reference at the run time.

If it is entered and the object name is not null, the value will be passed to an 
internal API to add security to a generated query for the LOV. However, if 
the object name is empty, then security predicate will not be added to the 
generated query.

Refer to Customizing List of Values (LOV) Security for more resource LOV data 
security information.

6. Define the object user in the Usage tab:
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� Object User: Select the object user from the list of values.

The Seeded check box is not editable. It indicates that the data is seeded.

Usage users are specified access locations where an object can be used. As long 
as the object is not seeded, all usages can be assigned.

See Also
� Setting Up the Source Object Code and Context

� Defining Task Statuses and Status Transition Rules

� Defining Task Priorities

� Defining Task Types

� Defining Task Date Types

� Designing Task Templates

� Defining Template Details

� Defining Task and Notes Reference Mapping

� Setting Profile Options

� Running the Task Manager Concurrent Program
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Working with Task Templates

This chapter covers the following topics:

� Designing Task Templates

� Defining Template Details

18.1 Designing Task Templates
A task template is a skeleton task and a task template group is a grouping of 
different task templates. Creating a template eliminates the user’s interaction with 
the specific properties of a task. This simplifies the task creation process when 
creating redundant tasks.

For example, a service department is constantly requested to have computer 
problems fixed. John Smith, a service director, requests the creation of a task 
template group called PC Repair that is specifically used for a service request. This 
template group consists of a set of required tasks, including customer appointment, 
computer repair, and progress update. These tasks are defined in a template format 
with task type, priority, and status information specified.

In addition to entering the basic task information into the task template, Task 
Manager provides the following two descriptive flexfields (DFF) for users to enter 
predefined flexfield information for your tasks:

� Task template groups additional information: It is located in the Template 
Groups region of the task template setup window. It allows users to enter 
descriptive information specifically for a task template group.

� Task Templates additional information: It is located at the end of the horizontal 
scroll bar of the Related Task Templates region. This descriptive flexfield is used 
specifically for each task template; therefore, its values can be passed to the 
tasks that are created based on the task template.
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In addition, you can define additional resource types and unit information, 
dependencies, and task recurrence information for a task template. Once a template 
or template group is created, users are able to create multiple tasks simultaneously 
based on the selected template or template group.

You can only define templates and template groups in the Forms-based version of 
Task Manager.

Perform the following steps to design a task template.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Task and Escalation Manager > Task > Task Templates.

Steps
1. In the Setup Task Template Group window, define and enter the following:

� Template group name

� Description

� Effective dates

� Descriptive flexfield information for the template group

2. Select a document type from the list of values (LOV).

3. Define and enter a template name and description.

4. Select the type, status, and priority for the template. 

Please note that the available task Type and Priority list of values are populated 
based on your selected document type. For example, if a template group is 

Note: The Private task flag in the Forms-based version of Task 
Manager is not supported at this time. This functionality will be 
removed in a future release. The new HTML-based Task Manager 
does support both Private and Public tasks.
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created for Service Request, then you should see only the service request related 
task types and priority information listed in the list of values.

5. Select task flags. See the Guidelines section for additional information on task 
flags.

6. Optionally, click Resources to specify resource type and unit information, 
Dependencies to set task dependencies, and Recurrences to set task 
recurrences for the template group in the Task Template Details window. For 
more information on how to define resources, dependencies, and recurrences, 
see the Defining Template Details section.

7. Save your template.

After saving the template, the Number field for each group you defined in the 
related task template region populates automatically. A task template now 
exists and task creation from the template is possible.

Guidelines
The following table describes task flags located in the Others tab.

See Also
� Defining Task Priorities

Task Flag Descriptions

Flag Description

Private The Private flag is currently not supported.

Publish The Publish flag indicates a task publishable over the web.

Holiday The Holiday flag indicates whether or not the task can be 
performed on a holiday.

Multibook The Multibook flag indicates whether or not the task can 
assign resources that are already assigned to other tasks.

Billable The Billable flag signifies a task as a service that requires 
billing.

Milestone The Milestone Flag indicates whether or not the task is a 
milestone.

Restrict Close The Restrict Close flag indicates whether or not it is necessary 
to close the task in order for the source object to be closed. For 
example, if this task references a service request, the task must 
be closed to close the service request.
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� Defining Task Types

� Defining Task Statuses and Status Transition Rules

� Defining Task Date Types

� Setting Up Metadata Objects

� Defining Task and Notes Reference Mapping

� Setting Profile Options

� Running the Task Manager Concurrent Program

18.2 Defining Template Details
Additionally, you can define resource types and unit information, dependencies, 
and task recurrences by clicking the appropriate buttons to bring up the following 
tabs shown in the Task Details window:

� Resources: Enter resource type (such as employee resource) and required unit 
information for each task you specified in the Related Task Templates region.

� Dependencies: Enter task dependency information if necessary. This 
functionality is currently not supported.

� Recurrences: Enter task recurrence information for tasks you want to repeat on 
a regular basis.

Perform the following steps to define task template details.

Prerequisites
A task template must be created and saved.

Responsibility
CRM Administrator

Navigation
Navigate to Task and Escalation Manager > Task > Task Templates.

Steps
1. In the Task Template Details window, with your template information defined, 

click Resources.

The Task Template Details window opens.
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2. Select a resource type from the list of values (LOV).

3. Enter the number of resources needed in the Required Units field.

Selecting the Enabled Flag activates the resource type for the corresponding 
task template.

4. Any information defined in the Dependencies tab is not supported at this time.

5. In the Recurrence tab, select how you want the task to repeat, daily, weekly, 
monthly, or yearly, and provide information in the corresponding required 
fields.

6. Click OK to save your information.

See Also
Designing Task Templates
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Customizing HTML Tasks Security

This chapter covers the following topics:

� HTML Task Security Overview

� Existing Task Security Rules

� New Task Security Model

– What is AOL Data Security Model

– Terms and Definitions 

– How Does the New Security Model Work

� Customizing HTML Tasks Data Security

– Setting the Security Profile Option

– Customizing List of Values Security Access

– Granting Manager-Directs Security Access 

� Troubleshooting HTML Task Data Security

19.1 HTML Task Security Overview
With the continuous support of the existing task security rules, HTML Task 
Manager leverages the Application Object Library (AOL) data security model to 
provide a flexible mechanism for task security access. This new security model not 
only supports the task rules used in the past, but also provides the ability to restrict 
data access to appropriate users through a specific authorization process.

For example, if a company only wants certain tasks to be viewed or updated by a 
particular user or user groups, then, with the new security model, this can be 
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achieved by granting a security access privilege (full access or read only) to the 
particular user or user groups to access specific tasks.

In other words, the task security authorization process can be considered as an 
analysis around

"Who (users or user groups) has what permission (full or read only access) to access 
which tasks (specific tasks)."

The following figure illustrates the high level picture of the task security rule 
analysis.

Figure 19–1 Task Security Rule Analysis

For example, appropriate users who can be either sales representatives, sales managers, 
or support managers are granted with full access or read only access permission to 
access certain tasks, such as from Task1 to Task5.

In order to authorize specific tasks access for particular users or user groups, the 
new task security model leveraging the concept of AOL data security can further 
allow users to customize task data for security authorizations. This includes 
customizing contextual task rules by using a profile option, building security 
around resource list of values, and allowing group managers to access his or her 
direct’s tasks.

Before introducing how to customize the task security rules, it is necessary to 
understand the existing task security rules, and the new task security concepts 
based on AOL data security. Therefore, relevant AOL data security concept and 
terminology will also be introduced in this chapter. 
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19.2 Existing Task Security Rules
Task Manager implicitly grants users with the following task security access:

� For the stand-alone tasks:

– The owner or assignee of a task has full access to the task.

– If a group or team is the owner or the assignee of the task, then all the 
group or team members have full access to that task.

Two security access privileges are used in Tasks:

– Read Only Access: Resources can only view tasks.

– Full Access: Resources can view, update, and delete tasks.

In addition, a resource can explicitly grant another resources full access or read 
only access to his or her tasks except the private tasks. This can be done through 
the calendar grant functionality.

� For the context sensitive tasks, currently Task Manager allows any users who 
can access the business object to have full access to all contextual tasks related 
to the object.

19.3 New Task Security Model
In order not only to continue supporting the existing task security rules, but also to 
provide a flexible system with the ability to restrict data access to appropriate users 
and to further customize the security rules to meet various business needs, HTML 
Task Manager leverages the AOL data security model to provide a new task 
security model. 

This section covers the following topics:

� What is AOL Data Security Model

� Terms and Definitions

� How Does the New Security Model Work

Note: The data security is enforced only in the HTML Tasks.
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19.3.1 What is AOL Data Security Model?
There are four different aspects of security access used in the AOL security model:

� User security is about determining the user identify and preventing access from 
unauthorized users. 

� Network security is about ensuring that communications over the network are 
secure.

� Function security is about controlling what people can do on the system. It 
focuses on which applications and modules you have access to.

� Data security, like function security, is also about controlling what people can 
do on the system. However, it focuses on what rows or columns of data you can 
look at as well as what operations can be carried out on those rows or columns.

The Data Security is comparatively a new feature in AOL security model. It is used 
to model and enforce security authorizations for access and modification of specific 
data records. In other words, data security is the finest security level that allows 
users to customize records in the data level.

To be able to customize task security in the data level, AOL data security model 
uses the concepts of object, object instance, and object instance sets to represent task 
features and possible modification, the concepts of privileges and roles to translate 
data access permissions, and the concepts of grants or global grants to represent the 
authorization process.

Take one of the existing task rules, for example, to further explain the AOL data 
concepts used for task rule customization:

The owner or assignee of a task has full access to the task.

In the AOL data security framework, owner or assignee can be translated as a user 
or user group. Full access is an access privilege that a user can act upon or perform 
on a task. As to "the task", Task Manager uses the concepts of objects, object 
instances, and object instance sets to explain the features of a task. For example, a 
task is considered as an object, task with number 1234 can be considered as an 
object instance. A grouping of multiple object instances is an object instance set. 
Therefore, tasks with number starting at 1000 to 1999 can be an object instance set.

With the new security model, the HTML Tasks module enable users to define and 
further customize the security rules for various business needs. 

Detailed information on AOL data security framework, refer to Oracle Applications 
System Administrator's Guide.
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19.3.2 Terms and Definitions
HTML Task Manager uses the following concepts, based on AOL data security 
model, to provide the flexibility to cover a wide range of data security scenarios:

� Users (User Groups)

� Objects

� Object Instances

� Object Instance Sets

� Privileges (Functions)

� Roles (Menus)

� Grants (Authorizations)

� Global Grants

Users (User Groups)
A user is a single person with an account on the system (represented by a row entry 
in FND_USER). Users can be grouped into groups. Therefore, a user role may 
represent a user or group of users. A user group is any grouping of FND_USERS 
who are exposed through the WF_ROLES view. 

Users and user groups can be referred as Grantee if they are the subjects of a data 
security grant. These users and user groups must be exposed in the WF_USER/WF_
ROLES.

Objects
An object is a type of thing on which security can be managed. For example, a task 
is considered as an object. 

In a technical definition, each object must be registered in the FND_OBJECTS tables. 
Every object definition will contain related database object (table or view) and 
primary key information for the object.

Object Instances
An object instance is a particular instance of an object. This generally corresponds to 
a row (or related set of rows) in the database. If Tasks is considered as an object, 
then Task with number 1234 is an object instance.
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In a technical explanation, object instances are derived from the primary key values. 
The primary key values should be set for the registered object in the FND_
GRANTS.

Object Instance Sets
An object instance set is a group of multiple object instances. For example, all tasks 
assigned to a user or all tasks with a number smaller than 5 could be considered an 
object instance set. 

In a technical definition, object instance set definition is stored in the FND_
OBJECT_INSTANCE_SET and FND_OBJECT_INSTANCE_SET_TL tables. The 
definition contains a SQL where clause by a predicate that combined with the object 
definition will return all the object instances that are part of the object instance set. 

An object instance set can be expressed in the following predicate for all tasks with 
a number smaller than 5. To avoid processing issues, all the columns used in the 
predicate should be prefixed with &TABLE_ALIAS in the object instance set definition. 
Then, this predicate can be added to the where clause.

SELECT *
FROM jtf_tasks_b  
WHERE Owner_id = FND_GLOBAL.USER_ID

AND &TABLE_ALIAS.task_id < 5

Privileges (Functions)
A function is an action that can be performed on an object or object instance. It is the 
smallest unit of secured product functionality. It can be granted to a user or user 
group which means gives them permission to perform that function. Therefore, it 
can also be referred as a permission or privilege from a user’s point of view.

There are two seeded security privileges currently used in the Task Manager:

� JTF_TASK_READ_ONLY (view only)

� JTF_TASK_FULL_ACCESS (update and delete)

Since these privileges are registered in the FND_FORM_FUNCTIONS and FND_
FORM_FUNCTIONS_TL tables and they are referenced in the actual code so that 
they cannot be changed or extended.

Note: Referencing PARAMETERx values from the grants can also 
parameterize the predicate.
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In addition, privileges (functions) can be grouped into roles (menus) to reduce the 
granting overhead. 

Roles (Menus)
A menu is a grouping of functions. Menus are used as roles for data security. It is 
required to group functions into related sets of menus necessary to perform a 
particular data security role on an object instance. A good example is an 
"Administrator" role, which might include many privileges required for a user with 
an administrator role to access the data. 

Currently, there are two new roles registered in the FND_MENUS and FND_
MENUS_TL tables specifically for task security:

� JTF_TASK_READ_ONLY: This role contains one privilege, JTF_TASK_READ_
ONLY.

� JTF_TASK_FULL_ACCESS: This role contains two privileges, JTF_TASK_
READ_ONLY and JTF_TASK_FULL_ACCESS.

The role privileges can be registered in the FND_MENU_ENTRIES and FND_
MENIU_ENTRIES_TL tables.

Grants (Authorizations)
A grant is an authorization for the grantee (a user, or group of users) to perform the 
specified security role on the specified object instance or object instance set. 
Therefore, grants are what tie the whole thing together. A grant consists of the 
following three components:

� Object: Any object instance or object instance set, for instance, all non-private 
tasks (object: JTF_TASKS and object instance set: JTF_TASK_RESOURCE_
TASKS)

� Grantee: Any user or user group, for instance, "JDOE" for John Doe

� Role (Menu): Any role, for instance, "JTF_TASK_FULL_ACCESS"

This grants the user, John Doe, the privilege to have full access to all non-private 
tasks. 

In addition, all grants should be registered in table FND_GRANTS.

Note: Roles are user definable, the seeded roles only exist to 
ensure backward compatibility.
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Calendar Grants

Task Manager still supports the calendar grant functionality, which means that 
when a user gives calendar access to another user, the access for tasks is also 
given. Since Task Manager uptakes AOL data security model, task security can 
be further customized. Granting calendar access to another user will still result 
in granting task access to the user. However, the access to the tasks can be 
restricted by additional data security implemented for tasks.

In the backend, the data that is being entered into FND_GRANTS table is not 
compatible with the way the FND_APIs work. In order to solve the backward 
compatibility issue, a new row for the task security is created while the same 
row for calendar is still kept. Therefore, on every grant, there would be two 
rows created (instead of one row). The same is true for every revoke. Two rows 
will be deleted.

Global Grants
To reduce the administration of grants, authorizations can be granted globally to the 
following:

� The "Global" user or user group

� The "Global" object instance

For example, any user will have full access to tasks where she or he is the owner or 
assignee. The seeded global grant uses the following values and customer cannot 
revoke this grant:

FND_GRANTS
GRANTEE_TYPE = "GLOBAL"
GRANTEE_KEY = "N/A"
MENU_NAME = "JTF_TASK_FULL_ACCESS"
OBJECT_NAME = "JTF_TASKS"
INSTANCE_TYPE = "SET"
INSTANCE_SET_NAME = "JTF_TASK_USER_TASKS"

Another global grant example can be that any user can see any resource team:

FND_GRANTS
GRANTEE_TYPE = "GLOBAL"
GRANTEE_KEY = "N/A"
MENU_NAME = "JTF_TASK_RESOURCE_ACCESS"
OBJECT_NAME = "JTF_RS_TEAMS"
INSTANCE_TYPE = "GLOBAL"
19-8 Oracle Common Application Components Implementation Guide



New Task Security Model
19.3.3 How Does the New Security Model Work?
With the leverage of AOL data security model, Task Manager adds the following 
two security functions to the new security model:

� Predicate: Adding a security predicate, the "where" clause, to an application 
query limits the task instance access for users. The predicate can be considered 
as the add-on new security rule to Tasks. To avoid processing issues, all the 
columns used in the predicate should be prefixed with &TABLE_ALIAS in the 
object instance set definition. As a result, a user will be only able to see certain 
task instances (such as all tasks with task id less than 5) that she or he has any 
kind of privileges.

For example, add a predicate (where clause) to an existing query:

SELECT *
FROM jtf_tasks_b  
WHERE Owner_id = FND_GLOBAL.USER_ID

AND &TABLE_ALIAS.task_id < 5

� Check Function: This allows the system to check whether or not a particular 
user has an appropriate access privileges (full or read only access) on a specific 
task instance.

With the two new functions added to Tasks, appropriate task instances are 
presented in the following logic:

For example, for the stand-alone task screens:

1. Add predicate to the main query. 

2. Check full access privilege for retrieved task instances. 

3. Display task instance(s) as updateable or read-only.

4. Check corresponding privilege before accessing the detail page.

Note: In the new security model, a user can have access to an 
object instance in many ways, such as access to an instance may be 
granted to the user, to the user's group(s) or to all users. 
Consequently the predicate might return duplicate instances
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19.4 Customizing HTML Tasks Data Security
Based on the new task security model, HTML Task Manager allows task security 
rules to be further customized in the following ways:

� Set the security profile option for the context sensitive tasks

� Customize list of values (LOV) security

� Grant manager-directs security access

19.5 Setting the Security Profile Option
Task Manager uses the Task Manager: Set Context Data Security profile option to 
control task data security for the context sensitive task instances, such as tasks 
attached to an opportunity or a lead. By using the profile option, you can choose to 
turn the task security function on or off based on the following profile values:

� If Full Access is selected (default value), then all the tasks related to the context 
can be viewed, updated, and deleted. 

This value turns the security OFF so as to support existing task security 
(backward compatibility), which allows any users with access to related object 
instance to update (full access) any task instance for that object. 

� If Security Access is selected, then whether the task for that context can be 
updated is based on the privileges granted to the user. 

This value turns the security ON for all task instances within context and only 
allows task accessible to the user with appropriate privileges.

Task Security Access Example
Three tasks (T1, T2, and T3) are created for an opportunity. User 1 is the owner of 
the task T1 and T2. Task T2 is also assigned to User 2. User 2 owns the Task T3.

Task Data Security Condition:

Grant read only access on task T3 (task id = 120087) to User 1.

FND_GRANTS
GRANTEE_TYPE = "USER"
GRANTEE_KEY= "USER1"
MENU_NAME = "JTF_TASK_READ_ONLY"
OBJECT_NAME = "JTF_TASKS"
INSTANCE_TYPE = "INSTANCE"
INSTANCE_PK1_VALUE = "120087"
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If Security Access is selected which turns the security function on, then the access 
privileges are changed to:

� User 1 can have full access to task T1 and T2, but has read only access to T3.

� User 2 can have full access to task T2 and T3.

In the past, all users who have access to a business object can have full access to all 
contextual tasks attached to that object. Therefore, both User 1 and User 2 can have 
full access to all three tasks attached to that opportunity.

If Full Access is selected which turns the security function off, then the task access 
privileges for User 1 and User 2 are changed to:

� Both User 1 and User 2 can have full access to Task T1, T2, and T3.

This is because if both users can access the opportunity business object, then they 
should all be able to access all contextual tasks for that object.

How Does the Context Sensitive Task Screen Generate?
Since the profile option controls the security access for contextual tasks, before 
displaying the task detail page, Task Manager will:

1. Check the profile value first to determine whether to display task instance(s) as 
updateable or read-only; then 

2. Check corresponding privilege to determine whether the logged-in user has any 
particular privilege on the particular task instance before the user can access 
any task detail page.

How to Set the Profile Option
Login with the System Administrator responsibility, and navigate to Profile > 
System to access the Find System Profile Values window. 

See Appendix A, Profiles Options, for details on how these profile options can be 
set.

See Also
� Customizing List of Values Security Access

� Granting Manager-Directs Security Access

� HTML Task Security Overview

� Existing Task Security Rules
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� New Task Security Model

� Troubleshooting HTML Task Data Security

19.6 Customizing List of Values Security Access
In addition to restricting task data access using the profile option, Task Manager 
also allows you to build security around the resource list of values (LOV) by using 
the concepts of the object instances or object instance sets.

Business Reason

For example, a sales manager is responsible for a special deal that only involves 
limited resources. To make sure that relevant tasks created for that deal are only 
restricted to certain people, the system administrator can create a specific set of 
resources and then grant them to the sales manager. Thus, the manager will only see 
those resources shown in the resource (owner or assignee) list of values when 
creating a task. 

For the similar reason, another set of resources can be granted to sales 
representatives. As a result, the sales representatives will not be able to see the 
resources granted to the sales manager, and the manager will not see the resources 
granted to the representatives.

Before introducing necessary steps to customize resource LOV, it is important to 
understand JTF object changes and other seeding strategy recently made in Task 
Manager to support the LOV security.

Note: The resource list of values can be resources of any category 
(employee, party, partner, supplier contact, group, team, other, and 
to be hired). 

In addition, resource LOV security functionality is based on 
resources. Therefore, it applies to owner, assignee, and reference 
(relate to) if it is defined based on resources. It does not apply to 
any customer/contact LOV (such as organization, person, or 
relationships) and reference other than resources (such as 
customer/contact and lead.)
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19.6.1 JTF Object Changes
In order to support the LOV data security, Task Manager modifies the JTF object 
meta-data form by adding two extra columns grouped in the Data Security Setup 
region of the LOV and Data Security tab. This establishes the link between JTF_
OBJECTS for existing LOV and FND_OBJECTS for all task data security objects.

Because in Tasks, on one hand, all LOVs are rendered using the common LOV 
Renderer. The LOV Renderer uses JTF_OBJECTS as meta-data repository providing 
input to all needed data when generating the LOV in a query. This query may be 
defined at design time or generated dynamically from JTF_OBJECTS. The LOVs 
addressed here are all generated dynamically.

On the other hand, all data security objects are newly defined in the FND_
OBJECTS.

In order to build connection between these two so that the existing LOV could have 
an extra security build on top of it, Task Manager uses the Data Security Setup 
region in the JTF object meta-data form to establish the link.

To access the security set up region, log on with the CRM Administrator 
responsibility, select the Task and Escalation Manager > Setup > Objects Meta-data. 

There are two new fields in the LOV and Data Security tab: 

� Object Name: It is the object name for a corresponding JTF_OBJECTS code and 
serves as the foreign key to FND_OBJECTS. This field is not required and can be 
empty (null). 

� Predicate Alias: It adds security information to application query. It should 
only be used to avoid ambiguity when LOV query contains more than one table 
joined by data object primary key(s) values. For example, if two tables ("jtf_
tasks_b" and "jtf_tasks_tl") are used, then it must be entered with either "jtf_
tasks_b" or "jtf_tasks_tl". Otherwise Oracle DBMS will report ambiguous task_
id reference at the run time.

If this field is entered and the object name is not null, the value will be passed to 
an internal API to add security to a generated query for the LOV. However, if 
the object name is empty, then security predicate will not be added to the 
generated query.

19.6.2 Other Seeding Strategy
In addition to the JTF object change, Task Manager also makes the following 
changes in order to support the LOV security:
Customizing HTML Tasks Security 19-13



Customizing List of Values Security Access
Creating new privilege (function) and role (menu):
� JTF_TASK_RESOURCE_ACCESS privilege (registered in the FND_FORM_

FUNCTIONS table)

� JTF_TASK_RESOURCE_ACCESS role (registered in the FND_MENUS table) or 
JTF_TASK_RESOURCE_ACCESS role (registered in the FND_MENU_ENTRIES 
table)

Registering LOV object data:
The resource team registered corresponding data object in JTF_OBJECTS. The 
following table represents the seeded data:

Creating global grants:
In order to provide backward compatibility, the following global grants are shipped:

� Any user can see any resource:

FND_GRANTS
GRANTEE_TYPE = "GLOBAL"
GRANTEE_KEY= "N/A"
MENU_NAME = "JTF_TASK_RESOURCE_ACCESS"
OBJECT_NAME = "JTF_RS_RESOURCE_EXTNS"
INSTANCE_TYPE = "GLOBAL"

� Any user can see any resource group:

FND_GRANTS

Table 19–1 Seeded Object Data

JTF Object Code FND Object Name

RS_EMPLOYEE JTF_RS_RESOURCE_EXTNS

RS_INDIVIDUAL JTF_RS_RESOURCE_EXTNS

RS_OTHER JTF_RS_RESOURCE_EXTNS

RS_TBH JTF_RS_RESOURCE_EXTNS

RS_GROUP JTF_RS_GROUPS

RS_TEAM JTF_RS_TEAMS

RS_PARTNER JTF_RS_RESOURCE_EXTNS

RS_PARTY JTF_RS_RESOURCE_EXTNS

RS_SUPPLIER_CONTACT JTF_RS_RESOURCE_EXTNS
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GRANTEE_TYPE = "GLOBAL"
GRANTEE_KEY= "N/A"
MENU_NAME = "JTF_TASK_RESOURCE_ACCESS"
OBJECT_NAME = "JTF_RS_GROUPS"
INSTANCE_TYPE = "GLOBAL"

� Any user can see any resource team:

FND_GRANTS
GRANTEE_TYPE = "GLOBAL"
GRANTEE_KEY= "N/A"
MENU_NAME = "JTF_TASK_RESOURCE_ACCESS"
OBJECT_NAME = "JTF_RS_TEAMS"
INSTANCE_TYPE = "GLOBAL"

If a system administrator decides to set the LOV security, then she or he should first 
disable corresponding global grant for the LOV data object by setting an end date to 
the specific global grant.

19.6.3 Customizing Resource LOV
The resource LOV can be further customized if necessary before it is granted to 
resources or resource groups. Therefore, it is necessary to understand when the 
customization needs to be done and how it can be done. In addition, how to grant 
the LOV to a user is also addressed here.

19.6.3.1 When to Customize the Resource LOV
The system administrator can grant an individual resource, all resources, or a 
specific set of resources to another resource, group of resources, or all resources. 

Grant An Individual Resource
For example, in the lowest security level and the most gradual one, a system 
administrator can grant a single employee resource (resource number 1234) access 
to the following grantee(s):

� A user "John Doe"

� All members of a resource group (group number 9876)

� All users
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Grant All Resources
As opposite to the previous one, in the most global security level, the administrator 
may grant all resources (global access) to another resource, all members of a 
resource group, or all users. 

Grant A Specific Set of Resources
When there is a need to grant a specific set of resources to a user, all members of a 
resource group, or all users, the administrator can customize the resource LOV by 
using object instance sets. 

19.6.3.2 Defining Object Instance Sets
For example, a company wants to grant access of a specific set of resource to a user, 
all members of a resource group, or all users.

This specific set of resources can be created by first registering a new parameterized 
object instance set using the following data:

FND_OBJECT_INSTANCE_SETS
INSTANCE_SET_NAME = "X_JTF_RS_GROUP_MEMBERS"
DISPLAY_NAME = "Members of Resource Group"
DESCRIPTION = "Members of Resource Group"
OBJECT_NAME = "JTF_RS_RESOURCE_EXTNS"
PREDICATE = 

"&TABLE_ALIAS.resource_id IN (SELECT resource_id FROM jtf_rs_group_
members WHERE TO_CHAR(group_id) = &GRANT_ALIAS.PARAMETER1)"

Please note that &TABLE_ALIAS is added as column alias in order to avoid 
problems with conflicting column names during runtime execution.

Use the following steps to define object instance sets:

Prerequisites
An object must be in place.

Note: Any new instance set must be designed very carefully. It 
must be error free and should perform well. Because any error 
introduced by the new set(s) can cause data corruption or 
erroneous behavior in Task Manager.
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Responsibility
FND Security Administration (Self Service Application)

Navigation
Objects

Steps
Tips: First locate the object that you want a new instance set created for, then enter 
necessary information for the set. 

1. Enter necessary search information in the Find Objects window to locate the 
JTF_TASKS object. Search results should be listed after executing the search. 

2. Click the object name hyperlink for which you want the new instance set to be 
created from the search result to open the Find Object Instance Set window.

3. Existing instance sets for the selected object are also listed here. Click Create 
New Instance.

4. Enter instance set detail information including instance set name, display name, 
description and predicate.

5. Save your work.

Detailed information on how to define object instance sets, see Oracle Applications 
System Administrator's Guide.

Guidelines
Once the instance set is registered, it can be granted to another resource, group of 
resources, or all resources. The system administrator needs to set resource group_id 
in the grant PARAMETER1.

19.6.3.3 Granting the LOV to a User
Before adding new grants, it is necessary to first disable the existing grants or 
necessary seeded global grants so that they will not interfere with the new grants.

Disabling Existing Grants
To temporarily disable the existing grants, the system administrator can set the end 
date for the existing grants, instead of deleting them completely.
Customizing HTML Tasks Security 19-17



Customizing List of Values Security Access
Prerequisites
None

Responsibility
FND Security Administration (Self Service Application)

Navigation
Grants

Steps
1. Search the existing grants that you want to disable by entering search criteria in 

the Search Grants window.

2. Click Go to retrieve the grants that match your search criteria.

3. Select the grant that you want to disable from the search result.

4. Set an end date in the Context window and click Finish to disable the grant.

More information on how to disable existing grants, see Oracle Applications System 
Administrator's Guide.

Adding New Grants
Once the customized resource LOV (object instance set) is created and registered, it 
can be granted to another resource, group of resources, or all resources.

Please note that the administrator can grant users or user groups (grantee) with 
different levels of data access privileges. The access can be granted to function 
(menu) level (such as "Administrator" role) or further down to the data level (such 
as the LOV data level) depends on users or business needs. 

Since the LOV access privilege controls the row level of data access, whenever there 
is a need to create a new grant for LOV security access, use the data grant 
functionality to add this grant.

For example, if group number 10000123 contains all resources defined for the LOV 
in the object instance set, then the administrator can use data grant functionality to 
grant the LOV access to user21. As a result, the user can see all members of resource 
group 10000123 while creating a task. The data grant information should be like:

FND_GRANTS
GRANTEE_TYPE = "USER"
GRANTEE_KEY= "USER21"
MENU_NAME = "JTF_TASK_RESOURCE_ACCESS"
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OBJECT_NAME = "JTF_RS_RESOURCE_EXTNS"
INSTANCE_TYPE = "SET"
INSTANCE_SET_NAME = X_JTF_RS_GROUP_MEMBERS"
PARAMETER1 = "10000123"

Use the following steps to add a new grant:

Prerequisites
None

Responsibility
FND Security Administration (Self Service Application)

Navigation
Grants

Steps
1. Select Create Data Grant to add new grants to sales managers or sales 

representatives.

2. In the Object window, select JTF_TASKS as the object name.

3. In the Grantee window, select an appropriate radio button. 

4. In the Function Set window, specify a menu name, such as JTF_TASK_
RESOURCE_ACCESS.

5. In the Data Set window, select the A parameterized set of rows (Data Set) radio 
button. Furthermore, specify the appropriate object instance set that you want 
to grant to the grantee.

6. In the Data Set Details window, enter appropriate primary key values.

7. In the Context window, enter appropriate organization, responsibility and start 
date information. Leave the End Data field blank.

8. Enter JTF_TASKS in the Program Name field.

9. Enter appropriate information in the Program Tag field.

10. Click Finish. Once it is done successfully, the confirmation page opens with the 
message saying that the grant has been created.

More information on how to create data grants, see Oracle Applications System 
Administrator's Guide.
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See Also
� Setting the Security Profile Option

� Granting Manager-Directs Security Access

� HTML Task Security Overview

� Existing Task Security Rules

� New Task Security Model

� Troubleshooting HTML Task Data Security

19.7 Granting Manager-Directs Security Access
In order to support reporting hierarchy used in Sales or Support organizations, 
HTML Task Manager allows group managers who have effective manager’s role to 
have appropriate privileges to access their direct’s tasks if necessary permissions are 
granted to them. Sales managers, for example, can view their direct’s tasks and be 
able to track possible sales related activities performed for a particular week.

Before granting any security access privileges to managers, we should first 
understand:

� The Functionality of Manager-Directs Security Access

� Definition of Reporting Hierarchy (how the group is defined)

� Seeding Strategy

� Other Limitations

� Customize the Manager-Directs Security Access

19.7.1 The Functionality of Manager-Directs Security Access
HTML Task Manager uses the manager-direct security access functionality to grant 
group managers an appropriate access privilege (read only or full access) to view or 
update their resource group member’s non-private tasks.

Use the following example to understand how this functionality works in a resource 
group hierarchy.

For example, a resource group is lead by Helen Freeman who has three directs 
reporting to her. These three directs are Jack William, Jeff Walsh, and Alex 
Brown who plays the administrator in Helen’s group. Jeff Walsh who reports to 
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Helen has three group members directly reporting to him. They are Pat Smith, 
Jim Breen, and Frank Nelson who plays the administrator role.

Figure 19–2 The Helen Freeman’s Group Hierarchy

After this resource group is organized, the hierarchical data will be denormalized 
and populated in the table JTF_RS_REP_MANAGERS as follows: 

Table 19–2 Group Denorm Data in the JTF_RS_REP_MANAGERS TABLE

Member Name Associated 
Group

Hierarchy 
Type

Parent 
Resource 
Name

Denormal-
ization 
Levels

Alex Brown HF’s group ADMIN_TO_
ADMIN

Alex Brown 0

Jeff Walsh HF’s group MGR_TO_
MGR

Helen Freeman 1

Jeff Walsh JW’s group MGR_TO_
MGR

Helen Freeman 1

Jim Breen JW’s group MGR_TO_REP Helen Freeman 1

Frank Nelson JW’s group MGR_TO_
ADM

Helen Freeman 1
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After understanding the functionality of the manager-directs access and how it 
works, the definition of a reporting hierarchy should be further identified.

Pat Smith JW’s group MGR_TO_REP Helen Freeman 1

Alex Brown HF’s group MGR_TO_
ADMIN

Helen Freeman 0

Helen Freeman HF’s group MGR_TO_
MGR

Helen Freeman 0

Jack William HF’s group MGR_TO_REP Helen Freeman 0

Jeff Walsh HF’s group MGR_TO_REP Helen Freeman 0

Pat Smith JW’s group REP_TO_REP Pat Smith 0

Jim Breen JW’s group REP_TO_REP Jim Breen 0

Jack William HF’s group REP_TO_REP Jack William 0

Frank Nelson JW’s group ADM_TO_
ADM

Frank Nelson 0

Pat Smith JW’s group MGR_TO_REP Jeff Walsh 0

Frank Nelson JW’s group MGR_TO_
ADM

Jeff Walsh 0

Jim Breen JW’s group MGR_TO_REP Jeff Walsh 0

Jeff Walsh JW’s group MGR_TO_
MGR

Jeff Walsh 0

Jeff Walsh HF’s group REP_TO_REP Jeff Walsh 0

Note: In addition to the columns in the JTF_RS_REP_
MANAGERS table, the following columns must be considered:

� START_DATE_ACTIVE

� END_DATE_ACTIVE

Table 19–2 Group Denorm Data in the JTF_RS_REP_MANAGERS TABLE

Member Name Associated 
Group

Hierarchy 
Type

Parent 
Resource 
Name

Denormal-
ization 
Levels
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19.7.2 Definition of Reporting Hierarchy
The definition of manager-subordinate hierarchy used for granting security access is 
based on the resource Group Hierarchy defined in Resource Manager. It is not based 
on the Human Resource (HR) reporting structure defined in the HR system.

Group Hierarchy in Resource Manager
While defining resource group hierarchy in Resource Manager, each resource will 
perform certain roles in a resource group. For example, a sales group can be 
organized by a few sales representatives and a sales manager. The sales 
representative and sales manager are the roles that are associated with each 
resource in that group.

In order to determine the reporting hierarchy in a group, each role is also associated 
to a specific role attribute. When a role is assigned to a resource, a role attribute is 
also given to that resource simultaneously. A sales representative role is associated 
with a member role attribute, and a sales manager role is linked to a manager role 
attribute. Therefore, group members with sales representative roles could report to 
the group member with sales manager role in the sales resource group mentioned 
earlier.

Each resource group can be formed for a specific period of time, so as to the group 
member’s roles. Therefore, when an end date (END_DATE_ACTIVE) is specified 
for a resource group or for any resource role of the group members, that group or a 
specific role can be terminated.

For more information, see Resource Manager chapter in the Oracle Common 
Application Components Implementation Guide.

Highlights of Group Hierarchy For the Manager-Directs Security Access
Since the manager-directs security grant functionality is based on the group 
hierarchy defined in Resource Manager, not HR hierarchy, it is possible to have 
multiple managers in one resource group, and these managers will all be granted 
with security access to view or update their direct’s tasks in the HTML Tasks.

In addition, as resource groups and roles can be terminated, only the managers who 
have effective manager’s roles can be granted with security access to his or her 
direct subordinate’s tasks. This grant only works if the managers belong to an 
effective resource group. If one of the manager’s subordinates left the group, or the 
role has been terminated, then the manager will not be able to see the subordinate’s 
tasks even with full access privilege.
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19.7.3 Seeding Strategy
A new object instance set JTF_TASK_MANAGER_SECURITY is seeded in Tasks to 
support the manager-directs security grant functionality.

19.7.4 Other Limitations
HTML Task Manager supports the manager-directs security grants, however, there 
are some restrictions for performance reasons and avoiding complexity.

Only Support "Manager" and "Member" Role Attributes
Resource Manager uses four role attributes (manager, admin, lead, and member) to 
associate a resource role while defining a resource role. However, this functionality 
only supports the Manager and Member role attributes.

Only Support One Level of Group Hierarchy

Figure 19–3 Resource Group Hierarchy

Note: Even full access is granted to a group manager, that 
manager still cannot see his or her direct’s private tasks.
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A group might have parent groups and child groups. However, Task Manager only 
supports one level of group hierarchy for the manager-directs security access. This 
means that a manager can only be granted with access of his subordinate’s tasks of 
one level below him. It does not include any multiple levels beneath. In other 
words, this grant only limits to one group. It does not extend to its parent or child 
groups.

Only Implemented in HTML Tasks
This functionality only applies to HTML Tasks. It is not implemented in the 
Forms-based Tasks.

19.7.5 Customizing Manager-Directs Security Access
Use the following steps to grant security access to group managers:

� Defining Resource Group Hierarchy

� Granting Security Access to Relevant Resources

19.7.6 Defining Resource Group Hierarchy
Use Oracle Resource Manager to define resource group hierarchy.

Detailed information on how to define employee resources, group resources, and 
assigning appropriate group member roles to each group member, see Resource 
Manager chapter of the Oracle Common Application Components Implementation Guide.

19.7.7 Granting Security Access to Relevant Resources
Once the appropriate group hierarchy is identified, system administrator can grant 
the seeded object instance set JTF_TASK_MANAGER_SECURITY with read only or 
full access to appropriate group managers.

Use the following steps to add a new grant to resource group managers:

Prerequisites
None

Note: After defining appropriate groups, the group hierarchical 
data is denormalized and populated in the table JTF_RS_REP_
MANAGERS. 
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Responsibility
FND Security Administration (Self Service Application)

Navigation
Grants

Steps
1. Select Create Data Grant to add new grants to sales managers or sales 

representatives.

2. In the Object window, select JTF_TASKS as the object name.

3. In the Grantee window, select an appropriate radio button.

4. In the Function Set window, specify a menu name (JTF_TASK_READ_ONLY or 
JTF_TASK_FULL_ACCESS) for either read only or full access.

5. In the Data Set window, select the A parameterized set of rows (Data Set) radio 
button. Furthermore, specify the seeded object instance set JTF_TASK_
MANAGER_SECURITY.

6. In the Context window, enter appropriate organization, responsibility and start 
date information. Leave the End Data field blank.

7. Enter JTF_TASKS in the Program Name field.

8. Enter appropriate information in the Program Tag field.

9. Click Finish. Once it is done successfully, the confirmation page opens with the 
message saying that the grant has been created.

More information on how to create data grants, see Oracle Applications System 
Administrator's Guide.

See Also
� Setting the Security Profile Option

� Customizing List of Values Security Access

� HTML Task Security Overview

� Existing Task Security Rules

� New Task Security Model

� Troubleshooting HTML Task Data Security
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19.8 Troubleshooting Task Data Security
System administrator must perform the following steps in order for task owners to 
have full access to the tasks that they just created. Otherwise, they will have read 
only access to these tasks.

1. Use Adadmin to compile menus

2. Bounce the middle tier after compiling menus

See Also
� HTML Task Security Overview

� Existing Task Security Rules

� New Task Security Model

� Customizing HTML Tasks Data Security
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Troubleshooting Task Manager

This chapter covers the following topics:

� Common Implementation Errors

� Answers to Frequently Asked Questions (FAQs)

20.1 Common Implementation Errors

20.1.1 Task Search On Name Does Not Return Results
If the Quick Find or the personalized search on task names does not return results, 
then rebuild the Intermedia index. 

This can be done one of three ways.

� Manually rebuilding the Intermedia index using the alter index command. 

� Starting the ctxsrv server daemon for background DML processing. For more 
information, consult the Oracle8i interMedia Text Reference.

� Run the Task Manager concurrent program, Rebuilding Intermedia Index for 
Task Names.

20.1.2 UOM is Invalid or Disabled
If you experience this problem, perform the following:

1. The Time Unit of Measure class must be defined in the Inventory module. For 
this Time Unit of Measure class, define the Unit of Measure codes (such as 
Hours, Minutes, etc.) 
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For details on defining the Unit of Measure class, refer to the Inventory Users 
Guide. 

2. The profile "Time Unit Of Measure Class" must be set to Time Unit of Measure 
class defined in the inventory module.

20.2 Answers to Frequently Asked Questions (FAQs)
The following are frequently asked questions. Answers to these questions may help 
you in troubleshooting problems with Task Manager.

20.2.1 How Do You Map Task Types, Priorities, and References?
You can map task types, task priorities, and references to any source using the 
Object Mapping window. In both the HTML and the Forms-based Task Manager, 
priorities and date types that are mapped to a source and those that are not mapped 
to any source appear in the corresponding LOV, in the Forms-based version, or in 
the drop-down list in the HTML version. For references, only mapped types, 
priorities, and date types appear in the HTML user interface (UI). For information 
on how to map task types, priorities, and references, see the following sections:

� Defining Task Priorities

� Defining Task Types

� Defining Task Date Types

� Defining Task and Notes Reference Mapping

20.2.2 What is the Difference Between Task Types and Task Categories?
Task types are fixed for a given user. However, you can define and maintain 
personal categories for use in the HTML Task Manager during task creation.

20.2.3 Can You Close a Parent Service Request When the Task is Still Open?
The Restrict Closure flag on the task tab determines whether or not to allow the 
closure of a parent service request, when the task is open. If this check box is 
selected and the task status is open, meaning the status does not have the Closed 
flag checked, then the parent service request (SR) cannot be closed. Any task status 
without the Closed flag turned on is considered Open. 
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This part of the Oracle Common Application Components Implementation Guide 
contains the following chapters:

� Implementation Overview

� Implementing the HTML Calendar

� Implementing the Forms-based Calendar
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Implementation Overview

This chapter provides an overview of the Calendar module implementation process.

21.1 Overview
The Calendar module contains two distinct functionalities. It can be used with other 
applications to help organizations in scheduling resources, or it can be used to help 
individual or group resources in managing daily activities and appointments. With 
these two different functionalities, implementing Calendar involves two separate 
setup procedures.

When Calendar is used for organizations in scheduling resources and assigning 
work shifts, the implementor or system administrator must define an appropriate 
calendar used for scheduling, define resource availability as work shifts, define 
resource unavailability as exceptions, assigning shifts and exceptions to a calendar, 
and then assigning resources to that calendar.

If Calendar is used to help individual or group resources in managing daily 
activities for personal or group calendars, then the implementor or system 
administrator must first integrate Calendar module by adding Calendar tab to an 
appropriate responsibility, create a calendar administrator who is responsible for 
new group calendar request approvals, create calendar general users, change 
calendar administrator if necessary, implement calendar events so that calendar 
events, such as marketing campaigns, can be displayed in the personal calendar in 
addition to appointments and tasks, set necessary profile options, and start 
workflow processes.

Therefore, before implementing Calendar, it is necessary to understand which 
functionality of Calendar in particular will be used in your organization. It can be 
distinguished by the Forms-based Calendar and HTML Calendar.
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21.1.1 Forms-based and HTML Versions of Calendar
Calendar was initially a Forms-based application and used mainly for resource 
scheduling and work shift assignment. This includes defining and viewing 
available and unavailable times for an employee resource, as well as creating 
personal to-dos using Calendar Datebook functionality. 

With the expansion of Calendar functionality, Calendar module includes an HTML 
version. But the functionality of the HTML version is different from the 
Forms-based Calendar. The HTML Calendar is used as a personal productivity tool 
to help individual or group resources in managing their daily activities and 
appointments. This includes creating appointments or tasks for an individual 
resource, a group or public calendar, inviting attendees for the appointments, and 
viewing scheduled appointments through calendar daily, weekly, monthly, 
combination, and yearly views.

As each version of the Calendar module contains different functionalities, the setup 
steps for each version require separate implementation procedures.

This chapter provides an overview of both the HTML and Forms-based Calendar 
implementation processes.

21.2 HTML Calendar Overview
Think of using the HTML Calendar as a personal productivity tool. Individual 
resources can use it to define and view personal daily activities and appointments. 
Users can create appointments, tasks or other calendar events, invite attendees for 
the appointment, and view scheduled activities through different calendar views. 

In addition, the HTML Calendar provides an effective mechanism for users to 
manage group activities by using group or public calendars. Calendar users can 
request new group or public calendars and get request approvals from the Calendar 
Administrator. Once the request has been approved, the requestor of the new group 
calendar becomes the group calendar owner or Group Calendar Administrator of 
that group calendar and is responsible for any future approvals of that group 
calendar subscription requests.

To implement the HTML Calendar, implementors can embed the Calendar tab into 
an existing Oracle e-Business Suite module if necessary. The implementor or system 
administrator must then create a Calendar Administrator. The Calendar 
Administrator, typically a workflow administrator or system administrator, creates 
individual calendar users later and is responsible for approving or rejecting new 
group and public calendar requests as well as starting and stopping required 
workflow processes.
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21.2.1 Setup Dependencies
To be able to use the full functionality of HTML Calendar, the following 
components must be set up properly:

� HTML Task Manager. Use HTML Task Manager to schedule appointments and 
tasks, and to create repeating appointments for meetings.

� HTML Resource Manager. Use HTML Resource Manager to retrieve individual 
resources for an appointment.

� Oracle Workflow. Use Oracle Workflow to send workflow notifications for 
processing new group calendar requests and subscription requests to existing 
group calendars.

� HTML Tech Stack. Use HTML Tech Stack to display the HTML functionality.

HTML Calendar also uses Accounts Receivable profile options to set the default 
client and server time zones for a user.

21.3 HTML Calendar Implementation Steps
This section provides an overview of the required steps for implementing HTML 
Calendar. Detailed instructions for these steps are contained in the subsequent 
chapters.

� Implementing the HTML Calendar

– Adding a Calendar Tab to a Responsibility

– Creating a Calendar Administrator

– Creating a Calendar User

– Changing a Calendar Administrator

– Implementing Calendar Events

– Setting Profile Options

– Starting Workflow Processes

– Running Concurrent Programs

21.3.0.1 Adding a Calendar Tab to a Responsibility
If the application that you want to integrate with HTML Calendar module already 
has a profile menu, then the implementor or system administrator can add calendar 
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profile node "JTF HTML Calendar Profile Preferences" to their profile main menu. 
As a result, the Calendar tab will appear in the application user interfaces.

21.3.0.2 Creating a Calendar Administrator
After integrating HTML Calendar into your applications, the implementor or 
system administrator must identify one employee resource to become the Calendar 
Administrator. The Calendar Administrator has the privilege to grant approval or 
rejection to all new group and public calendar requests through workflow 
notifications.

Creating a Calendar Administrator involves several steps. This includes assigning 
appropriate responsibilities to the user who becomes the Calendar Administrator, 
associating the user with the "JTF HTML Calendar: Administrator" profile option, 
and assigning additional profile options to the user if the stand-alone HTML 
Calendar is used.

21.3.0.3 Creating a Calendar User
Every employee resource with appropriate responsibilities can use the HTML 
Calendar functionality to create appointments, view personal calendars, request 
new group or public calendars, and subscribe to an existing group calendar. 
Therefore, make sure that all employees exist in the Resource Manager and the 
resources are linked to the application login user names (FND_User). Otherwise, 
they need to be imported from Oracle Human Resource Management System 
(HRMS) into Resource Manager.

To create a Calendar user, the implementor, system administrator, or Calendar 
Administrator needs to grant appropriate responsibilities to the employee resource. 
In addition, if the stand-alone HTML Calendar is used, then the general user also 
needs to be associated with two profile options.

The Calendar Administrator also has the same responsibilities as a general user 
does, but with an additional System Administrator responsibility assigned to him. 
In addition, the Administrator needs to be tied to the JTF HTML Calendar: 
Administrator profile option in order to have the privilege to grant approval for 
new group or public calendar requests.

21.3.0.4 Changing a Calendar Administrator
Since the HTML Calendar allows only one Calendar Administrator in the system to 
be responsible for any new group or public calendar requests, in the case of the 
absence of the Calendar Administrator or other considerations, the Calendar 
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Administrator or whoever has the JTF_CALENDAR_ADMIN role can perform the 
update by changing the name.

After the update, the JTF_CALENDAR_ADMIN role is automatically assigned to 
the new Calendar Administrator, and is revoked from the old Calendar 
Administrator. Therefore, the new Calendar Administrator will receive all the new 
group calendar requests through workflow notifications.

21.3.0.5 Implementing Calendar Events
If an integrated application wants to display calendar events, such as marketing 
campaigns, in the personal calendars in addition to scheduled appointments and 
tasks, then the implementor or system administrator must perform required setup 
steps to implement this functionality. Calendar users who belong to resource groups 
to which the event is published must also set up their calendar personal preferences 
to be able to see the calendar events in their personal calendars.

21.3.0.6 Setting Profile Option
The implementor or system administrator must set required profile options for 
HTML Calendar, such as set the default time zone for end users or grant the 
calendar administrator group calendar request approval privilege. Some profile 
options enable HTML Calendar used as a stand-alone module. 

21.3.0.7 Starting Workflow Processes
The implementor or system administrator must start the following two workflow 
processes in order to have the HTML Calendar work properly:

� JTF Calendar Workflows. Use JTF Calendar Workflow to track and route 
requests to the Calendar Administrator for new group and public calendar 
approvals and to Group Calendar Administrators (the owners of the group 
calendars) for subscription approvals.

� JTF Task Reminder. Use JTF Task Reminder to pick up appointment reminders 
for scheduled appointments. 

21.3.0.8 Running the Concurrent Program
In order to retrieve new and updated appointments from quick find search, the 
system administrator must run the Rebuilding Intermedia Index for Task Names 
concurrent program periodically.
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21.4 Forms-based Calendar Overview
Use the Forms-based Calendar to enter shifts and exceptions in order to define 
resource availability and unavailability, as well as to create personal To-Do List and 
view scheduled activities using Calendar Datebook functionality. 

The resource work shift information defined here will be displayed as yellow 
background in the Gantt chart while using Assignment Manager for resource 
selection. Telesales applications use the Calendar Datebook functionality to view a 
resource’s availability and assigned tasks.

To implement the Forms-based Calendar, implementors need to define a corporate 
calendar specifically used for resource scheduling, define resource availability as 
work shifts, define resource unavailability as exceptions, assigning shifts and 
exceptions to a calendar, and then assigning resources to that calendar.

21.4.1 Setup Dependencies
To be able to use the full functionality of the Forms-based Calendar, the following 
components must be set up properly:

� Task Manager (Forms). Use Forms-based Task Manager to create personal Todo 
List (tasks) and to have tasks displayed in different calendar views. The 
functionalities of Todo List and calendar views reside in the Calendar Datebook 
and can be accessed through the Telesales application. 

� Resource Manager. Use Resource Manager to retrieve a specific resource for 
different calendar views.

21.5 Forms-based Calendar Implementation Steps
This section provides an overview of the required steps for implementing the 
Forms-based Calendar. Detailed instructions for these steps are contained in the 
subsequent chapters.

� Implementing the Forms-based Calendar

– Defining a Calendar

– Defining Availability (Shifts)

– Defining Unavailability (Exceptions)

– Assigning a Shift to a Calendar

– Assigning an Exception to a Calendar
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– Assigning a Resource to a Calendar

21.5.0.1 Defining a Calendar
To be able to show resource work shift information, the implementor or system 
administrator must first define a calendar with start and end date information. 
Once the shifts and exceptions are specified, they can be associated with the 
calendar used specifically for resource scheduling. 

21.5.0.2 Defining Availability (Shifts)
After defining a calendar, the implementor or system administrator needs to define 
work shift information indicating the beginning and ending time for a specific day 
within a week. Examples of a shift can be that a service engineer works from 7:00 
a.m. to 4:00 p.m. on Monday, or from 8:00 a.m. to 3:00 p.m. from Tuesday through 
Friday. 

Multiple shifts can be combined into a shift pattern for a longer period of time, such 
as from January 01, 2003 to May 31, 2003. After identifying shift information, 
implementors can then associate it with a specific calendar.

21.5.0.3 Defining Unavailability (Exceptions)
In addition to the available work hours, the Forms-based Calendar also allows 
implementors to schedule unavailable days as exceptions to regular working shifts. 
This exception information will then be associated with a specific calendar.

21.5.0.4 Assigning a Shift to a Calendar
After defining work shifts, the implementor or system administrator must assign 
them to a calendar. To assign them to a calendar, query up the calendar specifically 
used for scheduling resource, and then enter shift information.

21.5.0.5 Assigning an Exception to a Calendar
Use the same calendar that has work shift information to assign previously defined 
exceptions. As a result, this calendar will have both available and unavailable work 
information for a period of time.

21.5.0.6 Assigning Resources to a Calendar
After associating work shift and exception information to a calendar, the 
implementor can assign resources to it. In order to show the resource work shift 
information as yellow background in the Gantt chart while using the Assignment 
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Manager for resource selection, implementor or system administrator must indicate 
this calendar is the resource’s Primary Calendar.

Resources of any categories defined in Resource Manager can be assigned to a 
calendar.
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Implementing the HTML Calendar

This chapter covers the following topics:

� Adding a Calendar Tab to a Responsibility

� Creating a Calendar Administrator

� Creating a Calendar User

� Changing a Calendar Administrator

� Implementing Calendar Events

� Setting Profile Options

� Starting Workflow Processes

� Running Concurrent Program

22.1 Adding a Calendar tab to a Responsibility
HTML Calendar can be integrated with an existing application within Oracle 
e-Business Suite. After integration, a Calendar tab appears in the application user 
interfaces (UI).

If the application already has a profile menu, then the implementor or system 
administrator can add calendar profile node "JTF HTML Calendar Profile 
Preferences" to the application’s profile main menu.

Perform the following steps in Forms to embed Calendar into an existing Oracle 
application.

Prerequisites
None
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Responsibility
System Administrator

Navigation
Query up your root menu structure.

Steps

1. Attach menu JTF HTML Calendar Main Menu to your Main node along with 
profiles node.

2. Add JTF HTML Calendar Profile Preferences for the preferences structure.

3. Bounce the server to view your changes.

The Calendar module is embedded and the tab is added to your user interface 
in the location you specified.

See Also
� Setting Profile Options

� Starting Workflow Processes

� Creating a Calendar Administrator

� Creating a Calendar User

� Changing a Calendar Administrator

� Running the Concurrent Program

22.2 Creating a Calendar Administrator
The Calendar Administrator, typically the system administrator or workflow 
administrator, has the privilege to grant approval or rejection to new group and 
public calendar requests. When new group or public calendar requests generated, 
the Calendar Administrator will receive workflow notifications for approval. 
Therefore, the user who will become the Calendar Administrator must exist in 
Oracle Human Resource Management System (HRMS) as an employee resource.

Use the following procedures to create a Calendar Administrator:

1. Assigning Appropriate Responsibilities:

After identifying an employee resource to become a Calendar Administrator, the 
implementor or system administrator must assign appropriate responsibilities to 
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the employee. In order to receive notifications and create calendar general users, the 
Calendar Administrator must have the following responsibilities:

� System Administrator. Use this responsibility to grant the HTML Calendar 
access responsibilities to calendar general users.

� CRM Application Foundation User. Use this responsibility to access the HTML 
Calendar and HTML Resource Manager modules. 

Optionally, use the JTF HTML Calendar User responsibility if it is to access the 
HTML Calendar only.

� Workflow User Web Applications. Use this responsibility to verify workflow 
processes, and to view workflow notifications. If it is configured correctly, you 
can view these notifications from your personal homepage.

� Preferences (Oracle Self-Service Web Applications). Use this responsibility to 
define user preferences, for example, send or do not send e-mail notifications. 
To receive workflow notifications, select General Preferences and change the 
value in the “Send me electronic mail notifications” field to “Do not send me 
mail”. This tells the system not to send you e-mail notifications, but instead to 
send them to your notifications page.

2. Associating the Calendar Administrator with Appropriate Profile Options

After creating the Calendar Administrator, the implementor must set "JTF HTML 
Calendar: Administrator" profile option to the Calendar Administrator. This grants 
the profile option to the administrator, so that she or he can grant approval for new 
group and public calendar requests.

In addition, if the stand-alone HTML Calendar is used as default application and 
responsibility after signing on, then the following profile options also need to be 
assigned to the administrator:

� JTF_PROFILE_DEFAULT_RESPONSIBILITY (22946)

� JTF_PROFILE_DEFAULT_APPLICATION (690)

Perform the following steps in Forms to create a Calendar Administrator.

Prerequisites
The user must exist in Oracle HRMS as an employee resource.
Implementing the HTML Calendar 22-3



Creating a Calendar Administrator
Responsibility
System Administrator

Navigation
Navigate to Security > User > Define.

Steps
1. In the Users window, enter a user name for the Administrator.

2. Select the name for the Administrator in the person field.

3. Enter a password, then re-enter it again for confirmation.

4. Add appropriate responsibilities to the user.

5. Choose File > Save to save your changes. Close the window.

6. Associate the Calendar Administrator with the "JTF HTML Calendar: 
Administrator" profile option:

a. Navigate to Profile > System to open the Find System Profiles Values 
window. 

b. Associate the profile option "JTF HTML Calendar: Administrator" to the 
user who will be the Calendar Administrator. Save your work.

7. (Optional) If using Calendar as a stand-alone module, then you must associate 
the Calendar Administrator with following additional profile options:

a. JTF_PROFILE_DEFAULT_RESPONSIBILITY: Enter 22946 to set the default 
responsibility when using calendar as a stand-alone application.

b. JTF_PROFILE_DEFAULT_APPLICATION: Enter 690 to set the default 
application when using calendar as a stand-alone application.

c. Click File > Save.

See Also
� Setting Profile Options

� Starting Workflow Processes

� Adding a Calendar Tab to a Responsibility

� Creating a Calendar User

� Changing a Calendar Administrator
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� Running the Concurrent Program

22.3 Creating a Calendar User
Every employee resource with appropriate responsibilities can use the HTML 
Calendar functionality to create appointments, view personal calendars, request 
new group or public calendars, and subscribe to an existing group calendar. Make 
sure that all employees exist in the Resource Manager and the resources are linked 
to the application login user names (FND_User). Otherwise, they need to be 
imported from Oracle Human Resource Management System (HRMS) into 
Resource Manager.

To create a Calendar user, the implementor, system administrator, or Calendar 
Administrator needs to grant the following responsibilities to the employee 
resource:

� CRM Application Foundation User. Use this responsibility to access the HTML 
Calendar and HTML Resource Manager modules. 

Optionally, use the JTF HTML Calendar User responsibility if it is to access the 
HTML Calendar only.

� Workflow User Web Applications. Use this responsibility to verify workflow 
processes, and to view workflow notifications regarding new group or public 
calendar requests, as well as existing group calendar subscription requests.

� Preferences (Oracle Self-Service Web Applications). Use this responsibility to 
define user preferences, for example, send or do not send e-mail notifications. 
To receive workflow notifications, select General Preferences and change the 
value in the “Send me electronic mail notifications” field to “Do not send me 
mail”. This tells the system not to send you e-mail notifications, but instead to 
send them to your notifications page.

Note: The Calendar Administrator also has the same 
responsibilities as a general user does, but with an additional 
System Administrator responsibility assigned to him. In addition, 
the Administrator needs to be tied to the JTF HTML Calendar: 
Administrator profile option in order to have the privilege to grant 
approval for new group or public calendar requests.
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In addition, if the stand-alone HTML Calendar is used as default application and 
responsibility after signing on, then the following profile options also need to be 
assigned to the user:

� JTF_PROFILE_DEFAULT_RESPONSIBILITY (22946)

� JTF_PROFILE_DEFAULT_APPLICATION (690)

Perform the following steps in Forms to create a calendar user.

Prerequisites
The user must exist in Oracle HRMS as an employee resource.

Responsibility
System Administrator

Navigation
Navigate to Security > User > Define.

Steps

1. In the Users window, enter a user name.

2. Select the name in the Person field.

3. Enter a password, then re-enter it again for confirmation.

4. Add appropriate responsibilities to the employee resource.

5. Choose File > Save to save your changes. Close the window.

6. (Optional) If using Calendar as a stand-alone module, then you must associate 
the Calendar User with following profile options:

a. Navigate to Profile > System to open the Find System Profiles Values 
window. 

b. JTF_PROFILE_DEFAULT_RESPONSIBILITY: Enter 22946 to set the default 
responsibility when using calendar as a stand-alone application.

c. JTF_PROFILE_DEFAULT_APPLICATION: Enter 690 to set the default 
application when using calendar as a stand-alone application.

d. Click File > Save.
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See Also
� Setting Profile Options

� Starting Workflow Processes

� Adding a Calendar Tab to a Responsibility

� Creating a Calendar Administrator

� Changing a Calendar Administrator

� Running the Concurrent Program

22.4 Changing a Calendar Administrator
HTML Calendar allows only one Calendar Administrator in the system to be 
responsible for any new group or public calendar requests; therefore, in the case of 
the absence of the Calendar Administrator, the Calendar Administrator or whoever 
has the JTF_CALENDAR_ADMIN role can perform the update by changing the 
name in the Calendar Administration window.

The JTF_CALENDAR_ADMIN role can be assigned through the System 
Administrator Console by system administrator. A user without this role 
attempting to access the Calendar Administration window will see an error 
message saying that "You don't have sufficient privileges to view this page."

Once you update the Calendar Administrator, the JTF_CALENDAR_ADMIN role is 
automatically assigned to the new Calendar Administrator, and is revoked from the 
old Calendar Administrator. Therefore, the new Calendar Administrator can get 
access to the Calendar Administration window while the old Calendar 
Administrator cannot. All the new group calendar requests should be sent to the 
new Calendar Administrator through workflow notifications.

Assign JTF_CALENDAR_ADMIN Role to a User

To grant the JTF_CALENDAR_ADMIN role to a user, log in to the System 
Administrator Console as a system administrator. Select Users tab > Registration 
subtab > User Maintenance. Query up the user name and then click the Roles 
button to access the User-Role Mapping window. Select the JTF_CALENDAR_
ADMIN role from the Available Roles block to move the role to the Assigned Roles 
block. Click the Update button to complete the change. The user will have access to 
the Calendar Administration window.

Perform the following steps to change the Calendar Administrator.
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Prerequisites
You must have the JTF_CALENDAR_ADMIN role to access the Calendar 
Administration window. This role is assigned to the user through the System 
Administrator Console. See the Oracle Applications CRM System Administrator’s 
Guide for more information on defining user roles.

Responsibility
CRM Application Foundation User

System Administrator

Navigation
Navigate to the Calendar Administration window by clicking the Profile icon.

Steps
1. Click Administrator in the side navigation bar.

The Calendar Administration window opens with the current Calendar 
Administrator information.

2. Clear the name field and enter a new name for the new Calendar Administrator. 
The resource’s job title and e-mail information populates automatically.

3. Click Update to save your changes.

The value of "JTF HTML Calendar: Administrator" profile option is updated to 
the new resource name.

See Also
� Setting Profile Options

� Starting Workflow Processes

� Adding a Calendar Tab to a Responsibility

� Creating a Calendar Administrator

Note: For more information regarding the Preferences and 
Personal Profile links accessed through the profile icon, please see 
the Oracle CRM System Administrator Console Concepts and Procedures 
Guide.
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� Creating a Calendar User

� Running the Concurrent Program

22.5 Implementing Calendar Events
In addition to scheduled appointments and tasks, HTML Calendar provides the 
ability to allow users to view calendar events, such as campaigns, on their calendar 
views.

In order to use this functionality, the integrated applications have to perform the 
following tasks: 

1. Identify resource groups to which they would like to publish events and add 
CALENDAR_ITEMS usage to the groups.

2. Make sure that business objects (known as events in calendar) that are 
published are valid JTF_OBJECTS with all the following metadata defined:

� SELECT_NAME 

� SELECT_ID 

� FROM_TABLE 

� OBJECT_CODE 

� WHERE_CLAUSE 

� WEB_FUNCTION_NAME 

� WEB_FUNCTION_PARAMETERS 

� WEB_HTML_CALL

3. Populate the JTF_CAL_ITEMS_B table using the JTF_CAL_ITEMS_PUB API. 

In order to view the calendar events in the personal calendars, calendar users must 
also meet the following conditions:

� Users must belong to resource groups to which the event is published. 

� Users must have the "Display Events" set to yes in the calendar personal 
preference page from the Profile navigation link. 

� Users must further personalize how these calendar items will be displayed in 
their personal calendars by selecting the desired color and prefix text. 

This feature will work only when integrated applications implement the 
functionality and follow the required steps.
Implementing the HTML Calendar 22-9



Setting Profile Options
Oracle Marketing Online (OMO) is one of the applications that is currently 
implementing this functionality. Please refer to Oracle Marketing Online 
Implementation Guide for more details.

22.6 Setting Profile Options
The following table describes the profile options that are specific to the HTML 
Calendar.

Table 22–1 Calendar Profile Options

Name
Default 
Value Level Description Outcome

JTF HTML 
Calendar: 
Administrator

No 
default 
value

Site The JTF HTML Calendar: 
Administrator profile option sets 
the Calendar Administrator who 
grants approval and 
subscription requests for group 
and public calendars.

Set the value to the username 
of the calendar user who 
grants group and public 
calendar requests.

Client Timezone America/
Los_
Angeles

Site The Client Time zone profile 
option is used by Calendar to set 
the default time zone for the 
client in the Create Appointment 
window.

Set the value to the location 
where your appointments 
take place.

Setting the time zone from 
the profile link in the 
Calendar UI is another way 
to set and update this profile 
value.
22-10 Oracle Common Application Components Implementation Guide



Setting Profile Options
See Also
� Starting Workflow Processes

� Adding a Calendar Tab to a Responsibility

� Creating a Calendar Administrator

� Creating a Calendar User

� Changing a Calendar Administrator

� Running the Concurrent Program

JTF HTML 
Calendar Task Span 
Days

No Site The JTF HTML Calendar Task 
Span Days profile option sets 
tasks that spans over more than 
one day to appear continuously 
across days on your personal 
calendar.

Set the profile option to Yes 
to have your tasks that span 
over more than one day to 
appear continuously across 
days on your personal 
calendar. 

If the value is set to No, the 
task shows as a memo for 
each day affected.

JTF_PROFILE_
DEFAULT_
RESPONSIBILITY

22946 User The JTF_PROFILE_DEFAULT_
RESPONSIBILITY profile option 
sets the default responsibility 
when using calendar as a 
stand-alone application.

Set the value to correspond to 
the calendar user. The user 
value is 22946

JTF_PROFILE_
DEFAULT_
APPLICATION

690 User The JTF_PROFILE_DEFAULT_
APPLICATION profile option 
sets the default application 
when using calendar as a 
stand-alone application.

Set the value to correspond to 
the calendar user. The user 
value is 690.

Note: See Appendix A, Profiles Options, for details on how these 
profile options can be set.

Table 22–1 Calendar Profile Options

Name
Default 
Value Level Description Outcome
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22.7 Starting Workflow Processes
HTML Calendar uses the following workflow processes in order for it to work 
properly:

� JTF Calendar Workflows. Use JTF Calendar Workflow to track and route 
calendar requests to Calendar Administrator for new group and public calendar 
approvals and to Group Calendar Administrators, the owners of the group 
calendars, for existing group calendar subscription approvals. It also sends 
invitations for appointment invitees and attendees.

� JTF Task Reminder. Use JTF Task Reminder to pick up appointment reminders 
for scheduled appointments. For example, if "15 minutes Before" is selected 
from the Remind Me drop-down list while creating an appointment, then a user 
receives a workflow notification 15 minutes prior to the scheduled meeting 
starts. 

Prerequisites
None

Responsibility
System Administrator

Navigation
Navigate to Concurrent > Request.

Steps
1. In the Find Request window, click Submit a New Request. The Submit a New 

Request window opens.

2. Select the Single Request option button and click OK. The Submit Request 
window opens.

3. Enter "Workflow Background Process" as the workflow process.

Note:

� Refer to the Oracle Workflow Administrator’s Guide to configure 
and monitor workflow.

� If the concurrent manager is not up and running, workflow 
does not work correctly.
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The parameters window opens.

a. Enter one of the following for the item type:

* Enter "JTF Task Reminders" to start the workflow for task reminders.

* Enter "JTF Calendar Workflows" to start the workflow process for 
group calendar approvals.

The item type restricts this engine to activities associated with the item type 
you select.

b. Enter the Minimum and Maximum thresholds, in a hundredth of a second, 
which specifies the minimum and maximum costs that an activity must 
have for this background engine to execute.

c. Enter Yes for the Process Deferred, which specifies whether or not this 
background engine checks for deferred activities.

d. Enter Yes for the Process Timeout and click OK.

4. Click Schedule in the At these Times region.

5. Select the job to run periodically, in the Run the Job region.

6. Enter the start date and leave the end date blank to run the workflow 
indefinitely.

7. Define the interval which triggers the workflow to check for requests every 
specified minute, hour, day, week, or month and click OK.

8. Click Yes in the confirmation window if you selected for the workflow to run 
indefinitely. 

9. Click Submit to confirm.

10. Click No to exit.

11. To stop the workflow process, query any workflows that are running and cancel 
the request.

See Also
� Adding a Calendar Tab to a Responsibility

� Creating a Calendar Administrator

� Creating a Calendar User

� Changing a Calendar Administrator
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� Setting Profile Options

� Running the Concurrent Program

22.8 Running Concurrent Program
The Rebuilding Intermedia Index for Task Names concurrent program rebuilds the 
intermedia index so that a user can use the Quick Find to search for new and 
updated appointments and tasks. For more information on running this concurrent 
program, see the Running the Task Manager Concurrent Program documentation in 
the Task Manager section.

Guidelines
The following table describes the Rebuilding Intermedia Index for Task Names 
concurrent program.

See Also
� Adding a Calendar Tab to a Responsibility

� Creating a Calendar Administrator

� Creating a Calendar User

� Changing a Calendar Administrator

� Setting Profile Options

� Starting Workflow Processes

Table 22–2 Task Manager Seeded Concurrent Programs

Name Description Frequency

Rebuilding Intermedia 
Index for Task Names

This program is used to rebuild the intermedia index 
so a user can use the quick find to search for new and 
updated tasks as well as to search by task name.

As needed
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Implementing the Forms-based Calendar

This chapter covers the following topics:

� Defining a Calendar

� Defining Availability

� Defining Unavailability (Exceptions)

� Assigning a Calendar to a Shift

� Assigning an Exception to a Calendar

� Assigning a Resource to a Calendar

23.1 Defining a Calendar
To be able to show resource work shift information, the implementor or system 
administrator must define a calendar with start and end date information. For 
example, you can create a corporate calendar which runs from January 01, 2003 to 
December 31, 2003. Once the shifts and exceptions are specified, they can be 
associated with the calendar used specifically for resource scheduling. 

Perform the following steps in Forms to define a calendar.

Prerequisites
None

Responsibility
CRM Administrator
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Navigation
Navigate to Calendar > Calendar Setup > Define Calendar.

Steps
1. Enter a name for the calendar. 

2. Select the type of calendar you want to create from the list of values (LOV). 
Options include, Corporate, Division, Group, Personal, and Team. 

3. Enter a description for the calendar type. 

4. Select the start and end dates from the LOV for your calendar.

This defines how long your calendar is active

5. Click Save.

See Also
� Defining Availability

� Defining Unavailability (Exceptions)

� Assigning a Calendar to a Shift

� Assigning an Exception to a Calendar

� Assigning a Resource to a Calendar

23.2 Defining Availability
Use the define shift window to define available work hours. A shift is defined as the 
time a resource is available, and a shift pattern is the shift that extends for a longer 
period of time. 

Examples of a shift can be that a service engineer works from 7:00 a.m. to 4:00 p.m. 
on Monday, or from 8:00 a.m. to 3:00 p.m. from Tuesday through Friday. A shift 
pattern for the service engineer is that she works from 7:00 a.m. to 4:00 p.m. on 
Monday and from 8:00 a.m. to 3:00 p.m. for Tuesday through Friday. This shift 
pattern can be defined from January 01, 2003 to May 31, 2003. 

In addition, implementors can further specify if the shift is a regular or standby shift 
in the Availability Type field. After identifying shift information, implementors can 
then associate it with a specific calendar.

The shift information can be seen as yellow background displayed in the Gantt 
chart while using Assignment Manager for resource selection.
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Perform the following steps in Forms to define shifts and shift patterns.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Calendar > Calendar Setup > Define Shifts.

Steps
1. In the Define Shift window, enter a shift name.

2. Enter a description of the shift.

3. Enter the start and end dates for the duration of the shift.

4. Select the day of the week from the list of values (LOV) in the Shift Pattern 
region.

5. Enter the time the shift begins in the following format: 00:00.

6. Enter the duration of the shift in decimals where .25 = 15 minutes, .50 = 30 
minutes, and .75 = 45 minutes.

Information on the end of the shift, including the day and time, is automatically 
populated once you enter the shift duration.

7. Select the availability type from the LOV.

8. Save your work.

Your shift pattern is saved to the database. 

Note:

� Shift patterns cannot overlap.

� Begin time is expressed in hours and minutes and duration is 
expressed in decimals.
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See Also
� Defining Unavailability (Exceptions)

� Defining a Calendar

� Assigning a Calendar to a Shift

� Assigning an Exception to a Calendar

� Assigning a Resource to a Calendar

23.3 Defining Unavailability (Exceptions)
You must define not only your working hours, but also the times when you are not 
available for work, such as federal holidays, vacation, or sick days. These days are 
exceptions to your regular working shift. 

Perform the following steps in Forms to define non-availability. 

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Calendar > Calendar Setup > Define Exceptions.

Steps
1. In the Exceptions window, enter a name for your non-available work time.

2. Select a category from the LOV. A category is a predefined type of exception.

3. Enter a description of your exception.

4. Define a start and end date for your exception.

5. Click Save.

Your exception information is saved to the database.

See Also
� Defining Availability
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� Defining a Calendar

� Assigning a Calendar to a Shift

� Assigning an Exception to a Calendar

� Assigning a Resource to a Calendar

23.4 Using the Assign Shift and Exceptions Window
You can use the Assign Shift and Exceptions window to perform the following 
actions:

� Assigning a Calendar to a Shift

� Assigning a Calendar to an Exception

23.5 Assigning a Calendar to a Shift
After defining work shifts, the implementor or system administrator must assign 
them to a calendar. To assign them to a calendar, query up the calendar specifically 
used for scheduling resource, and then enter shift information in the Shifts tab.

Perform the following steps in Forms to assign previously defined shift patterns to a 
specific calendar.

Prerequisites
You must first define your shifts and shift patterns.

Responsibility
CRM Administrator

Navigation
Navigate to Calendar > Calendar Setup > Assign Shift/Exceptions.

Steps
1. In the Assign Shift/Exceptions window, select the Shifts tab.

2. Enter a calendar name.

3. Enter the calendar type. 

4. Enter the calendar description.
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5. Enter the effective dates.

6. In the Shifts field, select your already defined shift from the list of values (LOV) 
and click Save.

See Also
� Defining Availability

� Defining Unavailability (Exceptions)

� Defining a Calendar

� Assigning an Exception to a Calendar

� Assigning a Resource to a Calendar

23.6 Assigning an Exception to a Calendar
Use the same calendar that has work shift information to assign previously defined 
exceptions. As a result, this calendar will have both available and unavailable work 
information for a period of time.

Perform the following steps in Forms to assign previously defined exceptions to a 
specific calendar.

Prerequisites
You must first define your non-available work hours (exceptions).

Responsibility
CRM Administrator

Navigation
Navigate to Calendar > Calendar Setup > Assign Shift/Exceptions.

Steps
1. In the Assign Shift/Exceptions window, select the Exceptions tab.

2. Select a calendar name from the list of values (LOV). 

3. Select the Exception Tab.

4. Select the name of the calendar from the LOV.

5. Select the reason for the exception.
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6. Enter the effective dates and click Save.

See Also
� Defining Availability

� Defining Unavailability (Exceptions)

� Defining a Calendar

� Assigning a Calendar to a Shift

� Assigning a Resource to a Calendar

23.7 Assigning a Resource to a Calendar
After associating work shift and exception information to a calendar, the 
implementor can assign resources to it. 

In order to show the resource work shift information as yellow background in the 
Gantt chart while using the Assignment Manager for resource selection, 
implementor or system administrator must select YES in the Primary Calendar 
field. This is because only primary calendar will be considered for availability 
purposes.

Resources of any categories defined in Resource Manager can be assigned to a 
calendar.

Perform the following steps in Forms to assign a resource to a calendar.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to Calendar > Calendar Setup > Assign Resources.

Note: A resource can be assigned to many calendars, but can have 
only one primary calendar for a period of time.
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Steps
1. Select the calendar name from the list of values (LOV).

2. Enter the calendar type.

3. Enter a description for the calendar. 

4. Select the resource type from the drop-down list. 

5. Enter the name of the resource.

6. If this is your primary calendar, set the primary calendar flag to Yes. 

7. Enter the Effective Dates for the calendar and click Save.

See Also
� Defining Availability

� Defining Unavailability (Exceptions)

� Defining a Calendar

� Assigning a Calendar to a Shift

� Assigning an Exception to a Calendar
23-8 Oracle Common Application Components Implementation Guide



Part VIII

 Escalation Manager

This part of the Oracle Common Application Components Implementation Guide 
contains the following chapters:

� Implementation Overview

� Implementation Tasks

� Troubleshooting Escalation Manager





Implementati
24

Implementation Overview

This chapter provides an overview of the Escalation Manager implementation 
process.

24.1 Overview
An escalation is a process used to highlight or flag certain issues within an 
organization, so that the appropriate personnel can react to these situations and 
monitor the resolutions. A reactive escalation is in response to a customer 
complaint. Necessary action must be taken in response to the situation. This 
includes manually assigning escalation resources through Escalation Manager. 

24.2 Steps
This section describes the order and process of implementing Escalation Manager in 
Forms.

24.2.1 Setting Profile Options
The Implementor identifies and sets specific profile options as required.

24.2.2 Starting the Background Workflow Process
The implementor starts the background workflow process to generate notifications 
for the designated contact when the escalation is created and the owner, escalation level, 
target date, or status is changed.
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24.2.3 Defining a New Escalation Status
The implementor optionally defines a new escalation status. Escalation statuses are 
used to define the state of the escalation document.

24.2.4 Defining New Escalation Reference Types
The implementor optionally defines new reference types. These determine if a 
document is going to be escalated. Examples are open, closed or working.

24.2.5 Define New Escalation Reason Codes
The implementor optionally defines new escalation reason codes. Escalation reasons 
are used to specify why a source document is escalated.

24.2.6 Defining the New Escalation Contact Types
The implementor optionally defines escalation contact types. Escalation contact 
types are used to classify the category for contacts. For example, contacts can be 
employees or customers.

24.2.7 Defining the Escalation Level
The implementor optionally defines escalation levels that specify the levels of 
escalation severity. 
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Implementation Tasks for Escalation

Manager

This chapter covers the following topics:

� Setting Profile Options

� Starting the Background Workflow Process

� Setting Escalation Status

� Setting Escalation Lookup Codes

– Defining Escalation Reference Codes

– Defining Escalation Reason Codes

25.1 Setting Profile Options
The first step in implementing Escalation Manager is to set the following profile 
options:

Note: There is no specific implementation order if you want to 
define new escalation reasons, levels, statuses, reference codes and 
contact types. 
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Table 25–1 Escalation Manager Profile Options

Name
Default 
Value Level Description Outcome

Escalation: Close 
Only When 
De-escalated

Yes Site The escalation document cannot 
be closed (you cannot set up the 
escalation status to 'Close') 
without first changing the 
Escalation Level to 'De-escalated'. 

If set to Yes, then it can 
regulate the escalation 
status change sequence 
from De-escalated to 
Close. 

If set to No, then it will 
not.

Escalation: Default 
Contact Type

Employee Site This profile option sets the 
default contact type to Employee 
in the Contacts tab.

You can also set it to 
Customer, and then it 
will default the contact 
type to Customer.

Escalation: Default 
Escalation Owner

Name Site This profile option sets the 
default escalation owner to a 
specific resource name, such as 
John Smith.

See description.

Escalation: Default 
Customer Contact 
Point

Phone Site This profile option sets the 
default customer contact point to 
Phone in the Contacts tab.

You can also set it to 
other values such as 
Cell, Email, Pager, or 
Web.

Escalation: Default 
Document Type

Task 
Manager

Site This profile option sets the 
default document type to Task in 
the Document field on the 
Reference Document tab.

You can also set it to 
other values such as 
Service Request or 
Defects.

Escalation: Default 
Employee Contact 
Point

Work Site This profile option sets the 
default employee contact point to 
Work in the Contacts tab.

You can also set it to 
other values such as 
Home, Mobile, or Pager.

Escalation: Default 
Escalation Level

Level 1 Site This profile option sets the 
default escalation level to Level 
1.

You can also set it to 
other values such as 
Never Escalated, Level 
2, or De-Escalated.

Escalation: Default 
Status

Open Site This profile option sets the 
default escalation Status field to 
Open.

You can also set it to 
other values such as 
Closed or Working.

Escalation: Default 
New Note Type

General 
Note

Site This profile option sets the 
default note type to General Note 
if additional notes are attached to 
an escalation document.

You can also set it to 
other values such as 
Event or Approved. 
25-2 Oracle Common Application Components Implementation Guide



Setting Profile Options
See Also
To change profile options and see detailed information, use the standard procedure 
outlined in Appendix A, Profile Options. 

The following table describes Escalation Manager Profile Settings.

Escalation: Default 
Notify (Y/N)

Yes Site This profile option sets the 
default Notify check box to 
"checked" in the Contacts tab. 

You can also set it to No, 
which will leave the 
check box "unchecked" 
in the Contacts tab.

Escalation: Default 
Reason Code

Slow 
Progress

Site This profile option sets the 
default escalation Reason field to 
Slow Progress.

You can also set it to 
other values such as 
Unacceptable Solution, 
or Unresponsive Owner.

Escalation: Default 
Reference Type

Escalation Site This profile option sets the 
default escalation reference type 
to Escalation in the Reference 
Document tab.

You can also set it to 
other values such as For 
Your Information.

Note: See Appendix A, Profiles Options, for details on how these 
profile options can be set.

Table 25–2 Escalation Manager Profile Settings

Profile Option Default Value

Escalation: Close Only When De-escalated Yes

Escalation: Default Contact Type Employee

Escalation: Default Escalation Owner No default value

Escalation: Default Customer Contact Point Phone

Escalation: Default Document Type Task Manager

Escalation: Default Employee Contact Point Work

Escalation: Default Escalation Level Level 1

Escalation: Default Status Open

Table 25–1 Escalation Manager Profile Options

Name
Default 
Value Level Description Outcome
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25.2 Starting the Background Workflow Process
The next implementation step is to start the background workflow process listed in 
the following table to ensure proper operation of Escalation Manager.

Use the following procedure to start the required background workflow process.

Prerequisites
None

Responsibility
System Administrator

Navigation
Navigate to the Navigator - System Administrator window.

Steps
1. Select Requests > Run.

The Submit a New Request window opens.

2. Select Single Request and click OK.

3. In the Submit Requests window, type W in the Name field and select Enter on 
your keyboard.

Escalation: Default New Note Type General Note

Escalation: Default Notify (Y/N) Yes

Escalation: Default Reason Code Slow Progress

Escalation: Default Reference Type Escalation

Table 25–3 Escalation Manager Workflow

Workflow Name Description User

JTFEC Reactive Escalation Notification Escalation Manager

Table 25–2 Escalation Manager Profile Settings

Profile Option Default Value
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The Reports window opens and displays report names that begin with "w".

4. Select Workflow Background Process and click OK.

The Parameters window opens.

5. Type "re" in the Item Type field and select Enter on the keyboard.

The Item Type window opens and displays items that begin with the letters "re."

6. Select Reactive Escalation Notification and click OK.

Leave the Minimum Threshold and Maximum Threshold fields empty.

7. Select Yes for both the Process Deferred and the Process Timeout fields and 
click OK.

8. Click Schedule on the Submit Request window.

9. Select Run the Job...Periodically.

More options appear for defining the time period.

10. Define the Start Time and the End Time.

11. In the Rerun Every fields, enter the number of minutes that defines the interval 
between job runs.

12. Select the From the Completion of the prior run box and click OK.

Guidelines
You must set up Notifications in Oracle Workflow to ensure that notifications are 
sent.

25.3 Setting Escalation Lookup Codes
Another required task in implementing Escalation Manager is to set lookup codes. 
The codes define the level, reason, contact type, and reference of an escalation. 
Escalation reasons are used to specify why a source document is escalated. 

First set up the escalation reason code and enable it in the Application Object 
Library: Escalation Reasons Lookups window. Then, as a task or document is 

WARNING: Be sure to define an end time. If the end time field is 
blank, then the process runs indefinitely and cannot be shut off. 
Implementation Tasks for Escalation Manager 25-5



Setting Escalation Lookup Codes
escalated, select this reason code from the list of values for the Reason field in the 
Escalations window.

� JTF_TASK_ESC_LEVEL 

� JTF_TASK_REASON_CODE

� JTF_TASK_CONTACT_TYPE

� JTF_TASK_REFERENCE_CODES

Lookup Code JTF_TASK_ESC_LEVEL 
The following table describes lookup code JTF_TASK_ESC_LEVEL, which describes 
escalation levels.

Lookup Code JTF_TASK_REASON_CODE 
The following table describes lookup code JTF_TASK_REASON_CODE, which 
describes escalation reasons.

Lookup Code JTF_TASK_CONTACT_TYPE 
The following table describes lookup code JTF_TASK_CONTACT_TYPE, which 
describes contact types.

Table 25–4 Lookup Code JTF_TASK_ESC_LEVEL

Code Description

DE De-escalated

L1 Level 1

L2 Level 2

NE Never escalated

Table 25–5 Lookup Code JTF_TASK_REASON

Code Description

SLOW-PROG Slow Progress

Unacceptable_Solution Unacceptable Solution

UNRES_OWN Unresponsive Owner

IMP_FAILING Implementation Failing
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Lookup Code JTF_TASK_REFERENCE_CODES 
The following table describes lookup code JTF_TASK_REFERENCE_CODES, which 
describes reference codes for the task.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to the Navigator - CRM Administrator window.

Steps
1. Select Task and Escalation Manager > Setup.

2. Select the appropriate lookup code. 

For example, select Define Escalation Reason to set the reason lookup codes.

3. Enter today’s date in the From field.

4. Leave the "To" field blank.

5. Select the Enabled check box to make it available.

Table 25–6 Lookup Code JTF_TASK_CONTACT_TYPE

Code Description

CUST Customer

EMP Employee

Table 25–7 Lookup Code JTF_TASK_REFERENCE_CODES

Code Description

ESC Escalation

FYI For Your Information
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6. Save your work.

25.4 Setting Up Escalation Status
There are three pre-defined Escalation Statuses: 

� Open

� Working

� Closed

You may add your own user-defined statuses to these available statuses. Perform 
the following steps to add user-defined statuses.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
 Navigate to the Navigator - CRM Administrator window.

Steps
1. Select Task and Escalation Manager > Setup > Define Escalation Status.

2. Enter a user-defined status in a blank field in the Status column.

3. Enter a brief description of the status type in the Description field.

4. Enter the effective dates in the From and To fields.

5. Select escalation status flags.

6. Click the Save icon to finish defining the Escalation status. 

References
The following table describes flags and definitions.
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25.5 Defining Escalation Reference Codes
A document or task can be combined with several other documents or tasks, such 
as when fulfilling a service request requires a series of tasks to be performed and 
related documents to be completed. In such a scenario, if one particular document 
or task needs to be escalated, the escalation might not apply to the other related 
items. 

When you associate an Escalation Reference to the escalated item, you point to the 
other related items and indicate their relation. There are two pre-defined Escalation 
Reference types: FYI and Escalation. 

� Use FYI (for your information) to indicate the task or document is related to the 
escalated item, but is not escalated.

� Use Escalation to indicate the task or document is related to the escalated item 
and also is escalated.

You can add other Escalation Reference types to your escalation references. Use the 
following procedure to define customized reference types.

Table 25–8 Escalation Status Flag Definitions

Flag Description

Assigned Assigned to an individual

Working In progress

Schedulable Scheduled or re-schedulable

Accepted Accepted by owner

Rejected Rejected by owner

On Hold Temporarily not active

Approved Approved by management

Completed Completed by owner

Cancelled Cancelled by owner, creator, or management

Delete Allowed Delete acceptable without cancellation

Closed Completed and closed

Seeded Pre-defined task status
Implementation Tasks for Escalation Manager 25-9



Defining Escalation Reason Codes
Prerequisites
None

Responsibility
CRM Administrator

Navigation
 Navigate to the Navigator - CRM Administrator window.

Steps
1. Select Task and Escalation Manager > Setup > Define Reference Type. 

The Application Object Library: Reference Codes for the Task Lookups window 
opens.

2. Enter the name of the new reference type in the first available row in the Code 
column.

3. Continue entering information in the remaining cells of the row to describe the 
escalation reference type and the effectivity dates.

4. Select the Enabled Check Box to make the escalation reference type available.

5. Save the new Escalation Reference and close the form.

25.6 Defining Escalation Reason Codes
You can add other escalation Reason Codes to customize your escalation reasons. 
Use the following procedure to define customized reason types.

Prerequisites
None 

Responsibility
CRM Administrator

Navigation
 Navigate to the Navigator - CRM Administrator window.
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Steps
1. Select Task and Escalation Manager > Setup > Define Escalation Reason.

The Application Object Library: Escalation Reasons Lookup window opens.

2. Select the first blank line.

3. Enter a code, meaning, and description.

4. Enter the effective dates in the From and To fields.

5. Select the Enabled flag.

6. Click the Save icon to finish defining the Escalation reason.
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Troubleshooting Escalation Manager

This chapter covers the following topics:

� Troubleshooting Tips

� Error Messages

26.1 Troubleshooting Tips
If you are having difficulties using Escalation Manager after implementing it, verify 
the following:

� Workflow is installed and working correctly.

� Territories have been defined and contain valid resources.

� System Profile Options starting with "Escalation..." are set to valid values.

If Assisted Assignment through the Assignment Manager does not return any 
resources, then check whether or not the Escalated object itself has a resource. 

26.2 Error Messages
This section contains information on some of the error messages associated with 
implementing Escalation Manager. 

26.2.1 APP-JTF-210807
APP-JTF-210807 No Resources Found.

Cause: This message is often reported as a problem with Escalation Manager. This 
error can occur when assigning an escalation territory. You can define the territory, 
with the appropriate resources, then associate an escalation territory with that 
 Manager 26-1



Error Messages
territory, and still the No Resources Found message appears. This happens most 
often because the object that is being escalated does not contain a territory itself. 

Action: If no territory is available in the escalated object, then there is no way to 
locate the appropriate escalation territory, so that the resources cannot be found.

Refer to bug #1617608 for further details on debugging steps.
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Implementation Overview

This chapter provides an overview of the Business Rule Monitor implementation 
process.

27.1 Overview
An escalation is a process used to highlight or flag certain issues within an 
organization, so that the appropriate personnel can react to these situations and 
monitor the resolutions. Escalation management is comprised of two modules: 
Escalation Manager and the Business Rule Monitor. The Business Rule Monitor is 
the proactive process.

In a proactive escalation, you take the necessary action to monitor customers issues 
before the customer complains. The Business Rule Monitor (BRM) is used to raise 
awareness. It provides a centralized place to define and also monitor business rules 
on a regular basis. Proactive escalation is used not just in response to problems but 
can be set up as a follow-up action.

27.2 Steps
The Business Rule Monitor is used to check active business rules by setting up an 
Oracle Workflow process which continuously loops and checks at a specified 
interval for all active business rules. This section provides a summary of the steps 
for implementing the Business Rule Monitor. Each step is performed in the 
Forms-based interface by the Implementor or the System Administrator.
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27.2.1 Define the Business Rule Monitor Workflow Administrator
The Business Rule Monitor workflow administrator can receive workflow 
notifications when the business rule monitoring process starts and stops, as well as 
when errors are detected. 

27.2.2 Set the Business Rule Monitor Workflow Administrator profile option
Before starting the business rule monitoring process, the Business Rule Monitor 
Workflow Administrator system profile option must be set and be linked to the 
E-Business suite Workflow Administrator.

27.2.3 Start the Background Processes
Before starting the business rule monitoring process, the background process for the 
Business Rule Monitor Main Process must be run. The following background 
processes are optional depending on which objects have active rules defined. Also, 
a background process should be started for any user-defined workflows that are 
being used.

� Business Rule Monitor Task Process 

� Business Rule Monitor Service Request Process

� Business Rule Monitor Defect Process

27.2.4 Create a New Business Rule
The implementor or system administrator can optionally create a new rule by 
defining a rule’s general information, specifying workflow and workflow attributes, 
and defining a rule’s condition which reflect your business logic.

27.2.5 Enable the New Business Rule
Before monitoring your business rules, the implementor or system administrator 
must enable them by entering the effective dates in the Business Rule Workbench 
window.
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27.2.6 Verify that an Escalation Territory has been created and contains at least one 
resource

Ensure that you have a resource assigned to an escalation territory. The escalation 
territory can be a catch all for all escalations. The resource needs to be a primary 
contact.

27.2.7 Start the Business Rule Monitor
The Business Rule Monitor is the control panel used to determine when the 
workflow process will run and stop.
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Phase I: Configuring the Business Rule

Monitor

This chapter covers the following topics:

� Setting Up the Business Rule Monitor

� Defining the Business Rule Monitor Workflow Administrator

� Setting Profile Options

� Starting the Background Workflow Processes

28.1 Setting Up the Business Rule Monitor
The Business Rule Monitor is one of the modules in Escalation Management. It is 
considered "proactive escalation" in that you can create rules based on your 
business logic and set them in a workflow process which will periodically check 
them. When the business rule is violated, the BRM workflow puts the violated rule 
in a queue, where it is picked up by Oracle Workflow. If a rule is violated, then a 
notification will be generated. How is this done? The Business Rule Monitor is 
integrated with other applications and modules, such as Oracle Workflow. The user 
that owns this workflow process receives notifications when the process starts and 
stops, and also when errors are detected. 

There are many dependencies which need to be set up prior to setting up the 
business rule monitor. Refer to the chapter "Before You Begin" for a list of 
dependencies.
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28.2 Defining the Business Rule Monitor Workflow Administrator
A workflow process controls the Business Rule Monitor, which in turn periodically 
checks all the active business rules. The BRM workflow administrator, typically the 
system administrator or workflow administrator who owns the workflow process, 
receives notifications when the monitoring process starts and stops, and also when 
errors are detected. This is to ensure that an owner of the workflow process exists 
and that the notifications can be sent successfully.

You must first setup the BRM workflow administrator user and add the following 
responsibilities to the workflow administrator, so that the administrator can start 
the Business Rule Monitor and receive workflow notifications:

� CRM Administrator responsibility: The workflow administrator can access the 
Business Rule Monitor module through this responsibility. He can start the 
Business Rule Monitor and monitor the workflow process. 

� Workflow (Oracle Self-Service Web Applications): The workflow 
administrator can check the workflow processes, and can view workflow 
notifications from the customize link Worklist region if it is set up correctly in 
your personal homepage.

� Preferences (Oracle Self-Service Web Applications): Use it to set up user 
preferences, for example, send or do not send e-mail notifications.

There are two types of notifications that can be sent through the Business Rule 
Monitor Main Process, to indicate the start and stop of the Business Rule Monitor, 
and any error conditions:

1. Workflow Notification: This type of notification can be viewed from the 
Worklist region if it is set up correctly in your personal homepage. 

To receive workflow notifications, select the Preferences responsibility. Then 
select General Preferences and change the value in the “Send me electronic mail 

Note: You can assign Workflow and Preferences responsibilities to 
many users, so that they can view workflow notifications if a 
business rule is violated and they are responsible for taking care of 
this automated escalation. However, there is only one BRM 
workflow administrator who will receive the notifications about 
when the monitoring process starts and stops, and also when errors 
are detected.
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notifications” field to “Do not send me mail”. This tells the system not to send 
you e-mail notifications, but instead to send them to your notifications page.

2. E-mail Notification: This notification requires correct workflow and email 
server setup and is usually done by the system or workflow administrator. To 
receive e-mail notifications, select the Preferences responsibility. Then select 
General Preferences and finally select the appropriate value in the “Send me 
electronic mail notifications” field.

Prerequisites
The designated workflow owner must already exist in order to start the workflow 
process. If no workflow owner exists, then the account must first be created.

Responsibility
System Administrator

Navigation
Navigate to the Navigator - System Administrator window.

Steps
1. Navigate to Security > User > Define.

2. Enter an existing username in the Name field.

3. Enter a password in the Password field.

Do not press Enter to move to the next field, you must move your cursor.

4. Enter the password again.

5. Select the Workflow Administrator responsibility from the List of Values (LOV) 
in the Responsibility field. This grants the responsibilities to the user.

6. Select the CRM Administrator responsibility from the LOV in the next 
Responsibility field. 

7. Select the Preferences responsibility from the LOV in the next Responsibility 
field.

8. Select File > Save.
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28.3 Setting Profile Options
The following table describes the profile options that are specific to the Business 
Rule Monitor.

28.4 Starting the Background Workflow Processes
The Business Rule Monitor, like other Oracle Workflow process, needs to have its 
background processes started in order for it to run. This is done using the standard 
applications concurrent manager. 

There are four predefined workflow item types. The Business Rule Monitor Main 
Process is the only one that is internal to the Business Rule Monitor. This process 
services the Business Rule Monitor looping workflow which itself checks all the 
active rules defined in the workbench and identify if any rule is violated.

The Business Rule Monitor Task Process is used when the violated business rule 
which is identified by the Business Rule Monitor Main Process is related to Task 
(object). This BRM Task process services the consequent activities based on the 
workflow information identified for the rule. For example, if the Escalate a Task 
(notification only) workflow is selected in the workbench for the rule, then a 
workflow notification will be sent automatically to the person identified in the 
workflow attributes window.

This is the same usage for the Business Rule Monitor Service Request Process and 
Business Rule Monitor Defect Process. The Business Rule Monitor Service Request 
Process is used when a violated rule is related to Service Request (object), and the 

Table 28–1 Business Rule Monitor Profile Options

Name
Default 
Value Level Description Outcome

Business Rule 
Monitor Workflow 
Administrator

No 
Default 
Value

Site This profile option must be 
set first in order to grant this 
profile option to the BRM 
Workflow Administrator. 

The Administrator can 
receive workflow 
notifications when the 
monitoring process starts 
and stops, and also when 
errors are detected.

Note: See Appendix A, Profiles Options, for details on how these 
profile options can be set.
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Business Rule Monitor Defect Process is used for a violated rule which is related to 
Defect (object).

These attributes are maintained within the Business Rule Workbench, and can be 
viewed by clicking the button next to the workflow field. The following table 
describes the seeded workflow processes.

Proper operation of the Business Rule Monitor requires that the Business Rule 
Monitor Main Process be started before starting the Business Rule Monitor. Perform 
the following procedure to start these background processes. Additionally, the 
optional background workflow processes may be started if necessary.

Prerequisites
None

Responsibility
System Administrator

Navigation
Navigate to the Navigator - System Administrator window.

Steps
1. Select Requests > Run.

The Submit a New Request window opens.

2. Select Single Request and click OK.

3. In the Submit Requests window, type W in the Name field and select Enter on 
the keyboard.

The Reports window opens and displays report names that begin with "w".

Table 28–2 Seeded Workflow Processes

Item Types Description

JTFBRM Business Rule Monitor Main Process

JTFBRMDF (Optional) Business Rule Monitor Defect Process

JTFBRMPR (Optional) Business Rule Monitor Task Process

JTFBRMSR (Optional) Business Rule Monitor Service Request Process
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4. Select Workflow Background Process and click OK.

5. Type "bu" in the Item Type field and select Enter on the keyboard.

The Item Type window opens and displays the four Workflow background 
processes required by the Business Rule Monitor.

6. Select one of the four Business Rule Monitor processes and click OK.

Leave the Minimum Threshold and Maximum Threshold fields empty.

7. Enter Yes in the Process Deferred field, in the Process Timeout field, and the 
Process Stuck field and click OK.

The Submit Request window appears in front.

8. Click Schedule on the Submit Request window.

The Schedule window appears in front.

9. Select Run the Job...Periodically.

More options appear for defining the time period.

10. Define the Start time and the End time. An end time of two hours after the start 
time is recommended.

11. In the Rerun Every field, enter the number of minutes that defines the interval 
between job runs. A rerun time of two minutes is recommended.

12. Select the From the Completion of the prior run box and click OK.

13. Repeat this entire procedure for any of the optional background workflow 
processes that you require, or for your own customized processes.

Guidelines
� If the four seeded background processes are not used, you still need to run the 

Business Rule Monitor Main Process, plus any of your own workflow processes 
that are used. Initially select some parameters and allow the background 
processes to run. Monitor their performance and tune the parameters as 
necessary to meet the needs of your enterprise.

� Remember to run your workflow processes periodically, for example, every 15 
minutes throughout the expected duration of the Business Rule Monitor.

WARNING: Be sure to define an end time. If the end time field is 
blank, then the process runs indefinitely and cannot be shut off. 
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Phase II: Implementing Business Rules

Using the Business Rule Monitor

This chapter covers the following topics:

� Creating and Enabling a New Business Rule

� Enabling a New Business Rule

� Verifying an Escalation Territory

� Starting the Business Rule Monitor

29.1 Creating a New Business Rule
In addition to the seeded business rules provided with the Business Rule Monitor, 
you can define your own business rules. Use the following procedure to define a 
business rule.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to the Navigator - CRM Administrator window.

Steps
1. Select Business Rule Monitor > Business Rule Workbench.
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2. Enter values for the following:

� Name: The name of the new business rule.

� Object: The object for which the rule will operate.

� Check Rule Every: The time interval that you want.

� Effective: Use the LOV to select the date to start the rule.

Only put an end date to stop the rule.

� Owner: Mandatory field.

� Workflow: Chose a workflow from the drop down menu.

Attributes can be defined for the Workflow and an Owner for the business 
rule.

3. Use the fields in the Simple tab to define conditions when the business rule is 
triggered. 

4. Click Validate to check the syntax of the PL/SQL statement defined in the 
Simple tab. The syntax check verifies whether or not the syntax is correct. 

A dialog box confirms that the syntax validation was successful. 

5. Click OK.

6. Click Generate. 

A dialog box confirms that your business rule has been generated.

7. Select File > Save.

Guidelines
� You can leave the Effective Dates field empty until the time you want to start 

the business rule. Once you enter the effective dates for your rule, you enable 
and start the rule.

� After defining a rule, specify its condition for your rule in SQL format. This can 
be done in either of the following tabs:

– Simple: Use the Simple tab to make guided SQL statements by specifying 
the appropriate values for the necessary fields. For example, if your rule is 
defined for a task with Open status, then you need to select Status (Task) 
from the LOV in the Left Value field, “=“ in the Operator field, and “Open” 
from the Right Value field.
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– Complex: Use the Complex tab if you are knowledgeable in SQL and want 
to directly write SQL statements.

See Also
Enabling a New Business Rule

29.2 Enabling a Business Rule
Before monitoring your business rules, you need to enable them first by entering 
the effective dates in the Business Rule Workbench window. Use the following 
procedure to first search for a rule, and then second, enable it.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to the Navigator - CRM Administrator window.

Steps
1. Select Business Rule Monitor > Business Rule Workbench.

The Business Rule Workbench window opens.

2. Select View > Find.

3. Enter a name, an object, or other search criteria, and click Find to return to the 
Business Rule Workbench. Use the up or down arrow keys to select the rule that 
you want to use if there is more than one rule that matches your search criteria.

4. Enter the effective date in the Business Rule Workbench window.

5. Save your work.

Guidelines
If this rule has been generated and the Business Rule Monitor has been started, this 
rule will then be monitored from the effective date. If this rule has not been 
generated, you can click Generate to generate your business rules. If a business rule 
Phase II: Implementing Business Rules Using the Business Rule Monitor 29-3



Verifying an Escalation Territory
is generated without problems, a note message displays “Your Business Rule has 
been generated.”

29.3 Verifying an Escalation Territory
The automatic assignment and notification of escalations depends heavily on the 
Territory Manager module. So what happens if escalation territories are not there?

If the identity of a person who receives notifications defined in the Workflow 
Attributes window cannot be determined, then a notification is sent to the primary 
contact for the escalation territory associated with the source document owner’s 
territory if the territory ID exists. If the territory ID does not exist, it is sent to the 
primary contact in the catch-all territory, or the Business Rule Owner. 

Therefore, the system administrator needs to ensure that the correct structure of 
escalation territories or a catch-all territory is defined at installation time. Use the 
following procedure to verify an escalation territory.

Prerequisites
None

Responsibility
CRM Administrator

Navigation
Navigate to the Navigator - CRM Administrator window.

Steps
1. Select Territory Manager > Territory Administration.

2. Select Administration > Search.

The Territory Search window opens.

3. Select your usage from the list of values in the Usage field.

Note: The Generate button dynamically creates a view in the 
database. This view queries the objects that fit the conditions you 
have defined in the business rule and is used by the main BRM 
process when it checks the rule, to detect the objects that it needs to 
take action about.
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4. Select Escalations from the Search Category field.

5. Click Search.

Guidelines
Refer to Using Territory Manager for details.

29.4 Starting the Business Rule Monitor
Use the Business Rule Monitor to monitor the workflow processes. Specify the time 
interval in the Control Panel region. This sets up an Oracle Workflow process which 
continuously loops and checks at a specified interval for all active business rules. 

For example, suppose the Open Task business rule is defined to be checked every 
hour. Now, if the interval is set to five minutes and the Start button is selected, then 
the BRM starts the monitoring process. The main background process (Business 
Rule Monitor Main Process) services the Business Rule Monitor looping workflow 
which itself checks all the active rules, not just your Open Task rule, every five 
minutes to see which of the active rules are due to be checked. If it is less than one 
hour since the Open Task rule was checked last time, then this rule won’t be 
checked until it is due. For those that are due, the BRM looping workflow then goes 
on to see if there are any objects that violate the rule. If a high priority task has 
stayed open for more than four hours, then this task will be identified. The 
appropriate background workflow process (such as Business Rule Monitor Task 
Process) is then performed to service the escalation activity workflow for that 
business rule. If the Escalate a Task (notification only) workflow is selected in the 
workbench, then the task owner will receive a workflow notification automatically. 
Perform the following procedure to start the Business Rule Monitor.

Prerequisites
Any workflow process that is used in the Business Rule Monitor must be started. If 
you have designed customized workflow background processes, then the 
background processes for these workflows must also be started. In addition, the 
Business Rule Monitor Administrator profile option must be set.

Responsibility
CRM Administrator

Navigation
Navigate to the Navigator - CRM Administrator window.
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Steps
1. Select Business Rule Monitor > Business Rule Monitor.

The Business Rule Monitor opens.

1. Enter the time period in the Interval field. Enter a time unit (minutes or hours) 
in the UOM field.

2. Click Save.

3. Click Start to activate the Business Rule Monitor. 

A dialog box confirms that the Business Rule Monitor started successfully. 

4. Click Workflow Monitor to view details of this process.

Guidelines
After the monitor is started, the Stop button appears. Click Stop to stop the monitor.

Click Refresh Status to get an immediate status on the BRM main process.
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Troubleshooting the Business Rule Monitor

This chapter covers the following topics:

� Troubleshooting Tips

� General Tips for Defining Rules

� Stopping the Business Rule Monitor

� Answers to Frequently Asked Questions (FAQs)

30.1 Troubleshooting Tips
If you are having difficulties using the Business Rule Monitor after implementing it, 
verify the following:

� The Concurrent Manager is running.

� Workflow background processes for all Escalation Workflows are running 
periodically.

� Oracle Workflow is installed and correctly running.

� Profile Option "Business Rule Monitor Workflow Administrator" is set to the 
Apps user ID of a valid user with the Workflow responsibility.

� Profile Option "Escalation: Default Level" is set to a value which exists in the 
Define Escalation Level form.

30.2 General Tips for Defining Rules
The following suggestions are helpful when defining rules in the BRM:
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� The condition should not reflect an absolute state. Otherwise, the monitor will 
keep detecting the same objects and acting upon them; you may have repeated 
notifications sent.

� Use reasonable check intervals. The check interval also determines the 
notification interval. So, if you check a rule every two minutes, notifications are 
sent every two minutes.

� Take loop time into consideration. If the main scan cycle is set to run every ten 
minutes, then there is no point in setting the check frequency to two minutes.

� Even in a simple rule, SQL syntax applies. You can use SQL functions, but you 
also have to use quotes around your character values. Also use IS NULL and IS 
NOT NULL instead of =NULL and <>NULL.

� Verify that the view does what you intended for it to do. The simplest way to 
do this is to cut and paste the view definition from the Complex tab into a SQL+ 
session.

� Check the performance of the view. Do a Select from your view. If it takes a 
long time to return the values, then ask a SQL expert for assistance.

30.3 Stopping the Business Rule Monitor
Some patches for CRM Foundation require the Business Rule Monitor to be stopped 
before the patch can continue. You can tell if the Business Rule Monitor is running 
by entering the CRM Administrator responsibility and navigating to Business Rule 
Monitor > Business Rule Monitor - this invokes the Control Panel. The Status field 
will show 'Active' or 'Stopping' if the Business Rule Monitor is in a running state.

To stop the Business Rule Monitor press the 'Stop' button on the Business Rule 
Monitor Control Panel. Note that the workflow background process for the 
'Business Rule Monitor Main Process' workflow should be running in order for the 
'Stop' command to be processed.

If the Business Rule Monitor Control Panel shows a status of 'Stopping' for an 
unusually long period of time, this is normally caused by the workflow background 
process not being running at the time the 'Stop' button is pressed. To start the 
workflow background process perform the following steps:

Steps
1. Select System Administrator responsibility from the Requests menu option.

2. Select Run.
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3. Run a Single Request.

a. The name is Workflow Background Process.

b. The item type is Business Rule Monitor Main Process

c. Leave min and max threshold blank.

d. Process deferred to Yes.

e. Process timeout to Yes.

4. Click OK.

5. Select the Schedule button.

6. Select Periodically.

7. Enter an end date and time of 15 minutes later.

8. Re-run every three minutes.

9. From Completion of the prior run, click OK.

10. Select Submit.

� Note that if your Business Rule Monitor main process is running every 30 
minutes, for example, then you will need to extend the end time of the 
background process so that it is still running the next time the BRM process 
checks for instructions.

� You then need to wait for the BRM to do its next run so that it will process the 
'STOP' command, then the status should show 'Complete' and you can continue 
with the patch.

� You should not comment out this script and continue with the patch as this will 
leave your system in an undefined state.

� If for some reason the main BRM workflow will not process the 'STOP' 
command then you will need to abort the process from within the Workflow 
Monitor. To do this:

a. Find the error notification for itemkey JTFBRM and the process ID that is 
shown on the BRM control screen: these notifications are usually sent to the 
SYSADMIN user.

b. View the notification for this process.

c. At the bottom of the screen there is a poplist from where you choose what 
you want to happen next, select Abort.
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d. After a short while the process should stop.

30.4 Answers to Frequently Asked Questions (FAQs)
The following are frequently asked questions. Answers to these questions may help 
you in troubleshooting problems with the Business Rule Monitor.

30.4.1 What is the relationship between the following "Time Related Features"?
Answer: In Business Rule Monitor (BRM), you have the option to select how often 
(in <<Interval>> Field) you want the BRM to check the rules noted in Business Rule 
Workbench (BRW). 

In BRW, you have option to select how often (in <<Check Rule Every>>, <<Tolerate 
Condition For>> Fields) you want the BRM to check the rule noted here. 

In Workflow background process (WBP), you have option to select how often you 
want to run the workflow background process. 

30.4.2 How Are The Parameters Discussed In Step 1 Related? 
For example, you can set five minutes as the Interval in BRM, set one minute in 
Check Rule Every in BRW for one of the rules AND only run the Workflow 
background process every DAY, then what will happen? 

Where is the point of reference for the time? If we run WBP at 12:00 pm, start the 
BRM at 12:05 pm, will the BRM continue to check every five minutes until … 
when 1:00 pm, or 5:00 pm or until whenever?

Answer: Be realistic when setting the time intervals as there is no cross-referencing 
between them, so all times are independent of each other. 

In the example of having the BRM run every five minutes, the BR check every 
minute and the WBP run once a day, then the BRM will run once when the WBP 
24-hour anniversary occurs each day. The checking of the actual BR will depend on 
when its WBP is next run after the BRM has run. The Workflow processes cannot do 
anything unless the WBP associated with that process is executed, so the timing of 
the BRM is dependant on when the WBP runs. 

The point of reference for the BRM is when the 'Start' button was pressed in the 
Control screen. So if it is started at 12.00 pm to run every five minutes, then it will 
check at 12.00 pm, then at 12.05 pm, until the 'Stop' button is pressed OR until the 
WBP stops repeating. However, this is dependent on when the WBP is run for the 
BRM Main Process. If the WBP is run from 12.00 pm every one minute then the 
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above will hold true. However, if it is run every two minutes then it will only check 
at 12.02 pm, 12:04 pm, 12:06 pm, and so forth, so the 12:05 pm run of the BRM will 
be delayed by a minute. 

For each BR the timing is taken from when the last iteration of that BR occurred. 
This is affected also by the timing of the WBP for that individual BR Process, in the 
same way as the main BRM as explained above, plus the timing of the main BRM 
run and how it coincides with the timing of each BR check. 

30.4.3 Can You Stop the Notifications From Repeating?
Once the conditions set in a Business Rule are met, then the notifications are sent 
continuously. Is this the intended functionality? Do you have the option to have a 
flag to indicate that only one notification should be sent?

Answer: If you choose to send a notification or create a Task, then that will happen 
each time the BR is checked if the condition is still true. This is as designed, you 
should set the BR interval to how often you want the notification to be sent. If you 
want to send the notification only once then you can either customize the Escalation 
Activity code to do that, or raise it as an Enhancement Request which will be 
considered for a future release. 

30.4.4 Can You Expand the Fields Available From The 3D View?
In the BRW, you are limited to fields in the CS_BRM_3D_SERVICE_REQUEST_
V view. For example, there is no problem code field in CS_BRM_3D_SERVICE_
REQUEST_V. Is there an option to use fields from other tables or views? 

Answer: The seeded 3D view makes available the fields that you see on the Service 
Request UI that are audited. You only use the fields that are audited because this is 
how you are able to detect how the values have changed over time. If you need 
additional fields then you can use the 'Complex' style of rule definition to specify 
these in standard SQL format.

30.4.5 How Do You Control Who Receives the Workflow Notifications?
When defining business rules, you have the ability to associate a Workflow process 
with each business rule. It is the Workflow process that generates the notifications.

The client can view the definition of these seeded workflow processes in the 
Workflow builder, however, it is not clear as to how the process determines whom 
the notifications should be sent to. For example, in the Workflow Builder, viewing 
the process definition of "Escalate a Service Request (notification only)", it has a 
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notification activity called "Object Conformed to a Rule" which sends a notification 
to a role defined in the "Notification Person" item attribute.

What is the default behavior of this workflow process? What is the hierarchy of 
criteria that the system uses to determine who to notify?

Answer: Select the button labelled '...' which is next to the Workflow LOV. This 
brings up the Workflow Attributes window, and from there you can select a value 
for each of the attributes for that specific Workflow process. For example, for the 
notification workflow you can choose the Notification Role, which is the role of the 
(in relation to the object, i.e. Service Request) who you want the notification to go to. 
The options are:

� Business Owner

� Document Owner

� Document Owner's HR Manager

� Escalation Territory Primary Contact

The default setting is Business Owner, which is the owner of the Business Rule. If an 
individual resource cannot be identified programmatically for any reason, then the 
notification will always default to Business Owner.

30.4.6 Where Can I View the Workflow Process Launched by the BRM?
I want to see if anything is happening for the rule I created which has six records 
in the database that have matched criteria. I completed all the necessary 
preliminary set ups to get the BRM running.

Answer: Perform the following steps.

1. First check that the rule will actually return the records that you think it should. 
Do this by going to the Complex tab in the rule definition and copy the text into 
SQL*Plus. If it returns rows, then the rule is fine, if not then re-examine your 
rule. Start simply, such as 'Task Number' = '12345'.

2. If rows are returned, then next look at the Workflow processes using the 
Workflow Monitor. Ensure that the SYSADMIN user has 'Workflow' 
responsibility attached, then connect to Applications as SYSADMIN through 
the PHP login for the instance that you are using. 

3. Under the heading 'Self Service', click Workflow. 

4. At the next page click View Progress. 
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5. In 'Item Type' choose the name of the Workflow process that you believe should 
be invoked for your rule. For example, any of the Task seeded Workflow 
processes would use 'Business Rule Monitor Task Process'.

6. Click Find. All of the Workflow processes that have been started in that instance 
will be displayed. Drill down into the details of each process.

7. If there are none, there can be a problem with the main BRM Workflow. You can 
look at its progress using the same method, but select Business Rule Monitor 
Main Process.

It could be that there is a problem with the Workflow you are using, so again it is 
suggested that you try the simplest case first so that you can see it working. Try 
using the 'Escalate a Task - send a Notification' seeded Workflow and have the 
notification sent to the 'Business Rule Owner' or the 'Document Owner'.
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Introduction to Oracle User Management

This chapter provides a conceptual understanding of the User Management 
framework. Topics include:

� Overview

� User Types

� Enrollments

� Templates

� Approval Processes

� Access Control

� Self-service Registration

� Terms and Definitions

31.1 Overview
Oracle User Management is a highly extensible framework that automates many of 
the user registration and administration processes for an organization based on its 
business requirements. Because these processes are self-service enabled, users can 
complete many of their own registration tasks and different levels of administration 
can be handled by predefined resources or partners of an organization who are 
granted the appropriate roles and permissions. This reduces an organization’s 
operating cost and its reliance on customer service agents who manually perform 
these tasks. Oracle User Management functionality is based on key concepts that 
include user types, enrollments, templates, approval processes, access control, and 
self-service registration. Once an organization has implemented Oracle User 
Management, it can automate the process for registering, approving, and 
maintaining different types of users, and for providing them with access to the 
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appropriate applications. This chapter provides a conceptual explanation of Oracle 
User Management in the following topics:

31.2 User Types
User types are categories of users based on an organization’s unique registration 
requirements. They provide a flexible, and extensible method of defining, 
categorizing, and implementing specific forms of user behavior. In addition, user 
types facilitate user self-service registration by enabling merchants to associate 
default roles, responsibilities, accounts, and registration templates with categories 
of users and to determine the appropriate approval process. All users that belong to 
a specific user type possess the same registration requirements and, if desired, are 
provided the same default application access with one responsibility and a range of 
security roles from none to several complex ones. They can sign up for and 
configure a set of enrollments and are required to participate in the same approval 
process. Oracle User Management contains three default user types: primary user, 
business user, and individual user. Information about each user that registers for 
one of these types is stored in the TCA, FND, and JTF schemas.

31.2.1 Primary User
The primary user is a business user and is also the primary contact for an 
organization. An individual belonging to this user type functions as customer 
administrator and is responsible for managing all users of the same user’s 
organization. It is generally the first user to register an organization and does not 
require approval.

31.2.2 Business User
The business user is a typical B2B user associated with an organization. The 
business user is generally approved by one or more primary users of an 
organization or someone in the merchant organization. Business users can be 
granted Primary User privileges with the new Primary User enrollment.

31.2.3 Individual User
The individual user is a typical business-to-consumer (B2C) user that has no 
relationship to an organization. Approval is generally not required for individual 
users.
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31.3 Enrollments
Enrollments are a set of add-on services that incrementally capture user data and 
grant users additional access privileges. Users can obtain enrollments during 
registration or after the approval process is completed. Enrollments typically grant a 
user access to an application, but can also enable the user to accept licensing terms, 
to provide surveys, and to sign up for parking permits or any other service. 
Enrollments can be tied to one or many user types, can be automatic, self-service, 
delegation only, or delegation and self-service, and may require an approval 
process. They correspond to a 0-1 responsibility and 0-many security roles and are 
optionally displayed in a user interface such as a JSP page. 

31.3.1 Self-service Enrollments
Self-service enrollments are enrollments that a user manually assigns to itself as part of the 
registration process.

31.3.2 Automatic Enrollments
Automatic enrollments are automatically and transparently assigned to a user when the user 
registers for a specific user type. For example, an organization may wish to automatically 
assign primary users with access to specific accounts that are not available to other user 
types. 

31.3.3 Delegation Only
Delegation only enrollments are assigned to users by an individual with the 
appropriate access privileges and never requires any approvers. This process only 
takes place at the delegating individual’s discretion and users cannot sign up for 
these enrollments. An individual with the appropriate access privileges can also 
grant delegation privileges to other users. Users cannot use self-service registration 
to sign up for enrollments that are delegation only enrollments. 

31.3.3.1 Required Roles
The delegation only enrollment is only available if:

� The administrator has granted the user all access roles associate with the 
enrollment.

� The delegation role is defined for the enrollment and the administrator has the 
delegation role.
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31.3.4 Delegation and Self-service
Delegation and self-service enrollments can be assigned to a user by either of two 
methods. Users can sign up for these enrollments or an individual with the 
appropriate access privileges can assign them to users. If a user signs up for a 
self-service enrollment or is delegated an enrollment by an individual with 
insufficient access privileges, then the user must complete the approval process. If 
the enrollment is a delegation and self-service enrollment the it is always available 
in the UI as a choice for the administrator. 

31.3.4.1 Required Roles
If the administrator has all of the required roles for an enrollment, then the 
administrator can grant users the enrollment without launching an approval 
process. If the administrator does not have all of the required roles for an 
enrollment, then the administrator can grant users the enrollment, however an 
approval process is launched and must be completed before it is granted to the user.

31.4 Templates
Templates are JSP pages that enable Oracle User Management to capture and retain 
information during the registration process. Each JSP page is associate with a Java 
class called a template handler, which captures the required information and writes 
it to the database. Each template is associated with one or more user types and 
enrollments.

31.5 Approval Processes
An approval process is a predefined series of steps required to approve user 
registration or service enrollment requests. They are associated with one-to-many 
user types and can be associated with one-to-many enrollments. Approval 
processes use Oracle Workflow for routing requests to the correct approvers and use 
email to send workflow notifications to the approvers. In addition, approval 
processes support time-outs and reminders. A request times out if it is left in an 
approvers queue for a specified amount of time. Users are sent email notifications 
once their requests have been approved or rejected. They will not be granted 
security roles or responsibilities until they have been approved. 
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31.5.1 Approval
An approval is an optional feature that enables approvers to reject or approve new 
user accounts. The System Administrator Console Users tab enables users to view, 
create, modify, delete, enable, and disable approvals, including those for specific 
organizations.

31.5.2 Approval Definition
An approval definition is the association of a user type or an enrollment with a 
workflow process, a default list of approvers, and optionally with an organization 
that overrides the list of approvers. It uses workflow to track and route an approval 
request to the approvers and to deliver an email notice to the approvers when 
required. If the approval definition has multiple approvers, then the email 
notification is sent to each successively to approve the request. The user is only 
granted the required access or enrollment after each approver has approved the 
request. Rejection is required from only one approver to deny the user the requested 
access or enrollment. If the order of the approvers changes, all pending requests are 
transferred back to the top of the new approver list. If the user type or enrollment is 
changed to use another approval definition, all pending request workflow processes 
terminate and a new workflow process is created and launched. If a user type or 
enrollment is modified and no longer requires an approval, then all pending 
requests are automatically approved.

31.5.3 Approval Flow
The approval flow is a predefined flow of steps required to approve user 
registration or service enrollment requests.

31.5.4 Approver Lists
An approver list is a group of one or more approvers associated with an approval 
definition. Each approval definition has a default approver list and can have 
separate approver lists defined for each organization that takes priority over the 
default list.

31.5.5 Approvers
Approvers are designated individuals who can modify user information and who 
can create and assign user accounts. Approvers with the CRM Primary User 
responsibility or access to the CRM System Administration Console can approve or 
reject user type and enrollment requests. Primary users can approve any request for 
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their organization if approval group capability has been implemented in the system. 
Oracle User Management recognizes the following levels of approvers:

� System Administrators

� Primary Users

� Request Owners

31.5.5.1 System Administrators
System administrators, also referred to as merchant administrators, can accept or 
reject any requests in the system and can define a global or default list of approvers 
for each user type and enrollment. They can also supersede any decision made by 
other approvers in an organization. To approve requests, system administrators 
must be assigned the JTF_REG_APPROVAL permission.

31.5.5.2 Primary Users
Primary users can approve requests that are explicitly assigned to them, and can 
approve any requests for their organization if approval group capability has been 
implemented in the system. Primary users must be assigned the 
JTF_PRIMARY_USER_SUMMARY permission to approve pending requests and 
must be assigned the JTF_PRIMARY_USER responsibility to access the approval 
page.

31.5.5.3 Request Owner
Request owners, also known as approvers are generated by the approver list and 
the most current state of workflow defined for given approval. Request owners 
have the JTF_APPROVER permission and can only approve requests assigned to 
them.

31.5.6 Approval Groups
User Management enables a designated group of users to approve account requests. 
All members of this group can view and process the request and only one member 
of the group must approve the request. Once this occurs, the request, if applicable, 
is assigned to the next approver in the approval hierarchy.

31.6 Access Control
Oracle User Management provides a flexible and granular level of access control 
through its system of permissions, roles, and responsibilities. 
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31.6.1 Responsibilities
Responsibilities are groupings of application menus that determine the user 
interface accessible to a particular user. During the registration process, users are 
granted access to one or more responsibilities depending on the services in which 
they enroll and the merchant policy. Typically, individual users are given access to 
only one responsibility. Oracle User Management contains the following 
responsibilities:

31.6.1.1 CRM HTML Administration
The CRM HTML Administration responsibility provides access to the HTML 
System Administration console. Oracle User Management functionality, can be 
accessed by clicking the Users tab.

31.6.1.2 CRM User Management
The CRM User Management responsibility provides access to the Registration and 
Setup navigation links in the System Administration Console.

31.6.1.3 CRM Primary User
The CRM Primary User page provides access to the Home tab and Users tab in 
standalone mode. This responsibility does not provide access to any other tabs in 
the System Administrator Console.

31.6.2 Permissions
Permissions are specific types of access privileges that can be assigned to a user. A 
user can perform specific tasks if the user is assigned the required permissions. 
Oracle User Management contains the following permissions:

31.6.2.1 JTA_UM_SETUP
The JTA_UM_SETUP permission provides access to all Oracle User Management 
setup screens and should only be granted to administrators in the organization who 
are responsible for implementing the system.

31.6.2.2 JTA_UM_DELEGATION_ACCESS
The JTA_UM_DELEGATION_ACCESS permission displays the Delegation column 
with checkboxes in the Enrollment selection page. This permission is automatically 
assigned when a user is granted delegation privileges for the first time for an 
enrollment.
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31.6.2.3 JTF_APPROVER
The JTF_APPROVER permission enables users to view and to approve requests that 
are assigned to them and to be approvers in the Approval Definition screen. 

31.6.2.4 JTF_PRIMARY_USER_SUMMARY
The JTF_PRIMARY_USER_SUMMARY permission provides users with access to 
the User Maintenance and Pending Approvals page s, and enables them to query all 
users in their organization. Users who are assigned this permission can perform the 
following in the User Maintenance page:

� Disable user accounts thereby preventing users from logging in.

� Reset passwords.

� Change Account Assignments.

� View Enrollments.

� Revoke enrollments.

� Assign new enrollments.

Users who are assigned this permission can perform the following in the Pending 
Approvals page:

� View and approve all requests assigned to them.

� View and approve all requests for their organization if the approval group 
function has been implemented in the system.

31.6.2.5 JTF_REG_APPROVAL
The JTF_REG_APPROVAL permission provides system administrator capability for 
specific functions that include the ability to view and respond to all requests in the 
system independently of the person to whom they are assigned.

31.6.2.6 JTF_SECURITY_ASSIGN_ROLE
The JTF_SECURITY_ASSIGN_ROLE permission provides system administrator 
capability for specific functions that include the ability to query any users and to 
change their details, to assign accounts, to manage enrollments, and pending 
approvals from the Pending Approvals link in the main navigation bar, to reset 
passwords, and to disable user access.
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31.6.3 Roles
Roles are groupings of permissions, which are page level or function level granular 
privileges used to maintain application security. A single user can be granted 
several roles, each of which separately determines access rights to the user interface 
details, the ability to perform certain transactions and the ability to access certain 
data sets. During the registration process, users are granted the appropriate set of 
roles that map to their job function. Although Oracle User Management contains the 
following predefined roles, users with the appropriate access privileges can also 
create and customize their own roles.

31.6.3.1 JTA_UM_DELEGATION_ACCESS
The JTA_UM_DELEGATION_ACCESS role is assigned the 
JTA_UM_DELEGATION_ACCESS permission and provides users with all of the 
access privileges associated with this permission.

31.6.3.2 JTA_UM_SETUP_ADMIN
The JTA_UM_SETUP_ADMIN role is assigned the JTA_UM_SETUP permission and 
provides users with all of the access privileges associated with this permission.

31.6.3.3 JTF_APPROVER
The JTF_APPROVER role is assigned the JTF_APPROVER permission and provides 
users with all access privileges associated with this permission.

31.6.3.4 JTF_PRIMARY_USER
The JTF_PRIMARY_USER role is assigned the JTF_PRIMARY_USER_SUMMARY 
permission and provides users with all access privileges associated with this 
permission.

31.6.3.5 JTF_SYSTEM_ADMIN_ROLE
The JTF_SYSTEM_ADMIN role is the global system administration role and 
contains all permissions required to access and operate the System Administration 
Console including JTF_SECURITY_ASSIGN_ROLE and JTA_UM_SETUP.

31.7 Self-Service Registration
Self-service registration is a user interface and set of background processes that 
enable users to perform their own registration tasks instead of doing so through an 
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administrator. This feature reduces an organization’s operating costs and removes 
registration restrictions that are based on the availability of an administrator.

31.7.1 Registration
Registration is the process that provides users with access to some or all of an 
application’s functionality.

31.7.2 Registration Self-service Administration UI
The Registration Self-service Administration UI is a user interface that enables 
system administrators, and designated primary users, to maintain users, parties, 
and accounts for an external organization or an internal group.

31.7.3 Registration Self-service User UI
The Registration Self-service user UI is a user interface that enables self-registration 
for primary, individual, or business users.

31.8 Terms and Definitions
This section contains additional terms and definitions that are essential to 
understanding Oracle User Management.

31.8.1 Customers
Customers are individuals who are external to the implementing organization and 
who use but do not implement the Oracle e-Business Suite.

31.8.2 Java Server Pages (JSPs)
JSPs are an extension to the Java servlet technology that was developed by Sun as an 
alternative to Microsoft's ASPs (Active Server Pages). JSPs have dynamic scripting capability 
that works in tandem with HTML code, separating the page logic from the static elements — 
the actual design and display of the page. Many of the Oracle User Management 
configuration and management tasks are performed using a HTML interface composed of 
JSPs.

31.8.3 Merchants
Merchants implement the Oracle e-Business Suite and should not be confused with 
“customers” who use the Oracle e-Business Suite.
31-10 Oracle Common Application Components Implementation Guide



Terms and Definitions
31.8.4 Users
Users are individuals who require partial or complete access to one or more 
applications in the Oracle e-Business suite.

31.8.5 Workflow
Oracle Workflow automates and continuously improves business processes, routing 
information of any type according to business rules you can change. The rules, 
which we call a workflow process definition, include the activities that occur in the 
process and the relationship between those activities. An activity in a process 
definition can be an automated function defined by:

� a PL/SQL stored procedure or an external function

� a notification to a user or role that may request a response

� a business event

� a subflow that itself is made up of many activities.
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Implementation Tasks for User Management

This chapter provides instructions for implementing the User Management 
Framework. Topics include:

� Introduction

� Creating the User Management Administrative User

� Setting Profile Options

� Setting up Workflow

� Setting up Approvals

� Setting up Templates

� Setting up Enrollments

� Setting up User Types

� Creating Primary User Approval Groups

� Backward Compatibility

� Related Documentation and Resources

32.1 Introduction
The Users tab in the System Administration Console provides functionality for 
setting up the User Management framework and for registering users. The Setup 
menu in the main navigation bar enables administrators to implement User 
Management by creating and managing approvals, enrollments, user types, and 
templates. This chapter provides instructions for implementing User Management 
including the steps performed in the Setup Menu of the Users tab. The Registration 
menu in the main navigation bar enables administrators to manage approvals, and 
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to setup, modify, or delete users. Instructions for performing these tasks are 
contained in the User Management chapter of the Oracle Common Application 
Components User’s Guide.

32.2 Creating the User Management Administrative User
To access the System Administrator Console and perform certain User Management 
administrative functions, a user must be a system administrator or an 
administrative user with the appropriate responsibilities and roles. This section 
provides instructions for creating a User Management administrative user and 
assigning it the appropriate responsibilities and roles. The steps for creating the 
User Management administrative user are performed in the HTML and 
Forms-based interfaces. 

Prerequisites
None

Responsibility
System Administrator

Navigation
Log in to the Forms and HTML interfaces as required.

Steps in HTML
1. Log on to the System Administrator Console as a System Administrator.

2. Click the Users tab and then click User Maintenance on the side navigation bar.

3. Enter the user name in the search field and Select Go.

4. Select the user name and then select Roles

5. Assign the required roles to the administrative user, select Update, and exit the 
System Administrator Console:

a.  JTA_UM_SETUP_ADMIN (for access to the setup screens)

Note: Because the Forms-based interface does not generate party 
information you should first perform the required steps for creating 
the User Management Administrative User in the HTML interface 
and then complete the process using the Forms-based interface. 
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b. JTF_APPROVER (for access to the approval screens)

Steps in Forms
1. Log in to the Forms interface with System Administrator responsibility and 

choose Security>User>Define.

2. Enter a user name and password in the Users window.

3. Add either of the following responsibilities, save your work, and exit the Forms 
interface:

� CRM HTML Administration

� CRM User Management

32.3 Setting Profile Options
The first step in implementing User Management is to set the appropriate values for 
the User Management profile options. Profile options determine a wide range of 
User Management functionality. Appendix A: Profile Options contains detailed 
instructions for setting profile options. The following table lists the User 
Management profile options:

Note: Responsibilities determine which pages a user can access 
and roles determine which functions the user can perform in those 
pages. If you do not assign appropriate roles to the user, then it will 
not be able to perform the required function even with the 
appropriate access to the page.
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Table 32–1 User Management Profile Options

Name
Default 
Value Level Description Outcome

JTF_PRIMARY_
USER

sysadmin Site Predetermines the username 
that corresponds with the 
"Universal Approver".

The supplied username 
corresponds to the 
Universal Approver.

JTF_
INDIVIDUALUSER_
ACCOUNT

Yes Site Enables automatic account 
creation for newly registered 
users.

When set to Yes, 
automatically creates a 
new account in the 
HZ_CUST_ACCOUNTS 
table for a newly 
registered user and 
associates the user with 
the account. Users must 
have an account to buy 
products in the iStore.

JTA_UM_
APPLICATION_
URL

None Site Specifies the application 
logon URL sent to users in 
email messages that are 
automatically generated 
once a user request has been 
approved. 

The supplied URL is sent 
to users in email messages 
that are automatically 
generated once a user 
request has been 
approved.

JTA_UM_
WORKFLOW_
OWNER

sysadmin Site When a workflow is 
launched it always identifies 
the user who launched it. 
The system administrator is 
the default User 
Management workflow 
owner. User Management 
uses workflow for 
registration and for resetting 
passwords. Users can query 
workflows using the name 
of the workflow owner. 

Specifies the name of the 
workflow owner.

JTA_UM_SENDER None Site Provides a sender clause for 
automatically generated 
email messages such as 
approval and password 
expiration notifications.

Provides a sender clause 
for automatically 
generated email messages 
such as approval and 
password expiration 
notifications.
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JTF_UM_
APPROVAL_
OWNER

sysadmin Site .Defines the individual who 
serves as an escalation point 
of contact and who receives 
and approval request when 
the last approver fails to 
approve the request.

This profile option is used 
in the approval process. If 
the last approver in a 
predefined approval 
definition fails to approve 
a request, the person 
defined in this profile 
option will be the 
escalation point of contact 
and will receive the 
request. The user specified 
as the value for this 
profile option must have 
the JTF_SECURITY_
ASSIGN_ROLE 
permission

JTF_UM_
APPROVAL_
TIMEOUT_MINS

1440 
Minutes 
(one day)

Site Defines (in minutes) how 
long a workflow notification 
remains in a queue before it 
is timed out.

When the notification 
times-out, the request 
goes to the next approver 
on the list. If no approver 
is specified, the approval 
owner receives and 
answers the request. If 
you enter 0 as the default, 
no time out occurs. If no 
value is set, the profile 
option is defaulted to 0. 
The Process Time-out field 
in the parameters window 
when starting the "JTF 
Approval" workflow must 
be set to Yes for this 
profile option value to 
take affect.

JTF_UM_
APPROVAL_URL

None Site Defines the user application 
logon URL. 

The URL is included in 
the workflow notification 
sent to each approver 
when they are assigned a 
request. The approver is 
sent an email message 
stating that the approver 
must approve a request.

Table 32–1 User Management Profile Options

Name
Default 
Value Level Description Outcome
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JTF_UM_
MERCHANT_
NAME

None Site Defines the name of your 
organization. 

Workflow inserts this 
name into request 
approval and rejection 
notifications when they 
are sent to the user.

JTF_
REGISTRATION_
CACHE

Yes Site Determines whether the 
registration pages will cache 
the data entered by the user 
during the registration flow. 

 If set to Yes and if the 
user presses the browser 
"Back" button, then the 
data entered on the 
previous page is available. 
If set to No, then the data 
(page) expires as soon as 
the user leaves the page.

ICX: Language American 
English

Site The ICX: Language profile 
can be set at the user level 
and determines the language 
displayed for the user when 
logging in. 

The language for the 
registration page accessed 
from the "Register Here" 
link of the login page is 
determined by the ICX 
Language profile set for 
the "Guest User" defined 
in the System 
Administration console. 
To change the language 
for this page access the 
ICX: Language profile 
option, click the User 
field, and choose a 
language from the LOV.

JTA_UM_REG_
ORG_FAX_REQD

Yes Site Provides Yes/No values in 
the registration page that 
determine whether or not an 
organization’s fax 
information is required. 

The Organization 
Information page changes 
its required options 
depending on the values 
set for this profile option, 
however the fax field 
remains optional in the 
user detail page 
regardless of how this 
profile option is set.

Table 32–1 User Management Profile Options

Name
Default 
Value Level Description Outcome
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JTA_UM_REG_
ORG_PHONE_
REQD

Yes Site Provides Yes/No values in 
the registration page that 
determine whether or not an 
organization’s phone 
information is required. 

The Organization 
Information page changes 
its required options 
depending on the values 
set for this profile option, 
however the phone field 
remains optional in the 
user    detail page 
regardless of how this 
profile option is set.

JTA_UM_HIDE_
QUICKFIND

No Site Optionally hides the 
Quickfind menu.

When set to Yes, this 
profile option hides the 
Quickfind menu from 
users. When set to No, the 
Quickfind menu appears. 
The profile option is set to 
No, to ensure 
compatibility with 
previous versions of User 
Management that did not 
contain this feature.

SIGNON_
PASSWORD_
LENGTH

5 Site Specifies the number of 
characters required to 
constitute a valid password.

Specifies the number of 
characters required to 
constitute a valid 
password.

JTA_UM_
PASSWORD_GEN_
WKF

JTAUMPS
W

All Specifies the name of the 
workflow used for sending 
passwords to users. 

Specifies the name of the 
workflow used for 
sending passwords to 
users. 

Table 32–1 User Management Profile Options

Name
Default 
Value Level Description Outcome
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JTA_UM_SUPPORT_
CONTACT

Null Responsibility Specifies the name or email 
address of the support 
person to contact in case of 
logging errors. 

Specifies the name or 
email address of the 
support person to contact 
in case of logging errors. 

JTF_UM_EMAIL_
AS_USERNAME

No Site Optionally disables the User 
ID field in the registration 
screen and enables the user’s 
email address to also 
function as the user ID.

When set to Yes, this 
profile option disables the 
User ID field in the 
registration screen and 
enables the user’s email 
address to also function as 
the user ID. During the 
registration process, User 
Management populates 
the USER_ID column in 
the FND_USER table with 
the user’s email address.

When set to No, this 
profile option retains both 
User ID field in the 
registration screen and 
consequently does not 
populates the USER_ID 
column in the FND_USER 
table with the user’s email 
address. 

Table 32–1 User Management Profile Options

Name
Default 
Value Level Description Outcome
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32.4 Setting Up Workflow
User Management uses workflow to track and route approval requests and to send 
notifications to approvers. The default workflow JTF APPROVER retrieves the first 
approver from the hierarchy list and notifies the approver. When the approver 
approves the request, Workflow searches for the next required approver and 
continues this process until all approvers approve the request, or the request is 
rejected. Workflow items are sent to an approvers worklist and email address. For 
user types, the approver receives a URL in their notification that provides access to 
the Pending Approvals window.

JTA_UM_DEFAULT_
ADDRESS_STYLE

US Site Determines the default 
country whose specific style 
of address fields must be 
displayed in the company 
registration page and user 
details page.

When a user registers for the 
first time, the user must 
choose a country before 
entering address 
information. The country 
specified by this profile 
option appears by default.

If User Management does 
not contain seeded data for 
the required country, then 
you must setup the 
address style using the 
Accounts Receivable flex 
fields. For instructions on 
configuring flexible 
address fields, see the 
Chapter 3 of the Oracle 
Receivables User Guide.

When the profile option is 
set for a specific country 
then the address fields 
required by that country’s 
address style appear in 
the company registration 
page, and user details 
page. If the profile option 
is not set for a specific 
country of if there is an 
error displaying that 
country’s address style 
then the registration and 
user details pages default 
to the U.S. address style.

The registration process 
cannot be completed 
unless information is 
entered in mandatory 
address fields. The 
mandatory definition 
can be turned on or off 
for a given field from 
the flexfield segment 
definition, as a single 
address field maps to a 
segment of the address 
flexfield.

Table 32–1 User Management Profile Options

Name
Default 
Value Level Description Outcome
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For information instructions on setting up Workflow, see the following:

� Starting the Workflow Process

� Stopping the Workflow Process

32.5 Starting the Workflow Process

Perform the following steps to start the Workflow process.

Prerequisites
See the Oracle Workflow Administrator’s Guide for more information.

Responsibility
System Administrator

Navigation
Log in to the navigator of the Forms-based application, select Concurrent>Request.

Steps
1. Click Submit a New Request and in the resulting window, select the Single 

Request option button and click OK.

2. Enter the name of the workflow process as "Workflow Background Process." 
Workflows must be defined in the approval setup. Oracle is shipping one 
seeded workflow out-of-the-box, JTFAPPROVAL workflow

3. Perform the following in the Parameters window:

Note: Email notification will only be sent if the Workflow mailer is 
setup and configured properly. The PHP / Self Service Workflow 
notifications page can also be used to view notifications. Please 
refer to the Workflow documentation for more information on how 
to start and configure the workflow mailer. If the concurrent 
manager is not up and running, workflow does not work correctly.

Note: Refer to the Oracle Workflow Administrator’s Guide for 
instructions on setting up and monitoring workflow.
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a. Enter JTF_APPROVAL or the workflow you want to start as the Item Type. 
This must be defined as an approval type in the approval definition set in 
the System Administrator User tab. 

b. Enter the Minimum and Maximum thresholds which specifies the 
minimum and maximum costs that an activity must have for this 
background engine to execute it, in a hundredth of a second.

c. Enter No for the Process Deferred, which specifies whether this background 
engine checks for deferred activities.

d. Enter Yes for Process Timeout and click OK.

If this is set to No, the workflow process ignores the JTF_UM_APPROVAL_
TIMEOUT profile option 

4. Click Schedule next to the At these times option, region.

5. Select the job to run the job periodically, in the Run the Job region.

6. Enter the start date and leave the end date blank to run the workflow 
indefinitely.

7. Define the interval which triggers the workflow to check for requests every 
specified minute, hour, day, week, or month and click OK.

8. Click Yes in the confirmation window if you selected for the workflow to run 
indefinitely, then click Submit to confirm, and click No to exit.

32.6 Stopping the Workflow Process
Perform the following steps to stop the workflow process.

Prerequisites
� A workflow must be running.

� See the Oracle Workflow Administrator’s Guide for more information.

Responsibility
System Administrator

Navigation
Log in to the navigator of the Forms-based application, select Concurrent>Request.
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Steps
Query any workflows that are running and cancel the request.

32.7 Setting Up Approvals
An approval is an optional feature that enables approvers to reject or approve new 
user accounts. The System Administrator Console Users tab enables users to view, 
create, modify, delete, enable, and disable approvals, including those for specific 
organizations. For instructions on setting up approvals, see the following:

� Creating a New Approval

� Removing an Approval

� Searching for an Approval

� Editing an Approval’s Details

� Enabling and Disabling Approval

� Updating Approval Preferences for an Organization

32.8 Creating a New Approval
Perform the following steps to create a new approval. In some cases an approval 
may generate an exception. When this occurs, an error window is generated that 
displays a default workflow error message and the workflow description.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

WARNING: The Use Pending Request Page check box should 
only be unchecked if your organization does not plan to use User 
Management’s pending approval window and intends to respond 
to all approvals through emails and the workflow notification 
window. 
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Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Approval Setup 
and click the Create New Approval button.

Steps
1. Enter the following approval information and click Next:

� Approval key

� Approval name

� Description

� Select a Workflow Item Type from the drop-down list. 

� Select an Application from the drop-down list.

� (Optional) Select the Use Pending Request Page check box if you want the 
approval to display during the registration process from the "Register Here" 
link.

2. Enter the following Approver Selection information, click Add User and then 
click Save:

� Enter a number to define the order that each approver gets the request.

� Enter the name of the first approver into the Approver1 field or click Go to 
search for an approvers name.

32.9 Removing an Approval
Perform the following steps to remove an approval.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management
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Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Approval Setup

Steps
1. Select the check box in the Remove column that corresponds to the Approval 

that you plan to delete.

2. Click Update to delete the Approval or click Restore to reset the original values 
in the window.

3. In the resulting window, click Confirm and Update Now to delete the 
Approval or click Cancel to cancel the deletion.

32.10 Searching for an approval
Perform the following steps to search for an approval.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Approval Setup

Steps
1. Select the Approval Name or Approval Key options from the Search Approval 

menu.

2. Enter your search criteria in the adjacent field and click Go.
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32.11 Editing an Approval Details
Perform the following steps to edit an approval's details.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Approval Setup

Steps
1. Click the name of the approval in the Approval Name column.

2. Edit the fields as desired and click Next.

3. Edit the information in the Update Approval window and click Next.

4. Edit the information in the approver selection order window and click Submit.

32.12 Enabling and Disabling Approval Definitions
Perform the following steps to enable or disable an approval definitions.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 
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Navigation
In the System Administrator Console, navigate to Users>Setup>Approval Setup

Steps
1. If you want to enable an approval, select Enabled from the drop-down list in 

the corresponding Status column.

2. If you want to disable an approval, select Disabled from the drop-down list in 
the corresponding Status column.

3. Click Update to modify the status of the approval or click Restore to reset the 
original values in the window.

A confirmation window opens.

4. Click Confirm and Update All to modify the status.

32.13 Updating Approval Preferences for an Organization
Perform the following steps to update approval preferences for an organization.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Approval 
Setup>Organization

Steps
1. Select Organization Name or Company Number from the Enter Search 

Criterion drop-down list.

2. Enter a minimum of three characters into to the search field.

The "%" and "_" (underscore) symbols are wildcards.
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3. Click Go. 

A list of search results appears in the window.

4. Click the column heading to sort the row.

5. Click the Organization Name.

The Approval Preferences window opens with a list of approval definitions for 
the specified organization.

6. Click the approval list that you want to update.

7. Enter the Approver Selection information:

a. Enter a number to define the order that each approver gets the request.

b. Enter the name of the first approver into the Approver1 field or click Go to 
search for an approvers name.

c. Enter your search criteria and click Go.

d. Select the option button for the user that you want to be the approver and 
click Add User.

e. (Optional) Enter the name of additional approvers into the other Approver 
fields (repeat steps a-e).

f. (Optional) Click Cancel to clear the fields.

g. (Optional) Click add 5 more rows to add five empty approver fields.

8. Click Submit to save.

32.14 Setting Up Templates
Templates are JSP pages that enable User Management to capture and retain 
information during the registration process. Each JSP page is associate with a Java 
class called a template handler, which captures the required information and writes 
it to the database. Each template is associated with one or more user types and 
enrollments. For instructions on setting up templates, see the following:

� Creating a Template

� Removing a Template

� Enabling and Disabling Template Definitions

� Editing a Template’s Details
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� Searching for a Template

32.15 Creating a Template
Perform the following steps to create a template.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Templates and click 
Create New Template.

Steps
1. Enter the following required information.

a. Enter the template key.

b. Enter a name for the template.

c. (Optional) Enter a description for the template. 

d. Select a template type from the drop-down list. Options include user type 
template or enrollment template. 

e. Enter the name of the template handler. The template handler is a java class 
implemented by the application to handle the registration data at runtime.

f. Enter the name of JSP page that is the first window of the template flow 
into the Page Name field. The extension of the window must be ".jsp".

g. Select an application from the drop-down list.

2. (Optional) Click Reset to clear the fields.

3. Click Create to save your information.
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32.16 Removing a Template
Perform the following steps to delete a template.

Prerequisites
None

A template is an application-specific set of JSPs that you can use to customize the 
user registration process. There are two template categories, user types and 
enrollments. Perform the following steps to create a template.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Templates.

Steps
1. Select the check box in the Remove column that corresponds to the template 

that you want to delete.

2. Click Update to delete the template or click Restore to reset the original values 
in the window.

A confirmation window opens.

3. Click Confirm Update to delete the template or click Cancel to return to the 
Available Templates window.

32.17 Enabling and Disabling Template Definitions
Perform the following steps to enable or disable a template.
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Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Templates

Steps
4. If you want to enable a template, select Enabled from the drop-down list in the 

corresponding Status column.

5. If you want to disable a template, select Disabled from the drop-down list in 
the corresponding Status column.

6. Click Update to modify the template’s status or click Restore to reset the 
original values in the window.

A confirmation window opens.

7. Click Confirm Update to modify the template’s status or click Cancel to return 
to the Available Templates window.

32.18 Editing a Template's Details
 Perform the following steps to edit a template's details.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 
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Searching for a Template
Navigation
In the System Administrator Console, navigate to Users>Setup>Templates.

Steps
1. Click the name of the template in the Template Name column.

The User Management: Update Template window opens.

2. Edit the fields as desired.

3. (Optional) Click Clear to reset the fields to their original settings.

4. Click Update to save your changes.

32.19 Searching for a Template
A template is an application-specific set of JSPs that you can use to customize the 
user registration process. Perform the following steps to search for a template.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Templates

Steps
1. Select how you want to search for the template. Options include Template 

Name or Template Key from the drop-down list.

2. Enter your search criteria into the text field and click Go.
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32.20 Setting Up Enrollments
Enrollments are a set of add-on services that can incrementally capture user data 
and grant users additional access privileges. Users can obtain enrollments during 
registration or after the approval process is completed. Enrollments typically grant a 
user access to an application, but can also enable the user to accept licensing terms, 
to provide surveys, and to sign up for parking permits or any other service. 
Enrollments can be tied to one or many user types, can be automatic, self-service, 
delegation only, or delegation and self-service, and may require an approval 
process. They correspond to a 0-1 responsibility and 0-many security roles and are 
optionally displayed in a user interface such as a JSP page. For instructions on 
setting up enrollments, see the following:

� Creating an Enrollment

� Removing an Enrollment

� Enabling and Disabling Enrollment Definitions

� Editing an Enrollment’s Details

32.21 Creating an Enrollment
Perform the following steps to create an enrollment.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Enrollments and 
click the Create New Enrollment button.

Steps
1. Define the following information:
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Removing an Enrollment
a. Enter an Enrollment Key.

b. Enter a name for the new enrollment.

c. (Optional) Enter a description for the new enrollment. This description can 
include HTML tags for style. There is a 2000 character limit in the field that 
includes all HTML tags.

2. Select roles and responsibilities.

a. Select a responsibility from the Responsibility drop-down list. If no 
responsibility is required, choose No Responsibility is Required.

b. Select the name of a role in the Available list and click > to move it to the 
Assigned list. You can hold down the [CTRL] key and use your mouse to 
select multiple roles. 

c. Repeat the previous step to add more roles to the list.

d. To move all Available Roles to the Assigned Roles list, then click >> or to 
move all Assigned Roles to the Available Roles list, then click <<.

e. Select an application from the drop-down list.

f. Select an approval from the drop-down list. If no approvals are required for 
the user to subscribe to the service, choose No Approval Required.

g. Select an enrollment template from the drop-down list. 

3. (Optional) Click Reset to clear the fields and click Create to save your changes.

32.22 Removing an Enrollment
Perform the following steps to delete an enrollment.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 
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Enabling and Disabling Enrollment Definitions
Navigation
In the System Administrator Console, navigate to Users>Setup>Enrollments.

Steps
1. Select the check box in the Remove column that corresponds to the enrollment 

that you plan to delete.

2. Click Update to remove the enrollment or click Restore to reset the original 
values in the window.

A confirmation window opens.

3. If you are sure you want to delete the enrollment, click Confirm and Update 
Now.

32.23 Enabling and Disabling Enrollment Definitions
An enrollment is an optional step in the user registration process. Perform the 
following steps to enable or disable an enrollment.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Enrollments.

Steps
1. If you want to enable an enrollment, select Enabled from the drop-down list in 

the corresponding Status column.

2. If you want to disable an enrollment, select Disabled from the drop-down list 
in the corresponding Status column.

3. Click Update to modify the information or click Restore to reset the original 
values in the window.
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Editing an Enrollment's Details
A confirmation window opens.

4. Click Confirmed and Update Now.

The enrollment status is modified.

32.24 Editing an Enrollment's Details
An enrollment is an optional step in the user registration process. Perform the 
following steps to edit an enrollment's details.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
In the System Administrator Console, navigate to Users>Setup>Enrollments.

Steps
1. Click the name of the enrollment.

The Update Enrollment window opens.

2. Edit the fields as desired and click Next.

3. Select the Assign the changed role to existing users of this Enrollment check 
box if you want previously registered users to be granted the specified role.

4. Assign new roles as needed.

5. Select the Assign the changed responsibility to existing users of this 
Enrollment check box if you want previously registered users to be granted the 
specified responsibility.

6. (Optional) Click Reset to reset the fields to their original settings or click 
Update to save your changes.

A confirmation window opens.
Implementation Tasks for User Management 32-25



Setting Up User Types
32.25 Setting Up User Types
User types are categories of users based on an organization’s unique registration 
requirements. They provide a flexible, and extensible method of defining, 
categorizing, and implementing specific forms of user behavior. In addition, user 
types facilitate user self-service registration by enabling merchants to associate 
default roles, responsibilities, accounts, and registration templates with categories 
of users and to determine the appropriate approval process. All users that belong to 
a specific user type possess the same registration requirements and, if desired, are 
provided the same default application access with one responsibility and a range of 
security roles from none to several complex ones. They can sign up for and 
configure a set of enrollments and are required to participate in the same approval 
process. Oracle User Management contains three default user types: primary user, 
business user, and individual user. Information about each user that registers for 
one of these types is stored in the TCA, FND, and JTF schemas. For instructions on 
setting up user types, see the following:

� Creating a User Type

� Removing a User Type

� Activating and Deactivating User Types

� Searching for a User Type

� Editing a User Type’s Details

32.26 Creating a User Type
A user type is a category of users based on common responsibilities and roles. User 
Management ships the following predefined user types out-of-the-box:

� primary user

� business user

� individual user

Each user type is assigned predefined enrollments that include different roles, 
responsibilities and availability. Legacy users that uptake the new user management 
framework, no longer have access to the default roles and responsibilities windows. 
The user type definition replaces these windows. Roles and responsibilities defined 
at the user level are the default. 

Creating a new user type is a multi-step process. The following table lists the three 
pages needed to create a user type.
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Perform the following steps to create a new user type.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Table 32–2 Necessary User Type Information

Page Information Description

Details � Description

� Enable Self-Service Registration

� Registration Template

� Application

� Approval by

� Optional description of user type

� Checkbox

�

�

�

You also can change the User Type 
name here.

Credentials � Default Responsibility

� Default Roles

� Role delegation

�

�

� Checkbox

Enrollments � Enrollment name

� Activate (Yes or No)

� Availability

� Order the active enrollments

�

�

�

�

Note: If you deselect the Enable Self-service Registration check 
box when you create a new user type, the user type does not appear 
in the self-service registration window when you click the "Register 
Here" link unless the user has the JTF_SECURITY_ASSIGN_ROLE 
permission. 

At runtime, the system validates that the user has this permission, 
if not, it confirms if the check box is selected and only shows the 
user types that are available for self-service.
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Role
 JTA_UM_SETUP_ADMIN 

Navigation
Log in to the CRM System Administrator Console as a system administrator, 
navigate to Users>Setup>User Types, and click the Create New User Type button.

Steps
1. Enter the details for the user type:

a. Enter a user type name.

b. Enter a user type key.

c. (Optional) Enter a description into the Description field. This description 
can include HTML tags for style. There is a 2000 character limit in the field 
that includes all HTML tags.

d. (Optional) Select Enable Self-service Registration to display the new user 
type during the registration process from the "Register Here" link.

e. Enter the order in which you want the user type to be displayed.

f. Select the default registration template and default application from the 
drop-down lists. 

g. Select the approval by information from the drop-down list and click Next.

2. Enter the credentials for the user type:

a. Select a default responsibility from the drop-down menu. This determines 
the default login page for the user.

b. Assign a default role to the user. This determines the default level of 
functional ability for the user.

3. Enter the enrollments for the user and click Next:

a. Choose Yes or No from the Activate drop-down list next to the enrollment 
name. 

b. Determine the enrollment’s availability by choosing either Automatic, 
Delegation & Self Service, Delegation Only, or Self Service from the 
drop-down menu. These values are explained in the Enrollments section of 
this document.
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c. Enter the order in which you with the enrollment to appear in the Order 
field.

32.27 Removing a User Type
A user type is a category of users based on common responsibilities and roles. A 
user type can be removed as long as it is not enabled (in use). Perform the following 
steps to remove a user type.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
Log in to the CRM System Administrator Console as a system administrator, 
navigate to Users>Setup>User Types.

Steps
1. Select the check box in the Remove column that corresponds to the user type 

that you want to delete.

2. Click Update to delete the User Type or click Restore to reset the original values 
in the window.

A confirmation window opens.

3. Click Confirm to delete the User Type or click Cancel to cancel the deletion.

32.28 Activating and Deactivating User Types
A user type is a category of users based on common responsibilities and roles. 
Perform the following steps to activate or deactivate a user type.
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Searching for a User Type
Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
Log in to the CRM System Administrator Console as a system administrator, 
navigate to Users>Setup>User Types.

Steps
1. If you want to activate an enrollment, select Active from the drop-down list in 

the corresponding Status column.

2. If you want to deactivate an enrollment, select Inactive from the drop-down list 
in the corresponding Status column.

3. Click Update to modify the status of the user type or click Restore to reset the 
original values in the window.

32.29 Searching for a User Type
A user type is a category of users based on common responsibilities and roles. 
Perform the following steps to search for a user type.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 
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Navigation
Log in to the CRM System Administrator Console as a system administrator, 
navigate to Users>Setup>User Types.

Steps
1. If you want to search by the User Type Name, then:

a. Enter your search phrase into the text input field.

b. Click Go.

The results appear in the window.

2. If you want to search by the User Type Key, then:

a. Enter your search phrase into the text input field.

b. Click Go.

The results appear in the window.

32.30 Editing a User Type's Details
A user type is a category of users based on common responsibilities and roles. 
Perform the following steps to edit a user type's details.

Prerequisites
None

Responsibility
CRM HTML Administration or CRM User Management

Role
 JTA_UM_SETUP_ADMIN 

Navigation
Log in to the CRM System Administrator Console as a system administrator, 
navigate to Users>Setup>User Types.

Steps
1. Click the name of the user type in the User Type Name column.
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Editing a User Type's Details
The User Type Details window opens.

2. Edit the fields as desired.

3. (Optional) Click Clear to reset the fields to their original settings.

4. Click Next to save and go on to the next page.

The Roles and Responsibilities window opens.

5. Edit the information as needed.

a. Use the drop-down list to select a user type responsibility.

b. (Optional) Select the Assign the changed responsibility to existing users 
of this user type check box if you want users registered under this user 
type to be granted the responsibility specified.

c. To assign roles, select the name of a role in one list and then click > or < to 
move it to the other list. Repeat this step for as many roles you want to 
assign.

d. If you want to move all Available Roles to the Assigned Roles list, then click 
>>.

e. If you want to move all Assigned Roles to the Available Roles list, then click 
<<.

f. (Optional) Select the Assign the changed role to existing users of this user 
type check box if you want users registered under this user type to be 
granted the role specified.

6. Click Next to save and go on to the next page or click Restore to revert back to 
the original values in the window.

The Enrollments window opens.

7. Edit the information as needed.

a. If you want to enroll the user type in an enrollment, select Yes from the 
drop-down list in the Enroll column.

b. If you do not want to enroll the user type in an enrollment, select No from 
the drop-down list in the Enroll column.

c. Select Automatic or Self-service from the drop-down lists to define the 
type. 

d. Enter a number into the fields in the Order column to set enrollment order.
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e. If you want to edit an enrollment's details, then click the name of the 
enrollment.

8. Click Next to save and go on to the next form or click Restore to revert back to 
the original values in the window.

The User Types window opens with the newly updated user type information.

32.31 Creating Primary User Approval Groups
User Management provides support for assigning requests to the group of primary 
users within an external organization. Merchants can set up an approval hierarchy 
for this group and then define a single "virtual" or "logical" approver within the 
approval hierarchy called the Universal Approver. Requests that are assigned to the 
Universal Approver can be seen and processed by any/all primary users of the 
external organization to which the request belongs and are removed from the queue 
when the first approver approves or rejects them. Security is maintained since 
primary users can only see requests that pertain to users of their organization. 
Universal Approvers receive email notifications each time a new approval is 
required. Consequently they do not have to log into the system and query new 
approval requests to determine whether or not any new approvals are required.

Prerequisites
You must be the merchant administrator, system administrator to create a universal 
approver.

Responsibility
System Administrator or CRM HTML Administration

Navigation
Log in to the CRM System Administrator Console as a system administrator, 
navigate to Users>Registration>User Maintenance>Create.

Steps
1. Choose the individual user registration profile and click Next.

2. Enter personal information for the user.

3. Assign the JTF_APPROVER permission to the user:

a. Click the Settings tab and then navigate to Security>Access 
Controls>Permissions.
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b. Search for and access the JTF_APPROVER permission.

c. Make a note of the role to which JTF_APPROVER permission is assigned. If 
this permission is not assigned to a role, navigate to Security>Access 
Controls>Roles and assign the permission to a new or existing role.

d. Click the Users Tab and navigate to Registration>User Maintenance.

e. Search for and access the user you created in steps 1 and 2.

f. Click Roles and assign this user the role containing the JTF_APPROVER 
permission.

4. Navigate to Setup>Approval Setup and either select an approval from the list or 
create a new approval.

5. Add the newly created user to the Approver list, enter the desired number in 
the Order field, and then click Submit.

6. In the Forms-based interface, navigate to Profile>Sytem, enter "JTF PRIMARY 
USER" in the Profile field and click Find.

7. In the Site column, select the newly created user from the list of values and click 
OK. Save your work and exit the Forms-based interface.

32.32 Backward Compatibility
User and account requests that are filed through iStore or before the latest version of 
User management was applied must be approved using the old "Pending Requests" 
screen. Perform the following steps to approve or reject these user requests.

Prerequisites
None

Note: You can test these steps by registering a new user for your 
organization and checking the workflow notifications in your 
personal home page. The work list on this page will contain 
workflow notifications for every user new user you subsequently 
register.

Note: The "End User" user type in the old registration module has 
been renamed to “Individual User"
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Responsibility
CRM HTML Administrator

Role

JTF_APPROVER

Navigation
In the System Administrator Console, navigate to Users>Registration>Pending 
Approvals

Steps
1. Review the following text at the bottom of the screen:

"Requests filed through the old registration module will have to be approved 
from the old request page. This link will be removed, once all these requests 
have been processed. Click here"

2. Click the Click Here link and approve or reject the users as you see necessary. 
Any user account requests filed after this patch has been applied will be visible 
in the main Pending Approval screen.

32.33 Related Documentation and Resources
You can consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

� Oracle Workflow Administrator’s Guide

� Oracle Receivables User Guide

These documents range from the general to the specific, in the order listed in the 
following table.
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Table 32–3 Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

This document contains information about new product 
features and functions for the various Oracle applications.

Installing Oracle Applications, Release 11i This documents the Rapid Install installation process.

Implementing CRM Applications, 
A85301-01

This document contains post-installation information on CRM 
modules.

Oracle CRM Foundation Components, 
Concepts and Procedures

This document contains a printed compilation of the Oracle 
Foundation online help system.

Oracle CRM Foundation, Technical 
Reference Manual

This document contains table and view descriptions for all the 
Foundation components.
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Post Implementation Tasks

This part of the Oracle Common Application Components Implementation Guide 
contains the following chapter:

Verifying the Oracle Foundation Implementation
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Verify the Implementation

33.1 Oracle Common Application Components Implementation 
Verification Tasks

This section covers the following topics:

� Running Diagnostic Tests

� Verification Task List per Module

33.1.1 Running Diagnostic Tests 
Before proceeding with the implementation of the Common Application 
Components, run the applicable diagnostic tests available through the HTML 
System Administrator Console. You can troubleshoot any setup and installation 
problems of the technology foundation and certain participating applications such 
as Foundation. Note that a product module must be registered with the diagnostic 
tool before diagnostic tests for it become available.

Additionally, you can register and employ new diagnostic tests, run test groups and 
individual tests, and manage tests and test groups. An implementor would most 
likely either verify using the Basic tab or the Advanced tab. The type of tests that 
are available depend on which application you test.

Each test generates a report if a problem is encountered. The report identifies the 
problem and provides a suggested resolution to the problem.

33.1.1.1 Accessing the HTML Diagnostic Test Set
The HMTL Diagnostic Test Set can be accessed in one of two ways:

� Selecting the Diagnostics tab in the System Administrator Console
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� Using a variation of the following URL: 

tap://<hostname>:<portnumber>/OA_HTML/jtfqalgn.htm

33.1.1.2 Selecting the Diagnostic Level that is Appropriate
The Diagnostic Tool contains three functional areas:

� Basic: Use the links on this tab to automatically run all the listed diagnostic 
tests or to run specific tests. Define test input parameter values using the 
Configuration tab.

� Advanced: Use the links on this tab to test specific CRM modules or groups. 
Enter input parameter values for the specific test directly in this window.

� Configuration: Use this window for test and group administration and to 
configure any necessary test input parameters.

33.1.1.3 Viewing the Diagnostic Reports
After a test is run, a summary appears on the Results window. To access the report, 
double-click the report icon.

Log-in Issues
A commonly reported problem is the inability of a user to log in to the console. 
Frequently, this has nothing to do with the setup of the HTML Tech Stack or the 
System Administrator Console. The problem is that user data, especially numeric 
data, is entered incorrectly during user definition. This can effectively make it 
impossible to log in to the Console and correct the problem. The independent URL 
for the Diagnostic Tool then becomes the portal for pinpointing and correcting the 
error.

Note: Consult the Diagnostic Tool user interface for a description 
of each test.

Note: Refer to the Understanding Diagnostics section in the Oracle 
Applications CRM System Administrator's Guide for additional 
information.
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33.1.2 Verification Task List per Module
After you complete the configuration and setup of all the Oracle Common 
Application Components modules, verify that you can perform the tasks outlined in 
the following table to ensure that you have setup the module correctly.

You must be able to complete each task successfully, or your Oracle Common 
Application Components modules will not work properly. If you are unable to 
complete a task successfully, then correct the problem before continuing.

Table 33–1 Common Application Components Verification List

Foundation Module Task Reference

HTML Tech Stack Login to HTML Applications as System 
Administrator

Oracle Applications CRM System 
Administrator's Guide.

User Management Register and approve a new user Oracle Common Application 
Components User’s Guide

Resource Manager � Import a resource (Forms)

� Create a salesperson (Forms or HTML)

� Create a group resource (Forms or HTML)

Oracle Common Application 
Components Implementation Guide

Notes Create a note for a task Oracle Common Application 
Components User’s Guide

Assignment Manager � Assign a resource to a task Oracle Common Application 
Components User’s Guide

Task Manager Create a task Oracle Common Application 
Components User’s Guide

Calendar (Forms) Assign a resource to a shift Oracle Common Application 
Components Implementation Guide

Calendar (HTML) � Create an appointment

� Invite attendees

Oracle Common Application 
Components User’s Guide

Escalations Escalate a task Oracle Common Application 
Components User’s Guide

Business Rule Monitor Ensure that a rule is violated and appropriately 
escalated

Oracle Common Application 
Components Implementation Guide
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Appendices

This section of the Oracle Common Application Components Implementation 
Guide contains the following chapters:

� Appendix A: Profile Options

� Appendix B: Concurrent Programs
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Profile Options

This appendix chapter describes profile option settings that are required for 
successful implementation. These profile options are only for Common Application 
Components. For additional functionality, you may need to set additional profile 
options from the appropriate calling applications. Consult the calling application’s 
documentation for additional information. Topics in this section include: 

� Before You Begin

� About Profile Options

� Setting Profile Options

� Common Application Components Profile Options

– Resource Manager

– Notes

– Spreadtable

– Gantt

– Assignment Manager

– Task Manager

– Calendar

– Escalation Manager

– Business Rule Monitor

– User Management
tions A-1



Before You Begin
A.1 Before You Begin
Before making Oracle Forms settings, ensure that all Oracle Applications server 
processes are up and running. In particular, if you stopped concurrent managers 
before applying Oracle Applications patchsets, restart them now by changing to

 $COMMON_TOP/admin/scripts

and executing

 adcmctl.sh <APPS username/APPS password> start.

A.2 About Profile Options
You set profile options whenever you want the application to react in different ways 
for different users, depending on specific user attributes. Profile options affect the 
way the applications run. Oracle Application Object Library establishes a value for 
each option in a user's profile when the user logs on or changes responsibility. 
Oracle Application Object Library provides many options that you can set to alter 
the user interface of the applications to satisfy individual preferences.

Profile options are defined and can be set at four levels:

� Site

� Application

� Responsibility

� User

You define a profile option to determine which subset of the organization's data 
your end user views. From the point of view of a System Administrator or end user, 
profile options that are defined are indistinguishable from those provided by Oracle 
Application Object Library. 

Site Level 
Site is the lowest user profile level. Site-level option values affect the way all 
applications run at a given installation. 

Application Level 
Application is the user profile level immediately above Site. Application-level 
option values affect the way a particular application runs. 
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Responsibility Level 
Responsibility is the user profile level immediately above Application. 
Responsibility-level option values affect the way applications run for all users of a 
responsibility. 

User Level 
User is the highest user profile level and is immediately above Responsibility. 
User-level option values affect the way applications run for an application user. 

Example
Oracle Application Object Library provides a site-level Printer option, an 
application-level Printer option, and so on. Oracle Application Object Library 
enforces the level hierarchy to ensure that higher-level option values override 
lower-level values. As a result, if your Site-level Printer value is "New York", but 
your User-level Printer value is "Boston" your reports print on the Boston printer. 

A.2.1 Setting Profile Option Values
A System Administrator can set values for profile options at each profile level. You 
can set default values for your new profile options by using the System 
Administrator responsibility. Typically, a System Administrator sets site-level 
option values after installing Oracle Application Object Library-based applications 
at a site. These site-level option values then work as the defaults until the System 
Administrator or end user sets them at higher levels. Oracle Application Object 
Library derives run-time values for each user's profile options based on values the 
System Administrator sets at each level. An option's run-time value is the 
highest-level setting for that option. 

Example
For a given end user, the Printer option is set only at the Site and Responsibility 
levels. When the end user logs on, the Printer option sets the value at the 
Responsibility level, since it is the highest-level setting for the option. If the default 
value of a user profile option at any level is inappropriate, the System 
Administrator can change it at any time. This change takes effect as soon as end 
users log on again or change responsibilities. 

See Also
The appendix in the Oracle Applications System Administrator's Guide.
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A.2.2 Setting Profile Options
A user profile is a set of changeable options that affect the way your application 
looks and behaves. As System Administrator, you control how Oracle Applications 
operate by setting user profile options to the values you want. You can set user 
profile options at four different levels: site, application, responsibility, and user. 
Perform the following steps to set profile options.

Prerequisites
None

Responsibility
System Administrator

Navigation
Navigate to Profile > System.

Steps
1. In the Find System Profile Values window, select an appropriate check box for 

the profile option that you want to set before clicking Find.

The System Profile Values window opens with the profile option you searched 
for.

2. Set an appropriate value for your profile option if the checkbox is selected:

a. Set the Site value.

This field displays the current value, if set, for all users at the installation 
site. 

b. Set the Application value.

This field displays the current value, if set, for all users working under 
responsibilities owned by the application identified in the Find Profile 
Values block.

c. Set the Responsibility value.

This field displays the current value, if set, for all users working under the 
responsibility identified in the Find Profile Values block.

d. Set the User value.
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This field displays the current value, if set, for the application user 
identified in the Find Profile Values block. 

You should set site-level default values for any required options after 
installation of an application. If you do not assign a particular profile option 
at any of the four levels, that option does not have a default value and may 
cause errors when you use forms, run reports, or run concurrent requests. 

3. Save your work.

A.3 Common Application Components Profile Options
This section summarizes the Oracle Common Application Components profile 
options per module that you need to set.

� Resource Manager

� Notes

� Spreadtable

� Gantt

� Assignment Manager

� Task Manager

� Calendar

� Escalation Manager

� Business Rule Monitor

� User Management

A.3.1 Resource Manager Profile Options
The following table describes the profile options that are specific to the Resource 
Manager. Each profile option is specific for HTML-based functionality.

Note: For Business Rule Monitor profile options, enter the name 
of the workflow administrator in the Site field. This user is the one 
that you previously named in Defining the Owner of the Workflow 
Process.
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Table A–1 Resource Manager Profile Options

Name
Default 
Value Level Description Outcome

Employee Resource 
Update Access

Self Site This profile option sets 
the security around 
updating employee 
information in the 
Resource Manager. 

If set to Self, only the employee 
can update their own 
information. 

If set to Any, others, including a 
System Administrator, can 
update the employee 
information, including 
overriding any previous values 
in the profile option: Resource 
Lookup Audience.

Group Update 
Access

None Site This profile option sets 
the security around 
updating groups, 
including hierarchies.

If set to None, then only the 
Administrator or manager can 
update their group and any 
other group following their 
group in the hierarchy. 

If set to All, then the user can 
update any group hierarchy in 
the site.

Resource Lookup 
Audience

General Site This profile option 
controls what the user 
views in the Resource 
Details window and in 
the Advanced Search.

If set to Admin, then the user 
can query in the Advanced 
Search using the additional 
fields of Resource number and 
Salesperson number.

If set to General, then the user is 
sees and searches on limited 
fields.

Role Update Access None Site This profile is used to 
control the access to the 
Role HTML windows.

The Resource Self Service 
Administrator 
responsibility level is set 
to the All value.

If set to None, then it is 
Read-Only access to the Role 
windows. You can search and 
view all the roles.

If set to All, then the user can 
create, update non-seeded roles, 
delete non-seeded roles, search, 
and view roles.
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A.3.2 Notes Profile Options
The following table describes the profile options that are specific to Notes.

A.3.3 Spreadtable Profile Options

The following table describes the profile options that are specific to Spreadtable.

Resource active 
days after 
termination of 
source

30 days Site This profile is used when 
end dating a resource of 
type Partner or employee. 
It allows a set period of 
days for the resource to 
stay active after 
termination. Set at Site 
level.

When set to x days the resource 
has that many days to stay 
active in the system.

Table A–2 Notes Profile Options

Name
Default 
Value Level Description Outcome

Notes: Default 
Note Status

Public Site This profile option 
sets the default note 
status. Profile option 
values include 
private, public, or 
publish.

If you select Publish, then that is the 
default value shown in the Status 
drop-down list when creating a new note.

If no profile option is set, default is 
Public.

Note: The browser must be restarted for changes to the profile 
option settings to take effect.

Table A–1 Resource Manager Profile Options

Name
Default 
Value Level Description Outcome
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Table A–3 Spreadtable Profile Options

Name
Default 
Value Level Description Outcome

JTA Display images 
in the grid

Null User This profile options 
sets whether or not 
images are visible in 
the spreadtable. 

Possible values are 
Null, Yes, or No.

If Null (left blank), the value is treated as 
Yes.

If set to Yes, all images are visible. This is 
a global setting for all spreadtable 
images.

If set to No all images are turned off. 

JTA Display images 
in grid column 
headers

Null User This profile options 
sets whether or not 
column header 
images are visible in 
the spreadtable. 

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all column header images are 
visible. 

If set to No all column header images are 
turned off.

JTA Display header 
popup images

Null User This profile options 
sets whether or not 
header popup 
images are visible in 
the spreadtable. 

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all header popup images are 
visible. 

If set to No, all header popup images are 
turned off.

JTA Display row 
header images in 
the grid

Null User This profile options 
sets whether or not 
row header images 
are visible in the 
spreadtable. 

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all row header images are 
visible. 

If set to No, all row header images are 
turned off.

JTA Display grid 
popup images

Null User This profile options 
sets whether or not 
grid popup images 
are visible in the 
spreadtable. 

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all header popup images are 
visible. 

If set to No, all header popup images are 
turned off.
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A.3.4 Gantt Profile Options
The following table describes the profile options that are specific to Gantt

JTA Display 
checkbox images

Null User This profile options 
sets whether or not 
images in cells 
defined as check 
boxes are visible in 
the spreadtable.

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all check box images are 
visible. 

If set to No, an asterick (*) is used for 
True and Null (blank) for False

JTA Display 
custom images

Null User This profile options 
sets whether or not 
images in cells 
defined as 'Image' are 
visible in the 
spreadtable.

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all cell images are visible. 

If set to No, the image description is used 
in place of the image.

JTA Display long 
wait images

Null User This profile options 
sets whether or not 
long wait images are 
visible in the 
spreadtable.

Possible values are 
Null, Yes, or No.

If Null (left blank), it has the same value 
as JTF_GRID_DISPLAY_IMAGES.

If set to Yes, all long wait images are 
visible. 

If set to No, no long wait images are 
visible.

Table A–4 Gantt Profile Options

Name
Default 
Value Level Description Outcome

JTF_GANTT_
SNAP_VALUE_
DAYS_MODE

60 
minutes

User Enables the start or end of a taskbar 
to automatically readjust (snap) 
during drag and drop operations in 
the "Day" view. 

Snaps to the default 
value if the user 
does not specify a 
snap value.

Table A–3 Spreadtable Profile Options

Name
Default 
Value Level Description Outcome
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A.3.5 Assignment Manager Profile Options
The following table describes the profile options that are specific to Assignment 
Manager.

JTF_GANTT_
SNAP_VALUE_
SIX_HOURS_
MODE

60 
minutes

User Enables the start or end of a taskbar 
to automatically readjust (snap) 
during drag and drop operations in 
the "6 Hour" view. 

Snaps to the default 
value if the user 
does not specify a 
snap value.

JTF_GANTT_
SNAP_VALUE_
THREE_HOURS_
MODE

30 
minutes

User Enables the start or end of a taskbar 
to automatically readjust (snap) 
during drag and drop operations in 
the "3 Hour" view. 

Snaps to the default 
value if the user 
does not specify a 
snap value.

JTF_GANTT_
SNAP_VALUE_
HOURS_MODE

15 
minutes

User Enables the start or end of a taskbar 
to automatically readjust (snap) 
during drag and drop operations in 
the "Hour" view.

Snaps to the default 
value if the user 
does not specify a 
snap value.

JTF_GANTT_
SNAP_VALUE_
30MIN_MODE

10 
minutes

User Enables the start or end of a taskbar 
to automatically readjust (snap) 
during drag and drop operations in 
the "30 Minute" view. 

Snaps to the default 
value if the user 
does not specify a 
snap value.

JTF_GANTT_
SNAP_VALUE_
15MIN_MODE

5 minutes User Enables the start or end of a taskbar 
to automatically readjust (snap) 
during drag and drop operations in 
the "15 Minute" view. 

Snaps to the default 
value if the user 
does not specify a 
snap value. 

JTF_GANTT_DEF_
TIMELINE_MODE

Day Mode Site 
Application 
Responsibility
User

Enables specification of one of the 
following modes upon startup:

� 15 Minutes Mode

� 30MIN

� Hours Mode

� 3 Hours Mode

� 6 Hours Mode

� Days Mode 

Specifies one of six 
available modes on 
startup. 

Table A–4 Gantt Profile Options

Name
Default 
Value Level Description Outcome
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Table A–5 Assignment Manager Profile Options

Name
Default 
Value Level Description Outcome

Activate Auto 
Selection of 
Resources

Yes Application This profile option is set to activate 
the auto-selection of resources by the 
Assignment Manager engine. The 
engine uses this profile option setting 
to determine where the user needs to 
make a selection from the provided 
list of resources, or if this task is 
performed automatically by the 
Assignment Manager engine itself.

If you set this profile 
option to No, the 
Assignment 
Manager engine will 
automatically make 
a selection from the 
provided list of 
resources.

Activate Contracts 
Preferred 
Resources

No Application This profile option is set to retrieve 
the preferred resource information 
from the Contracts module. The 
engine uses this profile option setting 
to determine whether the Contracts 
Preferred Engineers are picked up 
automatically by the Assignment 
Manager engine or not.

If you set this profile 
option to No, it will 
uncheck the 
Contracts in the 
Assignment 
Manager.

Activate Installed 
Based Preferred 
Resources

No Application This profile option is set to retrieve 
the preferred resource information 
from the Installed Base module. The 
engine uses the profile option setting 
to determine whether the Installed 
Base Preferred Engineers are picked 
automatically by the engine.

If you set this profile 
option to No, it will 
uncheck Territories 
in the Assignment 
Manager.

Activate Workflow 
Name

 No 
default 
value

Application This profile option is set to a 
user-defined workflow procedure 
name. This workflow procedure is 
user-programmed code for further 
filtering the resources. The engine 
retrieves the procedure name from 
this profile option, and uses it to 
process the user’s request.

This profile option is 
an additional filter 
based on the user’s 
criteria.

JTFAM: Resource 
Type for Unassisted 
Mode

Employee 
Resource

Site This profile option sets the default 
value for resource type in the 
unassisted mode.

This profile option is 
a convenience to the 
user who wants the 
resource type to be 
the defaulted value 
in the unassisted 
mode.
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JTFAM: Resource 
Search Order

Contracts 
Preferred 
Resource

Site This profile option sets the default 
order for resource selection between 
Contracts and Installed Base if both 
check boxes are selected in the 
Assignment Manager for a service 
request assignment. 

If Contracts 
Preferred Resource 
is selected, then 
Assignment 
Manager engine 
checks Contracts 
preferred resources 
first. If a Contracts 
preferred resource is 
found, then stop the 
process. If not, then 
check the Installed 
Base preferred 
resources. If a 
Installed Base 
preferred resource is 
found, and stop the 
process. If not, then 
continue check the 
territories. 

If Installed Base 
Preferred Resource 
is selected, then 
Installed Base 
preferred resources 
are checked first, if a 
resource is found, 
then stop the 
process. If not, then 
continue check the 
Contracts. 

If "Both Contracts 
and Installed Base" 
is selected, then 
Assignment 
Manager checks 
both preferred 
resources 
simultaneously 
before retrieving 
qualified resources 
from winning 
territories.

Table A–5 Assignment Manager Profile Options

Name
Default 
Value Level Description Outcome
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A.3.6 Task Manager Profile Options
The following table describes the profile options that are specific to Task Manager.

JTFAM: Usage for 
Groups and Teams

All Site This profile option sets the default 
value for the group and team 
resource selection used in a service 
request assignment.

If it is set to All, then 
all group or team 
resources, regardless 
of its usage, are all 
displayed in the 
Gantt chart. If it is 
set to Support, then 
only the group or 
team with Support 
usage can then be 
retrieved for a 
service request 
assignment.

Table A–6 Task Manager Profile Options

Name
Default 
Value Level Description Outcome

Task Manager: 
Default Task Type

No 
default 
value

Site Use the Default Task Type 
profile option to set the 
default task type. Possible 
values include appointment 
and lead.

Set the value to the task type that 
you want to appear in the task 
type drop-down list when you are 
creating a task. 

Task Manager: 
Default Task Status

Open Site Use the Default Task Status 
profile option to set the 
default task status. Possible 
values include open and 
completed.

Set the value to the task status that 
you want to appear in the task 
status drop-down list when you 
are creating a task. 

Task Manager: 
Default Task 
Priority 

Medium Site Use the Default Task Priority 
profile option to set the 
default task priority. Possible 
values include critical and 
medium.

Set the value to the task priority 
that you want to appear in the task 
priority drop-down list when you 
are creating a task.

Task Manager: 
Default Task 
Owner

No 
default 
value

Site Use the Default Task Owner 
profile option to set the 
default task owner.

Set the value to the name of the 
default task owner.

Table A–5 Assignment Manager Profile Options

Name
Default 
Value Level Description Outcome
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Task Manager: 
Owner Type for 
Task

No 
default 
value

Site Use the Owner Type for Task 
profile option to set the 
default owner type. Possible 
values include employee 
resource and party.

Set the value to the owner type for 
the task.

Task Manager: 
Default Assignee 
Status

Accepted Site Use the Default Assignee 
Status profile option to set 
the default assignee status.

Set the value to the assignee status 
that you want to appear in the 
Assign To Status drop-down list 
when you are creating a task.

Task Manager: JTF 
Tasks Default Date 
Selected

Scheduled Site Use the JTF Tasks Default 
Date Selected profile option 
to set the default date 
selected. Possible values 
include Planned, Scheduled, 
or Actual. 

Set the value to the default date 
that you want to default in the 
Create Task window.

Task Manager: Task 
APIs to Determine 
if Security is 
Implemented

No 
default 
value

Site The Task APIs to Determine 
if Security is Implemented 
profile option is reserved for 
future use.

The value of this profile option 
should always be set to No.

Time Unit of 
Measure Class

Time Site Use the Time Unit of 
Measure Class profile option 
to define the time unit of 
measure class in the 
inventory module.

Depending on the time unit 
of measure class, you will 
see the list of UOM codes in 
the Tasks module.

Depending upon the value of this 
profile, the Time UOM codes are 
shown in the list of values. If the 
value of this profile changes, then 
there will be a discrepancy 
between the existing data and the 
new LOV shown for the new Time 
UOM class. 

Oracle strongly recommends the 
value of this profile should NOT 
be changed after the system in the 
production

Task Manager: 
View All Task 
Privileges

Yes Site The View All Task Privileges 
profile option is reserved for 
future use.

Do not change the value of this 
profile option.

Task Manager: 
View All Task 
Privileges

Yes Site The View All Task Privileges 
profile option is reserved for 
future use.

Do not change the value of this 
profile option.

Table A–6 Task Manager Profile Options

Name
Default 
Value Level Description Outcome
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Task Manager: 
Delete Any Task 
Privileges

No Site The Delete Any Task 
Privileges profile option is 
reserved for future use.

Do not change the value of this 
profile option.

Task Manager: Use 
the Indicator of 
Data Truncation

... Site Use the Indicator of Data 
Truncation profile option to 
store a three-character code 
which is appended to the 
source object name of a Task 
when it has been truncated. 
The default value of this 
profile option is '...'.

For example, if the source of 
a Task is a Party, the name 
may be too large to store in 
the source_object_name 
column. If the name: "This is 
a very long name to test the 
truncation indicator 
functionality" (71 chars) is 
passed to the Task API as the 
source object name, it is 
written to the Task record as: 
"This is a very long name to 
test the truncation 
indicator..." (60 chars). The 
default value of this profile 
option is '...'.

Set the value that is appended to 
the source object name of a Task 
when it has been truncated.

Task Manager: 
Create Quick Task

No 
default 
value

Site Use the Create Quick Task 
profile option to display the 
quick create button on the 
Tasks Summary window.

Set the value to Yes if you want the 
Quick Create button to appear in 
the Task Summary.

Set the Value to No if you do not 
want the button to appear in the 
window.

Client Timezone America/
Los_
Angeles

Site The Client Time zone profile 
option is used by Calendar 
to set the default time zone 
for the client in the Create 
Appointment window.

Set the value to the location where 
your appointments take place.

Setting the time zone from the 
profile link in the Calendar UI is 
another way to set and update this 
profile value.

Table A–6 Task Manager Profile Options

Name
Default 
Value Level Description Outcome
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Task Manager: 
Send Notifications 
to Group or Team 
Members

No Site The Task Manager: Send 
Notifications to Group and 
Team Members profile 
option provides the ability to 
notify either the Owner or 
the Assignee of a Group or 
Team resource, when a task 
is modified.

This profile option is for 
workflow only.

If the value is set to No, then no 
notification will be sent to group 
or team members. 

If the profile option is set to Yes, 
then the system looks at any 
resources of type Group or Team 
and expand them to include any of 
their members whose resource 
type is RS_EMPLOYEE, RS_
PARTY or PARTY_PERSON.

When adding a resource to the 
notify list, the system checks to see 
if the resource is already on the list 
before adding it.

Task Manager: 
Enable Automated 
Task Workflow 
Functionality

No Site The Task Manager: Enable 
Automated Task Workflow 
Functionality profile option 
is used to determine 
whether to send the 
automatic notifications or 
not.

Set the value to No, for the task 
workflows not to be initiated by 
the API.

If the value is set to Yes, then task 
workflows are initiated by the API. 
The default value is No.

Task Manager: 
Abort Previous 
Task Workflow if it 
is still active

No Site The Task Manager: Abort 
Previous Task Workflow if it 
is still active profile option is 
used to determine whether 
to abort the previous 
workflow processes before 
starting the next one.

If the value is set to No, then the 
previous Task Workflows that are 
still active are not aborted.

If the value is set to Yes, then the 
previous Task Workflows that are 
still active are aborted.

JTF_TASK_
SUMMARY_
SOURCE

Source User The JTF_TASK_SUMMARY_
SOURCE profile option sets 
the view drop-down list 
value in the Task Summary 
context sensitive window. 
Possible values are Source 
and All.

Set the value to Source to have all 
tasks created with a particular 
source in the contextual window. 

Set the value to All to have all 
tasks created with a source as well 
as those which refer to that source 
in the context sensitive Task 
Summary.

Table A–6 Task Manager Profile Options

Name
Default 
Value Level Description Outcome
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A.3.7 Calendar Profile Options
The following table describes the profile options that are specific to the HTML 
Calendar.

Task Manager: 
Mass Task Reassign 
Access

No Site Use the Task Manager: Mass 
Task Reassign Access profile 
option to display the Task 
Reassignment window.

If the profile option is set to Yes, 
the Task Reassignment window is 
accessible and the administrator is 
able to reassign tasks. If the value 
is set to No, then the Task 
Reassignment window is not 
accessible and a relevant message 
is shown. 

JTF Sync: Category 
Value

Oracle 
Business

System This profile option is used in 
the Palm and Outlook 
synchronization process. 

It is to set the default value 
for the category while trying 
to download business 
contacts to the offline device. 

All business contacts downloaded 
to the offline device will be created 
with this category. If the category 
does not exist in the offline device, 
then it will be created upon 
synchronization.

Task Manager: 
Copy Task Start 
Date to End Date

Yes Site This profile option is used to 
control the task start and 
end date for the Palm and 
Outlook synchronization.

If it is set to Yes, the task start date 
is defaulted from the system date 
and the task end date is defaulted 
to the task start date. 

For example, if it is set to Yes, then 
any changes the user made to the 
task start date while the user is in 
the task creation screen will 
automatically be populated to the 
task end date field.

Task Manager: Set 
Context Data 
Security

Full 
Access

Site Use the Task Manager: Set 
Context Data Security profile 
option to set task data 
security for the context 
sensitive task instances.

If Full Access is selected, then all 
the tasks related to the context can 
be viewed, updated, and deleted. 
If Security Access is selected, then 
whether the task for that context 
can be updateable is based on the 
privileges granted to the user. 

Table A–6 Task Manager Profile Options

Name
Default 
Value Level Description Outcome
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Table A–7 Calendar Profile Options

Name
Default 
Value Level Description Outcome

JTF HTML 
Calendar 
Administrator

No 
default 
value

User The JTF HTML Calendar 
Administrator profile option sets 
the Calendar System 
Administrator who grants 
approval and subscription 
requests for group and public 
calendars.

Set the value to the username 
of the calendar user who 
grants group and public 
calendar requests.

Client Timezone America/
Los_
Angeles

Site The Client Time zone profile 
option is used by Calendar to set 
the default time zone for the 
client in the Create Appointment 
window.

Set the value to the location 
where your appointments 
take place.

Setting the time zone from 
the profile link in the 
Calendar UI is another way 
to set and update this profile 
value.

JTF HTML 
Calendar Task Span 
Days

No Site The JTF HTML Calendar Task 
Span Days profile option sets 
tasks that spans over more than 
one day to appear continuously 
across days on your personal 
calendar.

Set the profile option to Yes 
to have your tasks that span 
over more than one day to 
appear continuously across 
days on your personal 
calendar. 

If the value is set to No, the 
task shows as a memo for 
each day affected.

JTF_PROFILE_
DEFAULT_
RESPONSIBILITY

22946 User The JTF_PROFILE_DEFAULT_
RESPONSIBILITY profile option 
sets the default responsibility 
when using calendar as a 
stand-alone application.

Set the value to correspond to 
the calendar user. The user 
value is 22946.

JTF_PROFILE_
DEFAULT_
APPLICATION

690 User The JTF_PROFILE_DEFAULT_
APPLICATION profile option 
sets the default application 
when using calendar as a 
stand-alone application.

Set the value to correspond to 
the calendar user. The user 
value is 690.
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A.3.8 Escalation Manager Profile Options
The following table describes the profile options that are specific to Escalation 
Management.

Table A–8 Escalation Manager Profile Options

Name
Default 
Value Level Description Outcome

Escalation: Close 
Only When 
De-escalated

Yes Site The escalation document cannot 
be closed (you cannot set up the 
escalation status to 'Close') 
without first changing the 
Escalation Level to 'De-escalated'. 

If set to Yes, then it can 
regulate the escalation 
status change sequence 
from De-escalated to 
Close. 

If set to No, then it will 
not.

Escalation: Default 
Contact Type

Employee Site This profile option sets the 
default contact type to Employee 
in the Contacts tab.

You can also set it to 
Customer, and then it 
will default the contact 
type to Customer.

Escalation: Default 
Escalation Owner

Name Site This profile option sets the 
default escalation owner to a 
specific resource name, such as 
John Smith.

See description.

Escalation: Default 
Customer Contact 
Point

Phone Site This profile option sets the 
default customer contact point to 
Phone in the Contacts tab.

You can also set it to 
other values such as 
Cell, Email, Pager, or 
Web.

Escalation: Default 
Document Type

Task 
Manager

Site This profile option sets the 
default document type to Task in 
the Document field on the 
Reference Document tab.

You can also set it to 
other values such as 
Service Request or 
Defects.

Escalation: Default 
Employee Contact 
Point

Work Site This profile option sets the 
default employee contact point to 
Work in the Contacts tab.

You can also set it to 
other values such as 
Home, Mobile, or Pager.

Escalation: Default 
Escalation Level

Level 1 Site This profile option sets the 
default escalation level to Level 
1.

You can also set it to 
other values such as 
Never Escalated, Level 
2, or De-Escalated.

Escalation: Default 
Status

Open Site This profile option sets the 
default escalation Status field to 
Open.

You can also set it to 
other values such as 
Closed or Working.
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A.3.9 Business Rule Manager Profile Options
The following table describes the profile options that are specific to the Business 
Rule Monitor.

A.3.10 User Management Profile Options
The following table describes the profile options that are specific to User 
Management.

Escalation: Default 
New Note Type

General 
Note

Site This profile option sets the 
default note type to General Note 
if additional notes are attached to 
an escalation document.

You can also set it to 
other values such as 
Event or Approved. 

Escalation: Default 
Notify (Y/N)

Yes Site This profile option sets the 
default Notify check box to 
"checked" in the Contacts tab. 

You can also set it to No, 
which will leave the 
check box "unchecked" 
in the Contacts tab.

Escalation: Default 
Reason Code

Slow 
Progress

Site This profile option sets the 
default escalation Reason field to 
Slow Progress.

You can also set it to 
other values such as 
Unacceptable Solution, 
or Unresponsive Owner.

Escalation: Default 
Reference Type

Escalation Site This profile option sets the 
default escalation reference type 
to Escalation in the Reference 
Document tab.

You can also set it to 
other values such as For 
Your Information.

Table A–9 Business Rule Monitor Profile Options

Name
Default 
Value Level Description Outcome

Business Rule 
Monitor Workflow 
Administrator

No 
Default 
Value

Site This profile option must be 
set first in order to grant this 
profile option to the BRM 
Workflow Administrator. 

The Administrator can 
receive workflow 
notifications when the 
monitoring process starts 
and stops, and also when 
errors are detected.

Table A–8 Escalation Manager Profile Options

Name
Default 
Value Level Description Outcome
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Table A–10 User Management Profile Options

Name
Default 
Value Level Description Outcome

JTF_PRIMARY_
USER

sysadmin Site Predetermines the username 
that corresponds with the 
"Universal Primary User 
Approver".

The supplied username 
corresponds to the 
Universal Primary User 
Approver.

JTF_
INDIVIDUALUSER_
ACCOUNT

Yes Site Enables automatic account 
creation for newly registered 
users.

When set to Yes, 
automatically creates a 
new account in the 
HZ_CUST_ACCOUNTS 
table for a newly 
registered user and 
associates the user with 
the account. Users must 
have an account to buy 
products in the iStore.

JTA_UM_
APPLICATION_
URL

None Site Specifies the application 
logon URL sent to users in 
email messages that are 
automatically generated 
once a user request has been 
approved. 

The supplied URL is sent 
to users in email messages 
that are automatically 
generated once a user 
request has been 
approved.

JTA_UM_
WORKFLOW_
OWNER

sysadmin Site When a workflow is 
launched it always identifies 
the user who launched it. 
The system administrator is 
the default User 
Management workflow 
owner. User Management 
uses workflow for 
registration and for resetting 
passwords. Users can query 
workflows using the name 
of the workflow owner. 

Specifies the name of the 
workflow owner.

JTA_UM_SENDER None Site Provides a sender clause for 
automatically generated 
email messages such as 
approval and password 
expiration notifications.

The specified clause is 
sent with each 
automatically generated 
message such as approval 
and password expiration 
notifications.
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JTF_UM_
APPROVAL_
OWNER

sysadmin Site .Defines the individual who 
serves as an escalation point 
of contact and who receives 
and approval request when 
the last approver fails to 
approve the request.

This profile option is used 
in the approval process. If 
the last approver in a 
predefined approval 
definition fails to approve 
a request, the person 
defined in this profile 
option will be the 
escalation point of contact 
and will receive the 
request. The user specified 
as the value for this 
profile option must have 
the JTF_SECURITY_
ASSIGN_ROLE 
permission

JTF_UM_
APPROVAL_
TIMEOUT_MINS

1440 
Minutes 
(one day)

Site Defines (in minutes) how 
long a workflow notification 
remains in a queue before it 
is timed out.

When the notification 
times-out, the request 
goes to the next approver 
on the list. If no approver 
is specified, the approval 
owner receives and 
answers the request. If 
you enter 0 as the default, 
no time out occurs. If no 
value is set, the profile 
option is defaulted to 0. 
The Process Time-out field 
in the parameters window 
when starting the "JTF 
Approval" workflow must 
be set to Yes for this 
profile option value to 
take affect.

JTF_UM_
APPROVAL_URL

None Site Defines the user application 
logon URL. 

The URL is included in 
the workflow notification 
sent to each approver 
when they are assigned a 
request. The approver is 
sent an email message 
stating that the approver 
must approve a request.

Table A–10 User Management Profile Options

Name
Default 
Value Level Description Outcome
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JTF_UM_
MERCHANT_
NAME

None Site Defines the name of your 
organization. 

Workflow inserts this 
name into request 
approvals and rejections 
when they are sent to the 
user.

JTF_
REGISTRATION_
CACHE

Yes Site Determines whether the 
registration pages will cache 
the data entered by the user 
during the registration flow. 

 If set to Yes and if the 
user presses the browser 
"Back" button, then the 
data entered on the 
previous page is available. 
If set to No, then the data 
(page) expires as soon as 
the user leaves the page.

ICX: Language American 
English

Site The ICX: Language profile 
can be set at the user level 
and determines the language 
displayed for the user when 
logging in. 

The language for the 
registration page accessed 
from the "Register Here" 
link of the login page is 
determined by the ICX 
Language profile set for 
the "Guest User" defined 
in the System 
Administration console. 
To change the language 
for this page access the 
ICX: Language profile 
option, click the User 
field, and choose a 
language from the LOV.

JTA_UM_REG_
ORG_FAX_REQD

Yes Site Provides Yes/No values in 
the registration page that 
determine whether or not an 
organization’s fax 
information is required. 

The Organization 
Information page changes 
its required options 
depending on the values 
set for this profile option, 
however the fax field 
remains optional in the 
user detail page 
regardless of how this 
profile option is set.

Table A–10 User Management Profile Options

Name
Default 
Value Level Description Outcome
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JTA_UM_REG_
ORG_PHONE_
REQD

Yes Site Provides Yes/No values in 
the registration page that 
determine whether or not an 
organization’s phone 
information is required. 

The Organization 
Information page changes 
its required options 
depending on the values 
set for this profile option, 
however the phone field 
remains optional in the 
user    detail page 
regardless of how this 
profile option is set.

SIGNON_
PASSWORD_
LENGTH

5 Site Specifies the number of 
characters required to 
constitute a valid password.

When users define their 
password, the system will 
not accept passwords of 
fewer characters than the 
number specified in this 
profile option.

JTA_UM_HIDE_
QUICKFIND

No Site Optionally hides the 
Quickfind menu.

When set to Yes, this 
profile option hides the 
Quickfind menu from 
users. When set to No, the 
Quickfind menu appears. 
The profile option is set to 
No, to ensure 
compatibility with 
previous versions of User 
Management that did not 
contain this feature.

JTA_UM_
PASSWORD_GEN_
WKF

None Site Specifies the name of the 
workflow used for sending 
passwords to users. 

The workflow specified in 
this profile option sends 
passwords to users.

Table A–10 User Management Profile Options

Name
Default 
Value Level Description Outcome
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JTA_UM_SUPPORT_
CONTACT

Null Responsibility Specifies the name or email 
address of the support 
person to contact in case of 
logging errors. 

The name and email 
address specified in this 
profile option are used to 
contact support in case of 
logging errors. 

JTF_UM_EMAIL_
AS_USERNAME

No Site Optionally disables the User 
ID field in the registration 
screen and enables the user’s 
email address to also 
function as the user ID.

When set to Yes, this 
profile option disables the 
User ID field in the 
registration screen and 
enables the user’s email 
address to also function as 
the user ID. During the 
registration process, User 
Management populates 
the USER_ID column in 
the FND_USER table with 
the user’s email address.

When set to No, this 
profile option retains both 
User ID field in the 
registration screen and 
consequently does not 
populates the USER_ID 
column in the FND_USER 
table with the user’s email 
address.

Table A–10 User Management Profile Options

Name
Default 
Value Level Description Outcome
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JTA_UM_DEFAULT_
ADDRESS_STYLE

US Site Determines the default 
country whose specific style 
of address fields must be 
displayed in the company 
registration page and user 
details page.

When a user registers for the 
first time, the user must 
choose a country before 
entering address 
information. The country 
specified by this profile 
option appears by default.

If User Management does 
not contain seeded data for 
the required country, then 
you must setup the 
address style using the 
Accounts Receivable flex 
fields. For instructions on 
configuring flexible 
address fields, see the 
Chapter 3 of the Oracle 
Receivables User Guide.

When the profile option is 
set for a specific country 
then the address fields 
required by that country’s 
address style appear in 
the company registration 
page, and user details 
page. If the profile option 
is not set for a specific 
country of if there is an 
error displaying that 
country’s address style 
then the registration and 
user details pages default 
to the U.S. address style.

The registration process 
cannot be completed 
unless information is 
entered in mandatory 
address fields. The 
mandatory definition 
can be turned on or off 
for a given field from 
the flexfield segment 
definition, as a single 
address field maps to a 
segment of the address 
flexfield.

Table A–10 User Management Profile Options

Name
Default 
Value Level Description Outcome
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Concurrent Programs

This appendix chapter contains information relating to concurrent programs.

These concurrent programs belong to Core Application Components and for 
additional functionality, you may need to run additional concurrent programs from 
the appropriate calling applications. Consult the calling application’s 
documentation for additional information. Topics include: 

� About Concurrent Programs

� Running Concurrent Programs

� Common Application Components Concurrent Programs

B.1 About Concurrent Programs
Concurrent programs are tasks run by a concurrent manager. A concurrent process 
runs simultaneously with interactive functions and other concurrent processes. A 
concurrent manager coordinates the processes generated by user’s requests to run 
various data-intensive programs. A Foundation module can have several 
concurrent programs.

System administrator run concurrent programs periodically to update and 
synchronize their information.

B.2 Running Concurrent Programs
The following is a general procedure for running a concurrent program. Refer to the 
applicable chapter for specific information on running each specific concurrent 
program.
rams B-1



Common Application Components Concurrent Programs
Prerequisites
None

Responsibility
CRM Administrator or

System Administrator

Navigation
Navigate to the Navigator - CRM Administrator window, or

Navigate to the Navigator - System Administrator window

Steps
1. Select Request > Run.

The Submit a New Request window opens.

2. Select Single Request. 

3. In the Name field in the Submit Request window, select your chosen concurrent 
program.

4. Enter additional information if necessary in the appropriate fields.

5. Click Submit.

B.3 Common Application Components Concurrent Programs
The following modules use concurrent programs:

� Resource Manager

� Task and Calendar

B.3.1 Resource Manager Concurrent Programs
The following table describes the types of seeded programs, their use, and the 
frequency in which you need to run them.
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Table B–1 Resource Manager Concurrent Programs

Name Description Frequency Notes

Build Reporting 
Manager

This program is redundant, and, has 
been replaced with the "Synchronize 
Reporting Managers", and         
"Populate Reporting Manager" 
concurrent programs.

Run only 
when data is 
modified

None

Synchronize 
Employees

This program is used to synchronize 
employee data in Human Resources. 
Note the difference in employee 
parameters:

Yes: Synchronize all the employees 
that currently exist in Resource 
Manager. In addition, all new active 
employees in Human Resources are 
also imported

No: Synchronize only the employees 
that currently exist in the Resource 
Manager.

Daily For about 100,000 employees, 
this concurrent program should 
take about 10 minutes to run. It 
can be scheduled to run as a 
nightly process.

Flatten Employee 
Hierarchy

This concurrent program is ONLY 
meant to populate data in resource 
manager internal tables in order to 
expedite the data display in 
"Organization" link for Employee 
hierarchy. 

Daily Run this program after running 
Synchronize Employees

For about 100,000 employees, 
this program takes about 2-3 
minutes to run. So, it can be 
scheduled as a nightly process.

Flatten Group 
Hierarchy

This program is used to denormalize 
the Resource Group hierarchy 
structure into a flat structure for fast 
and easy data access.

Daily Run this program after 
Synchronize Groups Denorm.

For about 4000 groups, and 
average of 10 level hierarchy 
structure, this program takes 
about 10-15 minutes. It can be 
scheduled as a nightly process.

Synchronize 
Parties and 
Partners

This program keeps the Party 
Resource Name in Resource Manager 
in sync with information in TCA.

Daily For 1 million party records in 
HZ_PARTIES, this concurrent 
program should take about 20 
minutes to run. If the          
business is using a lot of Party 
type of resource, then this 
program can be scheduled to 
run on a nightly basis.
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Synchronize 
Supplier Contacts

This program is used to synchronize 
supplier contacts of type person in 
Purchasing.

Daily For 100,000 supplier contact 
records in PO_VENDOR_
CONTACTS, this program 
should take about 20          
minutes to run.

If the business is using a lot of 
Supplier Contact type of 
resource, then the program can 
be scheduled to run every night.

Synchronize 
Application User 
Name

This program is used to synchronize 
the FND user name and resource 
table.

Daily In a system comprising 50000 
users, this concurrent program 
should take about 5 minutes to 
run. It can also be scheduled as a 
nightly process.

Synchronize 
Groups Denorm

This program is used to denormalize 
the Resource Group hierarchy 
structure into a flat structure for fast 
and easy data access.

The 
application 
runs this 
automatically

For about 4000 groups, and 
average of 10 level hierarchy 
structure, this program takes 
about 10-15 minutes. It can          
be scheduled as a nightly 
process. This program achieves 
the same results as "Flatten 
Group Hierarchy". The only          
difference between the two is 
that this program is kicked off 
automatically from the UIs 
where as the latter is used for 
cases where the data may have 
been created using Resource 
Manager APIs.

Group Audit 
Report

This program is used to obtain audit 
information for a particular resource 
group.

As needed For a group, it should take no 
more than 1-2 minutes assuming 
normal system load and 
resource availability.

Group Structure 
Report

This program is used to obtain group 
structure information for a particular 
resource group. Given a group, it 
displays all the child groups, as well 
as all the immediate level members of 
the group. This information can also 
be obtained online through          
Resource Manager HTML windows.

As needed. For a group, it should take no 
more than 1-2 minutes assuming 
normal system load and 
resource availability.

Table B–1 Resource Manager Concurrent Programs

Name Description Frequency Notes
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Resource Manager 
Diagnostics

This concurrent program is a 
diagnostic tool to be used for 
troubleshooting in case of some 
undesirable behavior. It generates an 
output containing various critical file 
versions that comprise the resource 
manager functionality.

As needed None

Populate 
Reporting 
Manager

This program is used to populate data 
into an internal resource manager 
table which is accessed by Oracle 
Incentive Compensation team. This 
program should be used when 
Resource Group Membership data 
has not been entered through 
Resource Manager UIs, but, APIs 
instead.

As needed In a system with 150,000 
resources, and about 4000 
groups, this program takes 
about 10-15 minutes. It can be          
scheduled as a nightly process if 
a lot of changes around Resource 
Group Membership is made 
daily.

Table B–1 Resource Manager Concurrent Programs

Name Description Frequency Notes
Concurrent Programs B-5



Common Application Components Concurrent Programs
Synchronize 
Reporting 
Managers

This program is used to populate data 
into an internal resource manager 
table which is accessed by the Oracle 
Incentive Compensation team. It is 
launched automatically from 
Resource Manager UIs.

As needed In a system with 150,000 
resources, and about 4000 
groups, this program takes 
about 10-15 minutes. It can be 
scheduled as a nightly process if 
a lot of changes around Resource 
Group Membership is made 
daily.

Synchronize 
Workflow Roles 

This program synchronizes all 
attributes and records in the 
workflow wf_local_* tables with the 
mismatching records in Resource 
manager.

As needed This program should be run as 
follows:

� The first time group 
notification functionality is 
implemented in Resource 
Manager.

� When groups or resources 
that were not active at the 
time of their creation have 
become activated.

� If online transactions 
encounter a Workflow error.

� When the Synchronize 
Employees concurrent 
program is run.

� When the Synchronize 
Parties and Partners 
concurrent program is run.

� When the Synchronize 
Supplier Contact concurrent 
program is run.

Table B–1 Resource Manager Concurrent Programs

Name Description Frequency Notes
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B.3.2 Task and Calendar Concurrent Program
The following table describes the type of seeded program, its use, and the frequency 
in which you need to run it.

Resource Skills 
Report

This program generates skill reports 
for resources reporting to a manager 
and for group members.

As needed This program contains the 
following parameters:

� Manager. When this 
parameter is entered, the 
program displays a 
hierarchical skills rating 
report for all resources that 
report to the manager 
including direct and indirect 
reports.

� Group. When this 
parameter is entered, the 
program displays skill 
ratings for all group 
members. It does not 
display skill ratings for any 
child groups.

Note:  It is strongly recommended that an employee, party, 
partner, or supplier contact not have more than one entry in FND_
USERS. If an employee linked to two or more FND_USERS is 
imported into Resource Manager, then the USER_ID column in 
JTF_RS_RESOURCE_EXTNS table randomly picks a value from 
FND_USERS for that resource.

Table B–2 Task Manager Concurrent Programs

Name Description Frequency

Rebuilding Intermedia Index for 
Task Names

This program is used to rebuild the intermedia index so 
a user can use the quick find to search for new and 
updated tasks as well as to search by task name.

As needed

Table B–1 Resource Manager Concurrent Programs

Name Description Frequency Notes
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A   B   C   D   E   F   G   H   I   J   M   N   O   P   R   S   T   U   W

approval
An optional feature in User Management, whereby approvers can reject or approve 
new user accounts. In the User tab, the System Administrator Console provides 
windows so you can view, create, modify, delete, enable, and disable approvals, 
including those for specific organizations.

approval flow
The approval flow is a predefined flow of steps required to approve user 
registration or service enrollment requests in User Management.

assignee 
An assignee is the designated person who is assigned to fulfill a specific task or 
assignment. If an assigned task cannot be completed by the assignee, then the 
owner of this task can reassign a new resource (assignee) to this task.

The assignee, can also be the owner of the task.

Assignment Manager
The Assignment Manager is a tool that helps you assign resources to a task or a 
document.

assisted assignment option
The assisted assignment option is used to assign a resource to a task or a document 
based on predefined criteria in the Assignment Manager.
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attachment
An attachment is any document associated with one or more application modules. 
You can view attachments as you review and maintain a module. For example: 
operating instructions, purchase order, notes, item drawings, presentations, or an 
employee photo can be an attachment.

audit
An audit displays a history of changes that have been made to information in 
Oracle e-Business Suite.

automatic assignment 
Automatic assignment refers to the matching of territories to resources resulting in a 
"Winning Territory" in Territory Management.

bins
Bins are small reports, which display high-level summary information in a tabular 
format on your homepage.

business rule
A business rule is a user-defined condition. When a rule is violated, a relevant 
workflow process can be triggered.

Business Rule Monitor (BRM) 
The Business Rule Monitor is the engine that monitors documents over time against 
user-defined business rules.

business rule owner
A business rule owner is an employee resource who enforces the business rules.

business rule workbench
The Business Rule workbench is used to define a business rule in BRM.

business user
A business user is a typical Business to Business (B2B) user, associated with an 
organization. Generally, the Primary user(s) of the same organization approves 
these users.
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Calendar (HTML)
The HTML Calendar is a tool to effectively manage your daily activities, 
appointments, and tasks.

Calendar (Forms)
The Forms-based Calendar is a scheduling tool used to define and view available 
and non-available time for a resource or group of resources.

calendar datebook
The calendar datebook displays time availability for yourself, a resource, or a group 
of resources in the Forms-based Calendar.

concurrent manager
The concurrent manager is a process manager that coordinates the processes 
generated by users’ requests to run various data-intensive programs. An Oracle 
applications product group can have several concurrent managers.

contact
A contact contains information about a person and how to locate them such as their 
phone number and email address.

control tower
The Control Tower is a window in Field Service where you can view resource 
availability or assign resources to a task.

customer
Customers are typically primary users, Business to Business (B2B) users, business to 
Customer (B2C), and (individual) users.

customer relationship escalation
A customer relationship escalation is an escalation document that escalates multiple 
support requests, defects, or tasks.

customization
Customizations are enhancements to an Oracle Applications system made to fit the 
needs of a specific user community.
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defect
A defect is a document that tracks product problems and resolutions in Escalation 
Management. A defect can be escalated without an associated service request. It is 
escalated through Oracle Quality Online (OQO), formerly known as the Defect 
Management System.

dependency
A dependency is where one task must complete before another. This functionality is 
only available in the Forms-based Task Manager.

dynamic group
A dynamic group is a group which is created based on your criteria by using SQL 
statements in the Resource Manager.

effective dates
Effective dates are the dates used by Oracle e-Business Suite to specify when 
something is going to begin.

employee
An employee is a resource type that represents a person who is hired to work for a 
company. Employee resources can be imported as resources from the Oracle Human 
Resources Management System (HRMS). 

enrollment
Enrollment is a set of add-on services that you can receive during or after 
registration in User Management. One enrollment corresponds to zero or one 
responsibility, zero or one template, zero or one approval and zero or more roles. 
Enrollments are application specific and can be tied to user types.

escalation
An escalation is a modification of a process, a status, or both, to reflect an increased 
level of importance and a more immediate degree of response.

escalation management
Escalation Management is the process of managing proactive and reactive 
escalations. Proactive escalations are managed using the Business Rule Monitor and 
reactive escalations are managed using Escalation Manager.
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Escalation Manager
Escalation Manager is a tool used to reprioritize, reassign, and monitor a situation, 
such as a service request or task, to a satisfactory completion.

escalation owner
An escalation owner is a person who oversees the escalation task, or document in 
Escalation Management. Once a task or document is escalated, the responsibility of 
the original owner of the escalated task is transferred to the escalation owner. For 
example, a defect is escalated to Rhonda Abbott and Rhonda becomes the escalation 
owner of this defect. John Smith, the original owner of the escalated defect, is no 
longer responsible for the defect.

escalation plan
An escalation plan is a series of follow up tasks that are attached to the escalation 
document. 

exception
An exception is defined the time that a resource is not available in the Forms-based 
Calendar. Examples of exceptions include holidays, vacations, sick days, or 
weekends.

explicit enrollment
Explicit enrollments are enrollments that you manually register for during the 
registration process from the "Register Here" link in User Management.

forms
Forms are a logical collection of fields, regions, and graphical components that 
appears on a single screen. Oracle applications forms resemble paper forms used to 
run a business. You enter data by typing information into the form.

forms server
A Forms server is a type of application server that hosts the Forms server engine. It 
mediates between the desktop client and the database, providing input screens for 
the Forms-based products on the desktop client and creating or changing database 
records based on user actions.
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framework
A framework is a collection of collaborating classes. The interaction framework 
dictates the architecture. It defines the overall structure, its partitioning into classes 
and objects, the key responsibilities, how the classes and objects collaborate, and the 
thread of control. 

full access
Full access provides you with the ability to read and edit, and delete a record. This 
access type does not include the capability of granting access to others.

functions (privileges)
A function is an action that can be performed on an object or object instance. It can 
be granted to a user or user group that means gives them permission to perform 
that function. Therefore, a function can also be referred as a permission or privilege 
from a user’s point of view.

Gantt Chart
The Gantt chart provides a graphical overview of the scheduled tasks for resources. 

grant (authorization)
A grant is an authorization for the grantee (users, or user groups) to perform the 
specified object role on the specified object instance or object instance set. 

group calendar
A group calendar is a calendar used only by its subscribers in the HTML Calendar. 
For example, a group calendar called Key Account can be used by any subscriber 
after the subscription is approved.

GUI
An interface used with personal computers and workstations that allows the user to 
access fields and regions of the screen with a pointing device, typically a mouse. 
The acronym is pronounced "goo-ee."

HTML (hypertext markup language)
HTML is a simple language used to format documents, predominantly for viewing 
with a web browser. Portions of text or images, called hypertext, can be associated 
with other documents.
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HTTP (Hypertext transfer protocol)
The TCP/IP-based network protocol used to transmit requests and documents 
between an HTTP server and a web browser.

HTTP listener
An HTTP listener is a program on an HTTP server that accepts and processes 
incoming HTTP requests from web browsers.

implicit enrollment
These are enrollments for which a user is automatically registered for during the 
registration process using the "Register Here" link In User Management. The user is 
not asked to register for these enrollments. Instead, they are automatically attached 
to the user upon registration.

individual user
An individual user is an individual with no relationship to an organization in User 
Management. Generally, no approval is required for this type of user.

intelligent assignment option
The intelligent assignment option is used only in the Field Service Dispatch Center 
to assign the resource with the lowest cost. 

JAR (java archive) file
JAR files are a collection of Java classes compressed into files for faster download to 
a desktop client.

java class
Java classes are components of a Java program that define objects and operations 
performed on objects. A Java class also identifies an operating system file that 
contains a program or part of a program written in Java.

JInitiator
Oracle JInitiator enables end users to run Oracle Developer Server applications 
directly within Netscape Navigator or Microsoft Internet Explorer on the Windows 
95, 98, or 2000 and Windows NT4.0 platforms. Implemented as a plug-in (Netscape 
Navigator) or ActiveX component (Microsoft Internet Explorer), Oracle JInitiator 
allows you to specify the use of Oracle’s Java Virtual Machine (JVM) on web clients 
instead of having to use the browser's default JVM.
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JSP
Java server pages are an extension to the Java servlet technology that was 
developed by Sun as an alternative to Microsoft's ASPs (Active Server Pages). JSPs 
have dynamic scripting capability that works in tandem with HTML code, 
separating the page logic from the static elements — the actual design and display 
of the page.

list of values (LOV)
A list of value is a predefined list of choices that the user has to chose from.

menus (roles)
A menu is a grouping of functions. It is required to group functions into related sets 
of menus necessary to perform a particular job role on an object instance. A good 
example is an "Administrator" menu, which might include many functions required 
for a user with an administrator role to perform his job. Therefore, menus can also 
be referred as roles. 

merchant administrator (system administrator)
The Merchant or System Administrator is the main administrator of a company 
who approves requests for primary, business, and individual users in the User 
Management process. This System Administrator, who has the JTF_REG_
APPROVAL permission, sees all the pending requests to be approved and is able to 
approve them.

merchants
Merchants refer to implementors of the Oracle E-Business Suite. This term is used to 
clear up any confusion with the term “customers”, which refers to customers of a 
business using Oracle products as opposed to those implementing the product.

Notes
Notes is a tool that provides additional text locations where you can specify more 
detail, if needed. A note can be added to a task.

note source
A note source is the originating module of the note. For example, if the notes are 
entered from a service request application, then the source of the note is Service 
Request.
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note status
Note status determines note accessibility. For example, you can define a private note 
with status of Personal so that only you can see the note.There are three statuses 
available for notes that you can set:

� Private: Only the creator can view it.

� Public: The creator and others can read or write to it.

� Publish: Publishable over the Internet. Everyone can view it. This status is 
currently not used.

note text
A large type note, such as a customer’s letter or directions.

note type
Note types provide a further categorization to the notes based on a user’s 
individual needs. Also, a note type can be tied to a source type and such note types 
are visible only to that mapped source. Therefore, you must choose between the 
entire note types that have been defined for your source and those which do not 
have any source type attached to them.

Objects
An object is a type of thing on which security can be managed. For example, Tasks 
and Notes can be examples of an object.

In a technical definition, each object must be registered in the FND_OBJECTS tables. 
Every object definition will contain related database object (table or view) and 
primary key information for the object.

Object Instances
An object instance is a subset of an object. This generally corresponds to a row (or 
related set of rows) in the database. For example, if Notes is considered an object, 
then the Note with number 1541 is an object instance.

In a technical explanation, object instances are derived from the primary key values. 
The primary key values should be set for the registered object in the FND_GRANTS 
table.
Glossary-9



Object Instance Sets
An object instance set is a group of multiple object instances. For example, all notes 
with a number smaller than 5 could be considered as an object instance set. 

In a technical definition, object instance set definition is stored in the FND_
OBJECT_INSTANCE_SET table. The definition contains a SQL where clause, the 
predicate, that combined with the object definition will return all the object 
instances that are part of the object instance set. 

OMO
OMO is an acronym for Oracle Marketing Online.

OSO
OSO is an acronym for Oracle Sales Online.

other/TBH
Other/THB is the only resource that is created and not imported in the Forms-based 
version of Resource Manager. Use this resource to create a salesperson that is going 
to be hired (TBH) but is not yet an employee.

owner
An owner is a resource person who oversees a task or a document. Use the Task 
Manager: Default Task Owner profile option to set the default to a specific owner. 
For example, tasks can be owned by a specific employee such as Ms. Marsha Able. 
This way she can oversee the work completed per task.

partner
A partner is one of two or more persons who contribute capital to establish or 
maintain a commercial venture and who usually share in the risks and profits. 

party
A party is a person, group, or organization and is owned by TCA. Party relates to 
an employee, customer, or organization that can be related to a task.

permissions
A permission is the HTML equivalent to a responsibility.
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platform
Within a resource category, there could be numerous platforms in skills 
management. A resource can be rated individually for each of those platforms. 
Platforms can be rated with the following: foundation, intermediate, skilled, 
advanced, expert, or N/A.

PL/SQL
PL/SQL is a procedural extension of SQL that provides programming constructs 
such as blocks, conditionals, and functions.

port
In TCP/IP and UDP networks, a port is an endpoint to a logical connection. The 
port number identifies what type of port it is. For example, port 80 is used for HTTP 
traffic. 

primary user
A primary user is a designated person of an external organization, like a business 
partner, who is responsible for some administrative functions on behalf of the 
external organization in User Management. In the case of registration the primary 
user is responsible for managing the registration and maintenance of users, 
accounts, and enrollments. Primary users of different parties may have access to 
different responsibilities and they may be granted different access rights.

privileges
Privileges define how a user can operate a system resource on a network or a file 
server. Privileges also define a right to execute a particular type of SQL statement or 
to access another user's object. For example, the right to create a table or session.

problem code
Within a category in skills management, there could be numerous problem codes. A 
resource can be rated individually for each of those problem codes. Problem codes 
can be rated with the following: foundation, intermediate, skilled, advanced, expert, 
or N/A.

product
Within a category in skills management, it is possible to have numerous products. A 
resource can be rated individually for each of those products. A product can be 
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sub-divided into components. Products can be rated with the following: foundation, 
intermediate, skilled, advanced, expert, or N/A.

profile option
A profile option is a set of changeable attributes that affect the way Oracle 
applications appear and how they function.You set profile options whenever you 
want the application to react in different ways for different users, depending on 
specific user attributes. They can be set at the user, application, site, or responsibility 
level.

proxy server
A server that sits between a client application, such as a Web browser, and a real 
server. It intercepts all requests to the real server to see if it can fulfill the requests 
itself. If not, it forwards the request to the real server. 

public calendar
A public calendar can be used by everyone. Examples of public calendars can be 
corporate holiday calendar and local holiday calendars for branch offices.

read-only
Read-only access provides you with read-only capability. You cannot edit or delete 
any information.

recurrence
Recurrence is where a task is repeatedly assigned to a user in a pre-specified time 
increment such as daily, weekly, monthly, or yearly.

reference document
A reference document is a document that is linked to an escalation document. For 
example, a service request (number 9229) is escalated to John Smith in an escalation 
document (number 11749), then this service request (number 9229) is a reference 
document.

reference
Reference is where one task relates to another document. For example, a task can be 
related to a service request.
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reference type
A reference type specifies whether or not a reference document is escalated or used 
to provide additional information in Escalation Management.

registration
Registration is the process by which any user gains some access to the application’s 
functionality.

registration self-service administration UI
The registration self-service administration UI is used by System Administrators, 
and at times primary users, to maintain external organization or internal group, 
users, parties, and accounts in User Management.

registration self-service user UI
The registration self-service user UI is used by the primary, individual, or business 
users to register themselves in User Management.

registration templates
Applications require varying pieces of information to register different types of 
users in User Management. Registration templates refer to JSP files that are used to 
capture the registration information that is special to a particular user type or 
enrollment.

repeating task
A repeating task is repeated in specified time increment such as daily, weekly, 
monthly, or yearly.

request owner
The request owner is the current approver based on the approver list and current 
state of workflow defined for a given approval in User Management. The request 
owner is only able to approve the requests which they currently own. This user 
should have “JTF_APPROVER” permission. The request owner is tied to the JTF_
UM_APPROVAL_OWNER profile option.

resource
A resource is the basic element of the Resource Manager and is defined as people, 
places and things.
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resource category
There are five types of resources defined in Resource Manager: party, employee, 
partner, supplier contact, other/to be hired (TBH).

resource component
Within a product in skills management, there are numerous components. A resource 
can be rated individually for each of those components. Components can be rated 
with the following: foundation, intermediate, skilled, advanced, expert, or N/A.

Resource Manager
The Resource Manager is a tool used to define, access, and maintain all resources in 
Oracle e-Business Suite.

resource skill category
A resource skill category is the highest level that a resource can be rated in relation 
to skills management. If a resource is rated at the category level, and not rated at 
any one of the product, platform, or product code levels, it does not imply the 
resource is also rated at those levels. Categories can be rated with the following: 
foundation, intermediate, skilled, advanced, expert, or N/A.

responsibilities
Responsibilities are groupings of application menus that determine the user 
interface accessible to a particular user.

role
Roles are groupings of permissions, which are page level and function level 
granular privileges used to maintain application security.

role attribute
A role attribute is associated with a role. It defines the responsibility for each role in 
a group or team in the Resource Manager. For example, a Telesales Agent role 
represents the Member role attribute in a group, and a Sales Manager role 
represents the Manager role attribute in a group.

role type
A role type is a collection of roles associated with a particular module in Oracle 
e-Business Suite.
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salesperson
A salesperson is a generic term used for any person involved in the sale or support 
of products and services.

self-service registration
Rather than asking an Administrator to register users manually, users can register 
themselves through a self-service UI in User Management. Self-service registration 
includes the UI and the background processes used to complete the registration 
process. This involves assigning users the correct data and UI access privileges.

service request
A service request is a document that tracks information about a customer’s product 
and service problems.

servlet
A servlet is a Java program executed on an HTTP server, rather than downloaded to 
a desktop client.

shift
Shifts define a resource's availability to work in the Forms-based Calendar.

shift pattern
Shift pattern is a set of shifts, such as First Shift Monday through Friday 08:00 a.m - 
05:00 p.m. in the Forms-based Calendar.

skills management
Skills management provides the ability to add a new skill rating to a resource in the 
Resource Manager. The resource can update and maintain their skill rating, attach a 
numeric value to each skill level, and change the actual name of each skill level.

source
A source is the originator of the note. For example, if the notes are entered from a 
service request application, then the source of the note is Service Request. Sources 
are pre-defined.

source object
The source object is the originator of the task, note, or appointment; for example, 
Sales, Service, or Contract.
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Spreadtable
A spreadtable is the user interface component that contains row, columns, and 
column headers set in a grid that can be embedded into an Oracle form.

SQL (structured query language)
SQL is an internationally standard language used to access data in a relational 
database. The acronym is pronounced “sequel.”

SQL*Plus
SQL*Plus is an Oracle tool used to submit SQL statements to an Oracle database 
server for execution. It has its own command language.

SQL script
A SQL script is a file containing SQL statements that you run with a tool such as 
SQL*Plus to query or update Oracle data.

supplier contact
A supplier contact is the contact information for a person or agency that sells raw 
material or goods in the Resource Manager. Supplier resources can be imported as 
resources from the purchasing (PO) application. 

system administrator
The System Administrator is the person who manages administrative tasks in 
Oracle Applications, such as registering new users and defining system printers, 
using the System Administrator responsibility.

task
A task is a discrete unit of work that is assigned to one or more individuals. Tasks 
are managed by the Task Manager. Tasks are often scheduled events and have 
defined expirations. 

task assignee
An assignee is the person that is assigned to a task, which can include the owner. 
An assignee can accept, refuse, or reassign the task.

task category
A task category as a way of organizing tasks. For example, the task can be a phone 
call and the category could be call back customer.
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task creator
The creator is the originator of the task and defaults to the owner. However, the 
owner can be modified.

task template
A task template is a skeleton or surrogate task. 

task group template
A task group template is a grouping of different task templates defined during 
setup. 

Task Manager
Task Manager is a tool used to manage tasks throughout other applications. Task 
Manager provides a mechanism for tasks to be created, assigned, managed, sorted, 
and prioritized to provide timely response to customer issues. 

task owner
An owner is the person (resource) that creates and is responsible for the task.

task type
A task type defines the nature of the task such as a callback or a meeting.

TCP/IP (transmission control protocol / internet protocol)
A widely-used industry-standard networking protocol used for communication 
among computers.

team
A team is a collection of cross-functional resources. It is organized for the purpose 
of accomplishing a project in the Resource Manager. Team members are chosen for 
their availability, qualifications, and location. This functionality can be defined in 
the Forms version of Resource Manager only.

template handler
Template handlers refers to how the data flow built by other applications occur 
among registration and how they are associated with enrollments and user types in 
User Management.
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Thin Client Framework (TCF)
The Thin Client Framework server is a middle tier process that enables certain Java 
components of the Oracle Applications user interface to communicate with the 
middle tier and database tier.

tier
A set of machines that perform similar tasks. Client/server is a two-tier 
architecture, with machines on the client tier connecting to machines on the server 
tier. Internet Computing Architecture consists of three tiers. In Release 11i, machines 
on the desktop client tier communicate with machines on the application tier, which 
in turn, communicate with each other and with machines on the database tier.

to do list
A to do list is a personal listing of things to do.

unassisted assignment option
The unassisted assignment option is used to manually assign a resource to a 
document or task of your choice without taking predefined criteria into account in 
the Assignment Manager.

universal primary user approver
Create a universal primary user approver if you want to have multiple primary 
users in User Management.

user
A user is a single person with an account on the system (represented by a row entry 
in FND_USER). Users can be referred as Grantee if they are the subjects of a data 
security grant. These users must be exposed in the WF_USER table.

Users can be grouped into groups.

user group
A user group is any grouping of FND_USERS who are exposed through the WF_
ROLES view. User groups can be referred as Grantee if they are the subjects of a 
data security grant. These user groups must be exposed in the WF_ROLES table.

user ID
The User ID is a combination of a username and its password.
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User Management
User Management is a tool used to registering a user and thereafter maintaining the 
user in the system by granting or revoking privileges, accounts, customer profile 
information, and party relationships based on a set of business requirements 
set-forth by the organization where the process is deployed.

username
A name that grants access to a secure environment or program, such as an Oracle 
database or Oracle applications. A username is customarily associated with a 
collection of privileges and data available to a particular user (responsibilities in 
Oracle Applications). Every username is associated with a password.

user profile
User profiles, which are associated with responsibilities, are a set of user interfaces 
that give users access to their personal data and preferences. 

user type
A user type is a category of users that caters to the specific needs of an application’s 
business requirements in User Management. User types allow flexible and 
extensible ways for defining, categorizing and implementing behavior of users. A 
user type is associated to only one template, one responsibility, zero or one approval 
and zero or more roles.

web availability
Web availability is defined as a resource who has the immediate ability to attend to 
a service request that is assigned online in the Resource Manager.

window to promise assignment option
The Window to Promise assignment option is used only in the Field Service 
Dispatch Center to assign a resource to a specific time slot.

work
Work is broadly defined as a collection of items presented to an agent through the 
e-Business application to be processed. Work items can be either a media item or a 
task.
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workflow
Oracle Workflow automates and continuously improves business processes, routing 
information of any type according to business rules you can change. Oracle 
Workflow manages business processes according to rules that you define. The rules, 
which we call a workflow process definition, include the activities that occur in the 
process and the relationship between those activities. An activity in a process 
definition can be an automated function defined by:

� a PL/SQL stored procedure or an external function

� a notification to a user or role that they may request a response

� a business event

� a subflow that itself is made up of many activities.

workflow attributes
Workflow attributes control the behavior of the workflow.

workflow monitor
The workflow monitor is a Java based tool used for administering and viewing 
workflow process.
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